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Reference Manual
SENSORMATIC ELECTRONICS CORPORATION 
KANTECH – TYCO SAFETY PRODUCTS 

END-USER LICENSE AGREEMENT 

FOR KANTECH Software Provided With or Without Products or Components

IMPORTANT - READ CAREFULLY
KANTECH Software purchased with or without Products and Components is copyrighted and is purchased
under the following license terms:

• This End-User License Agreement (“EULA”) is a legal agreement between You (the company, individual or 
entity who acquired the Software and any related Hardware) and Sensormatic Electronics Corporation (“KAN-
TECH”), the manufacturer of the integrated security systems and the developer of the software and any related 
products or components (“HARDWARE”) which You acquired.

• If the KANTECH software product (“SOFTWARE PRODUCT” or “SOFTWARE”) is intended to be accompanied 
by HARDWARE, and is NOT accompanied by new HARDWARE, You may not use, copy or install the SOFT-
WARE PRODUCT. The SOFTWARE PRODUCT includes computer software, and may include associated 
media, printed materials, and “online” or electronic documentation. 

• Any software provided along with the SOFTWARE PRODUCT that is associated with a separate end-user 
license agreement is licensed to You under the terms of that license agreement. 

• By installing, copying, downloading, storing, accessing or otherwise using the SOFTWARE PRODUCT, You 
agree unconditionally to be bound by the terms of this EULA, even if this EULA is deemed to be a modification of 
any previous arrangement or contract. If You do not agree to the terms of this EULA, KANTECH is unwilling to 
license the SOFTWARE PRODUCT to You, and You have no right to use it.

SOFTWARE PRODUCT LICENSE
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as
other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold. 

1 GRANT OF LICENSE - This EULA grants You the following rights:
a Software Installation and Use - For each license You acquire, You may have only one copy of the 

SOFTWARE PRODUCT installed. 
b Storage/Network Use - The SOFTWARE PRODUCT may not be installed, accessed, displayed, run, 

shared or used concurrently on or from different computers, including a workstation, terminal or other digi-
tal electronic device (“Device”). In other words, if You have several workstations, You will have to acquire a 
license for each workstation where the SOFTWARE will be used.

c Backup Copy - You may make back-up copies of the SOFTWARE PRODUCT, but You may only have one 
copy per license installed at any given time. You may use the back-up copy solely for archival purposes. 
Except as expressly provided in this EULA, You may not otherwise make copies of the SOFTWARE 
PRODUCT, including the printed materials accompanying the SOFTWARE.

2 DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS
a Limitations on Reverse Engineering, Decompilation and Disassembly - You may not reverse engineer, 

decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is 
expressly permitted by applicable law notwithstanding this limitation. You may not make any changes or 
modifications to the Software, without the written permission of an officer of KANTECH. You may not 
remove any proprietary notices, marks or labels from the Software Product. You shall institute reasonable 
measures to ensure compliance with the terms and conditions of this EULA.
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b Separation of Components - The SOFTWARE PRODUCT is licensed as a single product. Its component 
parts may not be separated for use on more than one HARDWARE unit.

c Single INTEGRATED PRODUCT - If You acquired this SOFTWARE with HARDWARE, then the SOFT-
WARE PRODUCT is licensed with the HARDWARE as a single integrated product. In this case, the SOFT-
WARE PRODUCT may only be used with the HARDWARE as set forth in this EULA.

d Rental - You may not rent, lease or lend the SOFTWARE PRODUCT. You may not make it available to oth-
ers or post it on a server or web site.

e Software Product Transfer - You may transfer all of Your rights under this EULA only as part of a perma-
nent sale or transfer of the HARDWARE, provided You retain no copies, You transfer all of the SOFT-
WARE PRODUCT (including all component parts, the media and printed materials, any upgrades and this 
EULA), and provided the recipient agrees to the terms of this EULA. If the SOFTWARE PRODUCT is an 
upgrade, any transfer must also include all prior versions of the SOFTWARE PRODUCT

f Termination - Without prejudice to any other rights, KANTECH may terminate this EULA if You fail to com-
ply with the terms and conditions of this EULA. In such event, You must destroy all copies of the SOFT-
WARE PRODUCT and all of its component parts.

g Trademarks - This EULA does not grant You any rights in connection with any trademarks or service marks 
of KANTECH or its suppliers.

3 COPYRIGHT

All title and intellectual property rights in and to the SOFTWARE PRODUCT (including but not limited to any
images, photographs, and text incorporated into the SOFTWARE PRODUCT), the accompanying printed
materials, and any copies of the SOFTWARE PRODUCT, are owned by KANTECH or its suppliers. You may
not copy the printed materials accompanying the SOFTWARE PRODUCT. All title and intellectual property
rights in and to the content, which may be accessed through use of the SOFTWARE PRODUCT, are the prop-
erty of the respective content owner and may be protected by applicable copyright or other intellectual prop-
erty laws and treaties. This EULA grants You no rights to use such content. All rights not expressly granted
under this EULA are reserved by KANTECH and its suppliers.

4 EXPORT RESTRICTIONS

You agree that You will not export or re-export the SOFTWARE PRODUCT to any country, person, or entity
subject to US export restrictions. 

5 CHOICE OF LAW

This Software License Agreement is governed by the laws of the State of New York.

6 LIMITED WARRANTY
a NO WARRANTY

KANTECH PROVIDES THE SOFTWARE “AS IS” WITHOUT WARRANTY. KANTECH DOES NOT WAR-
RANT THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT OPERATION OF THE
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE.

b CHANGES IN OPERATING ENVIRONMENT
KANTECH shall not be responsible for problems caused by changes in the operating characteristics of the
HARDWARE, or for problems in the interaction of the SOFTWARE PRODUCT with non-KANTECH SOFT-
WARE or HARDWARE PRODUCTS.

c LIMITATION OF LIABILITY; WARRANTY REFLECTS ALLOCATION OF RISK 
IN ANY EVENT, IF ANY STATUTE IMPLIES WARRANTIES OR CONDITIONS NOT STATED IN THIS
LICENSE AGREEMENT, KANTECH'S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS LICENSE
AGREEMENT SHALL BE LIMITED TO THE GREATER OF THE AMOUNT ACTUALLY PAID BY YOU TO
LICENSE THE SOFTWARE PRODUCT AND FIVE US DOLLARS (USD$5.00). BECAUSE SOME JURIS-
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DICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL
OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

d DISCLAIMER OF WARRANTIES
THIS WARRANTY CONTAINS THE ENTIRE WARRANTY AND SHALL BE IN LIEU OF ANY AND ALL
OTHER WARRANTIES, WHETHER EXPRESSED OR IMPLIED (INCLUDING ALL IMPLIED WARRAN-
TIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE) AND OF ALL OTHER
OBLIGATIONS OR LIABILITIES ON THE PART OF KANTECH. KANTECH MAKES NO OTHER WAR-
RANTIES. KANTECH NEITHER ASSUMES NOR AUTHORIZES ANY OTHER PERSON PURPORTING
TO ACT ON ITS BEHALF TO MODIFY OR TO CHANGE THIS WARRANTY, NOR TO ASSUME FOR IT
ANY OTHER WARRANTY OR LIABILITY CONCERNING THIS SOFTWARE PRODUCT.

e EXCLUSIVE REMEDY AND LIMITATION OF WARRANTY
UNDER NO CIRCUMSTANCES SHALL KANTECH BE LIABLE FOR ANY SPECIAL, INCIDENTAL, CON-
SEQUENTIAL OR INDIRECT DAMAGES BASED UPON BREACH OF WARRANTY, BREACH OF CON-
TRACT, NEGLIGENCE, STRICT LIABILITY, OR ANY OTHER LEGAL THEORY. SUCH DAMAGES
INCLUDE, BUT ARE NOT LIMITED TO, LOSS OF PROFITS, LOSS OF THE SOFTWARE PRODUCT OR
ANY ASSOCIATED EQUIPMENT, COST OF CAPITAL, COST OF SUBSTITUTE OR REPLACEMENT
EQUIPMENT, FACILITIES OR SERVICES, DOWN TIME, PURCHASERS TIME, THE CLAIMS OF THIRD
PARTIES, INCLUDING CUSTOMERS, AND INJURY TO PROPERTY.

WARNING: KANTECH recommends that the entire system be completely tested on a regular basis. However,
despite frequent testing, and due to, but not limited to, criminal tampering or electrical disruption, it is possi-
ble for this SOFTWARE PRODUCT to fail to perform as expected.
v1 •  
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Chapter 1 • Introduction
Welcome to EntraPass, a powerful multi-user access control system that provides all the features 
required in the most demanding applications.

What is EntraPass? EntraPass is a comprehensive, menu-driven access control software 
package. Among the many features, EntraPass offers:
• Remote communication capability 
• Configurable desktops
• Integrated Badging capability
• Multiple reader technology
• Interactive floor plans
• Time and Attendance reporting
• Visual diagnostics
• SmartLink interface
• Elevator control
• Video Integration
• Local anti-passback

What is access control?  Access control consists of a set of components (door readers, exit 
detectors, motion detectors, etc.) that are professionally installed and electronically controlled. 
System workstations are used to receive event messages, acknowledge alarms, modify the system 
database, etc. A supporting advantage of access control is that all system events are carefully 
archived and can be easily retrieved for inspection purposes. 
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Some EntraPass Features 
Visual Diagnostics. EntraPass offers on-screen real-time visual representation of the system 
devices, with conditions updated in real-time, including high resolution floor plans that can be 
imported and displayed on screen. Interactive system icons can be added to the graphic to display 
component status in real-time. Manual operations may be performed from the real-time system 
graphic.

Express Setup.  The Express Setup utility enables installers to automatically define and 
configure the most standard system components. This saves installation time and prevents setup 
errors. With Express Setup, the system is fully functional and ready to test the hardware and 
wiring before the installer makes the customized changes necessary for a particular site.

Integrated Badging.  The Integrated Badging feature was added to EntraPass to allow users to 
design and print badges. Pictures and signatures can be imported or, with the necessary devices, 
captured and incorporated into cards for printing badges.

Vocabulary Editor.  The system is multilingual. It is available in English, French, Spanish and 
German. It can also be translated in up to 99 languages.

Time and Attendance feature.  The Time and Attendance feature is a low-cost alternative to 
high-priced dedicated Time and Attendance systems. It enables operators to print or download 
time sheets in a CSV format to a payroll system.

SmartLink feature. EntraPass enables organizations to interface to most intelligent devices 
such as CCTV multiplexers, alphanumeric pager systems, LCD panels, video matrix switchers, 
etc., using an RS-232 link cabled between one of the EntraPass SmartLink workstation and the 
external device. This feature can also be used to create, in real time, text or CSV files containing 
specific information concerning an event. These files can then be used with third party Time and 
Attendance systems, spreadsheet programs, etc.

Elevator Control capability. EntraPass allows installers to program up to 64 floors per 
elevator cab using expansion devices such as KT-PC4216, KT-PC4204 or REB-8. 
This indispensable feature in a multi-tenant building allows facility managers to restrict specific 
floor access to authorized cardholders. 

Video Integration.  EntraPass adds real-time monitoring capability to the Corporate and 
Global series as a response to the growing importance of video in access control systems. From 
EntraPass Corporate and Global Edition user interfaces, operators can configure viewing 
parameters for digital video applications.

Redundant Server & Mirror Database. The Redundant Server & Mirror Database option 
provides an alternative duplication mechanism in case of failures and errors of the Primary Server. 

Using KT-100, KT-200 and KT-300 controllers.  EntraPass is compatible with 
Kantech’s KT-200 controller, KT-100 and KT-300 controllers. This has an added benefit when 
1 • Some EntraPass Features2
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upgrading existing sites that require more flexibility and improved user interfaces. It also allows 
installers to select the controller that best suits their customers’ needs and budget.

Interfacing with external alarm panels.  KT-100 and KT-300 controllers allow users to 
arm, disarm, and postpone the arming of an external alarm panel through. This allows EntraPass to 
easily integrate with an external alarm system.
31 • Some EntraPass Features 
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EntraPass Manual and Help

Using the Reference Manual
The Reference Manual is designed for EntraPass system installers, administrators and users. You 
may refer to the hard copy of the manual or to the on-line version in pdf format. 
To download an updated version of Acrobat Reader, browse to http://www.adobe.com. 

Getting Help
Our window-level help will provide you with immediate and context-related help. Press [F1] on 
your keyboard to display the help related to the active window or select [Help] [Contents] from the 
EntraPass menu. 
For immediate help, use the Help button, found in all the system window. You may also use the 
right-click option; it may either display a shortcut menu or the help file of the active window. 

Technical Support
If you cannot find the answer to your question in this manual or in the Help files, we recommend 
you contact your system installer. Your installer is familiar with your system configuration and 
should be able to answer any of your questions. 
Should you need additional information, please call our Customer Assistance Service, Monday to 
Friday 8:00 AM to 8:00 PM E.S.T. (GMT -5:00)

Phone +1 (450) 444-2030

Fax +1 (450) 444-2029

US & Canada 1 888 222-1560 (Toll Free Number)

Internet http://www.kantech.com

E-mail kantechsupport@tycoint.com
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Chapter 2 • Software Installation
Before any installation takes place, make sure that the computers on which the software will be 
installed meet the necessary requirements.
For information concerning hardware equipment installed with the software, refer to the 
documentation supplied with the hardware deviserverorces.
This chapter contains information related to the EntraPass software. You will find:
• System requirements
• Software installation and upgrading
Depending on the system configuration, there are different system hardware requirements for the 
installation of the EntraPass software.
72 •  



Reference Manual
System Requirements
Make sure that the computer on which you are installing the software meets the following 
requirements:
• Operating Systems: Windows 98 (Second edition)/NT/2000/XP 
• Processor: Pentium III at 800 MHz (minimum)
• RAM: 256 MB RAM minimum
• Minimum free hard disk space: 4 GB 
• Color depth (for Video Integration): 24-bit (16 million colors)
• Screen resolution: 1024 x 768
• Graphic adapter: 32 MB 
• CD-ROM drive
• Network Interface card: 100 Base-T network adaptor

Video Applications
• Pentium III with 256 MB RAM recommended 
• Windows 98/2000/XP/NT, version 4, and Server 2003
• Microsoft XP Home and Professional
• Graphic adapter with at least 32MB of RAM
• Monitor with a resolution of at least 1024 x 768

Additional Requirements
For some applications, you can use the following devices:
• A video capture card—to capture user images for card identification
• A sound card—to use warning sounds when an alarm is reported
• A badge printer— to print badges (Badging)
• A signature capture device— to capture signatures (Badging)
• A log printer—(dot-matrix or laser) to print events (messages and alarms)
• A Report printer—(laser) to print reports
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Installation Kit 
The EntraPass installation package contains EntraPass software CD as well as the Reference 
Manual. It also contains a CBLK-10 kit including 100-foot cable, 2 connectors from KT-200/KT-
300 and a DB9 to DB25 adaptor. 
Your installation CD allows you to install the basic components of your EntraPass: 
• 1 Server application and 1 Workstation application (for configuration purposes)
• Report Viewer
• Vocabulary Editor
• 1 workstation application 
• 1 Corporate gateway application
• SmartLink and SmartLink Network Interface
The installation CD also contains system advanced options. They require an additional license:
• 6 Additional workstation applications (for a maximum of 20 +1)
• 40 Corporate gateway applications
• Redundant Server & Mirror Database application 
• Oracle/MS-SQL HR Interface application

NOTE: Additional options can only be installed after the EntraPass Server has been 
registered. They require an additional license.
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Installation Steps
It is easy to install EntraPass. The InstallShield Wizard guides you through the steps. All you need 
to do is to enter the System Installation Code (located on the software CD) and follow the 
instructions displayed on the screen.

Installing EntraPass Software   
The system will be up and running in only a few steps stages! Installers need to:
1 Install the software using the System Installation Code located in the CD pocket.
2 Register the system using the Registration Confirmation Code provided by Kantech Customer 

Assistance. 
3 Install the first components that are part of the installation kit (5 workstation applications and 

1 gateway; the first workstation application is automatically installed during the installation of 
the EntraPass Server).

NOTE: The software is fully functional even before it is registered. However, an unregistered 
system is restricted to ten cards. Moreover, there is an automatic logout after 1 hour of idle 
time, that is, when there is no action on the keyboard. After an automatic logout, operators 
need to enter a 20-character password; it is displayed in the lower part of the screen.

Adding Optional Components/Features
Only four steps are required to install additional components/features to your system. And there 
are two ways of doing it: 
1 Use your installation cd to install additional components all at once, or go through the Server 

or Workstation Registration window to add individual components to your system.
2 Call Kantech to obtain or register the component/option Option Code (located on the Option 

Certificate) and get the Registration Confirmation Code.
3 Enter the Registration Confirmation Code in the Registration window and activate the option. 
4 Install the component or option using the Installation Code (if applicable). The Installation 

Code is generated by the system; it is displayed in the Registration window. 

NOTE: You need to establish communication between the EntraPass Server and the computer 
where the new component/option is installed (if applicable). Perform this step only if you have 
installed the component/option on a computer other than where the EntraPass Workstation 
application has been installed. 
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Installing the System 
1 Before you begin the installation, make sure that no EntraPass application is running.
2 Insert the software CD into the CD-ROM drive. The installation program should start 

automatically if your computer is configured to autorun. If the installation program does not 
start automatically, click Start > Run, then enter d:\Setup.exe (where d: is the CD-ROM drive) 
in the displayed field. The system displays the installation setup window.

3 Before you go any further, you must select which language you wish to install the system in. 
English is selected by default.

NOTE: The system language depends on the language you select when installing the software. 
For example, if you select “French”, it will be the system default language at start up.

4  Click Next. The Welcome screen will be displayed.
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All the installation windows look the same as the Welcome window. 
• You will notice the software version you are about to install is located at the top left. 
• The middle section of the window contains the instructions you will follow throughout 

the installation process. The instructions will be updated automatically when you click 
Next.

• Back and Next buttons are available at the bottom of the screen to allow navigating back 
and forth within the installation screens if you wish to verify or modify a parameter you 
previously setup. 

• You can Cancel the installation at any time.
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5 Click Next to continue the installation. The Setup Start window will be displayed.

6 Select the operation(s) you wish to perform. The first set of options are for new installs and 
the last option is for updates. During the first installation, you will only be able to select one 
of the install options. We suggest that you install the first option in the list.
• Install Server, Database and Workstation: This option will install the EntraPass 

CorporateEdition system. It will be grayed out if the application is already installed on the 
machine.

• Install Additional Workstation: This option is selected when you are installing an 
additional workstation. It will be grayed out if a server or a workstation is already 
installed on the machine.

• Install System Options: This feature allows installing EntraPass options (card format, 
printer options, system parameters, etc.). You will need to contact Kantech Systems Help 
desk to get the registration key number to install the system options. see “Registering the 
System” on page 19. The feature will be grayed out if all options have already been 
installed on the machine.

• Install System Tools: This option allows installing EntraPass System Utilities (EntraPass 
Video Vault, Smartlink, Gateway Interface, etc.). You will need to contact Kantech 
Systems Help desk to get the registration key number to install the system options. see 
“Registering the System” on page 19. The option will be grayed out if the utilities have 
already been installed on the machine.

• Update Installed Applications: This option will be grayed out if the system has not been 
installed previously. To update your EntraPass system, see “Updating the System” on 
page 24.
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7 Click Next. The Serial Number window will be displayed.

8 Enter the Serial Number for the EntraPass Corporate Server  or Software.The information is 
located in the CD pocket. Make sure to enter the correct digits. The Next button is only 
enabled if the installation code is correct.

9 Click Next. The Setup window will be displayed, indicating the installation progress. Once 
completed, the system displays the software End-user license agreement.
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10 Click I accept... if you understand and agree with the conditions described in the end-user 
license agreement or click I do not accept... to cancel the installation.

NOTE: You will not be able to complete the installation if you refuse the terms of the license 
agreement. The Next button will remain grayed out until you select I accept...

11 Click Next. The Customer Information screen will be displayed.

12 Enter the User Name and the Company Name.
13 Select the user type: Anyone who will use this computer 

or Only the person currently logged in and registered in 
the system.

14 Click Next.You will be prompted to select the system and 
database language.

15 Select the primary language. You can select a secondary 
language or leave the selection to None. 
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16 Click OK. The Choose Destination window will be displayed.

17 Click Next to accept the default installation folder indicated in the window.
• If you want to change the directory where to install the application, click Change. The 

Choose Folder dialog will pop up where you can select the new installation directory.

• Type in the destination directory where you want to install EntraPass or double-click the 
directory structure all the way down to the destination directory. Then, click Ok. The path 
will be indicated in the Choose Destination Location window.
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• Click Next. The Ready to Install window will be displayed.

18 If you need to review the parameters you’ve setup, click Back. If everything is ready for the 
installation, click Next. The system starts the installation and displays the installation setup 
window. 

19 Once the first option installation is completed, the system will prompt you to consult the Read 
Me file. 
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20 Click Next. The system will verify if there are any other applications or utilities you can 
install. If this is the case, the following message will popup on screen:

• If you want to install other applications, click Yes and start over at number 4.

NOTE: If the application you want to install requires a serial number, you must call the Kantech 
Systems Help Desk to register the system before you can go any further: see “Registering the 
System” on page 19.

• If the installation is completed and you do not wish to install other applications, click No. 
The InstallShield Wizard Completed window will popup:

21 You can select to restart your computer at this time or do it later.
22 Remove the cd from the cd drive.
23 Click Finish to complete the installation.

NOTE: You must restart the computer after the installation.

24 Your next step will be to contact Kantech Systems Help desk to get your registration key 
number for the systems different components. Follow the instructions in the next section of 
this manual.
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Registering the System 
It is recommended to register the system as soon as possible so that users can install additional 
options and use the access system with no restrictions. In fact, though the system is functional 
even before the system registration, it is limited to only 10 cards. Moreover, when the system is 
not yet registered, operators are logged out after one hour of idle time; then they have to enter the 
randomly-generated 20-character password each time they are logged out. 

To register the system:
1 Click the Server icon on the computer desktop. You may also start the EntraPass Server from 

the Windows Start menu (Start > EntraPass  Edition > Server). 
2 Click Login / Logout button. The Operator Login window appears.
3 Enter Kantech in the User name field (not case sensitive). Enter the temporary 20-character 

password displayed at the bottom of the Operator login window (the temporary password 
appears on new installations only). The System registration window appears.

4 Click the Temporary password in use (...) yellow button to register the system. The System 
Registration window appears. This button is visible on new installations only. 

5 Enter the Registration Confirmation Code provided by Kantech, then click OK. The OK button 
is only enabled when you have entered the correct information. 

NOTE: If you exit the Server main window without registering the system, the Change 
Authentication Password window is displayed. It is no longer displayed when the system has 
been registered. 
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Adding Advanced Options
Once the Server has been registered, you may install advanced options. These include EntraPass 
applications and other utilities such as the Video Vault application. Before you install system 
components, make sure that the designated computer meets the minimum requirements.
You do not need to call Kantech Customer Assistance to install the first two workstation 
applications and the first Gateway application. These are part of the installation package.
1 In the Server main window (or Workstation application option window), click the Registration 

icon. The System registration window appears.

NOTE: . One workstation application is automatically installed when the Server is installed. It 
is used for configuration purposes. It does not appear in the lower pane because it is 
automatically installed and registered. Use the installation CD and the Installation Codes to 
install the four additional workstation applications. Make sure that the computer on which they 
are installed meets the minimum requirements.

2 Click the Print button to print the Installation Codes, so that you can take the codes where you 
are installing the workstation or gateway applications. To avoid errors, do not copy the codes 
on a piece of paper. 

NOTE: When you install an advanced option (for example an additional gateway), you can 
configure its sites using the Express Setup utility. 

3 From the System registration window, select the component you want to install. Then select 
the Click here to install component button (left-hand pane). The Component Registration 
(Name of component) window appears.

4 Enter the Option Serial Number (located on the Option Certificate) then call Kantech Customer 
Assistance (phone numbers are displayed on-screen) to get the Registration Confirmation 
Code.
2 • Adding Advanced Options Adding Optional Components/Features20



Reference Manual
5 Enter the Registration Confirmation Code, then click OK. The OK button is only enabled when 
the correct Registration Confirmation Code has been entered.

NOTE: When you have entered the correct Registration Confirmation Code, the system 
generates an Installation Code. Blue flags identify components that have been created, but 
not yet activated. Green flags indicate components that have been activated. 
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Editing System components
EntraPass enable users to assign custom names to applications for easy identification in system 
events. You can also modify components names in their definition menu (Devices > EntraPass 
Applications).

To assign a descriptive name to an application:
1 From the Registration window, select an application, then click the Edit button. The Edit a 

component window appears.

2 Enter a descriptive name for the selected EntraPass application in the Description fields. It is 
recommended to enter two names, one in the primary language and the second in the 
secondary language if EntraPass is run in two languages.

3 Check one or more appropriate option(s):
• Workstation locked: check this option if this application will be installed on a computer 

and be used only for receiving system events.
• Locked for authentication: check this option if you want the computer where you have 

installed the EntraPass application not to send its authentication data to the server.
• Use specific password for authentication: check this option if you want to assign a specific 

password to this workstation. If you select this option, enter the password in the 
Authentication password field.

NOTE: The Application type field displays the type of the selected EntraPass application. For 
instance, it will display “Corporate Gateway” if the selected application is a Corporate 
gateway application. This identification is also displayed in the EntraPass application 
definition window: Devices > Defining an EntraPass application.
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Establishing Communication with the EntraPass Server
After an EntraPass application has been installed on a computer, communication with the 
EntraPass Server must be established between the two computers. The following steps will assist 
you in configuring and establishing the first communication between the workstation application 
and the EntraPass Server using the proper protocol.

NOTE:  Before you proceed, make sure that the Server is online. If it is not, launch it.

To establish communication with the Server:
1 From the Windows Start menu, click on Start > Programs > EntraPass Corporate Edition > 

EntraPass application (x) > Register to Server utility. You may also start the EntraPass 
application; the system automatically launches the registration program when an application 
attempts to connect to the Server before it is registered.

NOTE: The Registration window also appears when you launch an application before the 
EntraPass Server is online. When this happens, simply start the EntraPass Server. 

2 Click to select the communication protocol that is used between the EntraPass Server and the 
EntraPass application.
• NetBEUI: The NetBEUI protocol (NetBIOS Enhanced User Interface) uses the computer 

name to communicate with devices. Enter the name of the computer where the EntraPass 
Server software is installed (case sensitive). The name of the current computer is 
displayed in the status bar. You may use the Scan  button to browse and to 
display existing computer names. 

• TCP/IP: Enter the TCP/IP address of the computer where the EntraPass Server program is 
installed. The EntraPass Server TCP/IP address appears in the Server status bar. 

• Local: Enter Local when registering a component on the same computer as the EntraPass 
Server software is installed. This option will take the address from the Server software.

3 Check the Provide local TCP/IP address button if this EntraPass workstation connects to the 
EntraPass server using a VPN (Virtual Private Network) connection. Type the IP address used 
by the VPN application. This address is provided by the VPN application and is usually 
accessible by clicking on the minimized VPN icon found in the system tray. 

4 You may enter an Authentication Password if you want operators to use a specific password 
when they register EntraPass workstations to the EntraPass Server.
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Updating the System
When you update your software, the system automatically detects the components that are 
installed and updates them.
It is highly recommended to update your system when the system is at its minimum use (Friday 
night, for example.)

Before you update your software
1 Perform a complete backup of your system database. For more information on how to perform 

a backup, see “Backups” on page 444.
2 If you have a Redundant Server & Mirror Database option installed, you MUST shutdown the 

Redundant Server FIRST.
3 Shutdown the EntraPass Server and all other EntraPass applications. No applications should be 

running when you perform a system update. 

NOTE: The update will be performed on all components of your system at once. Once the 
update is complete, DO NOT START THE Redundant Server and Mirror Database yet. 

4 Verify the system database (see “Database Utility” on page 450) to make sure that no errors 
are detected.

5 Once you have verified the database and no errors are present, start the EntraPass Server. 
Once the Server is up-and-running, start the Redundant Server & Mirror Database. It is 
essential to start the Server before starting the Redundant Server and the mirror database. 

6 Once all applications have been updated, we strongly recommend that you reload the 
gateways to ensure that all data will be refreshed and sent to controllers (Operations > 
Gateway reload). 

7 You may also use the View connected List menu item to verify the status of all the system 
gateways and EntraPass applications. For details, see “The EntraPass Server” on page 439.

Update your Software
1 Insert the software installation CD into the CD-ROM drive. The installation program should 

start automatically if your computer is configured to autorun. If the installation program does 
not start automatically, click Start > Run, then enter d:\Setup.exe (where d: is the CD-ROM 
drive) in the displayed field. The system displays the installation setup window.

2 Click Next. The Welcome window will be displayed.
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3 Click Next. The Setup Start window will be displayed. 

4 Select Update Installed Applications and click Next. The Previous Software window will be 
displayed, listing all the software that are currently installed on your machine.
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5 Click Next to continue. The update will start and all programs currently installed on your 
machine will be updated.

6 Click the View button to read the Read-Me File that contains information on the updates that 
were done to the different applications. When you are done with this file, close it. You will 
automatically return to the Setup End window.
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7 Click Next. The system will verify if there are any other applications or utilities you can 
install. If this is the case, a message will popup on screen:

• If you want to install other applications, click Yes and start over at number 2.

NOTE: If the application you want to install requires a serial number, you must call the Kantech 
Systems Help Desk to register the system before you can go any further: see Chapter 2 
‘Registering the System’.

• If the installation is completed, click No. The Maintenance Completed window will 
popup:

8 You can select to restart your computer at this time or do it later.
9 Remove the cd from the cd drive.
10 Click Finish to complete the installation.

NOTE: After the update, you must restart the computer in the order prescribed at the beginning 
of this chapter, see “Before you update your software” on page 24.
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Chapter 3 • Getting Started
This chapter introduces operators to the EntraPass system graphical user interface and basic 
function.
To start an EntraPass session, you have to launch the EntraPass Server, the gateway and the 
Entrapass Workstation. 
The server is a dedicated computer on a network that manages the access control system database. 
It is used to receive and dispatch information from the gateways. Gateways receive information 
from sites and transmit it to the server.
EntraPass Workstations enable operators to access and program the system database and 
components.

NOTE: In the EntraPass Global and Corporate Edition, the Redundant Server & Mirror 
Database option may be enabled to monitor the activity of the Primary Server and to serve as 
an alternative if the Primary Server fails.

The software allows operators to start the gateway and the workstation application at the same 
time by clicking on the Gateway-Workstation icon located on the desktop. 

NOTE: All authorized system operators must have a unique and confidential login name and 
password that should be assigned by the system installer/administrator. It is very important to 
restrict access to the EntraPass workstations to authorized personnel only.
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Starting and Ending a Session
From the Windows Start menu, click Start > Programs > EntraPass Corporate Edition > Server / 
Workstation > (EntraPass application), where the EntraPass application may be a Workstation only 
application, a Gateway application, or any system stand-alone utility. You may also start the 
program from the EntraPass shortcut icon on your desktop.
On startup, the application attempts communication with the Server. The display language 
depends on the settings of the operator who was previously logged on the EntraPass. English is the 
software default language.

NOTE: You have to start the EntraPass server first. If you start an EntraPass workstation 
before starting the server, you are prompted to register your application to the server even 
when the application has already been registered. If the application has been registered, you 
just have to start the server.

Starting the Primary Server
The EntraPass Server is used for:
• Displaying all the applications connected to the server, the system event and system error logs
• Registering new connections (workstation applications, gateway applications, client 

applications such as SmartLink, Video Vault, Report Viewer, etc.) 
• Performing backups (Data, Archives, Time and Attendance databases)
• Restoring data (data, archive, Time and Attendance databases) 
• Verifying database integrity
• Changing the database language

To start the Primary Server:
1 Start the Server (from Windows Start menu or from the desktop). The Server startup window 

displays a progress bar as well as the information related to the server startup process.
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2 From the EntraPass Server window, select the Login/logout button to login.

NOTE: To allow an operator to login to the server, select the option “Allow login on server”, 
during the “Operator security level” definition (System > Security Level). For more information, 
see “Security Level Definition” on page 306.

3 Enter the login information in the Operator login dialog box. The default User name is 
kantech. It is not case sensitive. The default Password is kantech, in lower case; it is case 
sensitive. 

NOTE: The system keeps the last five usernames, allowing operators to select their username 
from the drop-down list. To delete a username from the list, simply select it, then press Delete 
on the keyboard.
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4 Once you have entered the correct login information, the EntraPass Server main window 
appears. Select the desired tab or the corresponding menu item to perform an operation or to 
display system information. 

NOTE: The status bar indicates the communication status: Green: Communication is OK, Red: 
Communication problems. 

5 Point the cursor to the status flag (colored rectangle) to enable a hint describing the displayed 
information: the first two colored rectangles indicate the server database open state and the 
database locked state. 
• If the first status flag is red, this indicates that the system database is not open. This could 

be due to a backup or a database verification in progress. If it is purple, this indicates that 
the database is locked because a backup is being restored or the Mirror database is 
copying data.

• If the second status flag is red, this indicates that the database is unavailable. This 
happens when the server is processing data or updating the database.

Starting the Gateway Program
The gateway program may be installed on the same computer as the server or the EntraPass 
workstation application, but it is recommended to install it on a dedicated computer.
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To start the gateway:
1 Start the Gateway (from Windows Start menu or from the desktop). You do not need to enter a 

password or a username. The EntraPass Corporate Edition main window appears. 

2 You may right click anywhere in the Gateway program window to display a submenu:
• Minimize minimizes the Gateway window
• Send to tray sends the window to the status (tray) bar

3 Pay attention to the progress bars; they indicate:
• Configuration data received from the server: this indicates configuration data such as card 

modifications are being sent to the gateway from the server.
• Data requested by workstation: this is requested data such as a status request.
• Messages sent to server: these messages originating from a controller are sent to the 

server.
4 You may right click anywhere in the Gateway program window to display a submenu:

• Minimize minimizes the Gateway window
• Send to tray sends the window to the status (tray) bar

5 You may select the System menu item to login, to logout, or to perform a gateway reload.
6 You may select the Gateway menu item if you want to choose a gateway. The number of 

gateways that are communicating with the server is displayed on status bar in the gateway 
main window.

NOTE: The status flags show the communication status. The first status flag indicates the 
status of the communication with the server. If red, this indicates that the server is not 
communicating with the gateway. This can occur when the server is offline (you may then 
start the server). The system date and time, the number of gateways and the server IP 
address appear also on the status bar.

Starting the EntraPass Workstation
An EntraPass workstation is a computer where the EntraPass monitoring application has been 
installed. It enables operators to access and program the system database and components. 
Make sure that the server is online when you start the EntraPass workstation software.
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On startup, the workstation application attempts communication with the Server. The display 
language depends on the settings of the operator who was previously logged on the system. 
English is the software default language.

NOTE: Start the EntraPass server first. If you start an application before starting the server, 
you are prompted to register your application to the server even when the application has 
already been registered. If the application has been registered, you just start the server.

To log on an EntraPass Workstation:
1 Start EntraPass workstation (form Windows Start menu or from the desktop). 

2 Click the Login/logout button on the toolbar.

NOTE: When the server is off-line, the first status flag (colored rectangles of the status bar) 
turns red; the Login/logout button is disabled. If this happens, launch the server; the 
EntraPass workstation will resume its operation.
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3 Enter your Operator User name and Password. The password is case sensitive. The default 
User name is kantech. It is not case sensitive. The default Password is kantech, in lower case; 
it is case sensitive. 

NOTE: If you cannot log on properly, check if the Caps Lock key is activated. When proper 
login data have been entered, the system menu, toolbar and status bar are enabled.

NOTE:  Operators are not allowed to login on more than one EntraPass workstation at a time. 
However, an operator may login on the EntraPass Server and EntraPass workstation at the 
same time.

To access information on the workstation connection status:
1 Click any tab to access the system toolbar or select a menu item to access the system menu. In 

the lower part of the window, color-coded flags indicate the communication status: Green, 
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communication is OK; Red: communication problems; Blue: a report is pending. You may 
point the cursor to a rectangle or any number to display details.

2 Move the cursor over the colored rectangles to show details about the network status, the 
network database status and the workstation application report status. 

3 Move the cursor over the displayed numeric values to show details. It will indicate, in order, 
the system date and time, the operator’s name, items in the Alarms desktop, alarms to be 
acknowledged, etc.

4 Double-click (or single click, depending on your system settings) any number in the status bar 
to display the Status information window.

NOTE: It is recommended to use the Login/logout button when you exit EntraPass programs. 
This ensures that the system databases are shutdown properly.

To modify your work area properties:
1 Right click anywhere in the main window to display the Properties window. It allows you to 

customize the window buttons as well as the background color.

2 To modify the size of the toolbar buttons, select one of the following:
• Small buttons: small buttons are displayed below menu items
• Large buttons with images: components icons are displayed on large buttons
• Large buttons without images: no icons are displayed
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3 In the Miscellaneous section, make the appropriate choice:
• Display menu: only the menu bar appears. No icons are displayed. Right-click the work 

area to modify the properties.
• Display toolbar: the menu bar and the toolbar are displayed.

4 Select a background color for the work space.
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Express Setup
Express Setup allows you to configure system components such as sites and controllers, as well as 
devices associated with these components such as doors and inputs. This utility reduces 
programming to a minimum, allowing the installer to test the installation and system components. 
You may use it to configure a site or to define controllers associated with a site.
When used to configure a site, it allows installers to associate this site to a gateway. It also allows 
installers to configure the site rapidly, giving minimum configuration information about the 
controllers connected to it. 
You may launch Express Setup from Windows Start menu: Start > Programs > EntraPass Edition > 
Workstation/Server > Express Setup or by clicking the Express Setup icon from a number of 
EntraPass workstations’ windows. 

NOTE: There are two versions of the Express Setup program.

When used to configure a controller, it allows operators to assign default values to a controller and 
to its associated devices (input, relays and output). In this case, it is launched at a system message 
box or from a controller definition menu.

NOTE: You have to login to the server when you launch Express Setup. In fact, as the program 
allows you to modify the system devices configuration, it is essential to authenticate yourself 
before proceeding with any modification.

For details on Express Setup, see “Express Setup Program” on page 472.
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Other System Stand-Alone Utilities
EntraPass includes a number of stand-alone utilities that allow operators to perform a variety of 
tasks including verifying the system database or changing the system language. The following is a 
list of EntraPass stand-alone utilities:
• Database Utility: This program is intended to re-index archived files, update database fields, 

verify archived files, verify the database integrity, verify the database index, verify the 
database links and verify the database hierarchy. This utility is run while the server is 
shutdown.

• Express Setup: Program used to configure all the components related to a gateway including 
the type of readers used, type of connection, number of sites, number of controllers in a site, 
etc.

• PING Diagnostic: Program used to diagnose network related problems.
• System Report Viewer: Program used by the operator to view reports without having to start a 

Workstation. When this utility is installed, operators can view reports sent by other 
workstations using the EntraPass e-mail feature.

• Vocabulary Editor: Simple and easy program used to translate the software in the language of 
your choice.

• Workstation (Configuration Program): Program, similar to a standard workstation, used by the 
system administrator to configure the system logical and physical components.

• Migration Utility: Program used to transfer information relating to software and database for 
the upgrade from Special Edition to Corporate Edition or Corporate to Global Edition. 

These utilities may be launched from the Windows Start menu of any computer where Entrapass 
Server or EntraPass workstation are installed. For details on EntraPass stand-alone utilities, see 
“System Utilities” on page 449.
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EntraPass Workstation Toolbar
EntraPass windows display most of the following buttons. They are an easier way to access the 
system functions. Usually, a “hint” is displayed when you move the cursor over an icon. 
You may access the EntraPass toolbar from any EntraPass workstation window. Icons vary 
according to the window that is open. Most of the icons are similar to icons you are familiar with 
and that are used in the computer industry. 

Button Description

The New button is used to insert new information in the system 
database. This may be adding a site, a card, a schedule, a 
controller, etc.

The Save button saves all the information you have entered since 
the last save. Information is saved directly in the system.

The Save As button allows operators to save all of the information 
of an existing component under a new name without affecting the 
original component. When using this option while issuing a card, 
it allows you to create a new card or save under a new card number 
without having to modify the information of the original card.

The Delete button is used to delete the currently selected record. 
As a security against accidental deletion, a warning is displayed 
prompting you for confirmation. 
When a component is erased, all links with other items are erased 
as well. However, the records (archives) are kept in the database 
after an item is erased.

The Print button: depending on which menu you are working in, 
the Print button can be used to print reports, card lists, event 
parameters, etc. 

The Parent button allows operators to display their search in a 
hierarchy or to divide searches by gateways, site and controller 
(according to the menu). This button becomes useful when the 
system database increases in size; you can find a specific item by 
selecting its parent items. 
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The Link button enables operators to see all instances of an item in 
other menus. For more information, see “Viewing Components 
Links” on page 51.

The Find button allows operators to find a specific item or 
component in the system database by using a specific character 
string. 
For more information, see “Finding Components” on page 43.

The Express Setup button allows installers and system 
administrators to configure system devices by assigning default 
settings.

The Close button is used to close a menu or a sub-menu. If you 
forget to save your information before closing a menu, the system 
displays a window prompting you to confirm the “save” operation 
before closing the menu.

The Cancel button is used to cancel all modifications that were 
made since the last time a valid save was performed. The system 
will prompt you to confirm the operation.

Use the Help button to view the help content on a specific subject.

The OK button is used to save and accept the modifications, 
additions or deletions made to a record in the database of the 
system.

The Select all button is used to select all the items or components 
displayed in a list.

The Unselect all button is used to unselect all the items or 
components that were previously selected in a list of choices. 

Button Description
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In some system windows, operators have access to graphic and 
animation buttons. These buttons are particularly useful when you 
want to display the status of a component before performing an 
operation on that component.
• The Enable graphic button is used for example in the Status 

menu and in the Operations menu. When enabled, this button 
displays the image related to the selected component (i.e.: 
door) and displays also the associated components (i.e.: 
reader). To display components in real-time, this button must 
be used with the Enable animation button.       

• The Enable animation: when enabled, this button 
automatically enables the Enable graphic button. This 
activates the current component (i.e.: door) and displays its 
status in real-time. For example, if you wish to lock a door 
which was previously unlocked, the reader's image (also 
visible) will be modified; the green dot will change to red.

Right-click • The Right-click shortcut menus allow operators to enable a 
shortcut menu from which they can choose a specific 
command depending on the active menu.

Button Description
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Basic Functions
Following are the basic system operations:
• Find components
• Select components
• Print lists or reports
• View links between components 

Finding Components
The Find Components function allows operators to find a specific item or component in the system 
database by using a specific character string.
There are two types of Find Components dialogs: One that can be accessed from any EntraPass 
window toolbar; One that will be accessed through all the dialogs that pertain to users. 

To find a component:

1 From any EntraPass window toolbar, click . 

2 Enter a keyword to start the search. To reduce the search results, check one of the boxes:
• Start with: Results will list all components that start with the text you specify, in 

alphabetical order, and will include the rest of the list of components available in the 
database.

• Begins with: Results will list only components that start with the text you specified.
433 • Basic Functions Finding Components



Reference Manual
• Contains: Results will list all components that contain the text you specify.
3 Click OK. The system displays the list of the components found according to the search string. 

• To cancel a search in progress, click the Cancel button. 

NOTE: When you select one of the three search options, (Start with, Begin with and Contains), 
the selection will be selected by default the next time you open this dialog.

To find a card:

1 From any EntraPass window that pertains to users, click  in the toolbar. 

2 Enter a keyword to start the search. To reduce the search results, check one of the boxes:
• Start with: Results will list all components that start with the text you specify, in 

alphabetical order, and will include the rest of the list of components available in the 
database. (refer to the screen on the left in the example below.)

• Begins with: Results will list only components that start with the text you specified. (Refer 
to the screen on the right in the example below.)
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• Contains: Results will list all components that contain the text you specify.

3 To display the contents of one of the Card Information field with the results of the search, 
click the Index icon and select which field you want to display.

4 To view the picture that corresponds to the entry selected in the list, click Details. This will 
open a picture window next to the current dialog.
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5 Click OK. The system displays the list of the components found according to the search string. 
• To cancel a search in progress, click the Cancel button. 

NOTE: When you select one of the three search options, (Start with, Begin with and Contains), 
the selection will be selected by default the next time you open this dialog.

Using an Extended Selection Box
An extended selection box allows you to view all components of a drop-down list by right-clicking 
on the list. This option is available where a drop-down list exists for components such as 
applications, controllers, and doors. If the option is available, a hint box is displayed when the 
cursor is placed over the drop-down list.
Available text filters in the extended selection box:
• Contains 
• Starts with 
• Ends with 
• Exact word 
• Selected 

Selecting Components
The Component selection function allows operators to select one or more system components. The 
method employed may be context sensitive.
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To select a component:

1 From the active window, click the Select Components button . It opens a secondary 
window from which you may select appropriate options.

2 You may need to check options that are displayed or use the Select All button (left) to select all 
the displayed options. You may also select Single to view components that are not grouped or 
select Group to view the existing groups. 

3 From the displayed list, select the component/group you want to display. You may check the 
View sub-components option to display the components associated with the selected 
components.
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4 Where available, use the Select all button to select all the components, or use the Clear all 
button to remove the check marks from the selected components. Click Cancel to return to the 
previous window without any selections or changes.

5 Another selection method may be used as displayed in the following Controller Status 
window. Right click inside the window to display an Extended Selection Box with a complete 
listing of components.
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6 Set the required number of columns in the Extended Selection box window to display all 
components as required. A Text Filter may be employed to limit the listing.

7 Click OK to apply selections and return to previous window.

Selecting a Specific Folder
You may need to browse through the network or hard drive to locate a specific folder for backups, 
for example. 

To select a specific folder:
1 From the active window, click the Select button (it is identified by “...”). It opens a secondary 

window from which you may select a specific folder. 
2 To change the destination folder, browse the Drives drop-down list (lower part of the 

window). You may click the Refresh drive list to make sure that the displayed list is up-to-
date. 

3 Once you locate the folder you are searching, click OK to go back to the active window. 

Selecting a Specific Site or Gateway
EntraPass offers you the ability to associate a specific component with a specific gateway/site. For 
example, you can define a specific holiday for a specific site or gateway.

To select a specific gateway or site:
1 From an active window, click the New icon. The system displays the Select Gateway/Site 

window. 
2 Double-click a Site/gateway from the displayed list then click OK. 
3 Assign a meaningful name to the component being defined. 
493 • Basic Functions Select ing a Specif ic Folder



Reference Manual
4 Follow the steps to complete the task. 

Printing
Operators may need the Print function to:
• Print a list of cards
• Print event parameters
• Print event-relay association
• Setup a report for printing

To print a list or a report:
1 From any EntraPass window, click the Print icon. 
2 Select the components you wish to include in your list. You can use the Select all button (if 

available) to include all the displayed components in the list.
3 When you select Print empty fields option (if available), the list will include the titles of the 

fields even if they are empty.
4 When you have finished selecting the fields, you can preview your list before you actually 

print it. When you preview the list, you can:
• Define the printer setup 
• Print a hardcopy of your report or list 
• Save the report or list for later use with the Quick Viewer program or load an existing 

report. For more information on this program, see “Quick Viewer” on page 480.
5 If you want to modify the settings, close, modify and print your list.
6 You can use the Font button to select a specific font and font size for your list. 
7 To select or modify a font selection:

• Select the font type from the Font menu. A preview of your selection will be displayed in 
the Sample box.

• Choose the formatting attribute from the Font Style menu (regular, italic, bold or bold 
italic).

• Enter the font size from the Size menu (10 or 11 is a default). The smaller the font, the 
more items appear on your list.

8 You can also select a color from the Color menu (black is a default). The changes appear 
automatically in the sample box. Click on OK when you are done. Use the Preview button from 
the Print window to preview your output before printing.

NOTE: If there is no printer configured for the computer, an error message appears.
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Viewing Components Links
The View links function allows you to view all instances of an item within other menus. Therefore, 
it is possible to see all links an item has with other items.

NOTE: You can use the View links button before you delete a component from the database in 
order to see which menus will be affected by the deletion. You can also print the links of a 
selected component.

To view component links:
1 From any menu window, select a component and click the Link button. All the components 

that are associated with the selected component are displayed.
2 The icons that are located on the left side of the components indicate the component type. For 

example, if you select the Always valid schedule (in the Schedule definition menu) and click 
the Link button, the system will display a list of all the menus in which this schedule is used.

NOTE: In the highlighted example, the Always valid schedule is used as the REX (Request to 
EXit) schedule in the Door definition menu.You can right-click an item to select a category. 
For example, if you right-click and select Access levels, only the access levels in which this 
schedule is defined are displayed.
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3 To view the links of the selected door with other components of the system, select the door, 
then click the Link button again:

4  All system components that are associated with the selected door appear. In this example, the 
“door” is used in the Administrator access level; users granted this access level are allowed 
access to the selected door.

5 Click the Print button to print the information displayed on the screen.
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Chapter 4 • Configuring System Devices
After the installation of the system hardware and software, you have to configure the access 
system devices. These include software components (EntraPass applications, gateways, 
SmartLink, Redundant Server and Mirror Database and EntraPass Video Vault) and physical 
components (controllers, relays, doors, etc.). 

NOTE: It is recommended to use the Express Setup utility to save configuration time and to 
prevent setup errors. In addition, using Express Setup allows you to test the hardware and 
wiring immediately after the installation. 

You run the Express Setup utility when you are configuring Gateways, sites or controllers for the 
first time. You may run the Express set up utility by clicking its icon in EntraPass windows . 
You may also launch the Express Setup utility from the Windows Start menu or from the System 
Registration window or from a system prompt, when, for instance, you are adding a controller to 
your system.
For detailed information about using the Express Setup utility, see “Express Setup Program” on 
page 472.

NOTE: If you are using the Video Integration feature, EntraPass enables you to assign all 
system components into a video view; the same way you assign them to system interactive 
floor plans (graphics). To do this, you simply select the video view where you want the system 
component (EntraPass application, site, gateway, controller, etc.) to appear. Video views are 
defined in the Video menu (Video tab > Video views).
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Configuring EntraPass Applications 
The minimum configuration of an EntraPass software package includes a server, a workstation 
application (EntraPass monitoring application) and a gateway application.
The gateway application can be integrated with the EntraPass workstation on the same computer. 
The software package comprises a number of applications including:
• A workstation application
• A server application, 
• One Corporate gateway application,
• And a number of utilities such as the Vocabulary editor, the Express Database utility, etc. 
It is recommended to install the EntraPass server on a dedicated computer for system stability.
The EntraPass application menu allows operators to configure computers where EntraPass is 
installed. This includes configuring computers where you have installed: the EntraPass 
Workstation software, the Gateways, the Redundant Server and Mirror Database programs, as well 
as computers where you have installed the SmartLink Interface, if applicable.
To configure the EntraPass applications, you have to define:
• General parameters applicable to all computers where EntraPass is installed
• Security parameters (applicable to all EntraPass applications) 
• Filters (to define which gateways and EntraPass applications will send messages to the 

Workstation application being configured).
• Message/alarm controls.

Defining General Parameters
The General tab allows you to specify the system behavior when the operator is inactive, that is 
when there is no action on the keyboard (idle time). This feature provides additional security to 
prevent access to the system by an unauthorized person. The default delay is 20 minutes. 
This menu allows you also to select a graphic and a video view into which the EntraPass 
application will be displayed. For details on system graphics, see “Defining Graphics” on 
page 180. For details on video views, see “Defining Video Views” on page 143.
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To configure an EntraPass applications:
1 From the EntraPass main window, select the Devices tab, then click the EntraPass applications 

icon. The EntraPass applications main window appears.

NOTE: Items displayed in the EntraPass application window vary depending on the selected 
EntraPass application. For example, if the selected application is a workstation-type 
application, tabs such as Workstation, Gateway and site, etc. are displayed. If the selected 
application is a Redundant server, the Redundant server tab appear.

2 From the EntraPass application drop-down list, select the application you want to configure. 
This list displays all EntraPass applications that have been installed and registered. The 
Application type drop-down list displays the type of the selected item. It may display 
Workstation, Gateway, Redundant Server & Mirror Database, etc.

3 Assign a name to the selected EntraPass applications. If you are running the software in two 
languages, for example in English and French, you may assign a name in English and in 
French.

4 For added security, specify the system behavior when the operator is inactive. This feature 
provides additional security to prevent access to the system by an unauthorized person. The 
default delay is 20 minutes. You may keep the default delay or change it.
• Select the Send to tray on idle if you want the EntraPass applications to be minimized 

when there is no action on the keyboard. If you do this, you have to specify the period 
after which the application will be minimized if there is no action on the keyboard: in the 
Send to tray on idle, enter the delay after which the EntraPass applications will be 
minimized and sent to the task bar. 

• Select the Automatic Logout on idle option if you want the EntraPass applications to 
logout when there is no action on the keyboard. If you do this, you have to specify the 
period after which the application will be minimized: in the Automatic logout on idle 
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enter the delay after which the Operator will be automatically logged out, (the option has 
to be checked).

5 If the Video feature is enabled, the Video view field appears. If this is the case, select the Video 
view in which you want the defined component to appear. For details on defining video views, 
see “Defining Video Views” on page 143.

6 From the Graphic list, you may select the graphic to which the EntraPass applications is 
assigned, if applicable. For details on defining graphics, see “Defining Graphics” on 
page 180.

Defining Security Parameters 
This section applies to all EntraPass applications (EntraPass Workstations, Gateways, SmartLink 
(if installed), Redundant Server & Mirror Database, etc.).
1 From the EntraPass applications window, select the Parameters tab.

2 Make the appropriate choices:
• Disable application: if selected, the operator will not be able to start the application. This 

field must be used with caution. 
• Disable authentication: When this option is checked, it is no longer possible to register the 

EntraPass application to the server. 
• Encryption: select this option if all incoming or outgoing messages for this application 

should be encrypted.
• Auto disable authentication: if selected, the system will automatically disable 

authentication when the application has authenticated itself for the first time.
• Allow auto-connection: if selected, the EntraPass workstation will automatically attempt to 

connect itself to the server following a communication failure.
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• Must be login to close application: checking this option will oblige operators to login 
before they exit an EntraPass program.

• Suspend messages: if this option is selected, all incoming messages for this EntraPass 
applications will be suspended. Use this option for an EntraPass workstation that is used 
only to configure components or when messages are not required.

• Operator must login at least once to display messages: checking this option will oblige the 
operator to login at least once with a valid username and password before system 
messages can be viewed.

• Display login list: if checked, this option tells the system to save the five last login names 
to make them available for selection when opening new sessions. This option offers a fast 
way to open a session since an operator has only to select a user name and enter a 
password. You may however leave this field to its default setting (unchecked) for 
increased security; this will oblige operators to enter both a valid user name and password 
before accessing EntraPass.   

• Display description in title bar: check this box to display EntraPass applications 
description in the window titlebar (top).

• Display description in taskbar: check this box to display EntraPass applications 
description in the window taskbar (bottom).

• Disable video: check this option to hide the video view options from this EntraPass 
workstation user interface. If this option is checked, the Video Events List, Video 
Playback and Video desktop options are disabled in the system. Operators with 
appropriate user permissions will be able to configure the Video option but will not be 
able to view live or recorded video segments. 

• Notify when remote sites must be updated: check this option to tell the system to send a 
notification before updating remote sites. When this option is enabled, operators will 
receive a notification before updating site communicating via a modem. If this option is 
selected, operators will receive a notification each time data related to sites (such as 
schedules, controllers, etc.) are modified. They will have the choice of updating remote 
sites (Yes), refusing the change (No) or clicking Details so that they can select specific 
sites to be updated. 

Defining Filters
The Workstation tab allows you to select which applications will send messages to the 
workstation application being defined. This feature provides the ability to restrict incom-
ing messages to a computer. For example, you may decide that the application being 
defined will not receive messages from the SmartLink application. To do so, simply 
remove the mark next to SmartLink (by clicking it); messages from SmartLink will not be 
sent to this workstation. 
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To filter incoming messages:
1 From the EntraPass application window, select the Workstation tab. From the EntraPass 

application drop-down list, select the Workstation application you want to define. 

2 In the lower pane, select the application that will send messages to the EntraPass workstation 
being defined. Messages are sent via the EntraPass server. 
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To filter messages from gateways and sites:
1 From the EntraPass application drop-down list, select the application for which you want to 

define gateway and site filters. 

2 In the EntraPass application window, select the Gateway and Site tab. Gateway and sites 
defined in the system appear in the lower pane. The Gateway/Site tab appears if the selected 
application is a workstation.

3 Select the gateway and site that will send messages to the EntraPass application being 
configured. The selected gateway/sites send their messages via the EntraPass server. 
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To define message controls: 
1 Click the Messages tab to define how messages should be processed when the EntraPass 

workstation is connected (or not) to the server. 

NOTE: Messages  desktops are configured in the Desktop definition menu. For details, see 
Chapter 12 ‘EntraPass Desktops’ on page 337.

2 In the Message control section:
• Specify the number of messages that will be kept on the server when the EntraPass 

workstation is off-line, that is, when it is not connected to the server. The server buffers a 
maximum of 60,000 messages per EntraPass workstation (default: 5,000). 

• Specify the number of messages that will be kept on the workstation. There is a maximum 
of 60,000 messages per EntraPass workstation. By default, it keeps 5,000 messages. 

NOTE: The EntraPass workstation will always keep newer events. To view older events, you 
have to request a historical report. For details on requesting reports, see Chapter 13 ‘Reports’ 
on page 375.

3 Specify if the Server should keep newest or oldest messages when its buffer reaches the 
defined maximum number: 
• Keep older messages: the Server will keep the oldest messages and archive the newest 

messages when the EntraPass workstation is off-line and when the Server buffer is full. 
• Keep newer messages: The Server will keep the newest messages and archive the oldest 

messages when the EntraPass workstation is off-line and when its buffer is full. Messages 
are processed on a first in - first out basis. 
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4 You may want to create exceptions to the EntraPass workstation configuration by checking 
Apply operator parameters for messages options. When this option is enabled, operator 
settings have priority over EntraPass workstation settings. 

NOTE: If the Apply operator parameters for messages option is selected all events will be filtered 
according to the EntraPass workstation configuration, and filtered again according to the 
security level of the operator who is currently logged on the EntraPass workstation. If the 
“Apply operator parameters for messages” option is selected and no operator is logged in, or 
the EntraPass workstation is off-line, events will NOT be buffered by the server.

5 In the  Clear Message Desktops section, specify when messages should be cleared:
• On logout (on a regular logout by an operator)
• On workstation shutdown (when the EntraPass workstation is completely shutdown)

6 In the Picture information section, select the field content that will be displayed below the 
cardholder picture. The Show cardholder information with picture drop-down list contains 10 
definable fields (Card information 1, Card information 2, etc.).

NOTE: By default, the field displays “card information #1” to “card information #10”. These 
labels may be customized. For more information on renaming card information labels, see 
“Customizing Card Information Fields” on page 209.

7 In the Status icon refresh delay section, specify the time interval at which the EntraPass 
applications refreshes the condition reported by the status icon visible in the status bar. 
Refresh delays range from 0.01 to 4.59 sec. in increments of 0.01 sec.

8 You can define the Maximum Records in Report Desktop that can be retrieved from archived 
files and displayed on screen. The maximum is 200,000. 
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To define alarm controls: 
1 Click the Alarms tab to define how alarms should be processed when the EntraPass 

workstation is connected (or not) to the server. 

NOTE:  Alarms desktops are configured in the Desktop definition menu. For details, see 
Chapter 12 ‘EntraPass Desktops’ on page 337.

2 In the Alarm control section:
• Specify the number of alarms that will be kept on the server when the EntraPass 

workstation is off-line, that is, when it is not connected to the server. The server buffers a 
maximum of 60,000 alarms per EntraPass workstation (default: 5,000). 

• Specify the number of alarms that will be kept on the workstation. There is a maximum of 
60,000 alarms per EntraPass workstation. By default, it keeps 5,000 alarms. 

NOTE: The EntraPass workstation will always keep newer events. To view older events, you 
have to request a historical report. For details on requesting reports, see Chapter 13 ‘Reports’ 
on page 375.

3 Specify if the Server should keep newest or oldest alarms when its buffer reaches the defined 
maximum number: 
• Keep older alarms: the Server will keep the oldest alarms and archive the newest alarms 

when the EntraPass workstation is off-line and when the Server buffer is full. 
• Keep newer alarms: The Server will keep the newest alarms and archive the oldest alarms 

when the EntraPass workstation is off-line and when its buffer is full. Alarms are 
processed on a first in - first out basis. 
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4 You may want to create exceptions to the EntraPass workstation configuration by checking 
Apply operator parameters for alarms options. When this option  is enabled, operator settings 
have priority over EntraPass workstation settings. 

NOTE: If the Apply operator parameters for alarms options are selected all events will be filtered 
according to the EntraPass workstation configuration, and filtered again according to the 
security level of the operator who is currently logged on the EntraPass workstation. If the 
Apply operator parameters for alarms options are selected and no operator is logged in, or the 
EntraPass workstation is off-line, events will NOT be buffered by the server.

5 In the  Clear Message Desktops section, specify when alarms should be cleared:
• On logout (on a regular logout by an operator)
• On workstation shutdown (when the EntraPass workstation is completely shutdown)

6 You may define the acknowledgement parameters. Checking Display alarm message box will 
send an acknowledgement message box even if the operator is working in another application. 
When this option is enabled, you have to enter the delay during which the acknowledgement 
message box will be suspended. At the end of the delay, an alarm message box will be 
displayed again requiring an acknowledgement from the operator.

7 You can check the Disable auto display of video views option to prevent video views from 
being automatically displayed by this workstation. In fact, video views defined as alarms and 
associated with components are automatically displayed when the component goes in alarm. 

8 You may check the option Send message on acknowledge time-out to generate an 
“acknowledge time-out” event when the operator fails to acknowledge an event during the 
time-out delay specified in the Acknowledge time-out delay field. The message will be sent to 
the Message desktop and the Alarms desktop. For more information on EntraPass desktops, 
see Chapter 12 ‘EntraPass Desktops’ on page 337.
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To define network alarms
Alarm network alarms are setup in the EntraPass applications Alarm Network tab.

1 Specify whether all the system (network) alarms will be reloaded on startup. System alarms 
are stored in the server database. If the No reload on startup option is checked, operators will 
have to manually reload the system alarms.

NOTE:  Manual reload of the system alarms can be done though the Network Alarms desktop. 
To do so, open the desktop, right-click on an item and select Refresh from the contextual 
menu. You may want to check this option for fast startup; it is useful whent he system has a 
slow connection.

Configuring a Gateway Application
The Gateway converts the information received from a controller or a site and transmits the 
converted data to the EntraPass application. It also converts the information received from the 
EntraPass workstation and transmit it to controllers. The gateway interfaces the sites and the 
EntraPass application. 

The Gateway application allows you to monitor the controller sites connected to the gateway. 
You may add up to 40 Corporate gateways software. 
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To configure a gateway program:
1 From the EntraPass application drop-down list, select the gateway application. When the 

selected application is a gateway type, the Application type field displays “Gateway”. 

2 For details on defining the system behavior on idle, see “Configuring EntraPass Applications” 
on page 54.

3 To define security parameters for the gateway application, see “Defining Security Parameters” 
on page 56.

Configuring the Oracle/MS-SQL HR Interface 
The Oracle/MS-SQL HR Interface creates a real-time mirror copy of the EntraPass card databases 
(Card table, Card group table, Card type table and Badge table) in MS-SQL or Oracle database. In 
addition, it allows operators to interact with the system card database from their MS-SQL or 
Oracle programs. Operators can add, modify and delete cards, or obtain card-related information 
from the EntraPass card database. 
The card information is updated in all the databases, whatever the program used to modify or to 
update the database; MS-SQL HR Interface ensures that the modifications are conveyed to the 
server and then sent to the workstations. 

NOTE: The Oracle/MS-SQL Interface requires an additional license. 

Make sure that the MS-SQL or Oracle client software is installed on the same computer as the 
Oracle/MS-SQL HR Interface. It it not recommended to install the Oracle/MS-SQL HR Interface 
on a computer where EntraPass is installed. Installing the two applications on the same computer 
may cause problems during data exchange between EntraPass and the Oracle or MS-SQL server. 
To configure the Oracle/MS-SQL HR database Interface you have to define:
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• General parameters (applicable to the Oracle/MS-SQL HR Database Interface), including the 
EntraPass application security parameters 

• Database parameters, including the database access rights

To configure the Oracle/MSSQL HR Interface:
1 From the EntraPass application drop-down list, select Oracle/MS-SQL HR Interface. 

2 Define the application on which you have installed the Oracle/MS-SQL HR Interface. For 
more details, see “Configuring EntraPass Applications” on page 54.

3 Select the Parameters tab to define security parameters for the Oracle/MSSQL HR Interface. 
For details, see “Defining Security Parameters” on page 56.
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4 Select the MS-SQL/Oracle Interface tab to indicate how the EntraPass software will 
communicate with the client database and to define the database access rights.

5 From the Database type drop-down list, select the database server: Oracle 8.0 server, Oracle 
7.3 server or SQL server. Be sure to select the correct server version since the database 
configuration is different from one version to another. 

NOTE: If the wrong version is selected, the Oracle/MS-SQL HR Interface will not communicate 
and will not be able to connect to the server.

6 Enter the database server name in the Server name field. 
7 Type the name of the requested Oracle or SQL database in the Database Name field.
8 If you are using an Oracle server, type the name of the data file which points to the data you 

wish to access in the Oracle Data File field.

NOTE: Oracle and SQL servers may be configured to contain more than one database. 
Accessing an SQL database requires pointing to its name while accessing an Oracle database 
requires pointing to its name and specific data file. Refer to your network administrator for 
access parameters to the database specific to your application.

9 Check the Use administrator Access for Initialization option, if applicable. Checking this option 
enables you to enter a valid administrator username and password. 

NOTE: It is important to check this box. If you do not, you must manually create the database, 
the username and password in the database server.

10 Enter the username and password of the database administrator in the Administrator user name 
and Administrator password fields. The program will automatically create the database, 
username and password in the server database
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11 In the Database Access area, enter a username and password which will be used by the card 
gateway to connect to the Oracle/SQL database. 

NOTE:  The database access procedure does not allow the card gateway to create or modify 
an existing user profile on an Oracle/SQL server.

12 Check the Keep deleted records option if you want to keep the record of a card, even when the 
card is deleted from the EntraPass database. The record will be kept in the Oracle/MS-SQL 
HR Interface database.

NOTE: If you do not select this option, deleted records will be physically and permanently 
erased from the Oracle/MS-SQL HR database. 

NOTE: When EntraPass creates the card database automatically in the SQL or Oracle Server, 
it allows a maximum of 50MB for the card database. If you want to increase the size of the 
database, you must create the database manually, as detailed in the following section.

Manually Creating Server Databases
In order to integrate the database with EntraPass, you have to create the database that will be used 
and then create the Kantech operator in the database. If your system is using an MS-SQL server, 
proceed as follows:

To manually create the operator in the MS-SQL/Oracle Server: 
The first step in integrating MS-SQL/Oracle with EntraPass is to create the database that will be 
used.
1 Right-click the Database folder and select New Database. 
2 Enter the database name in the Database name field. 
3 Click OK once you have entered the name of the database.

To create the KANTECH operator for an MS-SQL Server:
You have to create an operator that the Oracle/MS-SQL HR Interface will use to log on the MS-
SQL server. 
1 Right-click Logins and select New Login. 
2 Enter kantech (lower case) in the Name field. 
3 Make sure that the SQL Server Authentication option is checked. 
4 Enter kantech (in lower case) as the password in the Password field. 
5 Click the Database Access tab.
6 Check the name of the database created in step 2. When you select this option, the bottom part 

of the window displays “Database Roles - Permit in database role”.
7 In order to be able to modify the database, check the Public and db_owner options and click 

OK to save and exit. You will be prompted to confirm the password.
8 Enter kantech (lower case) and click OK to exit.
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To create the KANTECH operator for an Oracle Server:
1 Log on the ORACLE server as the administrator. Default name “kantech” may be used.
2 Create a database. Default database name “KanCard” may be used.
3 Create a logon profile. Default username and password “kantech” may be used.
4 Assign the kantech operator the permission “Owner”. 

NOTE: If any defaults are changed, there must be a consistent Database name, User name 
and Password between the Database and EntraPass software.

Configuring the Mirror Database and Redundant Server 
The Mirror Database monitors the communication between itself and the Primary Server. The 
Mirror Database is a real-time copy of the system database and Windows system registry entries. 
When communication between the Mirror Database and the Primary Server fails, the Mirror 
Database automatically initiates the delay after which the Redundant Server is automatically 
started to replace the Primary Server. 
The Mirror Database & Redundant Server program cannot run on the same computer as the 
Entrapass software server. The Mirror Database & Redundant Server should be installed on a 
dedicated computer.

NOTE: You can operate the system with more than one Mirror Database & Redundant Server. 
The Mirror Database & Redundant Server feature requires an additional license. 

To configure the Mirror database & Redundant server workstation, you have to define:
• General parameters applicable to the Mirror Database & Redundant Server, including security 

parameters
• Redundant Server parameters
• Security parameters 
694 • Configuring EntraPass Applications Defining Filters



Reference Manual
To configure the Redundant Server & Mirror Database:
1 From the EntraPass application drop-down list, select the Redundant Server application. 

2 Define the workstation on which you have installed the Redundant Server& Mirror Database. 
For more details, see “Configuring EntraPass Applications” on page 54.

3 Select the Parameters tab to define security parameters for the Redundant Server& Mirror 
Database. For details, see “Defining Security Parameters” on page 56

4 To define communication parameters for the Redundant Server& Mirror Database, select the 
Redundant Server tab.
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5 Select the protocol that is used to communicate with the computer where the Mirror Database 
is installed: None, TCP/IP (network server), NetBEUI (computer name) or Automatic.

NOTE: When you select TCP/IP, the Redundant server address field is enabled to allow you to 
enter the TCP/IP address of the computer hosting the Redundant Server and Mirror Database. 
The field can also be edited when you select NetBeui.

NOTE: If Automatic is checked, the IP address of the computer hosting the Redundant Server 
and Mirror Database will be sent to the server for broadcast to all workstations on the 
network. This option is particularly useful if you don’t know the IP address or if the computer 
is set to a dynamic IP address or if the computer is connected to a DHCP server.

6 Enter the redundant server IP address. 
7 Select the course of action the redundancy server must takewhen it cannot connect with the 

Communication server on startup.    
8 Specify the options for starting the Redundant Server when the main server shuts down: this 

may be automatically on a normal shutdown (when an operator shuts down the EntraPass 
server) or on an abnormal shutdown (when EntraPass server “hangs” or “freezes”). The Mirror 
Database will start the Redundant Server when the delay indicated in the Wait before start 
server field has expired.

NOTE: If you do not check the Start server automatically option, the Redundant Server will not 
start when the primary server is closed under normal conditions (i.e. operator shutdown). 
Therefore, it will be necessary to start it manually.

9 Specify the system’s course of action when the server returns to normal (On server restore): 
enter the delay after which the Redundant Server will be stopped when the primary server 
returns to its normal functioning. During this time, the Redundant Server will continue to 
prevail (maximum allowed: 59:59 minutes).

10 Select the Restore Parameters to define the redundant server’s course of action when the main 
server shuts down. 
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• To automate the restore process from the redundant server, check the Automatic process 
on restore box. The rest of the options become enabled.

• Check the appropriate boxes depending on the features you have installed, and the restore 
process you want to activate.

NOTE: You can select Restore or Merge; not both.

• Restore: Will transfer the whole database that contains all the transactions from the 
redundancy server to the main server and overwrite any data created on the main 
server. 

• Merge: Will only transfer data from the redundancy server when the transactions 
cannot be found on the main server. 

NOTE: When using the Merge feature, data will not be transferred in cases where, for 
example, a card has been modified on the redundant server and the main server 
simultaneously while the main server was disconnected.    

Configuring SmartLink 
The SmarkLink application allows operators to interface the EntraPass access control software 
with any intelligent device such as video matrix switchers, paging systems, e-mail application, 
etc., using an RS-232 connection between one of the EntraPass workstations and the external 
device. Integration with other systems can also be accomplished through software DLLs. 
SmartLink can be used to connect to another computer to exchange information and update it 
automatically in real-time. It also enables EntraPass to receive and send messages or commands, 
and to communicate with client applications.

NOTE: The SmarkLink feature requires no additional license.
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EntraPass allows you to configure the SmartLink communication mode. For more information on 
SmartLink and how it works, see your SmartLink Reference Manual. 

To configure SmartLink connection options:
1 From EntraPass application drop-down list, select the system SmartLink application.

2 Define the workstation on which you have installed the Smartlink interface. For more details, 
see “Defining Security Parameters” on page 56.

3 Configure the SmartLink workstation security parameters. For more details, see “Defining 
Security Parameters” on page 56.
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4 Click the SmartLink tab to view and setup the Smartlink connection parameters. 

5 From the Mode enabled drop-down list, select the mode that is used: 
• The Unidirectional or Message mode is used to process the contents of instructions that are 

generated when an event programmed with an instruction occurs. Instructions are defined 
in the Instruction definition menu and assigned to events in the Event Parameters menu. 
For details on defining instructions, see “Instruction Definition” on page 330.

• The Bidirectional or Command mode is used to process the requests corresponding to 
commands received by the serial port or by the network, and to return the appropriate 
response from the process to the sender.

NOTE: When you start the SmartLink application, the connection options for the serial port and 
network modes are retrieved from the EntraPass Server. If the network connection mode of 
the SmartLink is different from “none”, the SmartLink application will be started to allow a 
client application to connect to the SmartLink application, either to execute commands or to 
receive messages sent through the network or both process simultaneously.

6 Check the Bypass event parameter preset option if you want to ignore all default settings of 
the Event Parameter definition menu (System > Event Parameters). By default, all events are 
programmed to be sent to all workstations (including the SmartLink workstation). Check this 
option to avoid receiving unnecessary instructions and events that are not intended for the 
SmartLink application.

NOTE: You will have to “manually” create associations of events and instructions in the Event 
Parameter definition menu. For example, you could select the event “Door forced open” and 
send only a specific instruction to the SmartLink application that would send an e-mail.
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7 Click the button to select a SmartLink startup instruction. The instruction you assign will be 
processed automatically when the SmartLink application is started. For details on defining 
Smartlink and other system instructions, see “Instruction Definition” on page 330.

8 To use the SmartLink option with the e-mail service, enter the E-mail server name and port in 
the E-mail server and port field. 

NOTE: The e-mail port value is set to 25 by default. You may leave it as is or change this value 
to another available port on the network (between 0 and 65 535). For information about 
setting of the e-mail server, contact the network administrator.

9 In the Messages section, you may want to define the status of messages in the Server, or to 
modify the number of messages that are kept in the Server. 

Configuring the EntraPass Video Vault Application
The EntraPass Video Vault application addresses the need for better video data archiving. This 
application retrieves video segments from the Video Servers connected to EntraPass and saves 
these video segments for future reference. In fact, video segments can be kept on the video server 
for a limited period of time. This period depends on the video server disk capacity and settings. In 
order to take full advantage of the Video Integration capability, EntraPass users who are running a 
video monitoring software need EntraPass Video Vault to manage their video archive database.
After installing and registering the EntraPass Video Vault application, you must define its 
environment among other EntraPass applications. For details about registering EntraPass Video 
Vault, see see “Adding Optional Components/Features” on page 10. For details about using 
EntraPass Video Vault, see “EntraPass Video Vault” on page 456.

To configure the EntraPass Video Vault application
1 From the EntraPass Application drop-down list, select EntraPass Video Vault.
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2 To define General parameters for the EntraPass Video Vault application,  see “Defining 
General Parameters” on page 54.

3 To define security parameters for the EntraPass Video Vault application,  see “Defining 
Security Parameters” on page 56.

4 Select Folder tab to specify the video file location and name structure. The settings defined in 
this window will be reflected in the way the video files will be displayed in the Browse Video 
Vault window (Video tab > Browse Video Vault).

• Destination drive(s): specify the list of drives where video segments will be archived. 
Video segments will be saved according to the disk space available on the drive and 
according to order of the selected drives. 

NOTE: Destination drives that are displayed for selection correspond to the mapped network 
drives on your computer. They differ from a computer to another.

NOTE: By default, drives are listed alphabetically. You may decide to change this order 
according to the space available on each disk. The up/down green arrows allows you to 
change the sequence of drives to use for archiving. displayed for selection correspond to the 
mapped network drives on your computer. They differ from a computer to another.

• Minimum free disk space (MB): Enter the minimum free disk space allowed before the 
system sends a message that there is no more disk space in the EntraPass Video Vault.

• Disk free space threshold (MB): Enter the maximum threshold space allowed before the 
system sends a message that the EntraPass Video Vault has reached its disk space 
threshold. 

• Date field separator: You can define the date field separator that will appear in the 
archived video directory.
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• Destination folder: select the folder that will be used to archive video data. If you do not 
specify a target folder, no video segment will be archived. By default, video segments 
will be archived in C:\KantechVideoArchive folder.

• Sub-folder structure: Each combo box contains the criteria that will be used to create a 
sub-directory where to archive video data. For example, selecting Video Server Name 
will create a sub-directory for each video server where all corresponding video segments 
will be stored. If you go down further and select Day-yyyy-mm-dd, another sub-directory 
will be created under Video Server Name to store video segments daily. You can go down 
to 5 levels of sub-directories. 

• Select File tab to define the file naming convention.

• Filename structure: Check the boxes that correspond to the information you wish to 
include in the file name. 

• Separators: You can define a field separator for the filename as well as data and time. 
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5 Select the Process tab to tell the system how archived video segments will be processed.

• Default Video file format for your video archives: You can archive video segments using the 
KVI, KVA, AVI or IMG formats. 

• KVI stands for Kantech Video Intellex format. The KVI format offers the ability to 
view, export, and store video and audio data. The KVI files can be viewed simply by 
double-clicking on the file itself since they are associated with the Intellex Video 
Player. However, the Intellex API must be installed on the computer hosting the file. 

• KVA stands for Kantech Video AVI format. Video data are stored in AVI format 
(.avi). A double click opens the video file using VideoPlayerWindow.exe. 

• AVI stands for Audio Video Interlaced format. AVI video files are viewed using 
Windows Media Player.

• IMG is the Intellex native format. Video data are stored in Intellex format (.img) and 
ca be viewed using the Intellex Video Player.

NOTE: KVI and KVA formats enable users to protect video files with a password and to specify 
key frames for any selected video event. Key frames offer a fast way for retrieving video 
segments based on a a still image (bmp) representing the whole video sequence.

• Simultaneous video segment transfers: Select the number of simultaneous downloads. 
You cannot retrieve more than one video segment from one video server at a time. 
However, it is possible to retrieve more than one segment from more than one video 
server simultaneously. The minimum value is 1; the maximum is 8. 

NOTE: A high number of retrievals requires more network bandwidth. As the flow of video data 
requires a great amount of network bandwidth, contact the Network administrator for these 
settings.
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• Video segment duration-limit: Specify the minimum and maximum duration of the video 
segment to be archived. Moving the cursor over the editable field will activate a hint 
indicating the minimum and maximum duration. This feature can prove useful if you want 
to restrict the number of archived video segments. For example, the restriction can be 
based on the size of the record. For example, you can tell the system to ignore all video 
recordings with a duration of less than 10 seconds. 

• Default password for KVI and KVA file formats: For increased security, check the box if 
you want to protect the archived video segments by a password. The KVI and KVA 
formats add the benefit of protecting your archived data with a password. Make sure to 
enter identical information in the Password and Password Confirmation fields. Operators 
with appropriate permission for viewing archived video segments will be required to enter 
a valid password before viewing the video segment.

• EntraPass server polling frequency (m:ss) Using the slide bar to specify how often the 
EntraPass Video Vault will poll the EntraPass server.

NOTE: Keep in mind that network traffic will be affected by the polling frequency between the 
EntraPass Server, Workstations, Gateways and Video servers. Faster polling means higher 
network bandwidth use. 

6 Significant Frame allows you to define the key images that will be used as thumbnails to 
preview video segments in the directories. 
• You must select a setup type:

• Significant Frame: The most representative still image of the video segment. This key 
image serves as a summary for the video segment. It can be used as a thumbnail, for 
example, when searching for a specific video segment.
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• Significant Frame on Sequence: This feature is used only with dome cameras where a 
pattern has been set for the camera to follow and the most representative still image 
of the video segment must be defined within that pattern.

• Significant Frame on Preset: This feature is used only with dome cameras where 
preset positions have been defined. The most representative image of the video 
segment can be set taking in consideration the time needed by a camera to move from 
the first frame to the next preset position. 

• You can select one of the Default Key Frame types for each setup type:
• No image: there will be no thumbnail for this video segment.
• First frame: The video segment will be represented by a still image of the pre-alarm 

recording. This automatically enables the Delay for Significant Frame (ss:cc) 
parameter, which is the delay calculated after the first frame to select the thumbnail 
image that will represent the video segment. Moving the cursor over the editable 
field will display the min./max. time range admissible.

• Event Frame: the video segment will be represented by the image that was capture 
when the alarm occurred. 

Sending Reports by E-mail
EntraPass offers users the ability to send and to view reports using e-mail capabilities. This feature 
is configured in the EntraPass applications menu. E-mails can be sent in two formats: report pack 
files (rpf) and comma separated values (CSV).
• rpf files: this file is a compressed report file. It can be opened by a simple double-click. To 

view rpf files, users must install a new version of EntraPass Workstation package or the 
Report Viewer (Set up window) utility found on the installation CD or on Kantech Web site 
(www.kantech.com). 

• CSV files: these files can be viewed using Excel or any text file editor.
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To configure e-mail options:
1 From the EntraPass applications main window, select the E-mail tab.

2 In the E-mail server (SMTP or Exhange) field, enter the name of the E-mail server that will be 
used for sending e-mails. 

3 In the Port field, enter the number of the port that will be used for sending e-mails (usually 
25). 

4 Enter a valid E-mail address in the From field. This e-mail address will be used for 
authenticating the e-mail server.

NOTE: To view reports sent from EntraPass, the Report Viewer utility must be installed on 
computers where EntraPass is not installed. To install this utility: Installation CD > Setup 
window.
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Configuring EntraPass Gateways
Entrapass Gateways convert the information received from a controller or a site and transmit the 
converted data to the Server. They also convert the information received from the Server and 
transmit it to controllers. 
 They may be installed on a dedicated computer, or integrated with another EntraPass workstation.

 The following table shows some features of a Corporate gateway:

Capacities Corporate Gateway

Number 41

Local sites 32 

Dial up modems at host site 32 per gateway

Remote dial up sites 512 per gateway

On-line remote sites 32 per gateway

Controllers 17,408 total (32 KT per site) 

Readers/keypads per gateway 34,816

Events for timer on/off 30
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To configure a Corporate Gateway: 
1 From the Devices definition tab, select the Gateway icon. 

2 From the Gateway drop-down list, select the gateway to be configured.
3 In the Keypad delays section, enter the Inter-digit delay time (m:ss). It represents the maximum 

delay permitted between each selection of a keypad key by a user.
4 Enter the Time-out on keypad delay time (m:ss). It is set in seconds. It represents the maximum 

time allowed for users to begin entering their personal identification number at a keypad. 

NOTE: The maximum time allowed for both the Inter-digit and Time-out on keypad delays is 
4 minutes and 15 seconds.

5 Click the Host Modem Definition button to configure the modem communication options if 
your Corporate Gateway connects to the first controller of a remote site via modem. For 
details, refer to see “Configuring Modem Parameters” on page 84.

6 Using the up and down controls, determine the number of Invalid attempts before keypad is 
disabled. Users have a maximum of 255 invalid attempts before the keypad is disabled.

7 Enter the Keypad disabled duration delay (h:mm). The maximum duration allowed is 4 hours: 
15 minutes. When the counter reaches the maximum attempts counter, the keypad will be 
disabled for all cards. It is disabled for the delay specified in the Keypad disabled duration 
field. 

8 Enter the Reset attempt counter delay (m:ss). When the delay specified in the Reset attempt 
counter field is expired, the system will set the attempt counter to zero. The maximum delay is 
4:15 minutes. If the value entered is greater than the maximum allowed, then the system will 
use the previous correct value.
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9 Select a Graphic and Video view to which the Gateway is assigned, if applicable. If the Video 
feature is enabled, the Video view field appears. If this is the case, select the Video view in 
which you want the defined component to appear.

To configure gateway events: 
1 From the Gateway window, select the Events tab to set the LED Timer on and Timer off for 

each event. A Corporate Gateway is configured to manage 30 events.

NOTE: A Corporate Gateway-based system may support up to 41 Corporate Gateways. You 
may add up to 40Corporate gateways .

Configuring Modem Parameters
If your Corporate Gateway connects to the first controller of a remote site via modem you have to 
configure the modem communication options. 
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To configure modem parameters:
1 From the Gateway window, click the Host modem definition button (lower part of the window) 

to display the modem setup window.

2 Click on the New button to add a modem to the modem selection list.
3 Configure the modem as per the example entries shown in the previous window and click OK 

to return to the Device definition window.

NOTE: For reliability and configuration consistency, Kantech currently supports the US 
Robotics Sportster external modem only. Moreover, the Modem connection type should be set 
to Receive and transmit while the Modem settings should not be changed. If you are uncertain 
about modem setup parameters, consult your network administrator for the settings which 
apply to your particular hardware configuration.

NCC 8000 Gateways will only work on a dedicated DOS 6.2 computer or Windows 98 with a DOS 
shell.
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Defining Sites
A site is composed of controllers attached to the same serial port. The system can manage up to 32 
local sites per Corporate Gateway. EntraPass allows users to add up 512 remote dial up sites per 
Corporate gateway.
Corporate and gateway sites are composed of KT-100, KT-200 or KT-300 controllers. 

NOTE:  It is suggested to use a site for each section of a building in order to provide easier 
system expansion and management.

Defining Sites 
Under a Corporate gateway configuration, you have to specify:
• The gateway to which a site is connected
• The number of controllers in the site
• The site communication options, etc.
You may also define the controllers for that specific site by clicking the Controllers icon in the Site 
window toolbar. 

To define a site :
1 From the Devices window, click the Site icon.

2 If you are defining a new site, assign a name to the new site and click the Save icon. The bullet 
next to the site name turns green.
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3 In the Hardware definition section, specify the number of controllers in the site. There may be 
up to 32 controllers per site. If the number specified is greater than the maximum allowed, the 
system will set the value to 32.

4 If the Video feature is enabled, the Video view field appears. If this is the case, select the Video 
view in which you want the defined component to appear.

5 Select the Options tab to define the site connection options.

6 From the Connection type drop-down list, specify how the site communicates with the 
gateway computer. This may be through:
• A direct connection
• A TCP/IP connection 
• A modem connection 

NOTE: Selecting Modem adds three extra tabs to the Site configuration window. To configure 
these tabs, see “Defining Extra Tabs on Modem Selection” on page 88.

7 Proceed as follows:
• Select Direct, if the site is connected to the gateway by an RS-232 serial port. Then you 

have to specify the Serial port (com:) as well as the Controller site baud rate (usually 
between 9600 and 19200). When the site communicates with the gateway using a direct 
connection, the Terminal server connection options section is disabled. You also have to 
select the Daylight saving time options (see the following step).

• Select TCP/IP if the site communicates with the gateway through a terminal server using a 
port number. Then you have to specify the terminal server IP address and Port number. In 
this case, you have to configure the terminal server. To do this, follow the manufacturer’s 
instructions or refer to the Terminal server documentation.
874 • Defining Sites Defining Sites



Reference Manual
• Select UDP (User Datagram Protocol), a connectionless protocol that, like TCP, runs on 
top of IP networks. UDP offers a direct way to send and receive data over an IP network. 
It used primarily for broadcasting messages over a network. Check this option if the site 
you are configuring uses this protocol. If you need more information about the 
communication protocol used by your site, contact the network administrator. If you are 
using the Lantronix UDS-10, refer to Lantronix UDS Setup Instructions DN1506 for 
detailed installation and configuration instructions.

NOTE: You may install up to 32 terminal servers (per gateway). 

8 Check the Use Windows daylight savings time setting box to automatically switch to daylight 
saving time according to Windows standard settings. Leave unchecked if you want to do it 
manually. 

9 If you are communicating with a remote site by modem, enter the time difference between 
gateway location and EntraPass server location Time adjustment based on Gateway timezone. 
This setting will allow events from the remote site to be displayed at local gateway time on 
EntraPass workstations located in different timezones.

Setting up Communication Timings
Caution: Do not use the Communication timing option. If you need to set up the communication 
delay and polling frequency, call Kantech Customer Assistance. Inappropriate use of this option 
may cause serious problems to the system. The Communication timings window shows the actual 
default settings. They must be preserved unless advised otherwise by Kantech Systems.

Defining Extra Tabs on Modem Selection 
If you specified Modem from the Connection type drop-down list, you need to access three extra 
tabs. 
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1 Select the Modem Options tab to set outgoing call behavior to site modem.

2 Enter Remote phone number and Code to access an outside line (if applicable). 
3 Set the Number of rings before answer to set the number of rings before the modem picks up 

the call. This option is valid whenever ring schedules are not in effect.
4 Set the One ring schedule option to configure the time interval during which site modem will 

be allowed to answer on one ring.
5 Set the Number of retries. This will set the number of calls the modem will attempt to make 

before giving up.

NOTE: For reliability and configuration consistency, Kantech Systems currently supports the 
US Robotics Sportster external modem only. 

NOTE: The Modem settings and Remote Baud rate should not be changed. If you are uncertain 
about modem setup parameters, consult your network administrator for the settings which 
apply to your particular hardware configuration.
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6 Once all modem options have been set, click on the Schedule parameters tab. This will allow 
you to set time intervals during which the gateway or site connects to remote sites or gateways 
(through modem calls) in order to perform specific tasks.

7 Click on the Retrieve site events browse button to bring up the schedule selection window. 
Select the schedule that best corresponds to the time requirements set out for this task. For 
more information on defining schedules, see “Defining Schedules” on page 176

8 Repeat this step for If data is modified since last, Report events under priority call type and 
Report events automatically.

NOTE: To schedule the reporting of events under priority call types, first define Priority call 
types for items such as doors, inputs and controllers.
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9 Click on the Miscellaneous tab to set how modems handle site incoming and outgoing calls.

10 Check the Use a callback connection box to force the gateway modem to hang up after initial 
connection to the remote site modem and to stand by for an acknowledgement call from the 
remote modem. You may also want to customize the standby-for-acknowledgement time in 
the Wait for security callback factory set to 01:minute:30 sec. 

11 Select primary modem in the Primary host modem drop down list. If available, select a backup 
modem in the Secondary host modem. This setting is useful when the primary modem is busy 
or fails to take the call.

12 Check After reception stay online for if you wish to limit in-call time to a predetermined 
amount of time which can be set to anywhere between 00.03.00 and 23.59.59.

13 Check the Call immediately upon slave controller communication failure to be alerted in the 
event that a slave controller fails to send data to the master controller (the one carrying the 
modem).

14 Check the Report when buffer 70% full to force download of a site controller’s event buffer as 
soon as it reaches 70% capacity.

Setting Remote Modem Delays
NOTE: Do not click the Remote modem delays button. All values are factory-set for optimum 
performances with the supported US Robotics modems. Settings should not be edited unless 
authorized by Kantech. 
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Configuring Controllers
Controllers provide audiovisual feedback on the access decision. Typically, a red/green light 
(LED) indicator on the reader informs the cardholder that the door is unlocked or that access has 
been denied. A local door alarm can be installed to provide an audible warning if the door is forced 
open or remains open after an access.The controller definition tells the system how a controller is 
being used and what devices are associated with it: (door(s), input zones, relays and output 
devices). 
Controllers may be defined during a gateway or site definition; or in the controller definition 
menu, by selecting either the controller icon (Devices window) or by using Express Setup 
(identified by the  icon).
EntraPass supports three types of controllers: KT-100, KT-200 and KT-300. These provide the 
ability to activate local functions associated with a controller. 
The number of devices associated with a controller varies according to the controller type. The 
following table summarizes the basic components associated with each type of Kantech controller:

Defining General Parameters for KT Controllers
1 From the Controller definition window, select the gateway associated with the controller site.
2 From the Site drop-down list, select the site where the controller is located.
3 From the Controller drop-down list, select the controller you want to define. Once selected, the 

language section is enabled. You may rename the selected controller.

Type Doors Relays Input Zones Auxiliary 
Outputs

KT-100 1 4 4 2

KT-200 2 2 16 4

KT-300 2 2 8 4
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4 From the Controller type drop-down list, select the controller type.

5 Assign a meaningful name to the controller it in the language section (English and French), 
then click the Save icon. Once you save, the Controller type drop-down list is disabled. 

6 The system prompts you to use the Express Setup program. Click Yes to continue. If you 
select No you will have to manually configure these devices in their respective definition 
menus (doors, relays, inputs and auxiliary outputs). 

NOTE: EntraPass offers you the ability to install two types of readers on the same controller 
The two readers must be of the same technology (Wiegand or ABA). This feature is only 
available with KT-100 and KT-300, under a NCC Windows and Corporate Gateways. 

7 After configuring components associated with the controller, select the reader and keypad 
installed on your controller from the Reader and Keypad type drop-down lists.

NOTE: The New reader driver icon  allows you to install a custom driver for a specific 
controller. Moreover, using this button allows you to add the driver in the Read Driver table, 
making it available the next time you want to configure a new controller. 
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8 To define the schedules applicable to the new controller, you must move to the Schedules tab.

9 Select the applicable Schedules for the new controller:
• When a KT-100 or KT-300 is selected: only the Power supervision schedule list is 

displayed.
• For KT-200, the Power supervision schedule and the Tamper switch supervision schedule 

lists are available.
10 If the Video feature is enabled, the Video view field appears. If this is the case, select the Video 

view in which you want the defined component to appear.
11 Click the Save icon.

Configuring a KT-100 Controller 
Once the general parameters are defined, the Controller type tab is displayed. A KT-100 or KT200 or 
KT-300 tab appears beside the General tab.
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1 Select the KT-100 tab from the Controller window.

2 Enter the controller serial number in the Serial number field. Usually, the number is found on 
the controller label. The field is defined to accept only numeric characters, except for the first 
character which may be an a or A. If a lower case character is entered, the system converts it 
to a capital letter.

3 Enter the Wait for second access card delay. The maximum time allowed is 2 minutes 07 
seconds. This feature is useful for secured areas where two cards are required to access a 
secured door. If the value entered is greater than the maximum allowed, the system will use 
the existing value.

4 In the Keypad escape key drop-down list, choose a keypad escape key if applicable. This 
feature is associated with PIN numbers. When a user enters a wrong number, he/she may press 
the escape key and re-enter the PIN, without incrementing the number of attempts.

5 In the Input resistor type drop-down list, select the resistor type used with your system. By 
default, this choice is set to Single resistor. This feature is used as a supervision device for all 
inputs. In fact, if this feature is enabled and if an input is disconnected, an alarm message is 
generated and sent to the Alarm message desktop (or other desktop configured to receive such 
events).

Configuring a KT- 200 Controller 
Each KT-200 can monitor, in real-time, the state of 16 input points such as magnetic contacts, 
motion detectors, temperature sensors, etc. The door contact (supervising door state) and the REX 
(warning the system that a user is exiting) are connected to such inputs.
The KT-200 is equipped with two relays. These relays can be activated according to schedules, 
reported events or a combination of different logical conditions. The system is expandable to 16 
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relays using REB-8 relay expansion board modules. REB-8 may be used as relays or as elevator 
controllers. KT-2252 are only used as elevator controllers.

NOTE: Please note that KT-2252 are no longer available. 

Defining KT-200 Expansion Devices 
KT-2252 elevator controllers offer a low voltage interface for up to 32 floors. Up to 4 KT-2252 
can be connected to one KT-200 controller for a maximum of 64 floors per cab. One KT-2252 can 
be shared between 2 cabs, serving a maximum of 16 floors each (one common service switch for 
both cabs). 
When users present their cards to the elevator cab reader, the KT-200 verifies which floors can be 
accessed by this cardholder and sends a list of floors to be enabled to the KT-2252 interface. The 
KT-2252 closes the electronic interrupters corresponding to the related floors.

To define KT-200 auxiliary devices: 
1 From the Controller definition window, select the KT-200 tab.

2 In the Auxiliary devices section, select the type of devices used with KT-200 controller. 
• Check the REB-8 relay option if REB-8 expansion boards are used as relays. Only 16 

relays can be defined. If two REB-8 are added, the last two relays (the 17th and 18th 
relays) can be used to perform different actions. You have to specify the additional 
actions for the two relays in the Extra relay drop-down list.

• Check the KT-2252 elevator controller and REB-8 relay option if KT-2252 are used as 
elevator controllers and REB-8 are used as relays on the same door controller. A 
maximum of four KT-2252 can be connected to the controller. 
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• Check the REB-8 Elevator Controller option if REB-8 are used for elevator control. Up to 
four REB-8 can be used for elevator control. 

NOTE: When an elevator controller option is checked, an Elevator tab appears beside the KT-
200 tab. 

The following section explains how to program elevator controls using REB-8 and KT-2252 
elevator controllers.

To program KT-2252 elevator controllers:
The Elevator tab allows you to specify which auxiliary devices are used with the KT-200 for 
elevator control and how they are used. Depending on the expansion board installed and on the 
option checked, the Elevator window displays the REB-8 Installed or KT-2252 Installed section.
1 From the Controller definition window, select the KT-200 tab.
 

2 In the Auxiliary devices section, select KT-2252 elevator controller, or KT-2252 elevator 
controller and REB-8 relay. The Elevator tab appears beside the KT-200 tab.
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3 To configure elevator controllers, select the Elevator tab. When KT-2252 elevator controllers 
are used, the Elevator Mode section is enabled.

 

4 In the Elevator mode section, check the appropriate number of floors. This indicates how the 
floors are controlled with the KT-2252. 
• Select 16 Floors if there is one KT-2252 for two cabs sharing the same floors.
• Select 32 Floors if there is one KT-2252 per cab.

NOTE: The Inputs column refers to the KT-2252 terminals. When floors have been defined 
(Floor menu), the Floors column contains the floors that are associated with the inputs.

5 In the KT-2252 installed section, specify the number of KT-2252 installed. The options are 
cumulative. If for example the KT-2252 #3 option is checked, KT-2252 #1 & 2 have to be 
checked as well. The following table summarizes how KT-2252 elevator controllers are used:

 

Number of cabs Number of floors Number of KT-2252

1 8 1

1 16 1

1 32 1

1 64 2

2 8 1

2 16 1
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6 In the Floors column, select the floors associated with KT-2252 controller terminals.

NOTE: The Inputs column refers to the KT-2252 terminals. When floors have been defined 
(Floors menu), the Floors column contains the floors associated with the inputs.

To program REB-8 elevator controllers:
REB-8 relay expansion boards may be used as a cost-efficient alternative for elevator control. 
With an REB-8 expansion board added to a KT-200, the software may control up to two elevator 
cabs per controller.
1 In the KT-200 definition window, select the REB-8 elevator controller option. When the option 

is selected, an Elevator tab appears beside the KT-200 tab. The REB-8 definition section is 
only active when REB-8 are used as relays.

2 32 2

2 64 4

Number of cabs Number of floors Number of KT-2252
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2 Select the Elevator tab to configure the REB-8 elevator controllers. Up to four REB-8 elevator 
controllers are supported.

3 Specify the number of REB-8 that are installed on the controller. The selection is cumulative. 
For example, if four REB-8 are installed, the first three checkboxes have to be checked also. 
The following table summarizes how REB-8 are assigned to floors and to elevator cabs.

NOTE: The Inputs column refers to the REB-8 terminals. When floors have been defined 
(Floors menu), the Floors column contains the floors that are associated with the inputs.

4 In the Floors column, select the floors associated with REB-8 controller terminals. For details 
on floor definition and door group definition, see “Configuring Doors” on page 107.

NOTE: There is no floor confirmation when an REB-8 is used as an elevator controller.

To define REB-8 relays:
When REB-8 are used as relays, you need to specify how many relays are installed on the KT-200. 
The controller can handle a maximum of 16 accessible relays and already provides 2 on-board 
relays.

Number of REB-8 Number of floors Number of Cabs

1 1 to 8 Cab 1

2 9 to 16 Cab 1

3 1 to 8 Cab 2

4 9 to 16 Cab 2
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1 In the KT-200 window, select the REB-8 relay option if REB-8 are used as relays.

2 If they are used with the KT-2252 elevator controller, select the KT-2252 elevator controller 
and REB8 relay option. In either case, the REB-8 definition section is enabled.

3 In the REB-8 Definition section, select the appropriate option: No REB-8, One REB-8 or Two 
REB-8.

4 If two REB-8 are added (for a total of 18 relays), the last two relays can be used to perform 
different actions: select the use for the extra relays from the Extra relay drop-down list. 

5 Select the Status relay tab to program a relay or group of relays that will be activated when an 
event occurs.

Configuring a KT-300 Controller 
The KT-300 constantly supervises battery condition and reports “Low battery/No battery 
condition” status to the system. It also supervises locking devices for short and open circuits to 
detect lock failures.
KT-300 controllers support Combus modules. The Combus is a 4-conductor cable bus to which 
several expansion modules are connected in parallel to add inputs, outputs, relays and an LCD 
time and date display.
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To configure a KT-300 Controller:
1 From the Site menu, click the Controller icon, then select the KT-300 tab.

2 Enter the controller serial number in the Serial number field. Usually, the number is found on 
the controller label. The field is defined to accept only numeric characters, except for the first 
character. It may be an a or A. If a lower case character is entered, the system converts it to 
upper case.

3 Enter the Wait for second access card delay. The maximum time allowed is two minutes and 
seven seconds. If the value entered is greater than the maximum allowed, the system will use 
the existing value. This feature is useful when access to a place is controlled by two cards.

4 In the Keypad escape key drop down list, choose a keypad escape key if applicable. This 
feature is associated with PINs. When a user enters a wrong number, he/she may press the 
escape key and re-enter the PIN, without incrementing the number of attempts.

5 In the Resistor type drop-down list, select the resistor type. By default, the Single resistor 
option is selected. If you hear a long buzz, verify the number of resistors installed on your 
system.

Configuring the KT-300 Combus module
 Four expansion modules can be connected to KT-300:
• KT-PC4108 (8-zone input expansion module). This module has a tamper contact input.
• KT-PC4204 (4-relay/power supply expansion module). It has a tamper contact input and also 

includes a built-in 12VDC, 1A power supply for field devices.
• KT-PC4216 (16-zone output expansion module). It can be used for elevator control, although 

additional hardware may be required.
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• KT3-LCD (Kantech 32-character liquid crystal display). The LCD is green (normal status), 
red (power failure) and yellow (trouble).

To configure the KT-300 Combus module
1 If a Combus module is installed to the KT-300 controller, click the Combus module 

configuration button. Undefined Combus terminals are identified by red flags/bullets. Once a 
module has been defined, it is identified by a green flag.

2 To define a module, select one, then click the Define button (lower part of the window). The 
Enter Combus module serial number message box appears.

3 Enter the module’s serial number, then click OK.

NOTE: To obtain this number, you have to activate the Tamper switch or to press any key on 
the keyboard. The Combus serial number is displayed in the Desktop Message. 

4 Assign names to the modules in the language fields.
5 Check the options related to the module you want to configure (if these are displayed in the 

window). 

NOTE: Usage options of a module vary according to the selected Combus module. For 
example, installing the KT3-LCD and checking the options Combus low power and Display date 
and time will allow the KT-300 to report Combus low power conditions and to display the date 
and time. 

The following table summarizes the options associated with each module:
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6 Check the Combus low power option so that the KT-300 will report any Combus low power 
condition

7 Check Display date and time option so that LCD can display the date and time; then click the 
Close button to go back to the KT-300 configuration window.

8 When you have finished configuring the Combus module, click the Close button to go back to 
the KT-300 configuration window.

9 Associate a Local activation relay for Power failure, Combus failure and Combus low power. If 
you want to assign a specific relay, you may click the pop-up window icon ( ) and select a 
specific relay or group of relays.

NOTE: To configure local activation relay, you must configure relays (Devices > Relays), and 
then select specific relays for local activation.

Combus type Options Additional options

KT3-LCD Combus low power, display date and 
time

No additional options

KT-PC4108 Tamper alarm, Combus low power 8 input module
May be used as inputs 

KT-PC4204 Tamper alarm, Combus low power, 
Low battery, Power failure, lower 
auxiliary power

Used as relays (1-4)

KT-PC4216 Tamper alarm, Combus low power Used as outputs
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10 Under Priority call type, assign the call type option that best suits failure event reporting. To 
access the Priority call type feature, the site connection type must be set to Modem.

Defining Controller Options
The Options tab enables operators configure such features as:
• Anti-passback (for synchronizing entry/exit readers)
• Duress function (for defining a panic button)
• Card count options (for specifying cards in an area), etc.

NOTE: The anti-passback option works with entry/exit readers. It allows security 
administrators to keep track of the number of monitored cardholders in an area. It is local to 
each controller defined by corresponding entry/exit readers. A relay can be activated when 
the counter reaches the number of cards defined to be inside the area; the relay is disabled 
when the number of cards in the area goes below the specified number. 

To define options for a controller:
1 In the Controller window, click the Options tab to define anti-passback options, duress options 

and card count options.
 

2 Determine the Duress options. When a duress option is selected, you have to assign a duress 
key, that is a silent panic key.
• Duress on access granted: this option enables the duress key when access is granted.
• Duress on access denied: this option enables the duress key, even when access is denied.

3 Select a duress key from the Keypad duress key drop-down list.

NOTE: For added security, you may select the two options. 
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4 From the Anti-passback options section, select anti-passback option from the Type drop-down 
list: when an anti-passback option is enabled, a card cannot be used on an exit door unless it 
has been used on a corresponding entry door.
• None: the anti-passback option is disabled.
• Soft passback: this option allows a cardholder to use an entry (or exit) reader more than 

once without using the corresponding exit (or entry) reader. Only an “Invalid passback” 
event is sent to the Message desktop.

• Hard passback: a card used at an entry reader will not be able to access the same entry 
reader again until it has used the corresponding exit reader.

5 In the Forgive schedule section, click the button to set a schedule for resetting the anti-
passback option on all other cards.

6 In the Miscellaneous section, indicate options for Fail-soft delays (10-255 second). During a 
fail-soft mode, the controller operates in stand-alone mode, following a communication 
failure.

7 In the Card count option, use the up or down controls to set the maximum card count. The 
maximum allowed is 65535. The system keeps track of the number of monitored cards that are 
in the monitored area and activates a relay when the count is reached. When users exit the 
area, the counter decrements and the relay will eventually reset when the count is smaller than 
the value defined.

8 You may configure the system to activate a relay when the maximum count is reached. Click 
the  button to select the relay or relay group that will be activated when the number is 
reached.
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Configuring Doors 
This menu is used to define the door parameters on which readers and/or keypads are installed. 
A door can be considered as an elevator door, a Time & Attendance door, an entry door for anti-
passback, an exit door for anti-passback or an access door. All this depends on how the settings are 
programmed.
The controlled door may be secured at all times or only during defined schedules. The common 
locking devices used are electric door strikes and electromagnetic locks. 
A door may be equipped with one or two readers, with one reader at each side. For doors equipped 
with two readers, the outer reader has to be defined as an entry reader and the inner reader as an 
exit reader.

Defining General Parameters
To define general parameters for a door:
1 In the Devices main window, select the Doors icon. 

2 In the Doors window, the appropriate Gateway to view the controller sites for a specific 
gateway, then select a site (from the Site drop-down list) and the controller associated with the 
door you want to define. 

3 From the Doors drop-down list, select the door you want to modify or to define. New items are 
identified with a red button. The button turns green once the item has been defined and saved. 

4 Specify the Door lock mode: Depending on the lock device used, the locked state will be 
energized or de-energized to lock.
• Fail-secure: The strike is locked when power is removed (door locks, door strikes). 
• Fail-safe: The lock output is energized to lock the door (electro magnetic locks).
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5 Specify the Door type:
• Access: The reader is considered as an access reader. Time and Attendance or Anti-

Passback options are not used with access doors. An access reader generates only “Access 
granted/Access denied” events.

• Entry: An entry door is an entry point for Time and Attendance or anti-passback. In order 
for the system to record an entry, the door must be opened after a valid access (if a door 
contact is installed).

• Exit: An exit door is an exit point for Time and Attendance or anti-passback. In order for 
the system to record an exit, the door must be opened after a valid access (if a door 
contact is installed).

6 Specify the Door access delay:
• Unlock time: The time during which the door is unlocked on a valid card read or a valid 

request to exit event (when the REX is defined to unlock the door). If this is an elevator 
door and a push button (input) is used to enable floor selection, this is the time during 
which a floor selection will be allowed. Usually, a longer period should be defined to 
allow the user to select floors. For more information, see “To define an input for an 
elevator door:” on page 125.

• Open time: The time during which a door can remain opened following a permitted access 
or a valid request to exit request. This applies only to a door defined with a door contact 
input. This time can be from 1 to 255 seconds (4 minutes 15 seconds). After this delay has 
expired, the system will generate the event “door open too long” and the door piezo will 
sound to warn the cardholder. You can use the Pre-alarm on door open too long (Doors 
window, Contact tab) to sound the door piezo when half of this delay has expired. It will 
continue to sound until the door is closed.

7 If the door is to be used for time and attendance purposes check the Time and attendance 
option. With this option the door must be set as either an entry or an exit door.

8 Check the Elevator cab option if the door is to be used for elevator control. When this option is 
checked, the Elevator tab is displayed to define the unlocking schedules.

9 If you are using an Extended door access delay feature, specify these delays in the Unlock time 
and Open time fields. This feature may be useful for cardholders with disabilities.

10 If the Video feature is enabled, the Video view field appears. If this is the case, select the Video 
view in which you want the defined component to appear.

NOTE: EntraPass offers the ability to program an extended door access delay and to specify 
specific unlock and open time delays reserved for people with disabilities. In addition to 
setting this special access delay, the user’s access card must be programmed with this 
feature. Only available on KT-100 and KT-300.
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Defining Door Keypad Options
Doors can be defined with relay activation when the * or # keys are pressed on the keypad. This 
option is available only for KT-100 (with firmware version 1.04 and up) and KT-300 (with 
firmware version 1.16 and up) controllers.

NOTE: The Keypad tab is enabled only if you have selected a keypad type while defining the 
controller associated with the door being defined.

To define door keypad options:
1 From the Door window, select the Keypad tab.

2 Specify how access to the door is controlled:
• Reader only: Select this option if access is granted using a reader. A reader only 

installation is the most common application.
• Keypad only: Select this option if access is granted using a keypad only. This option can 

also be enabled on a reader with an integrated keypad. A keypad only installation is 
generally considered less secure than a reader only installation, because users may “lend” 
their codes to another person but cannot prevent further use (in comparison to getting a 
card back). 

NOTE: This option can be enabled on a reader with an integrated keypad if you want for 
instance to use the keypad only.

• Reader and keypad: Select this option if both a reader and a keypad are used to permit 
access to this door. The keypad will only be used when the “keypad schedule” is valid. 
Adding a keypad to a reader significantly increases the level of security. PIN code 
requirement can be limited by a schedule for use only outside business hours, for 
example, rather than during high traffic hours.
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3 From the Card and PIN schedule menu, select a schedule during which cardholders will have to 
enter their PIN after a valid card read. The time allowed between a valid card read and 
entering the PIN at the keypad is set in the Gateway definition menu (Time-out on keypad 
option).

4 For doors defined with keypad or reader and keypad, you can program the star key (*) or 
pound key (#) to activate a relay. When this feature is enabled, users can activate a relay 
simply by pressing the appropriate key.

Defining Contact Options
In most applications, the low cost door contact is the only supervisory element that protects the 
investment made to control access to the door. The door lock and card reader (or keypad) provide 
security and prevent unauthorized entry only when the door is closed and locked. A simple door 
contact allows the ability to monitor several door conditions such as: door forced open, door open 
too long, interlocks options, etc.

To define the door contact settings:
1 In the Doors window, select the Contact tab.

2 Select the door contact from the Door contact list. 

NOTE:  For KT-200 Controllers, Input 1 (door contact) and 2 (request to exit device) are ideally 
reserved for Door 1 of the controller whereas Input 9 (door contact) and 10 (request to exit 
device) are ideally reserved for Door 2 of the same controller. The input that is used for the 
door contact or REX contact SHOULD NOT have a “monitoring” schedule defined in the “Input 
Definition” menu.

3 Check the door reading options:
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• Door open reading—If selected, this option allows the system to read cards while the door 
is open. However the system will not unlock the door if it was locked. If selected, the 
event “Access granted” is generated. Otherwise, the event “Access granted - Door open” 
is generated. 

• Door unlocked reading—If selected, this option allows the system to read cards while the 
door is unlocked manually by the operator or by a valid unlock schedule. If selected, the 
event “Access granted - Door unlocked” will be generated on access. To ignore all access 
events while the door is unlocked, leave this option unselected. 

• Pre-alarm door opened too long—If selected, this option allows the system to generate the 
event “pre-alarm door open too long” and sound the door piezo when half of the delay 
defined in the Open time field is expired. It will continue to sound until the door is closed.

4 Select the appropriate Relock on access option. You may choose to relock the door on a valid 
access, or relock the door when it closes.

Defining REX (Request to Exit) Options
A signal from the REX indicates that someone wants to exit through a controlled door. Devices 
such as motion detectors, push buttons can provide the REX signal. EntraPass enables users to 
configure doors with unlock time reset each time the primary or secondary REX is triggered. 
This option is available only for KT-100 (with firmware version 1.04) and KT-300 (with firmware 
version 1.16) controllers.

To define Rex options:
1 From the door window, select the REX tab, then check the appropriate Relock on Rex options: 

• Relock on door opening, if you want the door device to re-lock following a valid access
• Relock on door closing, if you want the door device to re-lock when it closes.
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2 For the primary and secondary Rex, make the appropriate choices:
• Assign the REX contact: the input to which a “request to exit” detector can be connected. 

This input must be local; it has to be one of the inputs on the controller operating the door.
• Select a Rex schedule: when this schedule becomes valid, the controller will detect 

request to exit signals originating for the exit contact. This option applies only to a door 
defined with a REX contact.

3 Select the Unlock on REX or Resettable REX function options:
• Unlock on REX: the door will be unlocked if a valid request to exit is permitted by the 

controller. This option may be useful on exit doors such as interior doors, shipping doors 
or other push doors through which people carrying packages may pass. The system will 
permit the exit and generates the “request to exit granted” event rather than “door forced 
open” event. 

• Resettable REX function: the unlock time is restarted on a valid request to exit. Open and 
unlock times are defined in the door definition (Devices > Doors > General). Select this 
option for high traffic area doors such as manufacturing doors where many users may 
need to exit at short intervals (for example after a work shift) to prevent unwanted door 
open too long or door forced open events. 

NOTE: It is recommended to choose either Unlock on REX or Resettable Rex function, not the two 
options at the same time. If you choose these two options, the door may remain unlocked for 
long periods of time. Moreover, these features should not be used if a door contact has not 
been defined. 

Defining Miscellaneous Options 
You may define interlock options between two doors to synchronize the time when these two 
doors are open/closed. The interlock option is also called the mantrap option. This ensures that 
once has accessed the first door, that door is closed and locked before the cardholder is granted 
access to the second door. The two doors have to be controlled by the same controller. 
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To define interlock options between two doors:
1 In the Doors window, select the Miscellaneous tab.

2 From the Doors drop-down list, select the first door for which you want to define interlock 
options. 

3 From the Interlock contact list, select the first input for the interlock feature. The selected 
input has to be the door contact of the second door.

4 Return to the Doors drop-down list to select the second door for which the interlock options 
are being defined; then select the interlock input for this second door. It has to be the door 
contact of the first door. 

5 Select the Interlock schedule: the two doors must have the same interlock schedule. This is the 
schedule according to which the interlock is checked by the controller before access is granted 
to users.

NOTE: The interlock feature is not available on doors controlled by a KT-100.

6 Check the Enable duress function on keypad option, if desired. 
7 In the Shunt on door unlock section, set the time during which selected inputs will not be 

monitored when the door unlocks. The Shunt delay indicates the time during which the 
selected inputs will not be monitored when the door unlocks. It is not possible to shunt a door 
contact since the system will automatically shunt it.

8 In the Shunt inputs scrolling pane, select inputs that will not be monitored when the door 
unlocks. Selected inputs will remain unmonitored for the delay defined in the Shunt delay 
field.
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Defining Elevator Doors 
During a door definition, it is possible to specify whether it is a “regular door” or an Elevator cab 
(Door window, General tab, Miscellaneous section). When a door is defined as an Elevator cab, an 
Elevator tab is displayed in the Doors definition window. This tab is used to define the automatic 
unlock schedules for specific floor groups. 

To define settings for an elevator door:
1 From the Doors definition window, select the Elevator tab.

2 From the Unlock schedule #1 list, select the applicable unlock schedule. By default, you may 
select the Always valid schedule. You may also create a new schedule (Definition menu, 
Schedules).

3 From the Floor group #1 list, select the appropriate floor group associated with the Unlock 
schedule #1. Only floors that have a valid schedule in the Floor group definition will be 
unlocked or available for selection when the Unlock schedule #1 becomes valid.

4 From the Unlock schedule #2 list, select the schedule applicable to the second group of floors. 
5 From the Floor group #2 list, select the appropriate floor group. Only floors that have a valid 

schedule in the Floor group definition will be “unlocked” or available for selection when the 
Unlock schedule #2 becomes valid.

Important Notes: 
• The Unlock schedule defined during a door definition (Door menu, General tab) will 

OVERRIDE these schedules even if they are valid.
• Only one Unlock schedule can be valid at a time. For example if the first schedule (Unlock 

schedule #1) is valid from 6h00 to 9h00 and the second schedule (Unlock Schedule #2) is 
valid from 7h00 to 9h00, then Unlock schedule #2 will NEVER be valid since Unlock schedule 
#1 is already valid.
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• Do not overlap schedules. For example, if the first schedule is valid from 8h00 am to 17h00 
and the second schedule is valid from 16h00 to 21h00, the gap (between 16h00 and 17h00) 
can result in erratic operation of the elevator control system.

• Only floors that have a valid schedule in the Floor Group definition will be “unlocked” or 
available for selection when the unlock schedules become valid.

NOTE: For more information on how to program elevator control using REB-8 relays, see 
“Defining KT-200 Expansion Devices” on page 96.

Configuring Door Events 
To define door events:
1 In the Doors window, select the Door events tab. This is to define the relays (or relay groups) 

that are to be activated on specified events.

2 Select the relay that will be activated locally, on such events as: Door forced open, Door open 
too long or Door alarm on relock. 

3 Under Priority call type, assign the call type option that best suits event reporting. 

NOTE: To access the Priority call type feature, the site connection type must be set to Modem. 
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4 Once all door event features have been set, select the Access events tab to define relays (or 
relay groups) that are to be activated on miscellaneous events.

NOTE: EntraPass offers you the ability to define a relay that will be activated if the Extended 
delay feature is used. The card used must be defined with this feature. Only KT-100 and KT-
300 can be configured with the Extended delay feature.

5 Select the relay that will be activated locally, on such events as: Invalid card status, Bad 
access level, Other access denied, Duress alarm, Access granted and Card traced.

6 Under Priority call type, assign the call type option that best suits event reporting.

To access the Priority call type feature, the site connection type must be set to Modem.

To define options for a KT-100 and KT-300:
Please note that the following options are available with KT-100 or KT-300 controllers only.
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1 Select the Options and alarm system tab.

2 Check the Unlock door by schedule after first access granted option to unlock the door 
automatically when a first card is read. 

3 Motor lock delay: enter the time (minutes:seconds) after which the door will be considered 
locked. This feature is used in specific applications such as bank vaults to compensate for the 
slow motor locks. Adding this delay avoids false door forced open alarms if a user is opening 
the door before it has been completely secured at the end of unlocking delay. The default 
value is 0:00 for inactive. For example, if this delay is set to 5 seconds and unlocking delay is 
20 seconds after access granted; the lock output will deactivate after 15 seconds and no door 
forced open alarm will be generated if the door is opened during the last 5 seconds.

4 If a second card read is required, select a schedule from the Second card schedule required 
(two-man rule) list. 

NOTE: When KT-100 and KT-300 are installed, the system offers the ability to interface an 
external alarm system. 

Configuring External Alarm System Options 
KT-100 and KT-300 offer the ability to interface with any external alarm system. When you add 
these Kantech controllers to an existing alarm system, cardholders can arm/disarm an existing 
system, simply by presenting a valid card on an entry/exit door. Adding a keypad will increase the 
system security since cardholders will be required to enter a PIN in addition to presenting a card.
There are five options to arm/disarm or postpone an external alarm system: 
• On a valid card read on an arming reader
• On a valid arming code entered on a keypad
• By pressing a button on a keypad
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• By pressing a button connected to an input
• By an automatic arming/disarming schedule 
There may be a combination of the three options. For example, an alarm system will be disarmed 
with a correct access code during a valid predefined schedule and after a valid card read.

To configure external alarm system options:
1 Select the External alarm system options button (Door > Options and alarm system tab). The 

Options and alarm system tab appears when a KT-100 or KT-300 is selected.

2 In the Arming request window, select the Arming request input. This is the input that is 
activated on an external alarm arming request. Once you have selected an arming request 
input, you have to set the schedule during which the request will be valid.

3 If applicable, select an arming access level from the list. The Group option allows you to 
select all access levels. Choose Single if you want to select a specific level. If the level you 
want does not appear in the list, you may create a specific level to arm the external alarm 
system (Users > Access level definition). 

4 Use the right-click menu to create a new access level.
5 To increase the security of your alarm system, check the Wait for access granted to arm option. 

This will oblige the user to present a valid access card before pressing the selected Keypad 
button. You may also check the Lock door when system armed option for increased security.

6 Specify the Exit delay and Entry delay (h:mm:ss). The Entry delay is the time during which the 
alarm system is bypassed after an access granted event. The Exit delay is the period before 
which the system is armed. The maximum values are 9:06:07 for both the exit and entry 
delays. Usually the entry delay is shorter than the exit delay. 

7 Select the input that will indicate the status of the external alarm panel. When the selected 
input status is “normal”, this indicates that the external alarm panel is armed.
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8 Select the Input tab to define input devices that will be supervised or shunted (no supervision) 
when the alarm system is armed. The input description column contains all the inputs that are 
defined in the system.

9 Check the Supervised column for inputs that you want to be supervised by the external alarm 
system; check the appropriate column for input for which you want to suspend supervision (on 
entry, on exit, or when the alarm system is disarmed). 

10 Select the Postpone arming tab to select the input that will be enabled to postpone arming. 
Select also the applicable schedule from the Enable postpone arming schedule. 

11 You may check the Wait for access granted to postpone option. If this option is checked, the 
alarm system will be postponed only after a valid card read and the cardholder will then press 
the selected keypad button to postpone the external alarm system.

12 Select the Postpone or disarm access level from the list. 
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13 Select the Relay tab to define a relay or a group of relays and input status for the external 
alarm relays. 

NOTE: When you select an Alarm relay, you may specify its activation type. It may be 
activated permanently or temporarily. 

14 Under Priority call type, assign the call type option that best suits relay activation reporting.

NOTE: To access the Priority call type feature, the site connection type must be set to Modem. 
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Configuring Relays
The output control relays provided on each KT-100, KT-200 and KT-300 can be used to activate 
alarms or other devices such as lighting control, ventilation, and air conditioning. 
These relays can be activated according to schedules, events reported by the system. They can also 
be activated to indicate the status of an alarm system or a combination of different logic 
conditions.

To define relays: 
1 From the Devices definition tab, select the Relay icon. 

2 Select the Gateway, the Site and the Controller from the displayed drop-down lists, then select 
the relay for which you want to define settings. 

3 Specify the Operating mode for the relay:
• Normal: the relay is normally de-energized (deactivated) until it is energized (activated) 

by an operator, an event or any other system schedule.
• Reverse: the relay is normally energized (activated or resting) until it is de-energized 

(deactivated) by an operator, an event or any other system function.
4 Specify the Automatic activation schedule: when this schedule is valid, the relay will be 

triggered (activated or deactivated) according to the specified activation mode.
5 Specify the Disable relay action: when this schedule is valid, the relay will be deactivated (or 

activated) according to the predefined operating mode. 
6 Set the Temporary activation timer to indicate the delay during which the relay will be 

temporarily triggered following a temporary activation.

NOTE:  When the timer is set to zero, the default activation delay is set to five seconds. 
Maximum time allowed: 255 seconds (4 minutes 15 seconds).
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7 Select a video view and graphic and a video view associated with the relay, if applicable. 
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Configuring Inputs
Door controllers can monitor the state of input points such as: door contacts, interlocks, alarm 
points, motion detectors, temperature sensors, any REX and other devices with dry contacts. KT-
100 monitors the state of 4 input points, KT-200 monitors the state of 16 input points, and KT-300 
monitors the state of 8 on-board input points, with a maximum capacity of 16. 
• For KT-200 only. Inputs are normally closed or normally open dry contacts connected in series 

with one resistor. If the dry contact is connected in series with the green resistor, the input 
number will be odd. If the dry contact is connected in series with the red resistor, the input 
number will be even.

• Input 1 (door contact) and 2 (request to exit device) are ideally reserved for Door 1 of the 
controller whereas Input 9 (door contact) and 10 (request to exit device) are ideally reserved 
for Door 2 of the same controller. The input that is used for the door contact or REX contact 
SHOULD NOT have a “monitoring” schedule defined in the “Input Definition” menu.

• For KT-100 Controllers. Input 1 is reserved for door contact while input 2 is reserved for a 
request to exit device.

• For KT-300 Controllers. Input 1 should be reserved for contact on door 1 while input 2 should 
be used for request to exit device for door 1 of the controller. Input 3 should be reserved for 
contact on door 2 while input 4 should be used for request to exit device for door 2 of the 
controller.

To define inputs :
You may define Input devices from the Controller definition menu or from the Devices definition 
window. 
1 From the Devices definition tab, select the Input icon.
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2 Select a specific gateway (from the Gateway drop-down list), a site (from the Site drop-down 
list), a controller (from the Controller drop-down list).

3 From the Input drop-down list, select the input you want to define. 
4 Assign a Monitoring schedule to the selected input: this is the schedule during which the 

system will supervise the condition of the input. When the schedule is valid, a change in input 
condition generates either an “Input in alarm” or “Input restore” event. 

NOTE: The input that is used for the door contact, REX contact or interlock contact SHOULD 
NOT have a monitoring schedule.

5 Specify the Normal condition for the input: it may be Closed or Open.
6 Specify the Loop response time. This delay is expressed in minutes (mm:ss:cc). The maximum 

time is 10:55:35 for both the alarm response and alarm restore times. 
• Response time—The delay before the system generates the input and alarm event.
• Restore site response—The delay before the system generates the input restore events . 

NOTE:  Specifying the site response time reduces bouncing when the contact changes state, 
and helps to generate only one event for each transition if this time is longer than the 
bouncing time. For example, a 01:00:00 delay requires that a condition remains stable for at 
least one minute before it is reported. 

1 From the Input drop-down list, select an input.
2 Select a graphic in which the input has been assigned.
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To define relays and inputs:
1 Select the Relay and input tab to define which relay(s) or input(s) will be activated or shunted 

when this input is enabled.

NOTE: For the system to process properly the reset delay on a temporary shunt, the Temporary 
Shunt Timer option must be set in the definition of the input that will reset the delay. For 
example, if Input 1 will temporary shunt Input 2, the Temporary Shunt Timer must be specified 
also in the definition of Input 2.

2 From the Activate relay list, select a relay or a relay group that will be triggered when this 
input is enabled. 

NOTE: Setting the timer to 0:00:00 will instruct the relay to follow the input's state. 

3 From the Shunt input list, select the input that will not be monitored when the input being 
defined is enabled.

NOTE:  When the input is restored or returns to normal condition, the shunted input will also 
return to normal condition. The event “Input shunted by input” will be generated by the 
system. When the input returns to normal condition, the event “Input unshunted by input” will 
be generated.

4 In the Temporary Shunt Timer (h:mm:ss) field, specify the period during which an input is not 
monitored. Setting the timer to 0:00:00 will instruct the relay to follow the input state. The 
maximum value for the Shunt delay (h:mm:ss) is 9:06:07. 

To define an input for an elevator door:
When the input being defined/edited is used for elevator control, an Elevator tab is displayed in the 
Input definition window.
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You may associate an input to a push button. It can then be used by a guard or by a receptionist to 
temporarily enable the floors defined in the Floor group activation section.
1 In the Input definition window, select the Elevator tab.

NOTE: Only the floors marked with an “X” in the State column in the Floor group menu will be 
available for selection. The system will temporarily enable floor selection according to the 
delay defined in the Unlock time of the Doors menu. A valid schedule has to be selected 
(Enable schedule list) for this feature to be activated. It may be necessary to define a door as 
an elevator cab to access this tab.

2 In the Select cab for floor group activation section, select the cab associated with the input. 
3 Select the Floor group associated with the selected cab, that will be enabled when the input is 

triggered.
4 Select a schedule according to which the defined input will carry out this command.
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To enable remote event reporting :
1 Select the Input event tab.

2 From the Local activation relay list, select a relay or a relay group that will be triggered when 
this input is in alarm (activated). 

3 Under Priority call type, assign the call type option that best suits the reporting of the event 
which triggered the input.
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Configuring Output Devices
Outputs usually control the reader LED and buzzer. There are four outputs available per KT-200 
and KT-300 controllers (2 per door). A KT-100 supervises the state of two outputs.
Electrical outputs are configured as open-collector. They provide an open circuit when deactivated 
(not connected to ground) and are switched to ground when activated.
You may configure Output devices from a controller definition menu or from a gateway window. 

To define general options for an output: 
1 From the Devices configuration window, select the Output icon. 

2 Select the physical components related to the output: gateway, site, controller for the output. 
3 From the Output drop-down list, select the output you are modifying. 
4 Specify the Operating mode for the output device:

• Normal—The output is switched to ground when it is activated.
• Inverse—The output is an open circuit (not grounded) when it is activated.

5 In the Selected doors section, select which door will affect the output you are configuring:
• Door #1—Only the first reader port will follow the state programmed for these events. 
• Door #2—Only the second reader port will follow the state programmed for these events.
• Door #1 and Door #2—Both reader ports will follow the state programmed for these 

events.

NOTE:  This option is not available with KT-100.
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6 Set the Activation period (m:ss) delay. It defines the activation time in seconds during which 
the output remains active when it is programmed for a temporary activation. An e will leave 
the output activated indefinitely, regardless of the activation type. 

NOTE: If you are using the Video Integration feature, EntraPass enables you to assign all 
system components into a video view, the same way you assign them to a system interactive 
floor plans (graphics). To do this, you simply select the video view where you want the system 
component (Workstation, site, gateway, controller, etc.) to appear.

To associate events with auxiliary outputs:
System events can trigger auxiliary outputs. You can define how each event will trigger the output. 
1 Select the Definition tab to associate a door event with an auxiliary output.

2 In the Options column, associate an event with an output state.
• Steady timed—The output given this option will not flash, it will remain activated for the 

specified activation period and will return to normal state when the activation period is 
over.

• Flash timed—The output will flash and remain activated for the specified activation 
period and will return to its normal state when the activation period is over.

• Steady—The output given this option will not flash, it will remain activated until it 
returns to normal condition.

• Flash—The output will flash and remain activated until its condition returns to normal. 

NOTE: The on-off delays for the outputs are pre-defined during the Gateway definition. For 
details, see “Configuring EntraPass Gateways” on page 82. Events for timer on/off vary 
depending on the type of the selected gateway.
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Chapter 5 • Video Integration
EntraPass adds real-time monitoring capability to the Corporate and Global series as a response to 
the growing importance of video in access control systems. The Video feature allows operators to 
define Video parameters and use video features from EntraPass Corporate and Global Edition user 
interfaces. 
EntraPass administrators have to define video configuration and viewing parameters including: 
• Video servers for use in EntraPass (identifying the Video source and specifying cameras 

connected to it)
• Video views for Video monitoring using EntraPass desktops
• Video recording triggers
• Recording parameters
• EntraPass Video Vault, etc.

NOTE: Installing and using the Video feature may take a great amount of your company 
network bandwidth (LAN or WAN). The network administrator may control the use of the 
network bandwidth for video data transfer.

The following diagram shows how the Video feature is integrated in EntraPass. The EntraPass 
Video Vault utility can be installed on the same computer as any other EntraPass application or on 
a dedicated computer.
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Configuring the Video Server
A Video server is connected to EntraPass through a specific IP address. The Video Server 
captures, stores and distributes video data to the EntraPass desktops for monitoring and 
surveillance purposes.Video data can then be accessed by any EntraPass workstation (with 
appropriate permission) through the network. 
In order to use the Video feature in EntraPass, the video server must be identified to EntraPass. To 
do this, you have to:
• Define the Video server communication settings
• Specify video parameters including the number of cameras connected to the server
• Set communication delays
• Define parameters for use with EntraPass Video Vault, etc. 

To define the Video Server communication settings:
1 From the EntraPass main window, click the Video tab, then click the Video server icon in the 

Video window toolbar. The Video server window appears with the General tab enabled. 

2 From the Video server drop-down list, select the Video server you want to configure (or click 
the New icon to create a new one), then assign it a descriptive name in the language section. It 
is recommended to supply a name in the two languages if you are running the application in 
two languages.

3 From the Video Server type drop-down list, select the Video brand for the Video server you are 
configuring. 

NOTE: The current version of the software integrates Intellex only. EntraPass supports all 
version of Intellex, including Intellex LT. This later version limits the number of cameras to 4, 
8 or 16 depending on the selected Intellex LT (LT-4, LT-8 or LT-16). Moreover, a number of 
features such as the event control are not available on systems running an Intellex LT. 
5 • Configuring the Video Server132



Reference Manual
4 Check the On-line option to tell EntraPass that the Video server is on-line. 

NOTE: The On-line option must be unchecked when the server is off-line for long periods such 
as maintenance reasons, for example. Otherwise, EntraPass will continue polling the video 
server; this may cause the system to hang. 

5 In the IP address field, specify the static IP address of the Video server. Make sure that the 
Video server is set to a static IP address. For specific information about the video server IP 
address, contact your network administrator. 

6 Specify the port information for Video, Communication and Events. Make sure that these are 
the same used by the DVR (Digital Video Recorder).

NOTE: The TCP port (Transmission Control Protocol) is used by the Video application to 
communicate with EntraPass. Options displayed in the TCP port section depend on the device 
you are configuring. For details about ports and their settings, contact your network 
administrator or the documentation provided by your Digital Video Recorder (DVR) vendor. 

7 Check the Bypass Ping for identification option if you want to save on Network utilization. In 
fact if this option is not checked, the workstation will continually poll for server 
identification. 

8 Check the Specify video server login option if you want users to enter their credentials before 
accessing the Video server. If this option is checked the Login tab appears in the Video Server 
window.

9 In the Video server parameters section:
• Enter the Number of cameras. The number of cameras connected to the video server (or 

use the up/down arrows) or click the Import camera details button to get this information 
from the video server. Using the Import camera details button offers a fast way to define 
cameras connected to the video server. In fact, when you click this button, EntraPass will 
connect to the Video server and get the number and default names for cameras connected 
to the DVR.

• Specify the Polling frequency (mm:ss). The polling frequency refers to the delay between 
two polls from the Kantech Server to the Video Server. This operation is processed by the 
Kantech Video Server Interface.

• Specify Polls before Communication failure. This refers to the number of unsuccessful 
polls before the EntraPass Server declares the Intellex server offline. For example, if you 
enter 4 in this field, EntraPass will attempt to connect four times to the video server 
before it declares that the Intellex server is down.

• Indicate the Timezone adjustment.Using the up/down arrows, specify the Timezone 
adjustment if the EntraPass server and the Intellex server are not in the same timezone. 
The timezone adjustment refers to the timezone difference between the Intellex server and 
the EntraPass server. Adjusting the timezone enables workstations to retrieve events 
generated by the Intellex server at the EntraPass Server’s time. 
1335 • Configuring the Video Server 



Reference Manual
• Check the Time for clock synchronization box. The Time synchronization refers to the 
time of the day when the video server will synchronize with the Kantech server for date 
and time. This operation is processed by the Kantech Video Server Interface. 

NOTE: The EntraPass server serves as the reference time source. Intellex server will process 
the time according to the EntraPass Server’s time. For example, if the EntraPass Server’s 
time is 3:00 and that of the Intellex server is 2:00, the Timezone adjustment data will be -1 so 
that the Intellex server can display the correct information about an event that occurred at a 
specific time. 

Enhancing the Security of Video Servers
If your Intellex Video server is secured by Policy Manager, EntraPass operators must use a 
specific login and user name to access the Video server. For details about the Video server security 
parameters, contact the network administrator.

To define the video server login parameters:
1 If the Specify video server login option is checked, select the Login tab that appears.

2 Enter the login data in the displayed fields: 
• Domain name: enter the domain name used by the Intellex Video server. 
• Login name: enter the login name used for accessing the Intellex server. 
• Password: enter the password specific to the domain controller. 
• Password confirmation: the password for confirmation must be identical to the password 

entered in the previous field. If you get an error message, make sure that the Caps Lock 
key is activated.
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Defining EntraPass Video Vault
The Video Vault parameters tab allows you to specify settings such as archiving schedule or 
transfer frequency for EntraPass Video Vault if this application has been activated in EntraPass 
and has been configured for use within the EntraPass applications. 
• For details about installing EntraPass Video Vault, see “Adding Optional Components/

Features” on page 10. 
• For details about configuring the EntraPass Video Vault application, see “Configuring the 

EntraPass Video Vault Application” on page 75. 
• For details about using EntraPass Video Vault, see “EntraPass Video Vault” on page 456.

To specify the video archive details:
1 From the Video server window, select the Video Vault parameters tab.

2 Enter information for the EntraPass Video Vault application:
• Archive schedule: the selected schedule indicates the period during which video segments 

will be saved. When this schedule is valid, all video segments from user-defined triggers, 
video server triggers or manual triggers will be saved for archiving purposes. 

• Video Vault application: the name of the EntraPass Video Vault application associated 
with the selected video server. 

3 Define the Video segment transfer parameters:
• Transfer interval (hh:mm): the interval specified in this field indicates the period during 

which videos segments are retrieved from the video server. This feature restricts data 
retrieval and the availability of the video server during a specified period of time.

NOTE: Intellex allows one video retrieval at a time. If, for instance, the specified period is 
02:00 --> 04:00, video segments will be retrieved for two hours per day. If the specified period 
is 18:00 --> 06:00, this indicates an interval of twelve hours starting from 6:00 PM to 6:00 AM.
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• Notify on transfer failure (days): this number indicates the number of days allocated for the 
video retrieval. If a video segment was not retrieved after the number of days specified in 
this field, the video segment will be considered irredeemable for archiving and EntraPass 
Video Vault will notify the operator of the failure. 

• File language: This option is applicable to KVI and KVA formats only. Users can choose 
between English and French as the language that will be used to describe the archived 
data. 

• Video file format: select the format for the video file that will be retrieved:
• Kantech Video Intellex Format (KVI). A simple double-click allows you to view the file 

using VideoPlayerIntellex.exe. 
• Kantech Intellex Video Format (KVA). A double click opens the video file using 

VideoPlayerWindow.exe. 
• AVI Format: Video files open using Windows Media Player.
• Video Vault default: this is the format defined for the selected EntraPass Video Vault 

(Devices > EntraPass Applications > (Select Video Vault application) > Video Vault 
Process tab).

• Intellex Format: Video data are stored in Intellex format (.img) and can be viewed 
using the Intellex Video player.

4 For increased security, check the Use a password for KVI and KVA file formats option if you 
want to protect the KVI and KVA archived video segments by a password. Make sure to enter 
identical information in the Password and Password confirmation fields. Before viewing video 
segments archived on the EntraPass Video Vault being defined, operators will have to enter 
this password. Archived video files can be viewed from the Browse Video Vault window. 
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 Defining a Camera
EntraPass offers you the ability to assign names to cameras, presets, and patterns for easy 
identification in the Video desktop and in all system video events.
The definition of a camera includes identifying its:
• Type (fixed or dome)
• Presets (for dome cameras)
• Patterns (for dome cameras)

Identifying Camera
The camera name is displayed when viewing live or recorded video events. The default names are 
Camera1 through Camera n (where n is the last camera number).

To define a camera:
1 From the Video window toolbar, click the Camera button. The Camera window appears.

2 Select the camera you want to define, then assign it a descriptive name in the enabled 
language fields. It is recommended to assign a name both in the primary and secondary 
languages if the system is running in two languages.

3 Select the Camera type from the drop-down list.
• Fixed: no preset/pattern; operators cannot control a fixed camera. 
• Dome: preset and pattern available; selecting this option allows operators to control the 

camera. If you select this option, assign descriptive names to the camera presets.
4 Check the Show camera option for the camera to be accessible for selection and display in the 

Video view desktop. It is important to check this option if you want the camera to be enabled 
in EntraPass. Only operators with appropriate permission will be able to view a camera with 
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the Show camera option not checked (Hidden/covert cameras). To assign permission to an 
operator: System > Operator definition > Privileges.

NOTE: If you leave the Show camera box unchecked, the camera will not appear in the Video 
view component window (Video view > Modify video view components) and will not therefore be 
assigned in the Video desktop for view. This feature allows to hide a camera from all view. 
Operators who do not have appropriate permission will not be able to view, search, export or 
carry any other operation on a camera for which they do not have access permission. 
However, all links and references to this camera will be kept. This feature is different from 
deleting a camera since links to a deleted camera are deleted as well. 

5 Check the Select specific events option if you want this camera to record specific events. By 
default all camera events are displayed in the Video Events List. However, you can decide 
which events will be recorded by a specific camera by checking this option. When you do this, 
the Event tab appears. You can then select it and select specific events will be recorded by the 
camera being defined. If this option is checked, you have to select events that will be recorded 
by this camera. 

6 Using the Up/down controls, adjust the number of presets and patterns for the selected camera 
if the selected camera is a dome. When you do this, the Preset or Pattern tabs appear in the 
Camera window.

7 Select the view type you want to display when an alarm occurs.
• Video View: The video view selected will be displayed when an alarm occurs on this 

camera. 
• Graphic View: The graphic view selected will be displayed when an alarm occurs on this 

camera.
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Defining Presets and Patterns
To define presets and patterns:
1 From the Video server window select the Preset (or Pattern) tab to assign custom names to 

your presets. 

2 Select a table cell, then overtype the default name. If you are running the system in two 
languages, enter the name in both the primary and secondary language, then click Close to 
close the Preset (or Pattern) window. 

NOTE: If you select a preset or pattern and click the Default button, the assigned name is 
replaced by the default name. 

Defining Events Recorded by a Camera 
If the Specific events option is checked, you have to:
• Select events that will be recorded by the camera being defined and that will be sent to the 

EntraPass Server. This option is disabled when a camera is connected to an Intellex LT DVR.
• Select or define a schedule that will be used by the video server to report selected events to the 

EntraPass Server. This schedule can be used as a filter to limit the message flow from the 
Video Server to the Entrapass Server. For instance, choosing an Always valid schedule will 
send all the selected events to the EntraPass server. Specifying a limited period of time will 
allow to send events that occurred during a targeted period of time.
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To select camera events and schedules:
1 From the Camera window, select the Event tab. Typical camera events are displayed in the 

window. These are specific to the selected DVR.

2 Select a schedule for camera event reporting. Only events that will be recorded during the 
specified period of time will be sent to the EntraPass server. Right clicking the Event report 
schedule field enables operators to create a new schedule or to select an existing one. To 
define a schedule see “Assigning/Defining Schedules” on page 176.

3 Select camera events that you want to send to the EntraPass server. Specifying events to be 
sent to the Intellex server is a way of saving on controlling the flow of the video data, and 
hence of saving on the company bandwidth. The list of events is specific to the video server. 
The following list is available on Intellex servers:

• Camera advanced motion alarm: the camera will send any event related to a motion 
alarm.

• Camera alarm: the camera will send any event related to a change that occurred in the 
target area. 

• Camera motion alarm: the camera will send to the EntraPass server all video segment 
events related to any movement that occurred in the target area. 

• Camera museum
• Perimeter: the camera will send to the EntraPass server all video segment events 

related to an object that has crossed into or out of the target area. 
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4 Select the Video Vault Comment tab if you want to add information regarding the camera being 
defined. KVI and KVA file formats from this camera that will be saved in EntraPass Video 
Vault will be displayed with the comment entered in this window.

5 Enter the comment you want to associate with the camera being defined, then save and close 
the window.
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 Associating a Camera with an Icon
EntraPass offers you the ability to associate a specific icon with a camera for easy identification in 
the Video desktop and system Graphic.

To associate an icon with a camera:
1 From the Camera window, select the camera you want to associate with an icon, then click or 

double-click the button next to the camera type drop-down list. The Define camera icon pop-
up window opens. 

2 Choose an appropriate icon to associate with the selected camera, then double-click it to close 
the Select an icon window. When you do this, a camera is associated with an icon using the 
icon index. 

NOTE: The Camera icon in the Camera window toolbar allows you to add custom icons to the 
list of available icons. The Add and Delete buttons allow operators to add other icons for 
selection or to remove icons from the displayed list. The list of icons is displayed when you 
click the Camera icon in the toolbar.
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Defining Video Views 
Once the video server is defined and its cameras identified, operators can define video views that 
will be displayed in the Video desktop for viewing and monitoring purposes. 
EntraPass operators will then call pre-programmed presets and patterns. There is no limit to the 
number of presets that can be defined in the system. 
EntraPass Devices (Workstations, Gateways, Sites, Controllers, etc.) can be associated with Video 
views. Later, the Video view can be selected in the components definition in order to display the 
component in the video view.

To define a video view:
1 Select the Video view button from the Video toolbar. The Video View window appears with 

the General tab enabled. 

2 From the Video view drop-down list, select a video view (or click the New icon to create one), 
then assign it a name in the language section. If the system is running in two languages, you 
have to give a name in each language. 

3 From the Default size on video drop-down list, select an appropriate size for the image that will 
be displayed: you may choose to select a smaller size if you have to display the Video window 
with another window.
• Large: 1024x768
• Medium: 800x600
• Small: 640x480
• Tiny: 400x300
• Last used: displays the size that was previously displayed in the Video desktop.

4 From the Default size on graphic drop-down list, select a size for the image that will be 
displayed on the system graphics (Large, Medium, Small, Tiny, Last used). 
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5 Specify the Refresh rate percentage using the Up/down arrows. 

NOTE: The Refresh Rate Percentage is related to the image compression/quality. The image 
quality impacts the system performance: the higher the quality, the lower the compression 
and the lower the system performance will be. If you set the Refresh Rate to high (> 80), the 
compression will be low. As result, the application will use a larger network bandwidth. This 
may result in a slower process. The following table shows the recommended options:

6 Check the Re-initialize video view delay (mm:ss) if you want the system to refresh the displayed 
image. If you check this box, the displayed image will be automatically updated when the 
specified delay is elapsed. This feature is very useful if the defined camera view includes 
patterns or presets.

7 From the Video control section, make the appropriate choices:
• Show metrics: this option enables the system to display the number of frames per second 

(Fps) and the number of bits per seconds (Bps) for the selected camera. The information 
appears in the upper section of the Video window (and in the Video desktop). 

• Show camera controls: check this option for use with dome cameras. Selecting this option 
allows operators to control a dome camera. It is not available with fixed cameras.

• Show overlay: check this option if you want the camera identification (camera name and 
server) to appear in the Video desktop. 

• Auto-hide text: if this option is checked, the system will not display the information 
related to a camera.

• Enable camera zoom: check this option if you want to display the zoom value for the selected 
camera.

NOTE: The Enable video pattern section is enabled once components have been assigned to 
the video view.

Quality Description Result

80 and Over Super quality Images are recorded at the highest image quality, using the 
lowest level of compression. This setting requires the high-
est amount of storage space and network bandwidth.

60 Normal, 
Default

Images are recorder at normal image quality. This setting 
provides a balance between compression and storage space 
requirements.The smaller, more subtle changers between 
images are ignored. 

40 Low quality Images are recorded at low image quality, using the highest 
level of compression. This setting requires the lowest 
amount of storage space and network bandwidth.
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8 Check the Enable video pattern box to alternate video images in the Video window. If you 
have defined a 2X2 view, then the video pattern will be composed of four images alternating 
in the video display according to the delay specified in the Camera display delay field. If you 
do not check this option, the video view will display a static image.

9 Check Delay before launching sequence (m:ss) box to specify the transition delay before the 
images start alternating in the Video window. 

10 Specify the display delays for Cameras, Presets, Patterns and Graphics. 

NOTE: These delays indicate the time interval during which a video or graphic appears in the 
Video display before it is replaced by another. Refer to the following table for the minimum/
default delays. The maximum delay is 9:59 seconds. 

NOTE: Select the Details tab to view data about the selected view: video servers, cameras, and 
when applicable, camera presets and patterns.

Delay Minimum (seconds)

Delay before launching sequence 2 seconds

Camera display delay  3 seconds

Preset display delay 5 seconds

Pattern display delay 10 seconds

Graphic display delay 5 seconds
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Creating and Modifying Video Views 
Video presets and patterns enable users to perform automatic actions on domes. They are 
configured for view in the desktop dedicated to Video viewing. They enable to optimize the time 
dedicated to video viewing when displaying videos using pre-programmed views. 
EntraPass enables users to define a wide variety of views, depending on their needs:

• Single camera 
• Multiple cameras 
• Multiple graphics and cameras
• Server-specific view: these are created by dragging a server into the display
• Multiple video servers: depending on their needs, EntraPass users can create views from 

multiple video servers.

To define a video view:

1 From the Video view window, click the  button 
to edit or create content for the Video view desktop. 

 

2 From the left-hand panes, select a camera, a camera preset, or a camera pattern, then drag it 
into a right-hand pane cell. A camera is identified by its name and corresponding icon. A 
preset is identified by the camera name and the preset name.

NOTE: A specific camera can appear in more than one cell; in this case, the Enable video 
sequence option must be enabled. A graphic can appear only in one cell. You can put cameras 
from different Video Server but the source must be from the same vendor.

3 Click one of buttons in the upper part of the right pane to specify the number of images you 
want to display:
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• Click the 1 X 1 button to display 1 image
• Click 2 X 2 to display 4 images 
• Click 3 X 3 to display 9 images 
• and 4 X 4 to display 16 images.

NOTE: You can create a view by dragging a video server into the display. This view will 
contain all cameras from this specific server.

NOTE: The number of the images displayed influence the speed of the network bandwidth. For 
example, if you are displaying 4X4 images, the network bandwidth will be slower than when 
you are displaying a 1X1 image.

4 Click the Test button to view the result of the selection. The displayed Video view appears in 
the Video desktop for video monitoring and surveillance (Desktops > Desktop dedicated to 
video monitoring).

NOTE: To delete a camera from a cell, right-click it, then select Delete from the shortcut menu.

5 Click the Close button (bottom left or the “X” top right) to close the Video test window.
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Video Triggers
Video triggers are system events that start or stop recording. Any event related to the selected 
component type can trigger recording including exception events originating from a video server. 
A source component must be specified for each type of triggering event. For example, the “door” 
component must be specified for the “Door forced” event message. There is no limit to the number 
of definable video triggers. 

Defining Video Triggers
The following information can be defined:
• Name in two languages
• Component type: type of component to be programmed for the trigger. Events are related to 

system components: gateway, site, controller, etc. 
Based on an event that occurred on the selected system component, the trigger will start or stop 
recording.

NOTE: The list of parameters depends on the video server type connected to EntraPass. It can 
vary depending on server feature availability and decisions on subsequent implementation. All 
EntraPass events can be associated with the video trigger function.

To define a video trigger:
1 From the Video toolbar, select the Video trigger button. The Video trigger window appears.

2 Click the new icon (or select an existing trigger if you want to modify one). Assign a 
descriptive name to the trigger.

NOTE: An alert message appears when you attempt to save before selecting the component 
type as well as the component for the trigger being defined.
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3 From the Component drop-down list, select the component that will trigger the recording 
event. It may be a door controller, for example.

4 From the Trigger schedule select a schedule for the trigger to be valid. If necessary, you can 
define a specific schedule for this trigger (Definition > Schedule). If there is no schedule 
selected for a trigger, the trigger will be disabled. 
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Recording Parameters
The Recording Parameters menu enables users to define parameters that control video recording 
and to associate recording parameters (such as video source, cameras, etc.) with a video trigger. 
For each recording event, you must specify parameters such as the video server source, the 
camera, etc. 
A recording can be stopped by a timer (maximum recording time) or by a trigger when a stop 
recording trigger is used. 
A source component must be specified for each type of triggering event. For example, the “door” 
component must be specified for the “Door forced” event message. The resulting action (whether 
to start or stop recording) must also be specified. 
EntraPass offers you the ability to associate multiple recording parameters with one trigger. In this 
case, all recordings will be associated with the single event and it will be possible to save all 
record segments as a single event recording.

Setting up Recording Parameters
The Video record window lets you configure how EntraPass Video records videos. You must 
possess the appropriate privileges to set up this feature.
There is no limit to the number of definable recording parameters. The following information can 
be defined:
• Name in two languages (for systems in two languages)
• Video source (server and camera)
• Preset and patterns
• Start recording trigger 
• Pre-alarm time 
• Maximum total recording time, etc.
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To set up recording parameters:

1 From the Video toolbar, click the Recording parameters icon .The Recording parameters 
window appears, the General tab enabled.

2 Click the New icon to create new Recording parameters (or select one from the Recording 
parameters drop-down list) and assign a descriptive name to the Recording parameters.

3 From the Video server pop-up window, select the video server that will be used for the 
Recording parameters. 

4 From the Camera drop-down list, select the camera for this Recording parameters. 

NOTE: If the selected camera is a dome, you can specify the preset and pattern name and 
number. Defining these options allows you to direct the camera to a specific position for 
recording. However, the pre-alarm time feature may not work well with the preset/pattern 
option. In fact, the pre-alarm may be triggered when the camera is directed to a location 
different from the one where the video recording event occurred.

5 From the Start recording trigger pop-up window, select the Video trigger you want to associate 
with the Recording parameters being defined. The Video trigger pop-up window displays all 
video triggers defined in the system.

6 In the Timings section, specify:
• Pre-alarm time (m:ss): This option enables users to retrieve from the Intellex server, 

segment that was recorded before recording was triggered. For example, if a recording 
was triggered at 2:00 PM and if the Pre-alarm time is 1min. 0 seconds, the record segment 
will start at 1h 59.

• Maximum total recording time (m:ss): This options allows you to specify a maximum 
length for the recording. This includes the pre-alarm time but not the post-alarm recording 
delay. The maximum allowed is 5 minutes.
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7 Check the Custom recording rate (fps) option if you want to enable the custom rate option so 
that EntraPass can override the Intellex image rate settings. Using the up/down arrows, 
specify the recording rate for recording parameters. The value you set will be used by 
EntraPass exclusively for the selected Recording parameters. By default, this value is set to 
2.5 fps. The average value is 7.5 fps. Below this value, there is no motion. When the value is 
set to a value grater than 7.5 fps, for example 8.5, there is motion. Adversely, the computer’s 
performance can be affected.

NOTE: The record rate is defined in frames per second (fps). The frames per second (fps) 
relates to how many pictures it will record in a second. Real time recording is about 30 fps on 
each camera. 

Setting up Stop Recording Parameters
If you want to associate the defined recording parameters with a trigger for stopping recording, 
check the Stop recording trigger option. If you do this, the Stop recording trigger tab appears in the 
Recording parameters window. 

To define stop recording parameters:
1 From the Recording parameters window, select the Stop recording trigger tab.

• Post-alarm recording delay (m:ss): this delay enables the system to end recording when 
recording is stopped by an “end recording delay” condition. Moving the mouse pointer 
over the field shows the value allowed in the field.

• Trigger: select one (or more) trigger(s) that will stop recording.

NOTE: You can create new stop recording triggers by right-clicking the triggers display area.
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Video Event List
The Video Event List window displays all video segments recorded in the system and stored in the 
Video server database as well as video segments archived in EntraPass Video Vault. These video 
segments can originate from three sources:
• Video triggers
• Manual requests from operators
• Automatic recordings from video servers 

NOTE: Operators must have access permission to the video server in order to perform 
operation on events displayed in the Video Event list. For example, if an operator has not 
been assigned permission to use a specific video server, he/she will not view events 
originating from this server. User permission are assigned while defining the security level: 
System > Security level.

Using the Video Event List
The Video Event List window displays all video events as well as their description. 
EntraPass operators can:
• Search for a specific event associated with a video segment based on the date and time when 

the video was recorded
• Play a video segment
• Export the video segment for future consultation
• Stream or copy video segments from EntraPass Video Vault
• Retry all aborted transfers: these are transfers of video segments that were tagged for archive 

but which were not transferred to EntraPass Video Vault.

Finding Video Events
Use the Search button to locate and view video segments. The Events tab allows you to filter 
events. The Options tab allows you to determine the size of the video you are looking for. 
Appropriate user access rights are necessary for performing this task. 
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To find video events:

1 From the Video Events List, click the Search button . The Find video event 
window appears.

NOTE: If the Menu and Legend buttons are not activated, the window will not show the legend 
nor the buttons in the lower part. 

2 From the Find a video events window, select the Start date and time and the End date and time 
for the video segments you are looking for. 

NOTE: The Legends button allows you to display a status legend related to video events. The 
Play and Copy from Video Vault buttons are enabled when the selected video events have 
already been archived on EntraPass Video Vault.
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3 Select the video server that you want to include in the search. You can select All video servers 
if you want to search through all video servers defined in the system. 

NOTE: If an event was registered by more than one video server, at least one of the servers 
must be selected for the event to be included in the list. 
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4 Select the Events tab to filter events to be included in the report. You can select All events all 
check specific events.

5 Select the Options tab to filter video segments according to their duration.
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6 Check the Size filter option, then enter the duration in the Greater than (mm:ss) and Smaller 
than (mm:ss) fields. The value entered is in minutes and seconds. This feature allows you to 
target video segments meeting specific duration criteria.

7 Select the Archive State tab to filter events according to the archive status.   

8 Check the Archive state option if you want to specify which events will be included in the 
filter. If you want to include all events, leave these options unchecked. 
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9 Click OK to go back to the Video event list window.

NOTE: The Play and Copy from Video Vault buttons are enabled when the selected video event 
has been archived on EntraPass Video Vault. Archived events are identified by a green flag.

10 Do one of the following using the buttons described bellow:

Button Use description

Use this Search to search for events associated with a video segment. For 
details, see “Finding Video Events” on page 153.

Use the Play button to view a video event. When you click this button, the 
Video desktop displays the video event. If only one camera was used, which 
is most often the case, the system displays the duration of the video event. If 
the video event was recorded by more than one camera on a single server, 
the video server will use the most optimal display layout. If the video event 
was registered by more than one server, it is possible to select a specific 
video server. For example, 2x2 for a maximum of 4 camera, 3x3 for a maxi-
mum of 9 camera or less and 4x4 for a maximum of 16 cameras. For events 
with various length, events will be played based on the longer event. Note 
that this feature shows limitations when used in systems not configured for 
continuous recording as it will not display cameras involved outside the 
selected time frame.
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Playing Video Segments
The Video Event List window is divided in two panes: the left-hand pane displays all video events 
that were retrieved according to the search criteria. The lower pane of the window displays the 
legend explaining the status of each event. It also contains buttons that enable operators to perform 
operations on video recordings.
The right-hand pane contains three tabs:
• The Details tab displays the text description of the video event such as the Video server that 

recorded the event, the operator who was logged on, etc. 
• The Camera tab shows cameras that are associated with a selected event. 

Copy from Video 
Vault

The Copy from Video Vault enables operators to retrieve a video segment 
that has been archived on EntraPass Video Vault.

Play from Video 
Vault

The Play from Video Vault enables operators to view a video event that has 
been archived on EntraPass Video Vault

The Retry all aborted transfers button enables operators to trigger any 
archiving process that was suspended. 

Use this buttons to display the buttons in the lower part of the window or to 
display a legend about the status of the displayed video recording events.

The KVI (Kantech Video Intellex) and KVA (Kantech Video AVI) and 
AVI formats are available for your export needs. These formats allow users 
to store all the data relative to a video event such as the event icon or key 
frame, description, etc.

The Save button is enabled when an operator enters data in the Comment 
field. It enables operators to save comments associated with a video event.

The Cancel button is enabled when the Comment field is modified. It 
enables operators to discard the comment and to go back to the previous 
value.

Button Use description
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• The Image tab contains the key frame for the video sequence. The key frame serves as preview 
of the video sequence. It is from this pane that you can associate a video key frame and link it 
to the video segment.

NOTE: Video recordings can be streamed from the left-hand pane (Play button) or from the 
Camera tab. You can also view camera recordings from the Message desktop. To do so, you 
have to select a video recording event (identified by a camera icon in the Message desktop), 
right-click it and select View video segment from the shortcut menu.

To play video segments:
1 From the Video event list, select an event, then click the Play button. The video clip appears in 

the Video Playback window. 
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2 You may select the Camera tab to view information about the camera that captured the 
selected event. To do this, select the Camera tab in the right hand pane. The system displays: 

• Start/End dates and time when the recording event occurred.
• Recording time (mm:ss): duration of the video segment. This duration is specified when 

defining recording parameters (Video menu > Recording parameters).
• Video trigger, if any: the video trigger is defined in the Video trigger menu and then 

selected in the Recording parameters definition.

NOTE: The status indicator next to the video server name indicates the current connection 
status of the server.

3 You can:
• Click the Play button to view this video segment of the selected camera for the duration of 

the recording. The video appears also in the Video desktop (Desktop menu)
• Click the Export button to export it for future use. For details, see “Exporting Video Files” 

on page 162.

Linking Video Clips with Key Frames
EntraPass users have the ability to save a still image that best represents a video sequence linking 
this image to the whole video recording. This may be useful for example if one event was 
registered by more than one camera and you want to associate the recording with a more explicit 
image. Viewing the video event will enable users to identify the best image for this video event, to 
snap it, paste it and save it as the best sequence for the video clip.
It is also possible to retrieve a previously saved image and to link it to a video segment, or to paste 
a previously snapped image.
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To associate a video event with a key frame:
1 From the video event list, select an event, then click the Image tab (right pane).

2 From the image window, you can:
• Import image: click the Import button to retrieve a previously saved or exported image 

from a file. 
• Paste image: click this button to paste a previously snapped image. The Paste image 

button is enabled only when you have snapped (copied) an image while viewing it. You 
can first play a video clip, snap it and then paste it.

• Clear: click the clear button to delete the displayed image from view.

Exporting Video Files
EntraPass exports video segments in four formats: KVI and KVA. 
• KVI (Kantech Video Intellex format). Video data are stored in Intellex format (.img). A 

simple double-click allows you to view the file using VideoPlayerIntellex.exe. 
• KVA (Kantech Video AVI format). Video data are stored in AVI format (.avi). A double click 

opens the video file using VideoPlayerWindow.exe. 
• AVI format
• IMG format
EntraPass users have two options when exporting videos:
• From the Video event list (without previewing the video)
• From the video playback window: in this case, the video is previewed before it is exported.
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To export a video segment:
1 From the video event list, select the video event you want to export.

2 Click the Export button. The Enter a video filename window opens. 
3 Enter a file name in the File name field. By default, the file is assigned the Kantech KVI 

format.The file will be saved among EntraPass program files:\Kantech\Server-GE or Server 
CE\Video. Later you can call this file simply by double-clicking it.    

NOTE: Video files can be viewed in the View exported videos window (Video tab > View 
Exported video). The video file is displayed with its name, date and time. Key frames (if any) 
associated with a video clip can also be previewed in this window. 

4 Click Save to close the Enter filename window. When you do this, the Description and 
password window appear. 

Adding Password to Exported Videos
You can protect exported videos using a password. Users must enter this password to view 
exported videos.

NOTE:  The password protection is applicable to KVI and KVA video formats only.
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To protect a video with a password:
1 Select the video you want to export, then click the Export button. 

2 Enter a description for the video segment, in the Enter Video filename window, then click 
Save. The Description and password window appears.
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3 Check the Use password box if you want to add more security to this video segment. Users 
will have to enter this password in order to view the saved video segment.

4 Enter a password and confirm the password in the displayed field.   
5 Click OK to close the Description and password window. Click OK to close the system 

message confirming the export. 
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Video Playback
The Video Playback feature offers the ability to view recorded video one camera at a time. To do 
so, you have to specify the period of time for the playback. A maximum of one hour is allowed. To 
do so: 
• Select a camera in the left-hand pane
• Drag and drop it into the View playback area. 

To view a video playback:
1 From the Video playback window, specify the Start date and time and End date and time for 

the video you want to view. The maximum allowed is 1 hour. Therefore you may stream video 
events that occurred on the same date and for a maximum of one hour.

2 From the left-hand pane, select a camera then drop it into the right pane. It plays for the time 
specified in the start and end time. Use the controls in the lower part of the Playback window 
(right pane) to play, fast forward, rewind or stop the video playback.

NOTE: If the requested video is not available, a message appears in the lower part of the 
window; the Snap and Export buttons remain disabled. If a video is available, the message 
Requesting video is displayed.

• Snap: copy the displayed image and save it in the \tmp\image folder and use it as a still 
image representing the video sequence. Later, the snapped image will automatically 
appear in the View exported video when browsing the exported videos. It is recommended 
to add a comment to the snapped image; the comment will appears next to the image.

• Export: export the video clip for future usage
• Tag to archive: mark the video sequence so that it is queued for archive.

NOTE: You can drag the slider at the bottom of the right-hand pane to increase or decrease 
the speed of the video clip your are playing. 
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3 To save a specific video image, click the Snap button. 

4 Accept the default name or enter a specific name for the video recording. The video recording 
is saved in: Program files\Kantech\Server_GE\Tmp\Image. The video image can then be 
viewed using a Windows image viewer such as Paint. Simply, double-click the video image to 
view it.
1675 • Video Playback Adding Password to Exported Videos



Reference Manual
Current Recording
The Current recording feature allows users to view the list of all on-going recordings. The 
information displayed depends on the source of the recording request:
• Started by a video trigger
• Started by an operator
• Started by an alarm on the video server

To view the current recordings:
1 From the Video toolbar, click the Current recording button. The current recording window 

appears, it shows all on-going recordings.

The following table shows the information displayed in the Current recording window depending 
on the source of the recording.  

Initiated by Information

Video server 
alarm

• Initiated by
• Event name 
• Start date and time

Video trigger • Initiated by
• Video trigger
• Recording parameter
• Event
• Start date and time
• Remaining time for the recording
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Operator • Initiated by
• Workstation
• Operator name
• Start date and time
• Remaining time for the recording

Initiated by Information
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Using the Video Desktop
The Video Desktop allows operators to monitor Video using an EntraPass desktop.
For details about configuring the Video desktop, see “Video Desktop” on page 370.

To display a video view:
1 From the EntraPass main window, select the Desktop tab, then select the desktop dedicated to 

Video. The Video View window appears in the desktop. 

NOTE: When you open the Video desktop, it is empty, it only displays “No video view 
selected”. You must scroll down to the bottom of the window and then select a video view from 
the Select a video view list. 

2 Select a Video view from the Select video view drop-down list (bottom of the window). You 
can edit the view (Video view > select a specific View > Modify Video view components button).

3 Click a button to resize the displayed images. Buttons in the lower part of the window allow 
you to perform various tasks:

Buttons Description

Use these buttons to select a size for the displayed video.
Note: A bigger image requires more process power. Therefore, selecting a bigger 
image may result in lower process power.
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4 Click the Show view selector button to display the View selector window. This small window 
allows you to so select a specific view or to monitor a specific camera pattern. For instance, if 
you select a cell in the View selector, the sequence is interrupted to display the selected cell. 

NOTE: When you open the Video view selector while a camera is recording, the camera icon 
will blink until the end of the recording.

5 From the displayed view, you can click a dome camera icon to display control buttons for 
this camera (movement, zoom, focus). Available options depend on the Digital Video 
Management system connected to your system. Please refer to your DVMS documentation for 
additional information. 

NOTE: If your dome camera is set with pre programmed movement patterns, you can define a 
view displaying a pattern composed of one or many of these pattern. For more details, see 
“Defining Video Views” on page 143. 

These buttons are configured in the Operator security level. They enable opera-
tors to perform pre programmed tasks such as viewing video playback with a 
fixed or variable delay, generating video events with fixed or custom parameters. 
For details on programing this buttons, see “Security Level Definition” on 
page 306.

Use these buttons to create and edit video views.

Use this Show view selector button to display a mosaic view of all the camera 
defined in the system. 

Help and Close buttons. These are EntraPass standard buttons.

Buttons Description
1715 • Using the Video Desktop Adding Password to Exported Videos



Reference Manual
Viewing Exported Video
EntraPass enables users to view all exported videos. This feature makes it possible to browse the 
list of all exported videos and to preview a key frame of the exported videos sequence for all KVI 
and KVA formats. 
Moreover, users can preview the exported video segment before viewing it. 

To view exported videos:
1 From the Video toolbar, select the View exported video icon. The Video folder opens 

automatically, with the list of all exported video sequences that have been exported.

2 Select a video sequence. The video thumbnail appears in the lowerleft part of the window. The 
directory contains the Date and Time the video was taken, the video file format (Type) and the 
File Name.  You can then click the Preview button for details about the exported video. When 
you preview the video sequence, the system displays information about the camera as well as 
the software version (Image tab, About button). 
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Browsing the EntraPass Video Vault
EntraPass Video Vault offers an easy way for preserving important video data for future reference. 
In fact, video recordings have a limited life span depending on the video server settings and 
capability. Moreover, since video recordings require a great amount of disk space, using an 
archive management tool such as EntraPass Video Vault enables organizations to better manage 
and easily retrieve video contents. 
The archiving activity is monitored from the EntraPass Video Vault user interface. The Browse 
EntraPass Video Vault interface offers a Windows-like navigation pane that enables operators 
(with appropriate permission) to play video segments archived on EntraPass Video Vault.

To view a video segments archived on EntraPass Video Vault:
1 From the Video main window, select the Browse Video Vault button.

2 To view a specific segment, select a video segment, then click the Play from Video Vault 
button.
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Chapter 6 • Definition
Use the Definition toolbar to define the system logical components such as:
• Schedules
• Floors
• Graphics
• Holidays
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Defining Schedules
A schedule indicates when the system will execute certain operations such as automatically 
unlocking doors, permitting access to employees, running automatic reports, monitoring inputs, 
etc. It also determines when events are to be acknowledged or when to activate relays controlling 
different functions (lighting, heat, etc.).
You can use the same schedule in different menus, but it is recommended to create a different 
schedule for each application, because it is much easier to modify a particular schedule without 
affecting other applications.
Each schedule is composed of four intervals. Each interval has a starting and ending time. Each of 
these intervals can be individually selected for the seven days of the week, and for holidays.
Two groups of schedules are available:
• System schedules: System schedules for global functions such as event parameters, operators 

login schedules and video triggers. These are not loaded in controllers.
• Corporate site schedules: These are defined per site. You can define 100 schedules per 

corporate site for such purposes as: power supervision (controllers), unlock schedule (doors), 
Rex schedule (doors), activation mode (relay), monitoring schedule (input). 

You can program 100 schedules per site and an unlimited number of system schedule. This feature 
must be enabled in the Server parameters menu (Option > Server parameters).

Assigning/Defining Schedules
If you are assigning or defining schedules, make sure that you are selecting the proper category for 
this schedule. For example, if you are assigning or defining a system schedule (for workstation, 
operators, event parameters, video triggers) this schedule will be available for selecting 
components of this category. If you are selecting a schedule for physical components such as 
controllers, doors, inputs, their schedules will be grouped by site If you have defined two sites in 
your system, there will be two separate groups of schedules for each site. You can define up to 100 
schedules for each site.   
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To define a schedule:
1 From the EntraPass main window, click the Definition tab. Then click the Schedules icon from 

the Definition toolbar.

NOTE: If you have checked the Upgrade to advanced schedule capability option (Server parameter 
> Server tab), the Gateway/Site drop-down list appears for selection. From the Gateway/site 
drop-down list, select a Site or System schedule (applicable to system components such as 
event parameters, video triggers, operator login).

2 From the Schedule drop down list, select the schedule you want to modify or select the 
schedule applicable to the category selected in previous step, or click the New icon to create a 
new one. 

3 Assign a name (or modify an existing one) to the schedule. It is recommended to choose a 
meaningful name. 

4 You can click the Holiday icon in the toolbar to view the list of holiday that are defined in the 
system. 

NOTE:  EntraPass supports four types of holidays. 

5 Specify the Start time: this is the scheduled time when the interval becomes valid. It will 
become invalid when the end time has been reached.

6 Specify the End time: this is the scheduled time when the interval is no longer valid. 

NOTE: Start and end times are in 24-hour time format; this gives a range from 00:00 to 24:00. 
For any interval, the end time must be greater than the start time. 

7 Check the Days during which this schedule interval will be valid. To do this, click in the 
check box below each day.

NOTE:  EntraPass supports four types of holidays. 

8 Check the Holiday column checkbox if you have defined four holidays in the Holiday 
definition menu and you want this interval to be valid during a holiday. 
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Creating a 2-day Continuous Interval
To create an interval from Monday 20:00 (8:00 PM) to Tuesday 08:00 AM, the schedule must be 
divided into two intervals:
1 First define an interval for Monday from 20:00 to 24:00;

2 Define a second interval for Tuesday from 00:00 to 08:00. The system considers these two 
intervals as one continuous interval.
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Defining Floors
The Floors definition menu is used to create or edit elevator floors. Once the floors are created, 
they are grouped and associated with a schedule that will define when access is permitted.

To define floors:
1 In the Definition main window, click the Floor icon.

2 In the Site drop-down list, select the gateway/site for which you are defining floors. This 
allows you to minimize the list of components defined in the system. 

3 Select a floor or click the New icon to create a new floor group. 
4 Assign a meaningful name to the floor, then click the Close button. The system prompts you to 

save.
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Defining Graphics 
A graphic corresponds to the secured area of the system where components (EntraPass 
applications, controllers, inputs, relays, etc.) are located on a site. 
With graphics, operators can easily view the exact location of a component installed on a site, or 
the status of components and devices such as doors, contacts, motion detectors, controllers, 
assigned to the graphic. Operators can perform manual operations directly from the displayed 
component (for example lock/unlock a door).
You can create as many graphics as you need. Each graphic can display up to 250 
componentsincluding using live video as a background. You may also import graphics or maps 
from other programs in the following formats (BMP, EMF, WMF, JPEG, GIF, PCX, PNG, TIF or 
PCD. 

NOTE: Entrapass offers users four sample floor plans. You can customize them to suit your 
system needs. To view these sample floor plans: C:\Program Files\Kantech\Server-
CE\Generaldata\Demobmp folder. 

To create a background image:
1 In the Definition window, select the Graphics icon.

2 From the Graphic drop-down list, select the graphic you want to modify, or click the New icon 
to create a new one.

3 Assign a name to the graphic (or modify the existing name).

NOTE: When you select a graphic, or when you create a new graphic, all the components that 
are assigned in your graphic are displayed in the left-hand pane. The right-hand part of the 
window display the selected graphic. 
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4 From the Graphic Definition window, click the  
button to bring up the Assign Components window.

NOTE: If the Video feature is enabled in your system, video components are added to the 
Graphics menu. These video components can be accessed from the graphic layout. The icon 
can be positioned on a graphic layout and its status can be retrieved by clicking on the video 
icon. In addition to standard option, the following Status option will be available for the video 
component: Video Server Online / Offline, Video Server Parameters (Related to a specific 
vendor) and Camera status.

5 Click on Options to display pull down menu of drawing options.

NOTE: The Draw transparently option allows you to place a transparent icon on top of a 
background picture for a blended effect.
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6 Double-click anywhere in the background to bring up the Design background picture window.

7 Use this window to import a graphic that was created with another application or create your 
own background using the drawing tool bar buttons. 
• To import an existing graphic, click the diskette icon, then drag and drop the diskette in 

the work area. The system displays the Open window. Make your selection and click Open 
to import your graphic.

• To create a background, select a form, drag and drop it to insert either a rectangle, a 
circle, a ellipse, etc. in your background. You can modify the background color only when 
the form selected is a rectangle. You can also insert a custom image in the background 
image. 

• To import a custom static icon into the background graphic you may call up images from 
the Custom image button . The Select image window appears.

8 Select an image, then click OK to close the window and import the image in your design.
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To add annotations and other features to the background image:
1 From the toolbar select an annotation, for example the pointer, click and drag where you want 

it to be.
2 Right-click on the arrow in the toolbar. From the displayed options, you can modify the 

properties (such as line width, color) and you can also specify if the arrow should be sent to 
the back or the front of the other annotations in your graphic.

3 When you are finished, click on Image from the File menu, save annotations. Annotations will 
be saved in a separate file. 

4 Click Clear (following your save) to clear the annotations. If you save the graphic with the 
annotations, the annotations are permanent.

5 Select the Load annotations option to retrieve annotations that were previously saved to disk. 
When you add annotations to a graphic, you have the option of saving the annotations on a 
separate file in order to enter them later. 

6 Select the Save annotations option to save annotations on a separate file from your graphic in 
order to retrieve them for later use. 

7 Use the View menu to define how the graphic will be displayed.
8 Use the Options menu to position and size the graphic in the Design background window

To add components to the background graphic: 
1 From the Design window toolbar, click and drag the selected component to desired position. 

To drag an object across a window, select the object with your mouse and drag, while keeping 
the button pressed down, to the desired location in the graphic.

2 Once you have positioned the component, you have to assign it to a component of your 
system:   Right-click the component and select Assign from the contextual menu:
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3 The system will display a component window, select the component that corresponds to the 
image, then click OK to go back to the previous window. 

NOTE:  If you do not assign the icon to a component, the icon will not be saved in the graphic. 
Only components that were not selected in the graphic will be available for selection. 

4 Select the Options menu to define the graphic:
• Select Show hints for the system to provide the component’s name (component's address 

and name) when you point over that graphic. To show the hints, right-click on the 
component, select the Show hint option (a check mark will be displayed).

• Select Draw frame to draw a frame around the component.
• Select Frame color to change the color of the frame for the assigned components.
• Select Edit background picture to edit the background of the selected graphic. From this 

window you can modify the graphic's frame and background color and add annotations.
• Select Clear background picture for the to clear the background picture of the graphic only 

leaving the assigned components. You can use this option when you want to insert a new 
graphic and leave the same components.

5 Right click on an assigned component to select or unselect it.

NOTE: When an object is selected, sizing handles (square handles that are displayed along 
the sides of the object that surrounds the selected object) indicate the object is selected. 
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Defining Holidays
A holiday is treated differently than other days. It is recommended to program holidays at the 
beginning of the year; this helps to modify floating holidays for the current year (Easter, 
Thanksgiving Day, etc.). 

To define a holiday for a Gateway:
A holiday may also be identified by a specific type (Hol 1,2,3,4). The same day may be defined as 
a holiday at one site, but as a regular day in another site. 

To define a holiday:
1 From the Definition window, select the Holiday icon. The Holiday window appears.

2 To create a new holiday, select the New icon. 
3 To create a global holiday, proceed with the holiday definition. If you want to define a holiday 

for a specific gateway/site, select the gateway/site from the drop-down list. 
4 Assign a name to the holiday.
5 From the Date pull-down menu, select a the holiday date from the calender.
6 Check the Recurring option if this is the case for the holiday you are defining.

NOTE: If the holiday is not a recurring holiday, you will have to reprogram it for the following 
year. You can program holidays years in advance; but it is recommended to review holidays 
on a yearly basis.

7 In the Holiday type section, select the type of the holiday you are defining. This gives you 
flexibility when defining a holiday. For example, you may decide that a given day is a holiday 
for a certain group of users, but it is a regular day for another group.
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Chapter 7 • Operations
The Operations toolbar allows operators to perform manual operations on various system 
components. Manual operations are used to override schedules or process special requests when 
necessary. 
When a manual operation is launched, it is possible to view in real-time, the status of the selected 
components. The following icons appear in most manual operation windows. Other icons also 
appear depending on the component that is displayed:
• The Enable Graphic button: When selected, this button displays the image related to the 

selected component (i.e.: door) and will also display the associated components (i.e.: reader). 
To display in real-time, this button must be used with the Enable animation button.

• The Enable Animation button: When selected, this button automatically enables the Enable 
graphic button at the same time. This will activate the current component (i.e.: door) and will 
display its status in real-time.

• The Select All button: This button is used to select all the items or components displayed in a 
list of choices. 

• The Unselect All button: This button is used to unselect all the items or components that were 
previously selected in a list of choices.
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Manual Operations on the Gateway
The Reload data command allows operators to refresh system parameters with new data from the 
system database. After a reload operation, the gateway reorganizes the data received and 
communicates the new data to all the sites and controllers. Communication with controllers will be 
suspended during a reload operation.
When to reload the gateway?
• After major changes in the system database such as new cards, new devices, modification of 

component definition, definition of new schedules;
• When one or more controller(s) is malfunctioning (when it does not receive data for instance).

To reload a gateway:
1 From the EntraPass workstation main window, select the Operations tab and click the Reload 

data to open the following Reload data window.

2 Select the desired gateway to reload. You may select the Enable graphic icon or the Enable 
animation icon in order to view real-time system animation on the gateway.

3 Click the Reload gateway icon to refresh data in the gateway.
4 You may select the Help icon to view more information about the gateway.
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Manual Operations on Sites
The manual operations on site feature is used to poll unassigned controllers. For example, when a 
controller has been added in the system without a serial number, you can use this command to get 
the controller serial number. 

To perform manual operation on a site:
1 From the Operation window, click on the Site icon to open the Manual operation on a site 

window, then select the gateway to which the site is connected. 

2 To poll a controller that is not assigned, click the Controller icon. A message is sent to an 
unassigned controller, asking it to identify itself. When the controller receives the call from 
the site, it sends an acknowledgement message in the Message desktop. 

3 You may select the Message desktop to view the controller serial number. 

NOTE: The% column shows the communication performance of a selected site. If the 
percentage is too low (below 75% for instance), it may indicate that the site is not 
communicating efficiently. Communication problems may stem from various reasons such as 
interferences, damaged cables, etc. 
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Communication options that are available from the toolbar:
 

Tool Description

Connect to remote site: Click to connect to a remote site using a 
pre-configured dial-up connection.

Disconnect remote site: Click to close the connection between this 
EntraPass workstation and the remote site.

Disable remaining time: Click to stay connected until clicked again. 
This action disables preset connection remaining time. This action 
bypasses any idle time.

Update remote site: After selecting site, click to connect and update 
parameters.

Update all remote sites: Click to connect and update parameters on 
all sites starting with the first site on the list.

Remove site from connect and wait list: Select a site then click to 
suspend connection after all sites had been set for update.
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Manual Operations on Controllers
This menu is used to reset or reload a controller: 
• A soft reset will not affect the controller database. This command sends new information to a 

controller to update its physical components (relays, inputs, doors and outputs);
• A hard reset will erase the existing controller database and reload it with new information in 

the controller database;
• A reload will reload the controller database; if for example a controller database is not 

reloaded correctly due to an erratic operation;
• A reload controller firmware will reload the firmware of the controller (KT-100 and KT-300). 
From the controller reset window, you may perform operations on the reader. For example, you 
may: 
• Unlock the reader keypad (KT-100 and KT-300);
• Reset the power on the reader (KT-300);
• Rest the number of cards in the area, display the list of Cards in/Cards out (KT-100, KT-200 

and KT-300). 

NOTE:  Reset commands should be executed with caution. Before you carry out a controller 
reset operation, we recommend you contact our Technical Support. For more information, see 
“Technical Support” on page 4. 

To reset a controller:
1 From the Operations window, select the Controller reset icon.

2 From the Site list (left-hand pane), select the Site on which the controller is located.

NOTE: If only one Site or Gateway is defined in the system, the Site or Gateway list window 
will not appear on the Controller window.
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3 From the Controller list displayed in the top right-hand, select the controller on which the 
operations will take place. It has to be highlighted. To perform the operation on a group of 
controllers, select All controllers (lower right-hand). 

4 Select the appropriate operation: soft reset to refresh the controller; hard reset, to re-initialize 
the controller, reload controller and reload controller firmware. 

NOTE: A hint is displayed when the cursor moves over a button. It gives details about the 
operation to be performed.

5 To perform a manual operation on a reader:
• Select the Unlock keypad button if you want to unlock the keypad;
• Select the Reset reader power if there is a problem with readers (KT-300 only).

6 Select Forgive if you want to reset the Cards in and Cards out counters. When you select the 
Forgive option, card holders will not be considered inside or outside until the next use of their 
card at an entry or exit reader.

7 You may want to know how many cards are in or out. To do this, use the Cards in and Cards 
out button. The passback option has to be enabled on the reader and the door has to be defined 
as an entry or exit door.

NOTE: The Card in/Cards out operations are performed only on a door defined as an entry or 
exit door. If you have one or more controllers configured with anti-passback, this function 
allows you, for example, to view a list of cards that are considered inside or outside the area. 
The passback option has to be enabled; that is, it has to be either soft or hard synchronization. 
This operation is performed only on one controller at a time as it may be a lengthy operation. 
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Manual Operations on Doors
This menu allows an authorized operator to manually modify the state of a door or group of doors. 
Operators can manually:
• Lock/unlock a door (icons with a red/green flag),
• Temporarily look/unlock a door or group of doors (icons with an hourglass image), 
• Enable or disable readers of selected doors (reader icons are red or green flag).
There are various reasons why you would want to perform one of these operations; for example 
you may need to “disable a reader” for a short period in order to deny access to the door, etc.
This operation allows an operator to lock a door that was previously unlocked by an operator or a 
schedule. When a door is manually locked through the Operation menu, it remains locked until:
• The presentation of a valid card (will re-lock after access), or
• The next valid change of the automatic unlocking schedule (for a door defined with an 

unlocking schedule), or
• An operator manually unlocks the door.

To lock a door manually:
1 From the Operations window, select the Door icon. The Door window appears.

2 The left-hand pane displays the site or gateway lists. You may select All sites/gateways or 
select a specific site or gateway. The doors are listed in the top right-hand. 

NOTE: If only one site or gateway is defined in the system, the site or gateway list window will 
not appear on the Controller window.

3  Select desired door(s) from top right-hand or All doors from bottom right-hand. 
4 Click the Lock-door icon in the toolbar.
5 Click the Enable animation icon to view a real-time display of the door status.
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To unlock a door manually:
1 From the Operations window, select the Door icon.

2 The left-hand pane displays the site or gateway lists. You may select All or select one site or 
gateway. The doors associated with the selected site or gateway are displayed in the right hand 
pane. 

3 Select a door in the upper part of the right-hand. You may also select All doors (bottom of 
window).

4 Click the Unlock-door icon in the tool bar. The selected door will be manually unlocked. The 
system will prompt for operator confirmation. A door defined with an automatic unlocking 
schedule, it will remain unlocked until:
• The next valid change of the unlocking schedule, or
• An operator manually locks the door.

To unlock a door temporarily:
1 From the Operations window, select the Door icon.
2 The left-hand pane displays the site or gateway lists. You may select All or select one site or 

gateway. The doors appear in the right hand pane. 
3 Select door in the upper part of the right-hand. You may also select a door group under the All 

doors (bottom of window).
4 Click the Temporarily unlock icon. The selected door will be temporarily unlocked by an 

operator. The system will prompt the operator to enter the delay, when this delay expires, the 
door will re-lock automatically. Use this option to grant access to a user who does not have a 
card or has forgotten his/her card. Maximum unlock time: 4”:15 (255 seconds).

NOTE: If a door contact is installed, the door will re-lock as soon the system sees a “door 
open-door closed” transition. There is no “Animation” for this type of operation.
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To enable a reader:
1 From the Operations window, select the Reader icon.

2 The left-hand pane displays the site or gateway lists. You may select All or select a specific 
site or gateway. The Doors appear in the right-hand. 

3 Select a door in the upper part of the right-hand. You may also select a reader group under the 
“All readers” (bottom of window).

4 Click the Reader-enable button. This option enables a previously disabled reader. 

To disable a reader:
1 From the Operations window, select the Reader-disabled icon.

2 The left-hand pane displays the site or gateway lists. You may select All or select a specific 
site or gateway. The doors appear in the right hand pane. 

3 Select a reader in the upper part of the right-hand. You may also select a reader group under 
the All doors (bottom of window).
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4 Click the Reader-disabled button. This option disables a previously enabled reader. Disabling 
a reader prohibits users from accessing the door, even if access rights have been granted. 
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Manual Operation on Elevator Doors
This menu allows you to manually lock, unlock or temporarily unlock elevator floors. The window 
will also display, in real-time, the status of the selected elevator door(s). 
How elevator access is authorized
• The cardholder pushes an “up/down” button, the elevator door opens, 
• The cardholder presents its card at the reader (usually inside the cab), 
• The system checks if the schedule assigned to this door is valid. If yes, the system checks 

which floor group is associated to this door, 
• Then the system verifies each floor of the floor group (in the floor group menu) and checks if 

the schedule associated to each floor of the group is valid or not valid. 
• Only floors that have a valid schedule will be available for selection by the user (the elevator 

panel will enable the buttons corresponding to the floors). 

NOTE: When a manual unlocking operation is complete, only floors that are defined with an “X” 
in the “state” field of the Floor Group Definition menu will be available for selection. Also, 
when communication is lost and the controllers are working in stand-alone mode, only the 
floors marked with an “X” will be available for selection and the access schedule will be 
ignored.

To lock floors:
1 From the Operations menu, select the Elevator door icon. 
2 Select an elevator door in the upper part of the right-hand. You may also select a door group 

under All doors (bottom of window). 
3 Click the Lock icon in the toolbar. This command will manually lock the floor group that was 

previously unlocked by an operator or a schedule (button with a red flag). 
4 Click the Unlock elevator floors icon in the toolbar to unlock a previously locked floor. This 

command will only enable the elevator floors that are defined with an “X” in the “State” 
column of the Floor group Definition menu. If you do this, the system will prompt the 
operator to select a floor group that should be unlocked (available). Once the group is 
selected, the system will prompt the operator to confirm the operation. 

NOTE: For a door defined with an “automatic unlocking schedule”, floors will remain available 
until:

• The next valid change of the unlocking schedule, or 
• An operator manually locks the door. 

NOTE: A door defined without an unlocking schedule will only be locked by a manual 
command. To lock all floors that were previously unlocked, use the Unlock option in the 
Manual operation on doors menu.

To unlock elevator floors temporarily: 
This command will only temporarily enable the elevator floors that are defined with an “X” in the 
“State” column of the “Floor group Definition menu” (available for selection).
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The system will prompt the operator enter the delay (when this delay expires, the floors will no 
longer be available for selection), then the system will prompt the operator to select a floor group 
that should be unlocked temporarily (available). 
Maximum: 4m15s (255 seconds).

NOTE: There is no “Animation” for this type of operation. To temporarily unlock all floors, use 
the “temporarily unlock door” option in the “manual operation on doors” menu.
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Manual Operations on Relays
Use this menu to manually change the state of a relay or group of relays. You can activate/
deactivate and temporarily activate relays or group of relays manually. The window will also 
display, in real-time, the status of the selected relay(s). 
This feature allows to manually turn off a relay; for example, when an input programmed to 
activate a relay goes in alarm in unknown conditions.

To manually deactivate relays:
1 From the Operation window, select the Relay icon.

2 In the left-hand pane, you may select a site or gateway, or you may select All to display all the 
relays. 

3 In the right-hand, you may select a relay in the upper part of the window, or you may select All 
in the lower part of the window.

4 Click the Deactivate relay icon.The selected relay(s) will be manually deactivated. This 
operation allows an operator to deactivate a relay which was previously activated by an 
operator, event, schedule or input in alarm.

NOTE: If you manually de-active a relay that is usually activated according to a schedule, it will 
remain deactivated until its reactivation schedule becomes valid. This means that if a relay 
needs to be activated according to a schedule and you deactivate it, remember to reactivate it 
again for the remaining scheduled time, because one relay can be defined for various 
components of the system; its activation or deactivation will relate to its configuration within 
these components.
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To manually activate a relay: 
1 From the Operation window, select the Relay icon.

2 In the left-hand pane, you may select a site or gateway, or you may select All to display all the 
relays. 

3 In the right-hand, you may select a relay in the upper part of the window, or select All relays in 
the lower part of the window.

4 Click the Activate relay icon. The selected relay(s) will be activated. This operation allows an 
operator to activate a relay which was previously deactivated by an operator, event, schedule 
or input in alarm.

To activate a relay temporarily:
1 From the Operation window, select the Relay icon.
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2 In the left-hand pane, you may select a site or gateway, or you may select All Relays to display 
all the relays. 

3 In the right-hand pane, you may select a relay in the upper part of the window, All Relays in 
the lower part of the window.

4 Click the Activate relay temporarily icon to open Change delay on action window. 

5 Enter the desired delay time and click OK.

NOTE: The selected relay(s) will be temporarily activated. This is useful for an operator who 
would like to activate temporarily a relay which was previously deactivated by an operator, 
event, schedule or input in alarm. The system displays a message box requesting that a 
temporary activation delay, is entered. When this delay is over, the relay will be deactivated 
automatically.
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Manual Operations on Inputs
To perform manual operations on inputs:
1 From the Operation window, select the Input icon. The Input window appears.

2 To return an input to its normal state, select the input, then click the Input Normal state icon. 
The selected input returns to its normal state as defined in the Device menu. For example, if an 
input is assigned a monitoring schedule in its definition and an operator has reversed the state 
of the input making it “not supervised”, it can be returned to its normal state using this button.

3 To stop monitoring an input, select the input, then click the Input no supervision icon. The 
selected input is not supervised, regardless of its schedules (if defined). Only a manual 
operation can modify this condition. 

4 To shunt temporarily an input, select the input, then click the Temporarily shunt icon. The 
input will not be monitored temporarily. 
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Chapter 8 • Users
The Users menu allows you to easily manage the EntraPass cardholder database.
The Users toolbar icons start the following tasks:
• Define and issue cards as well as to perform card-related tasks (find, modify or delete existing 

cards),
• Design and print badges,
• Define and manage card access groups,
• Define access levels, 
• Define and issue visitor cards,
• Define card types, 
• Define and issue day passes,
• Modify groups of cards,
• Import or export CSV files. 
The Integrated Badging feature was added to EntraPass to allow users to design and print badges. 
Pictures and signatures can be imported or, with the necessary devices, captured and incorporated 
into cards for printing badges. 
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Defining Cards
Cards are defined by the following properties: card number, cardholder name, access level and 
status (valid, invalid, pending, lost/stolen). Cards records can be searched, sorted and deleted.  
The Users menu is used to:
• Create and issue new cards
• Modify or delete existing cards
• Define multiple cards (by creating a group of cards) 
• Assign access levels and pictures, etc. 

To issue a new card:
1 From the Users menu, select the Card icon. The displayed Card window is used to enter/verify 

general information on the cardholder.

2 Click the New icon (first icon) in the toolbar. The Card number field is enabled. 
3 Enter the number printed on the card (Card number field), then press Enter. If it is a new card, 

the Card user name field is initialized with “New user”. If the card already exists, the system 
displays information about the card. 

4 Enter the cardholder’s name in the Card user name field. You can enter up to 50 characters.
5 Check the Copy to visitor card checkbox. When this option is checked, card information fields 

are copied to the Visitor database (the card number is not copied). This feature enables you to 
archive profiles that are retrieved should you issue a temporary card.

6 Click on the Card type box to access the Card type menu. Select the card type for the new card. 
The card type is used to group cardholders; it is useful for modifying an existing card group 
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and creating reports, etc. For more information on how to create/modify card types, see 
“Defining Card Types” on page 264.

NOTE:  From the Card type window, you can right-click the Card type field and choose New to 
create a new card type, choose Select to pick an existing card type or you can choose Edit to 
edit an existing card type.

NOTE: The system automatically displays the Creation date, the Modification date and the 
Modification count information. 

7 Fill out the Information #1 to #10 fields. These are user definable fields. They are used to store 
additional information regarding the cardholder. For example, you could use Information #1 
to store the employee number; Information #2, department; Information #3, the address, etc. 
Later, card information fields are used to index reports, customize the cardholder lists, etc. 

NOTE: These information fields are editable labels. To rename an information field label, 
double-click it, then enter the appropriate name in the displayed fields. You can enter up to 50 
characters. 

8 Click the Save icon. 

Creating New Cards Using the “Save as” Feature
The Save as feature allows you to create a new card based on an existing card, only making 
changes to specific information. For example: changing only the user name and keeping all other 
card information. 

To create a new card using “Save as”:
1 Type required changes into specific fields in the Card window and click the Save as icon. This 

feature allows you to create a new card under a new card number. 

2 Enter the new card number in the New card number field. 
3 Select the Keep/Delete original card options to specify if the original card should be kept or 

deleted (usually kept), then click OK to save the new information. The Card window is 
displayed.

Issuing Cards Using the Batch Load Feature
The Batch Load feature allows operators to issue cards by presenting cards to a door reader. The 
card number is displayed on an “unknown card” or “access denied” event messages. During a 
Batch Load operation, the operator can create new cards or modify existing ones.
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To issue cards using the Batch Load feature:
1 From the Card window, click the Batch Load  button.

2 From the Door drop-down list, select the Door that will be used to read the cards.
3 Check the following options:

• Refresh an access granted: if this option is checked, each time an access is granted the 
information displayed will be refreshed with data relative to the card. 

• Save on new card: if this option is checked, new cards will be saved in the card database 
on an “unknown card” event message. If this box is not checked, the operator will have to 
save the card manually each time a card is read. 

NOTE:  

• The Find button allows operators to search for an existing card in order to create a new 
card based on the existing card data.

• If an operator clicks the Close button without saving (when the Save button is still 
enabled), a system prompt will ask to save the last information.
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4 Right click the Door drop-down list to expand your search.

Issuing Cards using a PIN 
EntraPass offers you the ability to create new cards by associating a PIN to a card. To do this, use 
the Find a PIN button in the Card window toolbar. 

To issue new cards using the Find a PIN button:

1 From the Card window, click the Find a PIN button . 
2 In the Enter your PIN field, enter the PIN for the new card. 
3 Take note of the PIN for future use. 
4 Click OK to close and go back to the Card window. The system displays the card number in 

the Card window 
5 Enter the information for the new card. 

Viewing and Verifying PINs
EntraPass enables you to view and verify cardholders’ PINs in the Card and Visitor windows.
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To view cards assigned the same PIN:

1 From the Card or Visitor window, click the List of PIN owners button .

2 Enter the PIN number in the Enter your PIN field.

NOTE: If the system is set to PIN duplication (Options > Server Parameters), and if the PIN is 
used by more than one cardholders, the system displays a list of cardholders who are using 
the PIN. This feature is useful when for example you want to display the list of cardholders 
who are using a given PIN or if you are issuing new cards and you want to verify which PINs 
are already being used.

Editing, Finding and Deleting Cards

Editing a card
To edit a card, do one of the following:
• Enter the card number in the Card number field and press Enter. The system displays the card; 

you may then modify the card as required.
• Browse the Card number field using the Up/down arrows and then select the card to be 

modified.
• Browse the Card user name field, using the Up/down arrows. 

Searching for a card
1 From the Card window, select the Binocular icon.
2 Enter a keyword to start the search (For example, the cardholder’s first name).
3 Check the Display match only option to restrict the search.
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4 Click the Find button to launch the search.
5 Click the Details button to display detailed information about the cardholder.
6 Click the Index button to change the search field. 

NOTE: The system searches for “user name” by default. This may be changed with the Index 
button to search with any of the user definable fields.

NOTE: If you are searching for a visitor card, click the  from the Card window.

Deleting a card
The Delete feature allows an operator to remove a card from the cardholder database. A card that 
has been deleted from the cardholder database must be re-issued again in order to use it again.

To delete a card:
1 Locate the card you want to delete: to locate the card, you may enter the card number in the 

Card number field and press the Enter key or you may browse the Card number or Card user 
name fields using the up/down arrows.

2 Click the Delete icon, then click Yes in the Warning message box.

NOTE: Although a deleted card is removed from the card database, it remains in the card 
history; all events involving that card remain in the event messages database. An event report 
locating past events that involved any deleted card can be performed.

Customizing Card Information Fields
You may rename Card information fields according to your organization requirements. These 
fields can contain any information. They can be used as edit boxes or drop-down lists. 

To customize card information fields:
1 In the Card definition menu, select any card, then double-click the Card information field. The 

system displays the Change labels window:

2 Select the field you want to modify and enter the name in the language section. For example, 
if you want to rename Card Information #1 to Employee number, double-click the Card 
Information #1 label; it appears in the language section, then enter the new name in the 
language section. 
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3 Select the Edit field option if the information appears as an Edit field (one-line information) or 
Drop-down list (as applicable); then click OK to save your modifications. 

4 You need to repeat these steps for all the fields you want to modify.

NOTE: Check Mandatory field to ensure a field is not left empty. 

NOTE: The changes you make are not immediately effective. They will take effect only when 
you exit and then re-enter the Card menu.

NOTE: An operator must have full access privileges to edit card information fields. An operator 
with read only access may only view information in these fields.

Assigning Access Levels 
An access level must be assigned to each card. Access levels determine where and when the card 
will be valid. The access level allows the cardholder entry to selected locations during specified 
schedules. 
For information on defining access levels, see “Defining Access Levels” on page 261. 

NOTE: When you modify the access level assigned to a card, you also modify the user’s 
access permission to the doors and schedules associated to that access level. 

In order to assign an access level to a card, you have to:
• Create schedules that will correspond to the time the user has access to the desired doors,
• Assign the created schedule to the desired doors (in the Access level definition menu),
• Assign the access level to cards.
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To assign an access level to a cardholder:
1 From the Card definition window, select the Access level tab. The Access level window 

appears, it displays the Site column and Access level drop down list.

2 Click the Card access group button (displayed on the left of the Site or Gateway list). It is 
used to copy information from a Card access group to a card. The Site column displays the 
sites and gateways to which an access level will be associated.

3 From the Access level drop-down list, select the access level that will determine the 
cardholder’s access to the doors of the selected site. If you do not want this cardholder to have 
access to the door of this site, leave this field to None.

NOTE:  You have to create Access levels (Users > Access Level) to have them displayed in the 
Access Level drop-down list.

Defining Card Use Options
Use the Miscellaneous tab to specify and view card additional information.

To define card use options:
1 Select a card number using the Up/down arrows. The Start date field indicates the card creation 

date. You can change this information by selecting another date in the displayed calender. The 
2118 • Defining Cards Defining Card Use Options



Reference Manual
start date must be the same day or earlier than the current date; else, the Card state field 
(Miscellaneous section) will be set to “Pending”.

2 Check the Use end date box if applicable. When this box is checked, the system displays a 
calender allowing you to select the end date. When the end date is reached, the Card state field 
is set to “Expired”.

NOTE: When creating a card with a limited access time of 24 hours of less, for example a Day 
Pass, the card will expire at midnight. This expiration may take up to one minute to register in 
the system.

3 Check the Delete when expired option (if applicable). This option can only be used with the 
Use end date option. When selected, the card information will automatically be deleted on the 
expiry date (using the end date specified), otherwise the Card state field will be modified to 
“Expired”.

NOTE: A deleted card is a card that is not active in the system database. Even if a card was 
deleted, previous events generated by this card are still stored in the archive file. 

4 Check the Wait for keypad option to force users to enter a PIN on keypad to access all doors, 
then in the Editable PIN field enter the PIN that users will be required to enter. 

NOTE: Selecting the Wait for keypad will delay access to a door for this card until the correct 
PIN has been entered on a keypad. This only affects doors defined with both reader and 
keypad in the Door Definition menu (Devices > Doors). The keypad schedule must also be 
valid for this door. For more information on defining a door, see “Configuring Doors” on 
page 107. 

5 From the Card state drop-down list, assign a state to the selected card. By default, a card is 
valid. The following states are available:
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• Valid: the card is functional,
• Invalid: the card is NOT functional, 
• Lost/Stolen: the card is NOT functional,
• Expired: the card has reached its expiry date,
• Pending: the card is not yet functional.

NOTE: You cannot force a card state to Pending by selecting this state from the Card state 
drop-down list. To do so, you have to change the Start date. 

6 Check the Card trace option if you want to monitor the use of a particular card. Selecting this 
option will cause the “Card traced” event to be generated each time this card is presented to a 
card reader. For example, you can request and generate a report containing the “card traced” 
event in order to verify user actions.

7 Check the Disable passback option if you want the card to override the passback option when 
defined.

NOTE: If your are issuing a card for a cardholder with disabilities, check the Extended door 
access delay option. To enable this option in the system, you have to define appropriate delays 
in the Door definition. This option is also available when defining visitor cards.

Adding Comments to a Card
To add comments to a card:
1 From the Card window, select the Comment tab.

2 Enter a comment (if necessary) relative to this cardholder. The displayed field can be used to 
store additional information in the database. Maximum allowed: up to 241 characters.

3 Click the Save button, then the Close button to exit.
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Limiting Card Usage
EntraPass offers the ability to set card use count options so that you may limit the number of times 
a card can be used. 

To set usage restriction:
1 From the Card window, select the Usage tab.

2 Check the Enable usage restriction option in order to enable the card use count feature.
3 From the Card count value scrolling list, set the maximum number you want this card to be 

used. You may enter the number in the field or use the Up/down arrows.

NOTE: Once you set the Card count value, the Card count options field is automatically 
incremented each time the cardholder uses the card. After a certain number of uses, you may 
check the Reset to zero field if you want the counter to be reset to zero when the maximum 
value is reached.

Assigning Pictures and Signatures 
EntraPass offers the ability to associate photos and signatures with cardholders and to associate 
badge templates with cards as well as to print badges. 
Photos and signatures can be retrieved from files, pasted from the clipboard, or captured using an 
appropriate device. To capture video images, use any MCI and TWAIN compliant device. For 
capturing signatures, signature pads such as Topaz, Penware TTI500 and Penware TT3100 are 
recommended. 
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Assigning Saved or Pasted Images
To assign a picture from a file:
1 From the Card window, select the Picture tab.

2 Right-click the picture area. A shortcut menu appears; choose the appropriate action:
• Get picture from file: this option allows you to select a previously saved picture.
• Paste picture: this option allows you to paste a picture from the clipboard. To use this 

option, you have to copy the picture, then paste it into the picture window. 

NOTE: The Video capture option is enabled only when a video capturing device is installed. 

3 From the Files of type drop-down list, select the file type you are looking for or leave this field 
to All to display all image files. Make sure that the Auto displayer option is selected to enable 
preview.

NOTE: Files with the following extensions are supported: BMP, EMF, WMF, JPG, GIF, PNG, 
PCD, and TIF.

4 Select the directory where the image is stored. Select the image you are looking for, then click 
Open to import it into the Card window. 

NOTE: To delete the imported picture, right-click the picture, then choose Clear picture from the 
shortcut menu. 
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Assigning a picture using a video camera
The Video capture option is enabled only when the option Enable video capture is checked: Options 
> Multimedia devices > Video tab. 

NOTE: Before you can capture images using a video camera, all equipment needs to be 
properly configured. For more information, consult your manufacturer’s device manual. If you 
have more than one video driver, you will need to specify the video driver to be used (Options 
> Multimedia devices > Video tab). 

To incorporate a photo into a card using a video camera:
1 Right-click the picture area. 
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2 From the shortcut menu, select Video capture. This option is enabled only when the Video 
capture capability has been enabled in the Options menu (Options > Multimedia devices > 
Video).

NOTE: Options may vary depending on the video capture program. If you have more than one 
video driver, you will need to specify the video driver you are using. For more information on 
configuring your video drivers, see “Setting up Multimedia Devices” on page 413.

3 Click the Freeze button when you are satisfied with the displayed image, then click the 
Capture button to paste and save the displayed image. 
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4 To associate a badge layout with the defined card, select one from the Badge layout list. For 
information on how to define a badge layout, see “Designing Badges” on page 227.

NOTE:  The Print badge and Preview badge buttons are enabled only when a badge printer and 
badge layout has been selected and the option Use badge printer checked: Options > 
Printer>Badge printer. If these buttons are enabled, you can preview and print the cardholder’s 
badge.

Importing a Signature from a File
You can import a signature, just as you import other images such as logos or pictures into the card.

To import a signature:
1 From the Card window, right-click the signature area. A shortcut menu appears.

2 From the shortcut menu, make the appropriate choice:
• Get signature from file: allows you to select a previously saved signature,
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• Paste signature: allows you to paste a signature that was previously copied to the 
clipboard. The option is enabled when there is content in the clipboard.

NOTE: The Signature pad option is enabled only when the appropriate device is enabled in the 
Options menu (Options > Multimedia devices > Signature).

3 Select the signature file, then click Open.

Adding a Signature from a Signature Capture Device
Use this option if a Signature Capture Device is installed and configured. The Signature pad 
option is enabled only when the appropriate device is enabled in the Options menu (Options > 
Multimedia devices > Signature).

To place a signature:
1 From the Card window, right-click the signature area. A shortcut menu appears.
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2 From the shortcut menu, select Signature pad. The Signature window appears, allowing you to 
preview the signature.

3 Click OK to paste the signature in the card window.

Working with Photos and Signatures
The EntraPass Integrated Badging feature allows users to extract part of an image or enhance 
images that are incorporated into cards. 

Extracting Part of an Image 
If you have incorporated a large image but you need only part of it, you can select and extract the 
part that you want to assign to the card (picture, signature). 
8 • Defining Cards Working with Photos and Signatures220



Reference Manual
To extract part of an image:
1 Right-click the image you have just imported.

NOTE: The Extract option is enabled after you have started the selection mode. Similarly, the 
Undo option is enabled only when an image has been pasted. 

2 Select Start selection mode from the shortcut menu. 

NOTE: You can increase the size of the selection rectangle by dragging its sides and corners 
to adjust to the part of the image you want to extract. You can also move it by dragging it to 
the desired area of the image.
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3 Once you have selected the part you want to incorporate into the card, right-click the image 
again. A shortcut menu appears.

NOTE: To disable the current selection, right-click the picture, then select Cancel selection 
mode. Select Undo to discard the changes. The Undo option is enabled only when you have 
pasted an image.

4 From the shortcut menu, select Extract.
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Editing a Picture/Signature
1 Right click the image you want to edit. 

NOTE: The Barcode area allows you to assign a barcode to a badge for identification purposes. Select 
any item from the drop-down list to be used as the value of the barcode. Select Custom to enable the 
Value field and type a specific barcode value. If you do not enter a custom barcode value, the Card 
number is used as the default value.

2 From the shortcut menu, select Edit (picture or signature).

p
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3 Adjust the features of the image using the displayed options. The Reset all option enables you 
to go back to the original image:
• Auto contrast: this feature gives better contrast by intensifying lights and shadows: it 

makes the darks darker and the lights lighter. In general, this auto contrast feature gives a 
good result when a simple contrast adjustment is needed to improve an image’s contrast.

• Sharpen: this feature provides more definition to blurry images by applying sharpening 
only when an edge is found.

• Brightness: this feature allows you to add light to the image by sliding towards the 
positive values.

• Reset all: this feature allows you to undo all the changes and to restore the original image.
4 Click OK to close the Picture editing window.
5 From the Badge layout pull-down menu, select a layout to associate with the card you have 

defined To define a badge layout, see “Designing Badges” on page 227.

Printing Badges
You may print badges and Visitor card and DayPass menus from the Card or from all Badge 
preview windows. The software is set up to let you print one single or double-sided badges.
Before you print, you have to select a badge printer. It may be any network printer, or a specific 
badge printer.

Selecting a Badge Printer
1 From the EntraPass Workstation window, select the Options tab, then click the Printer Option 

button.
2 From the Printer option window, select the Badge printer tab.

NOTE: You can print badges to any network printer. However, to print badges on appropriate 
cards, you have to select a badge printer.
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3 Check the Badge printer option to indicate to the system that a badge printer is selected. If the 
Badge printer option is checked, the Print badge and Preview badge are displayed in windows 
where you can print badges (Card, Visitor, and Daypass windows).

4 From the Select badge printer drop-down list, select the printer dedicated to badging.
5 Adjust the margins:

• Origin offset, X axis: indicates the left margin.
• Y axis indicates the upper margin.

Previewing and Printing Badges 
The Badge - Preview and Print window allows you to preview a badge layout with card information 
(if the badge layout is associated with a card) or with default values (if the template is not yet 
associated with a particular card). The program permits you to print single or double sided badges. 

To preview badges:

1 From the Card, Visitor and Daypass windows, click the Preview badge  button. 

NOTE: From the Badge design window, the preview option allows you to view a badge with 
default values since there is no card associated with it (Badge design > Layout > Preview).
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2 From the Badge - Preview and Printing window, choose a printing option:

• Print front side: only the front side (preview in the left-hand pane) is printed.
• Print back side: only the back side (preview in the right-hand pane) is printed. This button 

is enabled only when the badge is defined with two sides.
• Print both sides: the front and back side are printed. This button is enabled only when the 

badge is defined with two sides.

NOTE: Important! In Order to print badges with barcodes, your printer has to be properly set. 
You have to select the “black resin” option, otherwise, barcode readers may not detect the 
barcode. If you have problems with barcode printing or reading, refer to your printer 
manufacturer’s manual. 
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Designing Badges
EntraPass contains a badge layout editor which enables users to create, save, edit or delete badge 
templates that are later selected and associated with cards for badge printing. 
You can create and edit badge templates, add colored or graphic backgrounds, logos, text, 
barcodes, and place photo or signature holders. 

Creating a Badge Template
To create a badge layout:
1 From the Users menu, select the Badge icon. The Badge window appears.

NOTE: The Badge window contains all the tools available in other EntraPass windows: new, 
save, copy, delete, print, links, search (the Hierarchy button is disabled). However, it contains 
an additional button  which allows to modify the number of sides assigned to a badge 
layout.

2 Click the New icon in the toolbar. The Badge properties window appears. 
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To specify properties for a badge:
1 In the Badge properties window, indicate the number of sides for the badge, then select the 

desired size for the badge layout, then click OK. 

2 Indicate the number of sides for the badge, then select the desired size for the badge layout, 
then click OK. 

NOTE: Measures are expressed either in inches or millimeters (a hundredth of an inch or a 
tenth of a millimeter). To change the unit of measure, check the appropriate radio button in 
the Units section.
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3 Enter the name for the badge template in the language fields. You can enter up to 40 
characters. 

4 You may check Set as default card layout if you want this new design to be automatically used 
for all new badges.

NOTE: Only one default layout is available. When you select one layout and check the option 
Select as default card layout, the current default layout is replaced.

5 Click the Save icon to save the badge template.

Editing a Badge Layout
The Badge design utility allows users to edit the badge layout, to add background color or 
graphics, to modify the font, etc.

NOTE: Once a card layout is created, you cannot modify its size; you have to create a new 
layout. However, you can modify the number of sides by clicking on the Sides icon in the 
Badge window toolbar.
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Modifying the Number of Sides
To modify the number of sides:
1 From the badge window, select the badge you want to edit.

2 From the Badge window toolbar, click the  button.

3 Click the Save icon to save the new badge information.
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Modifying the background color
To modify the background color for your badge:
1 From the Badge window, select the badge you want to modify.
2 Click the Click here to modify the card layout button (located in the lower part of the window) 

to open the Badge design window.

NOTE: When you move the cursor over the Badge design objects, a hint explaining each 
object appears.
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3 To modify the template background color, right-click anywhere in the work area. The 
Properties shortcut menu appears.

4 Select Properties. The Background properties window appears.

5 Select the appropriate options for the template:
• No background (default setting)
• Use color as background: this option will allow you to apply a background color to all the 

designs.
• Use image as background. This option allows you to incorporate an image that will be 

displayed as a watermark in all the badges.
• Orientation: allows you to select a landscape (horizontal) or portrait (vertical) display.
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Adding Objects to a Badge Layout
By a simple click and drop feature, the Badging utility permits you to incorporate objects into the 
badge template:
• Card fields information,
• Barcodes,
• Text boxes,
• Current date,
• Previously saved images and logos (BMP, JPG, GIF, etc.),
• Border,
• Rectangle (including rounded rectangle, ellipse),
• Line, pointer,

NOTE: objects are incorporated with their default settings. To modify an object’s properties, 
right-click the object, then select appropriate settings from the shortcut menu.

Incorporating Card Information Fields
1 To add card information fields to the badge template, click the Card fields icon. The Card 

fields submenu appears.
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2 To modify an object property before you drop it, go to Options in the Badge design window, 
then choose Show properties on drop. If you do this, the Properties window will open every 
time you drop an item in the template work area.

NOTE: Icons may also be used to drag down information fields for barcode, text, date, pictures 
and border.

NOTE: To enable last and first name selection in the Card fields menu of the Badge design 
window, go to the Options menu, then choose Server parameters, select the User name format 
tab, check Parse user name checkbox, then select the name (first or last name) that will be 
used for sorting cardholders’ names. For more information see “EntraPass Options” on 
page 405.
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3 From the shortcut menu, select the card information field you want to add to the template 
layout, then click in the template work area to incorporate that field you have selected. 

NOTE: When you add a photo to a badge design template, the photo that appears is only a 
placeholder. It indicates where the cardholder’s photo will be displayed. When a badge is 
assigned to a card, the appropriate cardholder’s photo is displayed.

Aligning Objects in the Template Layout
As you “click and drop” design objects in the template work area, they will not be properly 
aligned. The badging tool lets you align these objects, using the Align command.

Template 
Work Area
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To align items in the template:
1  From the Badge design window, select the Align menu, then select Show gridlines.

NOTE: Grids assist you in aligning items in the badge layout template. It can be used as a 
visual aid to place items on gridlines. The Snap to grid option allows for more precise 
alignments of items. For example, when an item is moved close to a grid mark, it will be 
automatically aligned to the grid point. 

• Show gridlines: displays grid points to aid with object alignment.
• Align to grid: aligns all objects to the nearest grid point.
• Grid settings: allows you to specify the horizontal and vertical grid spacing (in pixels).
8 • Designing Badges Adding Objects to a Badge Layout236



Reference Manual
2 To adjust the space between the grid points, right-click the badge design work area to open the 
Grid settings window.

3 Using the Up/Down arrows, select the desired spacing in pixels for the width and height, then 
click OK.

NOTE: To disable the grid: Align > Show gridlines

Modifying Card Fields Properties 
Objects are incorporated in the template with their default settings (font, color, etc.). You can 
modify the settings later. For example, you can modify the appearance of any text object, such as 
card field, static text, date, etc.
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To modify an object (card field, static text, date, etc.):
1 From the Badge design template, right-click the object you have inserted (in this example, 

Card information fields).
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2 From the shortcut menu, select Card fields properties.

NOTE: The Properties menu item depends on the selected item. For example, it will change to 
Image properties or Current date properties, depending on the selected object.

3 From the Card fields properties window, you can modify all the text properties:
• Font (name, color, style (bold, italic, underline)),
• Background (transparent or solid with a color),
• Justification (horizontal, vertical),
• Orientation,
• Parameters (word wrap, for example).

NOTE: The Set as default checkbox allows you to apply all the characteristic to all text objects 
that will be incorporated in the template. 

NOTE: When Text Orientation is set to “Other” it is not possible to resize the field.

Modifying Picture Properties
This applies to any picture object such as photos, logos, and signatures.
2398 • Designing Badges Adding Objects to a Badge Layout



Reference Manual
To modify the properties of a picture:
1 From the Badge design work area, right-click the image (picture, logo) or signature that you 

want to modify.

2 From the shortcut menu, select Images properties. 

3 You may select another image from file or modify the image properties:
• Stretch ratio: select this option if you want the image to be centered in the image holder 

space, while keeping the proportion of the original image. 
• Transparent mode: if you choose this option, there is no background color,
• Draw frame: select this option if you want a frame around the picture object,
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• Frame color (enabled when a Frame option is selected): select this option if you want to 
apply a specific color to the image frame. The Frame color drop-down list enables you to 
select a custom color from the frame.

4 You may check the Set as default option if you want these properties to apply to all image 
objects you add in the badge template.

Adding Static Text Objects
To add text objects to a badge, first click and drop a text box, then enter the text in the Text 
properties window. It is also in the Text properties window that you modify the text appearance.

To add a static text box:
1 From the Badge design tool bar, click the text icon. To resize the text box, select it and use the 

two-headed arrow to drag the sizing handles to the desired position. This also allows you to 
change the height and width of the text box.

2 To align the text box, see “Aligning Objects in the Template Layout” on page 235.
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3 To add text to the text box, right-click the text box, then select Static text properties from the 
shortcut menu. 

4 Enter text in the Enter text field; then modify the text properties as desired. The Preview 
section shows the result of the changes you apply to the text.

Adding Bar Codes
The Badging feature allows users to add bar codes to badges. By default, the barcode value is the 
card number, if no other value is specified.
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To add bar codes:
1 From the Badge design window, click the Barcode icon, then click in the Badge design work 

area.

2 To align the barcode, see “Aligning Objects in the Template Layout” on page 235.
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To set up barcode properties:
1 From the Badge design window, right click the barcode to open the Barcode Properties 

window.

2 From the Properties window, you can define settings for the barcode that you want to 
incorporate in the Badge design.

NOTE: If it is necessary to set Barcode encoding option to Code 39-Modulo 43, set Field 
Checksum to true.

Adding The Current Date
You add the current date just as you add any other design item by selecting the item in the tool bar, 
then by clicking in the Badge design work area.

Supported Encoding Options:
Code 39 or Code 39-Modulo 43
POSTNET
Codabar
EAN 8 & EAN 13
UPC A
UPC E
Code 2 of 5
Interleaved 2 of 5
Code 128
8 • Designing Badges Adding Objects to a Badge Layout244



Reference Manual
To Add the Current Date:
1 From the Badge Design template, select the Current date icon, then click in the Badge design 

work area.
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2 Right-click the current date to display the shortcut menu.

3 To align the current date, see “Aligning Objects in the Template Layout” on page 235.
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4 Select Current date properties from the shortcut menu.

5 From the Current date properties window, you can:
• Select the date format (top of the window)
• Change the text properties: font, color, justification, orientation etc.

Adding An Image
Background images can be imported from any directory. Scanned images, photos taken with a 
digital camera and artwork created in any illustration design program can be incorporated into the 
badge design.
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To incorporate an image into the design:
1 From the Badge design window, select the Picture icon.

NOTE: The Badging feature supports most available image formats: BMP, JPG, EMF, WMF, 
GIF, PNG, PCD, and TIF.

2 Drop the Picture icon in the template work area. The Image properties window appears. 

3  Click the Select image from file button. The Open window appears, allowing you to select an 
image.
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4 Browse to the desired image, then click Open. The picture appears in the template area.

NOTE: When you import an image, you have to resize it to its original size as illustrated on the 
following image. 

5 Using the sizing handles, adjust the image to the desired size, then move it to the right-hand 
position; you can use the grid to align it properly. For more information, see “Aligning 
Objects in the Template Layout” on page 235.

Click the 
zoom 
button to 
increase the size 
of the image in 
the preview pane
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6 Right click the image to modify its properties. For details, see “Modifying Picture Properties” 
on page 239.

Placing Other Design Objects
The Badging feature lets you add borders, rectangles (regular, rounded, ellipse), lines and pointers, 
just as you add any other design object, by a click in the toolbar, then a drop in the design work 
area.

To add a border, a pointer or a line:
1 From the Badge design window, select the object you want to add (next to the Diskette icon), 

then click in the Badge design work area” The Border properties window opens.

2 To modify the border properties, select the border color, the border style, and the border 
width. You may check the Set as default option, then click OK to exit. 
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To place a rectangle:
1 From the Badge design window, select the rectangle tool (next to the Border tool), then click 

in the work area.

NOTE: This applies also to rectangles, rounded rectangles and ellipses.

2 From the Rectangle properties window, you may define the rectangle properties before 
importing it: 
• Line color,
• Line style,
• Background (brush style and brush color).
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Validating Card Access
The Validate card access feature lets you view access levels that are assigned to a particular 
cardholder. 

To validate user access:
1 From the Card window, select a card.

2 From the Card window toolbar, click the View and Validate Access button (the key icon in the 
toolbar).

3 From the Select specific value section, select the date, time and the door on which the 
validation is required. The system displays the access levels for the selected door as well as 
the schedules assigned to the displayed access levels. The Access Level column displays the 
access levels associated with the selected door. The Schedule column displays the schedule 
associated with the access level.
• Red—Indicates that access to the selected door on the selected date and time is not 

allowed (not authorized).
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• Green—Indicates that access to the selected door on the selected date and time is allowed 
(authorized). 
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Printing Cards
Use the Print feature to print a specific range of all the cards that are stored in the database. You 
can select various filters to customize the card list.
You can preview your list so that you can modify or verify the settings (fields) before printing.
You can also use the Font button to set a different font and font size for your report.

NOTE: Whatever your selections, the card user name and card number will always be 
displayed. By default, only fields containing information will be printed. If no fields are 
selected, only cards containing information will be printed. If you want to print empty fields, 
check the Print empty fields option. If you want to simply preview card reports there must be at 
least one printer installed on the computer.

To print cards:
1 From the Card window, click the Printer icon.

NOTE: By default, empty fields are not printed. To print empty fields, check the Print empty 
fields option. 

2 Select a sorting criteria from the Card Index drop-down list. These are card information fields.
3 If you are printing a specific range, check the Specific range option. Select the field that will 

be used to sort the card list. For example, if you select Card number, the cards in the list will 
8 • Printing Cards Adding Objects to a Badge Layout254



Reference Manual
be sorted according to the card numbers in ascending order. This field can also be used to 
target a specific range of cards when using the Lower/Upper boundaries fields.
• If you want to print a specific range, you have to specify a starting number in the Lower 

boundary field. It has to be used with the Upper boundary field. You must use the “card 
index field”.

• If you have decided to print a specific range and if you have entered a Lower boundary 
value, enter the last number or letter in the Upper boundary field. This field is used with 
the Lower boundary and the Card Index field. 

NOTE: Only cards that match ALL the selected filters will be printed. For example, if you 
specify six filters, all the six criteria must be met. Cards that do not match all the six criteria 
will not be included in the range.

4 Select the Filter option if you do not want the system to search through all the cards of the 
system. Filters will restrict the search and facilitate the production of the desired card list.
• Start date between—The system will include cards with a “Start date” field which is 

within the specified range (Miscellaneous tab).
• End date between—The system will include cards with a “Use end date” field which is 

within the specified range (Miscellaneous tab).
• Card state—Check the option and then select the desired state. The system will include 

cards that have this card state selected in the Card window (Miscellaneous tab).
• Card type—Check the option and then select the desired card type. The system will 

include cards that have this card type selected in the Card window.
• Select the Exist trace for the system to include cards that have the “Card Trace” option in 

their definition (Card window, Miscellaneous tab).
• Select the Exist comment option for the system to include cards that have information in 

the Comment field in their definition (Card window, Comment tab).
• Select Exist PIN—The system will include cards that have a PIN.
• Select Exist delete when expired—The system will include cards that have information in 

the Delete when expired field (Card window, Miscellaneous tab).
• Select Exist wait for keypad for the system to include cards that have information in the 

Wait for keypad field (Card window, Miscellaneous tab).
5 You may also check the Print selected fields to include specific data. If you select this field, no 

other fields below, the system will print the cards that match the filters you specified above 
with the card number and user name only. 
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6 Click the  button if you want to include cards associated to a 
door. 

7 Select the Based on time option if you want to select cards according to the time or select 
Based on schedule if you want to select cards according to a defined schedule.

NOTE: To extend the selection, right click within Select door for access filter window.

8 Check the appropriate field you want to print. The system will include the field content as it 
appears in the card definition.

9 You may save the list as a.QRP file (Quick Report) to view later using the Quick Viewer 
option. 
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10 You can also use the “Font” button to use a different font and font size for your list. The 
changes will appear automatically in the sample box. Use the Preview button from the print 
window to preview your report.
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Viewing Last Transactions
The View last transactions feature lets you view the most recent transactions for the selected 
cardholder. For example, the window will display “Access denied” as the type of event, and will 
display the date and time as well as the event message that was displayed in the Message desktop. 
The system displays the 15 most recent transactions for each category: 
• Access denied events (bad location, bad access level, bad card status, etc.),
• Access granted events,
• Database events (that have affected the database, such as: card definition modified, relay 

definition modified, etc.),
• Other/Miscellaneous events (these include events that were generated by cardholders),
• Time and Attendance events (entry, exit).

NOTE: To view more transactions for a specific category, see the “Card use report” option in 
the menu Historical Report definition menu.

To view the last transaction:
1 From the card definition window, select the View last transaction icon. 

• Type—Displays the event category. 
• Date and time—Displays the date and the time stamp of the event message.
• Event message—Displays the event message that was sent to the server (and to the 

authorized EntraPass workstation) when this event occurred. This is the same message as 
in the Message desktop (Desktop menu).

• Details—Displays additional details directly related to the type of transaction. For 
example, for a “card definition modified” event message, the Details column lists the 
EntraPass applications from which the card was modified as well as the operator name.
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• Refresh—This button can be used to refresh the window with new transactions as they 
happen. As cardholders generate events, new information is available.

• Parent—To view the parent component of a selected component. For more information, 
see “Basic Functions” on page 43.

• Print—Use this button to print an exact copy of the window. For more information, see 
“Basic Functions” on page 43.
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Defining Card Access Groups
Pre-programmed card access groups allow quick selection of access levels for various sites of the 
system. This card access group can be recalled during card programming instead of re-entering the 
access levels for each site.
It is only the card access group information that is associated with the card. Therefore, you can 
modify the card access group information without modifying the card access information. 

NOTE: When importing cards, the Card access group may be used to assign an access level to 
the cards.

To create Card access groups:
1 From the card definition window, click the access group icon.

2 To modify an existing card access group, select it from the Card access group drop-down list. 
To create a new group, click on the New button and enter the group name in the language 
section. The Site column displays the site associated with a card access group. 

3 From the Access level drop-down list, select the primary access level that will determine the 
access to the doors of the selected site.
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Defining Access Levels
Access levels determine where and when the card will be valid. Pre-programmed card access 
groups allow quick selection of access levels for various gateways. A total of 250 access levels can 
be programmed per site. 
In order to assign an access level to a card, you have to:
• Create schedules that will correspond to the time the user has access to the desired doors
• Assign the created schedule to the desired doors (in the Access level definition menu)
• Assign the access level to a card.

NOTE: The default access level is Always valid, all doors: cardholders assigned this default 
access level have access to all doors at any time. To restrict access to certain doors and at a 
certain time, you have to create a specific access level.

To define access levels:
1 From the Users menu, select the Access level icon. The Access level window appears.

NOTE: You can click the Hierarchy button (next to the Printer icon) to display the gateway list.
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2 From the Access level drop-down list, select New access level, then assign a meaningful name 
to the access level you are creating.

NOTE: Components that are displayed in the Doors, Schedule or Floor group column have to 
be defined for selection in the Access level definition. To define Doors: Devices > Sites > 
Doors. To define Schedules: Definition > Schedules. To define Floors groups: Groups > Doors.

3 From the Doors list, select the doors to which the cardholder has access.
4 From the Schedule column, select the schedule during which the cardholder will have access.
5 Select the floor group, if applicable.
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Defining Visitor Cards
A visitor card is issued on a temporary basis. It serves as a template for entering user information. 
You can create visitor cards in two ways:
• Copying the card information field into the Visitor card database when a new card or a 

daypass is created in the system,
• Creating a new visitor card.

To create a visitor card when creating a new card:
1 Select the Card icon from the Users window. The Card window appears.

2 Check the Copy to visitor card option. The card information will be used later for creating new 
cards and issuing day passes.

To create a visitor card using the card template:
1 Select the Visitor card icon from the Card window toolbar.

2 Enter the required information in the Visitor card fields.

NOTE: For more information on Day Passes and Visitor cards, see “Defining Cards” on 
page 204. The Picture tab allows you to display the cardholders picture and signature as well 
as to preview and print badges.
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Defining Card Types
A card type is used to group cardholders and can later be used to modify an existing card group or 
to create reports. It can also be used to restrict access to card information for a particular operator. 
For example, you can restrict an operator’s ability to issue or view a specific card group. For 
instance, if a card type is defined as “Administrators”, an operator who does not have the 
appropriate security level will not be able to issue, view, modify, delete, or print this type of card. 

NOTE: The system is preset with five card types: administrator, employee, security, 
maintenance and visitor. A card type can be assigned to a card access group. This way, if a 
cardholder is issued a card type associated with a card access group, the access information 
of the card access group will automatically be transferred to the cardholder. 

To create a new card type:
1 From the Users menu, click the Card type icon. The Card type window appears.
 

2 In the Card type window, click the New button in the toolbar and enter the necessary 
information in the language section. 

3 From the Card access group to assign list, select a card access group or create one. For details 
about card access groups, see “Defining Card Access Groups” on page 260.

4 To assign a card type to a cardholder, see “Users” on page 203.
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Defining Day Passes
A day pass is issued to visitors such as contractors, employees from different divisions, customers, 
etc. This menu option offers an easy way to allow access to “visitors” for a single day.
Even if the day pass cardholder does not return the day pass card, the card will expire the same day 
at 24:00, and will no longer grant access.
You can use profiles that were copied to the “Visitor definition” menu to create day passes (use 
the “find visitor” button). You can also use an existing day pass to create a new one.

To create a day pass:
1 From the Users menu, select the Day pass icon. The Day Pass window appears.

2 You can fill out the fields or browse the card databases to the desired card. For more 
information, see “Users” on page 203.

3 Check the Copy to visitor card option if you want to save this day pass in the visitor database. 

NOTE: For more information of visitor cards, see “Defining Cards” on page 204. The Picture 
tab allows you to display the cardholders picture and signature as well as to preview and print 
badges.
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Creating New Day Pass Using the “Save as” Feature
The Save as feature allows you to create a new day pass based on an existing one, only making 
changes to specific information and assiging it new card number.  You may, for example, change 
only the user name and keep all other card information. 

To create a Daypass using “Save as”:
1 From the Users menu, select the Day pass icon. The Day Pass window appears.

1 To locate an existing card, click the binoculars and select the card you want to duplicate.
2 Type required changes into specific fields and click the Save as icon. 
3 You will be prompted for a new card number.
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Batch Operations on Cards 
This menu is used to modify a specific card type group. For example, you could modify the “end 
date” of all the cards assigned the “administrator” card type. Individual fields will appear only 
when the appropriate check box is checked.

To perform operations on a group of cards:
1 From the Users menu, click the Batch operations icon.

2 Select a user group from the Card type drop-down list. All cards having this card type will be 
modified.

3 Select the appropriate option from the Operation with drop-down list. 
• No notification—The system will not notify nor request confirmation from the operator.
• Notification—The system will display a window displaying the process.
• Notification and confirmation—The system will display a window displaying the process 

and will prompt operators to confirm the operation for each cardholder having the 
selected card type.

4 Check the option you want to modify for the selected type. 
• Card state—If a card state is selected, the system will assign this new card state to all the 

cardholders of the selected card type.
• Card count value—If a card count value is selected, the system will assign this value to all 

the cardholders of the selected card type.
• Trace—If trace is selected, the system will trace all cardholders of the selected card type.
• Start date—If a start date is selected, the cards will be valid only from this start date. This 

new date will be assigned to all cardholders having the selected card type.
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• End date—If an end date is selected, the cards will be invalid after this end date. This new 
date will be assigned to all cardholders having the selected card type.

• Delete when expired—If selected, the cards will be deleted when the end date specified in 
the Card Definition menu is reached.

• Wait for keypad—If selected, all the cardholders of the specified card type will have to 
enter their PIN at the keypad after a valid card read, in order to permit access to the door 
(if keypads are defined).

• Card access group—If checked, four options are provided to modify card access groups.
• Replace card access group.
• Update card access group.
• Add new access level.
• Update add access level.

5 Click the Execute button to start the process. The system will prompt you to accept the 
operation. 

6 Click Yes if you want to continue.
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Importing and Exporting CSV Files
The CSV Import/Export feature allows the ability to import or export card files that are saved in a 
CSV (Comma Separated Value) format. Importing/exporting data between two applications allows 
the ability for the two application to share data.
CSV files can be edited in most applications (Excel, NotePad, etc.). 
You will use the CSV Import/Export feature if:
• You are upgrading from EntraPass DOS or WinPass 64 and you want to retrieve the cards 

created in these previous versions.
• Your company desires to import the card database information into the payroll system. Using 

the Import/Export feature will save a considerable amount of time in setting up the card holder 
database.

• Your company has a new database: instead of having to reprogram all the information already 
available in the card database, the system administrator could export the data contained in the 
card database (names, departments, card numbers, etc.) into a CSV file that can be imported 
into the target database. 

NOTE: The CSV Import/Export feature imposes a number of rules: each field contains a 
specific value format that has to be respected. For example, the card state field will only 
accept the following values (0=valid, 1=invalid, 2=stolen/lost). 

To import/Export card information, you may use Kantech pre-defined patterns or you may create 
your custom patterns. Two patterns are available: the EntraPass (1,2,3) and the WinPass 64 
models. You may use the Kantech template “as is” or you may edit it. 

Using a Predefined Pattern
Two patterns are available: the EntraPass (1,2,3) and the WinPass 64 model. You may use the 
template “as is” or you may edit it.

To use a predefined template:
1 From the Users menu, select the Import/Export CSV button.

2 From the Select operation drop-down list, select either Import or Export.
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3 In the Available Patterns pane, select the pattern you wish to use. This depends on the software 
you are upgrading from.

4 Use the Edit button if you want to edit the pattern.

Creating a New Pattern
This menu lets you create your own import/export mask that will be used to import or export CSV 
files. 

To create an import/export pattern:
1 From the Users menu, select Import/Export CSV File icon. The system displays the Import / 

Export CSV file window.

2 From the Import/Export CSV file window, click . The New pattern window 
displays a list of all the fields that are available in the EntraPass card databases. They contain 
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specific value formats that have to be respected. For example, the card state field will only 
accept the following values (0=valid, 1=invalid, 2=stolen/lost). 

3 Using the Hand buttons, select the fields you wish to include in your pattern. The Transaction 
code and the Card number fields are displayed by default. Once the fields are selected, you can 
use the red Up/down red arrows to organize information (this will indicate how information 
will be arranged in the CSV file).

4 Specify the Add code and Modification code. These codes are used by the system to identify, 
when importing a file, which card has to be modified or added to the card database. Default 
add code is “+” and default modification code is “+”.

5 Select the Delete code. This code is used by the system to identify, when importing a file, 
which card has to be removed from the card database. Default delete code is “-”.

6 Select the Field separator. This code will be used to separate the selected fields when 
importing or exporting data. Usually a comma (,) is selected. Keep this in mind when adding 
users’ last names and first names separated by a commas.

7 Select the Date format. The date will be exported or imported according to the specified 
format. The most commonly used format is YYYY/MM/DD.

NOTE: The Use DLL feature allows you to enable a program that will convert specific card 
numbers. You may use the Remove DLL when you do not wish to enable the program that 
converts card numbers.
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8 Click OK to exist the pattern window and to specify the new pattern name.

9 Enter the pattern name, then click OK. The system automatically returns to the Export/Import 
CSV file window. The pattern you have just created is displayed in the Available patterns list. 

10 If you want to add or remove fields from your pattern, double-click the new pattern to edit and 
make the necessary modifications. Now you can import or export your information using the 
new pattern you have just created.

Exporting Cards
Your organization may need to export the card database data into another application. You may 
use a predefined template or create a custom template.

To export data:
1 From the Users menu, select the Import/Export CSV File button. The system displays the Import 

/ Export CSV file window.

2 From the Select operation drop-down list, select Export. 
3 From the Available patterns list (left-hand pane), select the pattern you want to use when 

exporting cards. If necessary, you may edit the pattern so that it matches the target application 
pattern, else, you may create a new one. (For more information on how to create a pattern, see 
“Creating a New Pattern” on page 270).
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4 From the Transaction file, select the folder in which EntraPass will save the card database 
content. You can open the CSV file in Excel, Notepad, etc. 

5 Once you have selected/created an export folder, click OK to return back to the Import / 
Export CSV file window. 
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6 Click ; it is enabled once the transaction file is selected. The system displays a 
window allowing you to filter the cards you want to export.

 

NOTE:  For cards to be included in your file, they must match all the selected filters, if one or 
more filters are not matched, the card will not be included.

7 In the Export Card’s filter window, specify the cards you want to export. Once you have made 
all your selections, click the Export button. The Import / Export CSV file window appears.

NOTE: The Transaction file field shows the target file name and location. By default, the export 
file is saved in the specified folder (Exportdata, in this example). The status bar (lower part of 
the window), shows the number of imported cards (1, in this example). The default name is 
YYYYMMDD.csv. You can open the target file with Notepad for instance.
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Importing Cards
1 From the Users menu, select the Import/Export CSV File icon. Then select Import from the 

Select operation drop-down list.

2 From the Available patterns list, select the pattern that will be used to import the cards 
information (for more information on how to create a pattern, see “Creating a New Pattern” on 
page 270).

3 From the Transaction file pull-down menu, browse your hard drive to the CSV file that 
contains the data to import into the card database, then click Open.
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4 Select the CSV file to import, then click Open. The Import / export CSV file window appears.

NOTE: The system scans the file to be imported; then it displays the results using a color 
code. Each entry is identified by a color flag. A yellow or red flag identifies an entry in error. 
Errors are frequently caused by the patterns. You have to select another pattern or edit the 
pattern you are using so that the pattern entries have to match the source file entries. There 
may be errors also even if the transaction code is identified by a green flag.

5 If no errors are present (or once you have corrected errors), click to complete the 
operation. 

Correcting Import/Export Errors
The CSV Import/Export feature imposes a number of rules: each field contains a specific value 
format that has to be respected. For example, the card state field will only accept the following 
values (0=valid, 1=invalid, 2=stolen/lost). The pattern used has to match the pattern used by the 
source file.
The present section will assist you in correcting import/export errors.
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To correct import/export errors:
1 Click the Import or Export button to start the transaction (the following example illustrates a 

case of importing CSV data). The lower part of the window displays the number of cards in 
the list.

NOTE: Although entries in the Transaction code column are identified with a green flag, the 
Card number column is empty. This indicates problems in the pattern conversion. 

2 Click .

NOTE: The Error button is enabled because the system encountered problems during the 
import transaction. 
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3 You may click the Error button to display information about the error. The Process error 
window shows that the pattern used is invalid.

4 Click the Close button to go back to the Import Export window.
5 In the Import/Export CSV window, double-click the pattern you have used for the Import 

transaction (Custom, in this example).
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6 From the Field separator drop-down list, select Comma as the field separator, then click OK. 
The Card number field contains data. This indicates that the import transaction will be 
successful.
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Chapter 9 • Creating Groups
It is useful to create groups so that operators can perform modifications on a group of components 
or other system functions.

NOTE: Each system component has to be defined before it can be included in a group. 

You can create:
• Controller groups
• Door groups
• Relay groups
• Input groups,
• Access level groups 
• Floor groups
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Creating a Controller Group
The Controller group menu is used to group a number of controllers of the same site. The 
controller group can later be used to perform manual operations on controllers, for instance (i.e.: 
reload).

To create a controller group:
1 From the Groups window, select the Controller icon.

2 Select the View hierarchy button to display all the sites defined in the system.
3 From the Gateway/Site drop-down list, select the site or gateway from which you want to 

group controllers.
4 To create a new group of controllers, click the New icon. To modify an existing group, select 

one from the Controller group drop-down list, then enter the necessary information in the 
language section. 

5 From the list of controllers connected to the selected site, check the controllers that are to be 
assigned to the group.

NOTE: For more information on controllers, see “Configuring Controllers” on page 92
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Creating a Door Group
The Door group menu is used to group doors of a specific site. The door group can later be used to 
carry out manual operations such as unlocking a group of doors. 

To group doors:
1 From the Groups window, select the Door icon.

2 Select the View hierarchy button to display all the sites defined in the system. 
3 From the Gateway/Site drop-down list, select the site or gateway from which you want to 

group doors.
4 From the Door Group drop-down list, select a door group you want to modify or click the New 

icon to create a new group, then enter the necessary information.
5 From the Door list, select the doors that must be assigned to the group.

NOTE: For more information on doors, see “Configuring Doors” on page 107.
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Creating a Relay Group
The Relay group menu is used to group relays of a specific site. This relay group can later be used 
to carry out manual operations such as temporarily activating relays. 

To create a relay group:
1 From the Groups window, select the Relay  icon.

2 Select the View hierarchy button to display all the sites defined in the system.
3 From the Gateway/Site drop-down list, select the site or gateway from which you want to 

group relays.
4 From the Relay group drop-down list, select a relay group or click the New icon to create a new 

group; then enter the necessary information in the language section.
5 From the Relay list, select the relays that must be assigned to the group.

NOTE:  For more information on relays, see “Configuring Relays” on page 121.
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Creating an Input Group
The Input group menu is used to group inputs of a controller site.
This input group can later be used to carry out manual operations such as shunt on inputs. 

To group inputs:
1 From the Groups window, select the Input icon.

2 Select the View hierarchy button to display all the sites defined in the system.
3 From the Gateway/Site drop-down list, select the site for which you want to group inputs.
4 From the Inputs group drop-down list, select an existing group to modify it, or click the New 

icon to create a new group; then enter the necessary information in the language section.
5 From the Inputs list, select the inputs that must be assigned to the group.

NOTE: For more information on inputs, see “Configuring Inputs” on page 123.
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Grouping Access Groups 
The Access level group menu is used to group access levels of the same site. 

To group Access groups:
1 From the Group window, select the Access level group icon.

2 Select the View hierarchy button to display all the sites defined in the system.
3 From the Gateway/Site drop-down list, select the site or gateway from which you want to 

group access levels.
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Creating a Floor Group
This menu is used to group the floors that were created in the floor definition menu. Floor groups 
are also used for various operations in the system such as: manual operations (unlocking 
schedules), access levels, etc.

To group floors:
1 From the Groups window, select the Floor/Elevator door icon.

2 Select the View hierarchy button to display all the sites defined in the system; then from the 
Gateway/Site drop-down list, select the site or gateway from which you want to group the 
floors.

3 From the Floor group drop-down list, select an existing group if you want to modify it; or click 
the New icon to create a new group. Then enter the name of the group in the language section. 

4 From the list of defined floors that is displayed by the system, check the State column for the 
Floors  you want to include in the group. Only floors that have the State field selected will be 
enabled when: 
• A manual unlock operation is done, or 
• An “input” is programmed, for example, as a push button to enable floors for visitors 

(Devices > Input definition menu > Elevator tab), 
• Cardholders present their card to the card reader to enable floor selection when the 

controller is operating in stand-alone mode (due to communication failure). Only the 
floors marked with an “X” are available for selection.

5 Only floors that have State selected will be enabled when: 
• A manual unlocking operation is done, or 
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• An “input” is programmed, for example as a push button to enable floors for visitors 
(input definition menu - elevator tab), 

• Cardholders present their card at the card reader to enable floor selection and the 
controller is operating in “stand-alone” (due to communication failure). Only the floors 
marked with an “X” will be available for selection
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Chapter 10 • System Status
The Status menu allows system operators to view the status of various devices and components of 
the access system:
• The Connection list button provides information regarding applications connected to the 

server (operator name, local identification, etc.).
• The Text status button allows operators to view, in text, the status of EntraPass applications, 

gateways, sites, controllers (KT-100, KT-200, or KT-300), doors, relays, inputs. The status 
displayed depends on the controller installed.

• The Numerical button allows operators to view the statistical status of all components, by 
gateway. For example, you can view the number of inputs in an alarm.

• The Graphic button allows operators to display the graphic status of a controller.
• The Video Server button allows operators to display the statuses related to the EntraPass Video 

Vault process. 
• The Database status button provides information on the database structure. In addition, an 

operator can perform configuration operations or manual commands from the database 
window.
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Connection List
The Connection list feature displays details about a selected application, such as: operator name, 
last query date, local identification number, etc. It is also used to verify if EntraPass applications 
are connected to the server.

To view the system connection list:

1 In the Status window, select the Connection icon . The Connection list window   appears.

• The Red circle indicates that the EntraPass application is not connected to the server 
• The Green circle indicates that the EntraPass application is connected to the server.

2 Select a specific EntraPass application for which you want to display the status. Click the “+” 
sign to see detailed information about an application; to see if an operator is logged on, for 
example.
• Protocol—Identifies the protocol (language) used to communicate with the server. The 

protocol is used to inform the system on how the information is shared between 
computers. 

• Local identification—Identifies the label of the application on the network. This name is 
used by the server to identify your application.

• Network identification—Provides the IP address of the application on the network or 
NetbEUI name. 

• Operator name—Displays the name of the operator currently logged on this application. 
The operator name is used for many purposes, such as to identify who performed a 
modification to a card, who acknowledged an alarm, etc. For information on modifying 
the operator name, see “Operator Definition” on page 302.

• Last query date—Displays the time the application last polled the server. The server and 
application exchange information on a regular basis.
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• Connected date—Displays the date and time at which this application started its 
connection with the server. This date will be used to generate an event and kept in 
archives.

• Transactions—Displays the number of requests performed by the application (number of 
exchanges with the server), i.e. report queries, for example. 

• Errors—Displays the amount of errors encountered by the application. This field will 
reset when the application is shutdown.

• Messages/Alarms buffered (0/1) 
• 0: the number of messages/alarms buffered for this application on the server when 

the application is off-line (not in communication). This number will reset to “0” 
when the application connects to the server and messages are sent.

• 1: the number of messages/alarms that were sent to this application since the Server 
is operational. If the Server is shutdown, this number will reset. 

NOTE: The server holds a maximum of 60,000 messages and 60,000 alarms per workstation 
(default: 5,000) in the buffer. You can modify these settings through the Workstation 
Definition menu. You can also specify if newer or older events should be buffered. Events will 
be buffered only when the workstation is off-line (not connected to the server); and when the 
fields “Apply operator parameters for messages” and “Apply operator parameters for alarms” 
are not selected (for more information, see “Configuring EntraPass Applications” on page 54).
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Text Status
The Text status allows an operator to display the status of a selected component (and sub-
components) as well as all the characteristics associated with this component in a text form. This 
menu option applies to all the system devices: applications, gateways, sites, controllers, doors, 
relays and inputs. The text window contains additional buttons/icons that assist operators in their 
tasks:
• The first eight buttons represent system devices (Workstation, Gateway, Site, Controller, 

Door, Input, Output Summary / Detailed list—The magnifying glass icon is used to display 
components that are not in normal condition. It displays a summary list or a detailed list. 
• Summary: shows the components that are not in normal condition
• Detail: shows all the components in any condition.

• Stop display—This button is used to stop the display when the information is taking too much 
time. It cancels or interrupts the process.

• Refresh—Refreshes the status of the selected components.
• Print—Use this button to print the displayed status. You can preview your report before 

printing it.

To display a component status:

1 From the Status window, select the Text Status button . The Text status window appears.
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2 In the Text window, select the icon of the component for which you want to view the status. If 
you select the Workstation icon, the system displays the list of the EntraPass Applications 
defined in the system.

3 You can check the EntraPass application you want to display the status or enter a few 
characters of the component name (field at the top) for the system to searched in the database. 
For example, you can enter “Sec” for Security Office. The system will highlight the first name 
containing the entered characters. You may also click the Select all button to select all the 
EntraPass applications; or select specific components by clicking in the checkboxes next to 
each component name. The Clear all button removes the check marks from the selected 
components. Click Cancel to return to the previous window without any selections or changes.

4 You may check the View sub-components box (lower part of the window) to display detailed 
information on the sub-components linked to the selected component. For example, if you 
selected a controller, all its components (doors, relays, inputs) with appropriate status will be 
displayed on the window if this option was checked. For more focus in one window, filter 
doors, relays or inputs by site.

5 Click OK to return to the previous window and apply your selections.

NOTE: The Magnifying glass button ( )is used to display components that are not in normal 
condition. When it is in a “summary” position, only components that are not in normal 
condition will be displayed; the “detailed” position, displays a full status of all components.
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Numerical Status
This menu allows an operator to view the number of components in a “not normal” state for a 
selected gateway. 

To view the numeric status of a specific gateway:

1 In the Status window, select the Numerical status button . The Numerical window 
appears.

2 From the Gateway drop-down list, select the gateway for which you want to display the status. 
The system displays the number of cards for that gateway, the number of inputs in alarm, the 
number of relays manually activated, the number of doors forced open, etc. This can be very 
useful if you need to find out how many cards are defined.
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Graphic Status
This feature is used to display a graphical status of a door controller, including the status of all its 
components (outputs, inputs, power supply status, communication status, etc.) represented by 
colored shapes (circle, square, etc.).
• An ellipse shape represents the controller
• A circle represents a door
• A square represents a relay
• A rectangle represents an input. Rectangles may be horizontal (KT-200 and KT-300) or 

vertical (KT-100).

To view a controller status: 
1 From the Gateway drop-down list, select the gateway on which the controller to display is 

located. You may select “All gateways” to display all the controllers in the list. 
2 From the Controller drop-down list, select the controller for which you want to display the 

status.

NOTE: The displayed graphic depends on the type of the controller selected.

3 To find out which items are represented by a colored shape, move the mouse over a colored 
shape. The item highlighted on the right-hand (in the list) identifies the component.

4 Select a controller from the Controller list drop-down list (right side of the window), double-
click the item on which status is required.
• Red—The component is “Supervised” and “in a trouble state”.
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• Green—The component is “Supervised” and “in normal condition”.
• Yellow—The component is “Not Supervised” and “in a trouble state”.
• Gray—The component is “Not Supervised” and “in normal condition”.
• Blue—The relay is activated (by an event or an operator).

NOTE: If there’s more than one controller site per gateway, the numbers between parentheses 
(xx) indicates the controller number and the following numbers (xx) indicate the component 
number.
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Video Server Status
This feature is used to monitor video servers’ statuses related to the EntraPass Video Vault 
archiving process. The Video Server option can be accessed from the Status tab. The Video Server 
window lists all video servers and their statuses.

To View Video Server Status
1 Click the Video Server icon under the Status tab. The Video Server window will open and 

display all video servers and their statuses. 

• State: Enabled/Disabled video archiving
• Video Vault: Linked to the EntraPass Video Vault
• Schedule: Valid/Invalid archive schedule state
• Date and Time: of the last transaction for this video server with the EntraPass Video Vault
• State: Description of the las transaction for this video server with the EntraPass Video 

Vault.

To Enable/Disable Video Archiving
1 Right-click the server for which you want to enable/disable the video archiving process. 

• In the contextual menu, select Enable to activate the archiving process.
• In the contextual menu, select Disable to interrupt the archiving process. 
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Database Status
This window displays the status of the components within the database while browsing the 
database structure. The system displays all applications (connected or not), the Gateway, 
controller sites, etc. 
You can also perform manual operations directly from the window and edit components in order to 
modify their configuration. 

To view information about the database:

1 From the Status window, select the Database  icon. The Database window appears.

NOTE: The icon identifies the type of component. 

2 In the Database window, select the application you want to view the database. The lower part 
of the window displays the actual status of the selected component as well as its full name.

3 Select a component to modify its definition directly from the Database window. For example, 
if you have selected a door, right-click the door to display a shortcut menu. 

4 Select a command in the cascading sub-menu; select a menu option. 

NOTE: The command list varies according to the selected component.

5 Make your modifications to return to the Database status window. The Right-click shortcut 
menu offers the following options:
• Full expand—This feature allows you to fully expand the tree status and view all 

components. Only applications that are connected to the server will display a “+” sign.
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• Full collapse—This feature allows you to fully collapse the tree status and hide all 
components of the root component. 

• Edit—When you select an assigned component (i.e.: input) and click edit, the system will 
edit the definition window so you can modify its definition and when finished, return to 
the window you edited the component from.

• Limited display / No limited display—When you click on a physical component, the bottom 
part of the window displays its status. 

• By selecting Limited display, the system will erase the previous status and display the 
status of the next selected component. 

NOTE: The icons on the left side components indicate the component type.
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Chapter 11 • System
Use the System menu to define parameters for systems operators, security levels, event 
parameters, instructions, and message filters. This menu allows you also to view the EntraPass 
database structure.
You will define system parameters as follows:
• Operator: user name, login name, password settings for EntraPass operators 
• Security level: use this menu to grant or deny access permission on system logical and physical 

components
• Event parameter: use this menu to define priority, color, schedule (display, printing schedule, 

acknowledgement) for system events 
• Instruction: use this menu to create instructions for alarm messages and SmartLink 

applications
• Message filter: Use this menu to direct event messages from a specific EntraPass application to 

another EntraPass application and to define sort criteria for messages that are sent to the 
Filtered Message desktop. 

• Database structure: Use this menu to display EntraPass physical and logical components and 
to edit or sort system components.
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Operator Definition
Use the Operator menu to define system operators and to determine their security level and 
privileges. An operator is responsible for issuing cards, carrying out manual operations on system 
components, requesting reports, arming the system, etc. 
For security reasons, each person using and accessing the system database should have his/her 
operator defined to ensure that each action performed in the system will be traceable. You need to 
create at least one operator account or modify the pre-created accounts in order for the operator to 
use and operate EntraPass and to receive event messages. 
There are three default operators created in the system. These are associated with three levels of 
access rights:
• Installer (login name and password are kantech): Full access to view, modify, delete, print 

components.
• Administrator (the login Kantech1 and the password kantech): Medium access with limited 

access to some system menus. 
• Guard (login Kantech2 and password are kantech): Limited access to system menus. 

NOTE: You can define operators using the default operators or you can create new operators. 
For details about operators’ security levels, see “Security Level Definition” on page 306.

To create or edit an operator:
1 From the System tab, select the Operator icon to open the Operator window.

NOTE: The upper right-hand corner shows the last EntraPass workstation where the operator 
logged on and the last login date for the operator who is logged on.

2 Enter the operator name in the Name field. The operator name is composed of a maximum of 
40 alphanumeric characters (including spaces). 
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3 Enter the operator Login name. This is a descriptive name composed of 6 to 20 alphanumeric 
characters (including spaces).

NOTE: On login, operators must enter their login name followed by their password in order for 
the system to validate their access. The login name is displayed in the events’ details when 
operator events are generated (i.e. manual operation, login, logout, etc.).

4 In the Password field, enter the password that will be used to login with the login name. The 
password is alphanumeric and consists of a maximum of twenty characters (minimum seven 
characters). The password is not displayed nor printed, the system displays the password as 
asterisks.

NOTE: The password is case-sensitive - make sure that all operators are aware of this. 

5 In the Password Confirmation field, enter the operator password again for confirmation using 
the proper case. If this password is not identical to the one entered in the password field, an 
error message will appear.

6 In the Language section, check the appropriate option for the display language for this 
operator. If you change the display language, it will be effective only when the operator logs 
out and logs in again. When an operator logs out and exits an application, the next operator 
who logs on the application will see the startup window in the language of the last operator.

7 In the Privileges section:
• Select the Auto acknowledge option. If this option is selected, the Manual button is added 

to the Alarms desktop (see Chapter 12 ‘EntraPass Desktops’ on page 337). The operator 
can decide to manually or automatically acknowledge events. This is an operator 
privilege.

• Select the Bypass workstation message filter option, if applicable. When this field is 
selected, the basic workstation configuration will be ignored and the operator will receive 
events from all workstations and gateways.

• Check the Privileges option if you want this operator to view hidden cameras. For camera 
definition: Video > Camera > Show camera option

• Automatic video display: this option tells the system to automatically display video clips 
on an alarm event for the operator who is logged on. If the Alarm desktop is configured 
and open, the video is automatically displayed. If the alarm desktop is not open, the 
system checks the video display settings for this workstation (Devices > Messages 2 of 2, 
Disable autodisplay of video views, if this option is not checked, the system checks the 
video view settings for this operator: Operator > Automatic video display checkbox.

NOTE: The Bypass workstation message filter option is a privilege granted to operators. It allows 
them to receive all events regardless of which workstation they are logged into at the time. If 
this option is selected and the Apply operator parameters for messages and Apply operator 
parameters for alarms options of the Workstation definition are also selected, then the basic 
configuration will be ignored and events will be filtered according to the security level of the 
operator who is currently logged into the workstation.
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8 Click on the Security tab to set operator access parameters. 

9 From the Login Schedule pull-down menu, select the schedule during which the operator will 
be allowed to login into the system. You may want to create a specific schedule for an 
operator (Definition > Schedule), and then assign the schedule to the operator.

NOTE: To allow an operator to logon to different EntraPass applications or to the EntraPass 
Server select the field Allow login on application and/or Allow login on server (System > 
Security Level > Miscellaneous tab).

10 From the Security Level pull-down menu, select a security level that will determine which 
components an operator has access to. A security level consists of menus through which an 
operator can modify the database, create components, view system components and events, 
etc.

NOTE:  It is possible to define up to 250 custom security levels; the system offers 3 built-in 
security levels (Installer, Administrator and Guard) on configuration. The default configuration 
for Installer permits access to all system commands. The Installer must program other 
security levels to limit operator access to menu commands and/or options.

11 Access the Security section to edit the security features of the currently displayed operator 
profile:
• Operator disabled: use this feature if you want to suspend or limit an operator access. If 

you select an operator and then check this box, the selected operator will not be able to 
run the application.

• Change password at next log on: use this feature if you want an operator to change his/her 
password at next log on. 
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• Disable operator on bad password: use this feature to limit the number of retries on bad 
password. For example, if you set this number to three (3), the operator will be disable 
after three errors when entering his/her password.

• Days before password is reset: this feature allows to manage operators’ passwords. At the 
end of the number of the days specified in this field, the operator will be prompted to 
change his/her password.

• Use expiration date: this feature allows you also to manage operators’ password. When 
this feature is checked, you have to select an expiration date (Operator expiration date). 

• Operator expiration date: used with the Use expiration date feature, the Operator expiration 
date allows you to disable an operator’s access at a specified date. 

NOTE: Changes to the currently displayed profile will take effect at the next log on attempt.
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Security Level Definition
Security levels refer to the permissions granted to an operator to modify the database, create items, 
view components, print lists or reports, etc. There are three default operators and security levels. It 
is possible to customize an operator security level; the system allows you to create up to 250 
security levels.

NOTE:  You have to program the appropriate security levels if you want to limit operator 
access to commands and/or options of the system menu.

Each default operator has a separate login name, password and a corresponding security level. The 
password is case-sensitive. These are: Installer, Administrator and Guard.
• Installer: 

• Login name and password: kantech
• Security level: By default, a user defined as Installer has full access to all the system 

menus. He/she can read and edit system components and has unrestricted access to the 
system.

• Administrator: 
• Login name: kantech1; password: kantech
• Security level: Administrator. By default, a user defined as Administrator has limited 

access to a number of the system menus. 
• Guard: 

• Login name: kantech2; password: kantech
• Security level: Guard. By default, a user defined as Guard has limited access to the system 

menu.

Creating/Modifying an Operator Security Level
Assigning security levels is critical to the system. In fact, if a Security level is given full access to 
a system menu, operators who are assigned this security level can modify system parameters. 
Make sure that each operator is given the security level corresponding to his/her tasks. 
Items in the Security Level window are presented in a root tree with all components available for
selection. This structure makes it possible to target specific components when granting
security level for manual operations. 
The security manager or an operator with appropriate permissions can easily change or assign a 
component to a lower level security level by double clicking an item until it changes to the desired 
color code.

NOTE: Operators will not be able to see items for which they have not been given access. 
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Each security level is identified by a color: full access (green), read-only (yellow) and no access 
(red)

NOTE: Security managers or operators can easily change or assign a security level by double- 
clicking an item to change the color of its adjacent bullet. 

To create/modify an operator security level:
1 From the System main window, select the Security level icon. The Security level window 

appears with the Menu tab enabled.

NOTE: If the Video feature is enabled in EntraPass, the tabs relative to the video feature (such 
as Video Server and the Video View tabs) appear in the Security level window.

2 To modify a security level, select one from the Security level drop-down list. To create a new 
security level, click the New button and enter the necessary information in the language 
section. 

3 In the Menu window, double-click an item to make it No access (red), Read-only (yellow) or 
Full access (green). You can specific components when granting security level for manual 
operations

Defining Login Options for an Operator
The Miscellaneous tab allows you to define: operator login and system display options:
• Operator login options: you can allow or restrict an operator to log on an EntraPass 

workstation or server
• Active windows that can be kept on the desktop: EntraPass allows operators to keep five 

active windows on the desktop
30711 • Security Level Definition Defining Login Options for an Operator



Reference Manual
• Component display options: components can be displayed with our without their physical 
address. The physical address can appear on the left or right of the component name. 

To define login and display options:
1 Select the Miscellaneous tab to define other parameters for the Security level being defined. 

These include login restrictions and viewing parameters.

2 In the Login restrictions section, select the appropriate login options:
• Select Allow login on server to allow the operator to log onto the an EntraPass server 

(Primary or Redundant).
• Select Allow login on workstation to allow the operator to log onto any application in the. 

To narrow down the list of authorized applications, use this option with the Use 
workstation list for login feature. This option is checked by default when a new operator is 
created.

• Select the Use workstation list for login option to restrict the number of authorized 
applications for an operator. If selected, the operator will only be allowed to log onto the 
workstations that are selected in the EntraPass application tab. The Allow login on 
workstation option must also be selected.

3 The Keep on application desktop section allows users to increase the number of active 
windows on the desktop. In fact, operators can open five windows at the same time: one 
configuration window and four windows from the other categories. EntraPass windows are 
classified in five categories: 
• Configuration screen: this group includes all the menus that allow an operator to program 

the system. This group includes such menu items as: 
• User menu (card, Badging, card access group, access level, visitor, card type
• Definition menu 
• Group menu 
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• Devices menu 
• Video menu 
• System menu
• Historical and Time and attendance reports. 

• Operation screen: this group includes all the Operation menu items and the Video 
playback option. 

• Status screen: this group includes windows of the Status menu, Current recording menu 
and Report state menu.

• Database screen: The following menus are included in this category: 
• Option menu (card format, authentication password, select languages, Printers 

options, Changes date and time, etc.), 
• Items of the User menu (Daypass, batch operations and Import/Export CSV)
• View Report, Operation on T&A, and View exported videos

• Report screen: this group includes Quick Report, Historical and Time and attendance 
report requests and Video list windows.

NOTE: These options allow operators to keep active four operation windows on the desktop. 
They can bring to front or send to back the window they want to display, simply by pressing 
CTRL-F6. 

4 In the Components physical address section, specify how the component's physical address 
will be displayed for the security level being defined. This will also affect how components 
will be sorted.
• Display on left—If selected, components will be sorted by their address (i.e. 01.01.01 

Controller xyz).
• Display on right—If selected, components will be sorted by their component name (i.e. 

Controller xyz 01.01.01).
• No display—If selected, the address will not be displayed (i.e. Controller xyz) and 

components will be sorted by name.
5 If your are using the Video feature, EntraPass enables you to deny viewing permission to a 

specified security level by checking the Hide camera from video views for the security level 
being defined. 

NOTE: Checking the Hide camera form video view option tells the system to verify access 
permission to cameras before loading a video view. For example, if the selected operator’s 
security level has access to a video server but not to all cameras defined in the video server 
and has access to the selected video view, the system will hide the camera that has been un-
selected when assigning permission to the video server. For details, see “Limiting Access to a 
Specific Camera” on page 317.

Filtering Applications Available to an Operator
This feature allows you to filter applications that will be available to Operators assigned the 
selected security level when viewing or modifying system components. For example, if you 
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assigned the menu “EntraPass application”, only workstation selected in for this security level will 
be displayed in the EntraPass Application list when the operator who is assigned this security level 
wants to modify an EntraPass application. 
Operator assigned a given security level will not see nor view or modify a specific application if it 
is not selected in their security level definition. 
In the following example, the selected security level (Guard) will not view messages sent by the 
EntraPass SmartLink application because it is not assigned to their security level.

To filter EntraPass applications available to an operator:
1 From the Security level drop-down list, select the security level you want to define/edit. when 

viewing or modifying components. 

NOTE: When an operator is allowed to use the “Network alarms message desktop (Desktops 
menu), only alarm events originating from the EntraPass applications and components of the 
applications that are selected in this window will be displayed. The security level definition 
acts as a filter for the “Network alarms message desktop”.

2 Check the All EntraPass applications option if you want the operators assigned this Security 
level to see all the Entrapass applications defined in the system. 

Filtering Gateways and Sites Available to an Operator
As for the EntraPass applications menu, operators assigned a given security level will not see nor 
view or modify a specific gateway or site if it is not selected in their security level definition. 
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To filter gateways and sites available to an operator:
1 Select the Gateway and Site tab to narrow down the list of gateways and sites that will be 

available to the operator who is assigned this security level for modifications or normal 
operations. 

NOTE: When you select a gateway or site, you also select all the components defined “under” or 
attached to the gateway (i.e. sites, controllers, doors, relays, inputs, outputs, etc.). 

2 Select All gateways and sites if you want all the displayed gateways and sites to be available to 
the operator assigned this security level when modifying doors, relays, inputs, etc. or 
performing modifications/operations related to controllers. You can also select specific 
gateways/sites from the displayed list.

Filtering Controllers Available to an Operator
EntraPass allows you the ability to assign to a security level Controllers that will be available for 
view. To do so, you must select the Operator security level, then select the Controllers tab and 
check controllers that you to be available for the selected security level.
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To filter controllers available to an operator:
1 From the Security level drop drown list, select the security level you want to define. 

2 From the Security level window, select the Controllers tab to assign controllers to the selected 
security level. The selected controllers will be available for viewing or editing to the operator 
who is assigned this security level. 

NOTE: When you select a controller, you also select all the components defined “under” or 
related to the controller (i.e. doors, relays, inputs, outputs).Make sure that you have also 
selected the gateway (Gateway and Site tab) for which the selected controller is defined. If 
the gateway is not selected, the controller will not be available even if it is selected in the list.

Filtering Doors Available to an Operator
EntraPass allows you the ability to assign to a security level Doors that will be available for view. 
To do so, you must select the Operator security level, then select the Controllers tab and check 
controllers that you to be available for the selected security level.
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To filter doors available to an operator:
1 From the Security level drop-down list, select the security level you want to define/modify, 

then select the Door tab.

2 Select All doors if you want all the displayed doors to be available to the operator assigned this 
security level when modifying doors, relays, inputs, etc. or performing modifications/
operations related to controllers. You can also select only the doors you want from the 
displayed list.

NOTE: Make sure that you have also selected the controller for which the selected door is 
defined. If the controller is not selected, the door will not be available even if it is selected in 
the list.

Filtering Access Levels 
Associating specific access levels to a security level allows you to control the access levels that an 
operator can define or modify. For example, a security guard may have the right to issue cards that 
are valid for a given door or access level only.
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To filter access levels available to an operator:
1 From the Security level drop drown list, select the security level you want to define/edit. 

2 Select All access levels if you want all the displayed access levels to be available to the 
operator assigned this security level when creating cards or performing modifications related 
to access levels. You can also select only the access levels you want from the displayed list.

NOTE: Make sure that you have also selected the gateway for which the selected access level 
is defined. If the gateway is not selected, the access level will not be available even if it is 
selected in the list.

Filtering card types available to an operator
This feature restricts the operator action. In fact, card types that are not selected in this menu will 
not be available to an operator when creating or editing cards. For example, you may decide that 
an operator with the Guard security level will not be able to issue a specific card type such as 
Security. To do this, select the Guard security level, then do not select Security when filtering card 
type for the Guard security level. 
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To filter card types available to an operator:
1 From the Security level drop-down list, select the security level you want to define/edit. 

2 Select All card types if you want all the displayed card types to be available to the operator 
assigned this security level when creating cards or performing modifications related to card 
types. You can also select only the card types you want from the displayed list. 

Filtering reports available to an operator
This feature gives operators access to specific reports according to their security level. For 
example, a System Administrator may have access to all the reports that can be generated whereas 
the Guards’ Supervisor may only have access to all Guard Tour related reports. The reports will be 
generated from the Archived Message list on the workstation desktop. Once the reports have been 
assigned to security levels, operators will only have access to reports that correspond to their 
security level. 
31511 • Security Level Definition Fil ter ing reports avai lable to an operator



Reference Manual
To filter reports available to an operator:
1 From the Security level drop-down list, select the security level you want to define/edit. 

2 In the Report tab, select the reports you want to assign to the selected security level. Or, check 
the All reports check box if you want to give full access to all reports to the operator assigned 
this security level. You can also select only the card types you want from the displayed list. 

Filtering Video Servers
The security level menu allows you to assign or limit operator access to specific video servers and 
cameras. For example, even if a security level has access to a video server, you still have the 
ability to restrict access to a specific camera. This feature makes it easier to define or modify 
permission for accessing a video server, a video view or other video menu items by double-
clicking the colored bullet next to an item: green: full access; yellow: read-only; and red: no 
access. The video server, video view and video trigger menus offer the three access options. For 
other video menu items such as Recording parameters, video event list, current recording, video 
desktop, etc., only the no access and full access options are available.
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To filter Video Servers:
1 From the Security level drop-down list, select the security level you want to define/edit, then 

select the Video server tab. 

2 Check a specific video server, or check the All video servers option if you want the selected 
security level to have access to all video servers defined in the system.

NOTE: To filter video views available to an operator, the operator’s security level must have 
access permission to the video server associated with this specific video view. For example, if 
operators are granted access permission to a video view but if their security level does not 
have access to the video server where the video view is defined, the video view will not be 
available to operators with this security level. 

Limiting Access to a Specific Camera
EntraPass offers the ability to grant permission to a video server and still restrict access to its 
cameras.

NOTE: If you want the operator not to view the camera for which he/she does not have access, 
you must check the Hide camera from view option when defining the security level. Checking 
this option will hide the camera from the video view even when the operator has full access to 
the video view in which the camera has been defined.
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To restrict access to cameras:
1 From the Security level window, select the Video server tab. 

2 Double-click the video server (for this, you have to un-select the All video servers option).
3 From the Select camera window, un-select cameras you want to hide for this security level 

then click OK to close the Select camera window. 

4 Save your modifications. When a video server has been modified, it’s color turns red. 
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Filtering Video Views
1 From the Security level window, select the Video view tab.

2 From the list of displayed views, select the views available to this security level. You may 
check All video views if applicable. You may also deselect a view if you want to restrict access 
to a specific view. 

Hiding Card Information
EntraPass offers you the ability to hide card information fields from view. For example, you can 
decide that a certain security level (Guard for example) will not modify card information field. To 
do so, select the security level, then in the Card database fields (Security level), select fields you 
want to be hidden. 
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To hide card information:
1 Select the Card database fields tab to limit the number of card fields which are visible to the 

operator who is assigned this security level.

2 Select the fields (either individually or in groups) that will be hidden to the selected security 
level. In the example above, operators who will be assigned the Guard security level will not 
see the selected fields.

Assigning Video Custom Buttons
EntraPass offers you the ability to customize five buttons for use in the Video interface. System 
installers and administrators can customize buttons for use by operators in the Video desktop. For 
example, a button customized for Playback with fixed delay with specific pre-record and record 
delays and assigned to a specific Security level will enable operators to trigger the actions related 
to the specific button.
If you associate a custom button with a specific task (play back or generating video events, 
additional buttons are added to the Video desktop (Desktops > Desktop dedicated to video 
viewing)
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To customize buttons for use in the Video desktop:
1 From the Security level drop-down list, select the security level you want to define/edit. 

2 Select the Video custom button tab to assign permission to this operator. The following 
permission can be granted:
• Playback with fixed delay
• Playback with custom delay
• Generate recording event with fixed
• Generate recording with custom parameters.

3 Select the option you want to assign to the operator being modified. 

NOTE: Pressing the button associated with Playback with fixed delay will start a play back with 
the specified duration. This includes the pre-alarm recording time and the maximum recording 
time. 
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Event Parameters
Defining event parameters is one of the most powerful features of the system. For each event, you 
can determine how it will be processed by the system. For example, you can:
• Direct events to output devices (such as Messages desktop and log printer), 
• Send instructions to a SmartLink application
• Define schedules that will allow, for example, to send alarms to an EntraPass application only 

at night
• Send a specific event to a specific EntraPass application, etc.
There are more than 400 system events including:
• Access granted
• Input in alarm
• Card modified by operator, etc. 
Events are associated with system components, such as doors, controllers, gateways, Entrapass 
applications, etc. Every event message is associated with a system component and output devices 
or group of devices. For example, an Access granted event can be defined for each individual door 
or by default it can be defined for all doors. This flexibility allows for different actions or 
responses on a door-by-door basis.

Defining Events Parameters
The Event parameters menu allows you to customize your system events. In fact, you can specify 
events that will be printed automatically or acknowledged during a specific schedule. You can also 
send instructions to inform an operator of an alarm or through other media (i.e. e-mail, pager, etc.) 
when alarms are generated.
By default, all events are defined to be displayed on all the Message desktops of all EntraPass 
applications defined in the system. You can customize your system events by manually associating 
events and components.
There are two types of associations: manual and default association. For details about associations, 
see “Creating and Viewing Associations” on page 324.

NOTE: Manual associations take priority over default associations. When you define a manual 
association between an event message and a component, the default association is ignored. 
It can be restored by deleting the manual association Manual associations should be used 
with caution. The most common use for this feature is the SmartLink application.
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To define parameters for a system event:

1 From the System main window, select the Event parameters icon .

2 From the Event drop-down list, select an event for which you want to define settings. 

NOTE: By default, all events are defined to be sent to the Messages desktop of all EntraPass 
workstations defined in the system with an always valid schedule. It is recommended to keep 
default settings especially when these settings apply to all components/events. However, you 
may decide to create manual associations if you want a specific event to appear on a specific 
EntraPass workstation. The selected event will appear on all doors and will be displayed on 
all EntraPass workstations. 

3 In the Display settings section, specify the display options: by default, all events are 
programmed to be displayed in the Messages desktop window of all the EntraPass 
workstations of the system. By default, they are assigned an Always valid schedule.

NOTE: If you are running EntraPass SmartLink application, this schedule must remain to 
Always valid or otherwise messages/commands will not be forwarded to the application.

4 From the Print pop up-down menu, select a schedule to determine when the event will be 
printed. When this schedule is valid, the selected event will be printed on the printer defined 
on the workstation to which it is being sent.

NOTE: You must also select a printer and specify if the printer should print messages or 
alarms, or both. For more information, see “Basic Functions” on page 43.

5 From the Color drop-down list, select the color that will be used to display the event in the 
Message desktop. The default colors are set according to the following convention:
• Red for alarm events;
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• Green for elements returning to a normal condition;
• Yellow for warnings and errors;
• Blue for other events.

6 In the Alarm Settings section, specify:
• Alarm (schedule)—When this schedule is valid, the event will be sent to the Alarms 

Desktop of the selected workstations and will require an acknowledgement from the 
operator.

• Instructions—Select the instruction that will be sent to the Instruction desktop with the 
event to be acknowledged. Instructions will only be sent when the alarm schedule is valid.

NOTE: For the SmartLink application, the instruction does not require that the alarm schedule 
be valid. You can leave the Alarm schedule field blank, and the instruction will be sent anyway.

7 Assign the Priority level to the event. This determines the sequence in which alarms messages 
will be displayed to the operator in the alarm queue. The priorities are preset to the most 
common values (0 = higher, 9 = lower).

Creating and Viewing Associations
There are two types of associations: 

• Default. The default associations are preset in the system. By default all events messages 
occur on all components associated with them and are displayed in all workstations. You 
may keep the default settings. However, EntraPass offers you the ability to create manual 
associations.

• Manual associations.

Default associations
Comments

Component Workstation

Default Default All events originating from all 
components are sent to all 
workstations

Default (Specific) Workstation 2 All events originating from all 
components are sent to only 
Workstation 2

Specific (Door 1) Default Only events originating from 
Door 1 are sent to all 
workstations
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The following table shows the three types of manual associations:

To create an association:
1 In the Event parameters window, select an event from the Event drop-down list. From the 

component pane (on the left) select a component and then select an EntraPass application to 
which the event message will be sent. 

Manual association
Example

Component Workstation

Specific Specific Events generated by Door 1 are 
sent to only Worksation 1

Specific Unspecified or default Events generated by Door 1 are 
sent to all Workstations 
(default)

Unspecified or default Specific Events generated by any of the 
Doors (Default) will be sent to 
only Workstation 1
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2 Click the Save icon to create the new association. In this case, All access denied events that 
will occur on the selected door will be sent to the Additional workstation computer (selected 
on the right-hand) . 

NOTE: The Save icon is enabled only when you the selected pair (component/event) is not yet 
part of an associated.

To view an association:
1 In the Event parameters window, select a component from the left-hand pane, then select a 

workstation in the Send to workstation pane. 

2 Click the View association icon in the toolbar .The View default parameters message box 
shows the component and EntraPass application. You can click the Delete icon in the toolbar 

 if you want to modify the displayed association.

Deleting and Restoring Associations
You may decide that events from Door 1 should no longer be sent to the Message Desktop of all 
workstations, but to a specific desktop. To do this, you have to delete the existing association and 
then create a manual association. It is recommended to use this feature with caution.
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To delete an association:
1 In the Event parameters window, select an event message from the Event drop-down list. 
 

2 From a component, select a workstation in the Send to workstation pane then click the 
association icon. The View default parameters message box appears.

3 Click the Delete icon  in the toolbar. 

4 From the Delete event parameters window, make your choice:
• Restore default: this option will apply the default alarm and display settings. 
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• Delete association: if you select this option, the alarm and display settings fields will be 
left blank and ready for new information. Once you have deleted the settings, you must 
re-define them.

• Cancel: select this option if you want to cancel the delete operation.

Printing Event Parameters
EntraPass allows you to print events parameters (alarm and display settings) for the selected 
events and selected workstations.
You can also use the Font button to choose a different font (and font size) for your report.

To print event parameters:
1 From the Event parameters window, select the Printer icon.

2 In the Select events pane, select the events to be included in your printout or click on the 
Select all button to select all the events from the displayed list.

3 In the Select applications pane select the EntraPass workstation (or workstations) to be 
included in your printout or click on the Select all button to select all the EntraPass 
workstations from the displayed list.

4 You may check the Print empty fields option in the bottom of the window. If selected, the 
system will print the fields that do not contain any information. Only the field title will be 
printed.

5 You may check the Print with default values option. If selected, the system will print the 
default associations as well as manual associations.
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6 You may check the Print components reference option. If selected, the system will print the 
component physical address next to the component identification.

NOTE: If you do not select this field, only manual associations (not involving defaults) will be 
displayed in the report. If you do not have manual associations (Component x with workstation 
y), the report will be empty.

7 Select the Preview button before printing, if desired.
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Instruction Definition
This menu is used to define instructions that will be sent to the Instruction window (Desktop 
menu) when an alarm is generated and sent for acknowledgement.
Usually, each line will contain a single directive; the response instructions will be composed of 
several directives (lines). This allows for greater flexibility when modifications are required.

To define instructions:
1 From the System main window, select the Instruction icon.

2 To create a new instruction, click the New icon. To modify an existing instruction, select one 
from the Instruction drop-down list. 

3 Enter the instruction name/identification in the language section. 
4 Select an appropriate language tab to enter the instruction. Instructions are entered in one 

selected language. 

NOTE: You may enter up to 511 characters (including spaces) per instruction.

5 To assign instructions to events, see “Event Parameters” on page 322.

Creating a SmartLink Instruction
The Instruction definition menu allows you to create SmartLink instructions. If you have a 
SmartLink application installed, the Macro-insertion menu button is enabled. It allows operators to 
send built-in macro-commands to the SmartLink application.
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To enter a Smart Link instruction:

1 In the Instruction window, select the  button or right-click and a menu 
will be displayed.

 

NOTE: When creating SmartLink instructions, only commands that are written in the primary 
language are considered as valid commands. For more information on macro-commands, 
refer to your SmartLink Specifications Manual.
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Message Filters Definition
The Message filter feature allows you to define filters for the Filtered Messages desktop. These 
filters are used to view a specific selection of events. For example, you may define specific filters 
for an operator: a Guard may be only interested by “Guard tour events”. You can then create filters 
so that only guard tour events are sent to the Guard’s EntraPass workstation.
There are many pre-defined filters such as: access events, controller events, etc. These filters can 
be accessed by all operators. You can select or create filters directly from the “Filtered Messages” 
desktop or from the Message Filters menu.

NOTE: For more information, see “Filtered Messages Desktop” on page 351.

To define event for a message filter:
1 In the System main window, select the Message Filter icon.The Message filter window 

appears.

2 From the Message filter drop-down list, select an event message type (for example: Door 
events or Relay events) for which you want to define a filter. You may also click the New icon 
to create your own filter.

3 From the Event list, select the events that must appear in the selected filter. You may check the 
Select all events option, if you do not want to select specific events. For example, for a Door 
events type filter, you may decide to include all events or select the Access-denied events. 

4 Select the Door filters tab to filter doors that will send messages to the Filtered messages 
desktop. Additionally, when “Access events” are filtered, the cardholder’s picture can be 
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displayed with the event (if pictures are assigned to cardholders). You can select which doors 
will display the cardholder picture when the event for this door is generated.

5 Check the All doors option or choose specific doors for which the cardholders’s picture will be 
displayed an door event. 

6 From the Door filter type, select the filter that will be used for filtering Door events:
• Door filter: Only events related to the selected doors will be sent to the Filtered Message 

desktop
• Pictures filter: Cardholders’ pictures related to cards presented to the selected doors will 

be sent to the Filtered Message desktop 
• Filters for doors and pictures: Door events related to the selected doors as well as 

cardholders’ pictures that triggered door events on the selected doors will be sent to the 
Filtered Message desktop.
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7 Select the EntraPass applications tab to filter applications that will send messages to the 
Filtered Messages desktop. 

8 Check the All EntraPass applications option for the Filtered Messages desktop to receive all 
events originating from all EntraPass applications defined in the system. You may also choose 
to display events from specific applications. To do this, select the EntraPass application from 
which you want to receive events.

9 Select the Gateway and site tab to filter gateways and sites events sent to the Filtered Messages 
desktop.
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10 Check the All gateways and site option to receive events originating from the components of 
the gateways or sites. You may select the Gateway or the site that will send events to be 
displayed. 

NOTE: When you use filters, the system retrieves events that are already displayed in your 
Message desktop and sorts these events according to the settings of the selected filter. If some 
events originating from a specific gateway are displayed in your messages desktop and this 
gateway is not selected in the filter definition, then these events will not be displayed when 
you select this filter.

11 Select the Special filter tab to filter events according to their type.

• Picture: all events associated with a cardholder’s picture will be displayed in the Filtered 
Message desktop. 

• Fail-soft: all events generated by a controller in stand-alone mode following a 
communication failure will be sent to the Filtered Message desktop. Fail-soft messages 
are identified with a + sign in the Filtered Message desktop (and Message Desktop) when 
this option is select when defining the Messages list properties (Desktop > Message 
Desktop > right-click an event > Properties).

• Video: all video record events will be sent to the Filtered Messages desktop.

NOTE: When you use filters, the system retrieves events that are already displayed in your 
Message desktop and filters these events according to the settings of the selected filter. If 
some events originating from a specific gateway are displayed in your messages desktop and 
this gateway is not selected in the filter definition, then these events will not be displayed 
when you select this filter.
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Database Structure
Use the Database structure menu to browse the system database. It will display the entire structure 
of the database including:
• The system physical components (EntraPass applications, gateways, sites, controllers, doors, 

relays, inputs and auxiliary outputs), and 
• Logical components (cards, schedules, reports, instructions, groups, etc.). 
Operators can edit or sort the system components from the Database structure window. 

To view the database components:
1 Form the System menu, select the Database structure icon.

NOTE: If the Video feature is enabled in EntraPass, its components will appear in the 
Database explorer.

2 To display only the Physical component, select the physical components icon.When selected, 
only the physical components of the database will be displayed. 

NOTE: By default, physical components are ALWAYS displayed.

3 To display Logical components, select the logical components icon. When selected, logical 
components of the database will be displayed along with the physical components. 

4 You may use the Refresh button to refresh the display in order to obtain the most recent 
information saved in the server database.

5 You may select the Full Expand button to fully expand the tree structure and view all sub-
components of a selected component. For example, if you use this button on a controller, the 
system will display the controller components (doors, inputs, relays) on the right-hand side of 
the window.

6 You may select the Collapse button to fully collapse the tree structure and hide all sub-
components of a selected component.

7 To edit a component, right-click it and select Edit from the contextual menu. The system will 
display the definition window so you can modify the component’s parameters.

8 To sort the component, right click the component, then select Sort from the contextual menu. 
Sort the components listed in the right-hand pane of the window for an easier find. You can 
sort by component address or name.

NOTE: You can define how the component's physical address will be displayed. This will also 
affect how components will be sorted. For more on this, see “Security Level Definition” on 
page 306.
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Chapter 12 • EntraPass Desktops
Desktops receive and display system events (current or historical), alarms, cardholders’s picture, 
system graphics, etc. A desktop can also be used to acknowledge alarms, display instructions, etc. 
There are eight (8) pre-defined desktops. These can be configured as follows:
• Desktop 1: all system events
• Desktop 2: System events and pictures
• Desktop 3: Filtered system events
• Desktop 4: Filtered system event and picture, etc.
• Desktop 5: Alarms screen
• Desktop 6: Graphic screen
• Desktop 7: Network alarms screen
• Desktop 8: Video desktop, if the Video option is enabled in EntraPass. 
The following windows can be combined with other desktops:
• Instructions
• Pictures
• Historical Reports
It is possible to display more than one window at a time. Depending on their security level, 
operators can modify the settings of each of these windows (background color, size, toolbar, etc.). 
However, an operator whose access level is ‘read-only’ on a given desktop cannot modify, move, 
maximize or minimize a desktop. 

NOTE: Only operators with the required security level can customize their desktops (System 
menu > Access Level). They also have the ability to allow “Read-only operators” to modify their 
desktop settings. In this case, the changes apply only to the current session.
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Customizing the Work Area
EntraPass enables operators with appropriate permissions to customize their work area and to 
modify the desktop properties. 
To define an operator’s security level: System menu > Security Level.
To change the display properties:
1 From the Desktop window, right-click anywhere in the window. 
2 Select Properties from the shortcut menu.

3 From the Properties window that appears, select the display options: you may change the 
default size of buttons, the default background color, etc. 
• Small buttons: If this option is selected, small components’ icons are displayed with no 

descriptive text. This option can be appropriate for operators who are familiar with 
EntraPass icons and do not need an additional description. 

• Large buttons with images: Icons are displayed with their description. 
• Large buttons without images: Large buttons are displayed with no description. 
• Display menu: check this option to view the system menu.
• Display toolbar: check this option to view the toolbar for system menus.
• Background color: select a background color for the whole work area. 
• Change system font: click this button to change the font for all the user interface.
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Customizing a Specific Desktop
EntraPass enables operators with appropriate permission to customize their desktop. Moreover, 
operators with full access permissions can permit operators with read-only permission to 
customize their desktop for a limited time. They can also customize a specific desktop and transfer 
this customized desktop to other operators using the Assign desktop feature. The following 
sections explain how to customize a desktop:
• Customizing a desktop by a full access operator
• Customizing a desktop for a read-only operator
• Transferring a customized desktop

Customizing a Desktop (Full Access Operator)
Operators with full access permission have the ability to customize their desktops. To grant full 
access to an operator: (System > Security Level).
33912 • Customizing a Specific Desktop Customizing a Desktop (Full  Access Operator)



Reference Manual
To customize a specific desktop:
1 Select the desktop you want to customize, then right-click to open the Desktop properties 

window, then select Properties from the short-cut menu.

NOTE: If the Video option is enabled in EntraPass, the Video desktop option appears in the 
lower part of the Desktop properties window.

2 From the Desktop name field, assign a meaningful name to the desktop you are configuring.
3 Select the window type:

• Floating window—a floating window can be resized and positioned anywhere in the work 
area screen. For example, you can choose to send it to the back or to bring it to the front. 
If a floating window was sent to the back, you may bring it to the front by right-clicking 
the desktop button, then selecting the Bring to front menu item.

• Desktop window—a desktop window is trapped within the work area. It is not possible to 
send the window in the background. It always remainswithin the main work area.

4 To save your changes:
• Click OK—If selected, you just save your the changes, the window is not displayed. 
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• Click OK & GO—If selected, this function saves your changes and displays the window 
you have just configured.

NOTE:  When opening a desktop window for the first time, you may need to re-size it in order 
to view the information correctly. To do so, point to the frame border you want to change; 
when the pointer turns into a double-headed arrow, drag the border to exact size. You may 
then position the window in the work area to the desired position.

Customizing a Desktop for a “Read-Only” Operator
The security manager or an operator with the appropriate security level can give permission to 
operators who do not have the appropriate permission to customize their desktop during a session. 

To change desktop properties:
1 Log on, using the user name and password of the operator with ‘read-only’ security level. To 

do this, use Kantech2 as the username and kantech as the password. 
2 Then, right-click a desktop, then select Properties. The desktop properties window appears.

NOTE: The Permit button appears when the operator who is logged on has ‘read-only’ access 
permission. The permission acquired during this session will be valid until the operator logs 
out.

3 Click the Permit button. The operator login window appears. Enter your username and 
password, and click, OK. The temporary permission will be granted. 
34112 • Customizing a Specific Desktop Customizing a Desktop for a “Read-Only” Operator



Reference Manual
Transferring a Customized Desktop 
Another possibility available to the Security Manager (or to the operator with the appropriate 
security level) is to customize a desktop, and then to assign the settings to other operators who 
may not have the appropriate security level to modify their desktop settings.

To transfer desktop settings:
1 Right-click the desktop you want to assign the settings. 

2 Select the Assign (desktop) option from the shortcut menu. 

3 From the displayed window, select the operators to whom you wish to assign the desktop 
properties (you must check the appropriate checkbox). You may select operators one by one, 
or you may use the Select all button. 
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Messages List Desktop
By default, the first desktop is defined as the Messages List Desktop. It displays all system events. 
Events are displayed with their icon, date and time, description, system components involved in 
the event such as controllers, cardholder pictures (if defined), etc. When a new event is displayed, 
the window scrolls up. The newest events are added at the bottom of the window. 

Viewing and Sorting System Events
By default, the first desktop is dedicated to displaying system events.When you select an event 
from the list, you interrupt the incoming sequence (the green status indicator located at the bottom 
left part of the desktop turns red when scrolling is interrupted). By default, the scrolling will 
restart automatically after a pre-set period of time, unless the auto-scroll parameter was disabled, 
In that case, to restore the normal scrolling, click the Restart Scroll button.

NOTE: If you configure a Desktop as a message screen and a picture screen, two windows are 
displayed simultaneously when you select the desktop.

 To display and sort system events:
1 Select the first desktop. By default, all system events are displayed in ascending order with an 

area at the bottom of the screen that displays the selected event in the list. 

NOTE: You may change the message color: System > Events parameters.

NOTE: You may change the events display order; see “Customizing Event Display” on 
page 345
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2 From the Message list screen, you may change the sorting criterion (Sorted by scroll-down 
list). You may choose to sort by:
• Sequence—Events are sorted according to the normal sequence (default). New events are 

added at the bottom of the window. (This option is not available for Archived Messages 
Lists.) 

• Date and time—This sort order interrupts the normal scrolling of events. This feature is 
useful when you want to know when an event was generated. This time may be different 
from the “normal sequence” for dial-up sites for instance or after a power failure.

• Event—When selected, the system sorts the Event message column in alphabetical order, 
grouping identical events. For example, all Input in alarm events are grouped together in 
alphabetical order.

• Message type—When selected, the system sorts the Event message column in alphabetical 
order, grouping similar events. For example, all Site events are grouped together in 
alphabetical order. 

NOTE:  To go back to the default display, Select Sequence from the Sorted by drop-down list. 

3 Click the Text filter button (top of the window) to display specific events containing a text 
string. When you do this, the Find dialog box appears. Enter the string that will allow you to 
display specified events, then click the Find next button. 

4 To close the Find dialog box, click the Cancel button or the Windows closing button (X).
5 To return to the normal display in the Messages list screen, click the Text filter button.

NOTE:  Every time you select an entry in the list, scrolling stops. By default, EntraPass is set 
to start scrolling automatically after a pre-set period of time. If you disabled this feature or do 
not wish to wait for the pre-set period to start scrolling the list again, click the Restart scroll 
button at the top of the screen. 
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Customizing Event Display
To modify the message desktop properties:
1 From the displayed shortcut menu (Message desktop > Right-click a message), select 

Properties.

2 From the Properties window, select the appropriate display options.
• Multi-line—Usually, events are displayed on a single line. You can increase the line 

spacing between events by checking the appropriate option (1, 2, 3 or 4 lines). 
• Show icons —You can choose to display different types of icons beside each event. 

• Message type—When you select this option, the system inserts an icon next to events 
indicating the type of event. For example, if the event is a “door forced open” an icon 
representing a door is displayed (a hand represents a manual operation, a diskette 
represents the operation that modified the database, etc.). Access events are 
represented by the login/logout icons. 

• Picture—When you select this option, the system inserts a card icon next to events 
containing cardholder pictures.

• Fail-soft messages—When you select this option, the system displays a plus (+) sign 
next to the events that occurred when controllers were off-line.

• Video: check this option if you want the selected desktop to display video data from 
the video server connected to your system.

• The Miscellaneous section allows you to enable additional options:
• Keep card picture—When selected, the system keeps the latest card picture (if the 

Picture window option is selected) until another event containing a card occurs.
• Display toolbar—Displays/hides the toolbar on the top of the Message Desktop.
• Manual properties save only—When you select this option, you have to click the Save 

button (once selected, the button is disabled). The system saves all the settings 
defined in the Properties window as well as the position of the window within the 
Messages Desktop. 

• Display selected messages (full)—When you select this option, a smaller window is 
added at the bottom portion of the Message window. It displays the selected event 
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with its full description. This feature is very useful when your Message window is 
too small to display the entire description of an event. 

• Display events in bold: select this option to increase the legibility of text event 
messages displayed in EntraPass desktops (Message list, Filtered messages and 
Alarm desktops). Moreover, if the color selected for an event message is the same 
color as the background color, the event message will be displayed in black bold so 
that it can always stand out. (This option is not available for Archived Messages 
Lists.)

• Last Message on Top: By default, event messages are displayed in ascending order of 
occurrence, with the area at the bottom of the screen reserved for the highlighted 
event. You can select to display the events in descending order, with the highlighted 
event showing above the list of event messages.

• Auto-scroll delay (mm:ss): Will automatically start scrolling the message list after a 
pre-set delay when the operator selects an item in the list. By default, this option is 
turned on with a preset delay. You can select to turn this option off which means that 
the operator will have to click the Restart Scroll button in the Messages List. (This 
option is not available for Archived Messages Lists.)

• Message background color—Allows the operator to modify the background color of the 
message window.

NOTE: To change the font color of system messages: System > Event parameters.

Performing Tasks on System Messages
EntraPass enables you to perform various tasks on system events. These include:
• Deleting messages
• Viewing card information
• Validating card status and card transaction
• Modifying the desktop properties (such as display options), etc.
• Play, edit and export video recordings
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• Play archived videos from the EntraPass Video Vault

NOTE: Some tasks are related to the selected desktop. For example, if you right-click an alarm 
event, the shortcut menu displays tasks that are related to alarm events. For details, see 
“Alarms Desktop” on page 356.

To perform additional tasks on messages: 
1 From the Message desktop, right-click an event to enable a shortcut menu:
2 Do one of the following:

• Delete all—This option allows an operator to delete all the events displayed. 
• Card—This menu items offers two choices: View card transactions and Search card. Select 

View card transactions to display all access information related to the cardholder who has 
triggered the access event. The Search card shortcut allows you to browse the card 
database and to display information about a card from the View card information window. 
From this window, operators can perform a variety of tasks including viewing and 
validating information contained on a card, such as the card number, cardholder name, 
card state (valid or invalid), card type, etc. They can also select a card and view its 
transactions or view and validate a card access. For details about validating cardholders’ 
access and last transactions, see Chapter 8 ‘Defining Cards’ on page 204.

• Video recording— This menu items offers three options: Play, Play/Edit/Export and Play 
from Vault. Selecting Play allows users to play the video event in the Playback window, 
offering options to snap (copy) it and save it for future use. Selecting Play/Edit/Export 
offers users features similar to the ones in the Video Event List. Operators can then 
display details about the event (camera, server, comment field) and camera information, 
etc. The video event can also be played and exported. Selecting Play from Vault allows 
operators to view a video that is already stored in the EntraPass Video Vault.

NOTE: If camera icons are not displayed, simply right-click a video event message, select 
properties from the shortcut menu, and check Video in the Show icons section of the 
Properties

• View parent—Displays the parent of each component related to the selected event.
• Edit—This feature offers you the ability to edit each component associated with the 

selected event. If Edit is selected, a shortcut menu displays components associated with 
the selected event. In this example, the Site definition modified event involves the 
EntraPass application, the operator who was on duty when the event was generated and 
the site related to the event. It is now possible to edit any of the three components by 
selecting it from the shortcut menu.

NOTE: If the selected event is an access event and if the card that triggered the event has 
already been registered in the system, it will be possible to edit the card. However, if the card 
is associated with an Access denied - card unknown event, the card will be created and 
registered in the system.
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• Send to back—This option only works when the window type is set to floating. It sends 
the active window behind the main application window. To bring back to front, right click 
the desktop button, then select Bring to front.

• Properties—This menu item enables users to modify the display properties for the 
selected desktop. 
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Picture Desktop
If you selected Picture screen when defining the Message desktop, the Message desktop always 
appears with a Picture window. Access events are displayed with the cardholder’s picture if you 
have set the appropriate display option in the Message filter definition (System > Message filters). 
For details, see “Message Filters Definition” on page 332.

To modify pictures display options:
1 From the Filtered Message list and Picture, select an access event, then right-click the 

cardholder’s picture.

2 From the shortcut menu, select Properties. 
 

3 From the Aspect drop-down list, select the display size for the picture:
• Design size: the cardholder’s picture will be displayed with its original size.

Send to back—This option only works when 
the window type is set to floating. It sends the 
active window (Picture window) behind the 
Message desktop main window. To bring it 
back to front, right click the Message desktop 
button, then select Bring to front from the 
shortcut menu.
34912 • Picture Desktop Performing Tasks on System Messages



Reference Manual
• Stretch —This option stretches the picture to the window size without maintaining 
proportions. The picture may appear distorted.

• Stretch ratio—This option stretches the picture to the window size while maintaining 
proportions.

4 Select the information you want to see displayed with the cardholder’s picture:
• Door: The door where the card was presented will be displayed above of the cardholder’s 

picture
• Event: The event message will be displayed
• Card information: The card information field will be displayed above the picture.
• Comment: If this option is selected, a comment field appears below the cardholder’s 

picture. The comment entered when defining the card appears in this field.
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Filtered Messages Desktop
The Filtered Messages desktop allows operators to display specific events. For example, you can 
create filters to display events that are related to a specific controller and from a particular 
gateway of the system. If this is the case, those events will be displayed in the Filtered Message 
desktop.
Filtered messages are defined in the Message filters menu: System > Message filters.

NOTE: When you use filters, the system retrieves events that are already displayed in the 
Messages desktop and filters these events according to the selected filters. 

To configure a Filtered Messages desktop:
1 From the Desktop main window, select the desktop you want to configure as a Filtered 

messages desktop.
2 Assign a meaningful name to the Filtered message desktop; then define the desktop type 

(Message window, Picture window or both).

3 You can change the Text filter, to display specific events. For details on the Filtered messages 
desktop, see “Messages List Desktop” on page 343.
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Historical Report Desktop
The Historical Report desktop allows operators to display events that come from pre-defined, 
historical reports, view the report generation state and, when available, to play video recordings 
from the EntraPass Video Vault. Security levels will determine which historical reports are 
available to each operator. 
The Historical Report message list operates the same way as all message lists in EntraPass except 
that it has an extra combo box that allows operators to select a pre-defined historical report.
Historical reports are defined under Report > Historical Report
Security levels for reports are defined under System > Security Level > under the Report tab.

To Configure a Historical Reports Desktop:
1 From the Desktop main window, click the desktop button you want to configure as a Historical 

Reports Desktop.
2 Assign a meaningful name to the Historical Reports Desktop, then define the desktop type 

(Message window, Picture window or both). 

3 Select the sort criteria you want to use to display historical data (Date and Time, Event, or 
Message Type).

NOTE: The sequential sort option is not available for archived messages.

4 You can enter a text string that will be used for searching specific archived messages (when 
applicable).

5 In the combo-box, select the historical Report you want to generate. The list of available 
reports corresponds to your security level. 
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6 After selecting the report, a Date and Time window will popup requesting a reporting date and 
time period. 

7 Enter Start and End date and time or click the calendar icon to open the calendar and select the 
start and end dates, and then type in the start and end times.

8 Check the Empty screen box process request box in order to clear the Historical Report 
message list of the previous search results.

9 Click OK. The status indicator light located at the bottom left of the screen will change from 
green to blue to indicate a historical report is being generated. It will turn green again when 
the data transfer will be completed and the historical data will be displayed according to the 
criteria you have selected.

Create and Edit Historical Reports 
• When your security level allows you to create new reports, you can access the Historical 

Report dialog from the New Report command in the Historical Report Desktop pop up menu. 
For more information on Historical Reports, see see “Defining Historical Reports” on 
page 379

• When your security level allows you to edit existing reports, you can access the Historical 
Report dialog from the Edit Report command in the Historical Report Desktop popup menu. 
For more information on Historical Reports, see “Defining Historical Reports” on page 379

To Display Historical Report State in Real-Time
This feature allows you to view the progress of report generation for a specific report in the 
Historical Report Desktop List
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1 Right-click an entry in the Historical Report Desktop window. A contextual menu will pop up.

2 Select Report State. The Report State dialog will open displaying Report generation 
information.

3 When the report is finally generated in the Desktop window, the information in the Report 
State dialog will disappear. Click Close. 
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To Play Archived Video Recordings from a Desktop Message List
1 Select the video you would like to play and right-click to access the contextual menu. 

2 If the video has been stored into the Entrapass Video Vault, the Play from Vault option will be 
enabled. Once you click on it, the Video Playback window will open and start playing the 
selected recording.
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Alarms Desktop
The Alarms desktop is used to view and to acknowledge alarm events. Alarm events are defined in 
the Event Parameter menu (System > Event Parameters). Any event can be defined as an alarm 
event. Alarm events require operator acknowledgment and are displayed in the Alarms desktop.
A schedule must be defined for all alarms (System > Event parameters, Alarm settings).When an 
alarm is generated during a valid schedule, operators have to acknowledge the alarm.
Alarms are displayed with date and time, alarm description, details, instructions (if defined) and 
associated graphic or video clip (if defined). New events are added at the bottom of the Alarm 
desktop unless you have setup the list to display in descending order (in the Alarm Desktop 
Properties dialog). 

NOTE: An Alarms desktop may be defined as a Message window, a graphic window and an 
Instruction window. These features may apply to a single desktop. When you select a desktop 
defined with these three features, three windows are displayed simultaneously. For a better 
display, you may need to resize and to position the windows. 

To define an Alarms desktop:
1 From the Desktop main window, select the desktop in which you want to display alarm 

messages, then define the window type: Floating or Desktop type.
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2 Specify the secondary windows that will be associated with the Alarms desktop: 
• Display on new alarm—Will open the Alarms desktop automatically when an alarm 

occurs. 
• Message screen—This window allows operators to view and acknowledge alarms that 

have an “acknowledgement schedule” selected in the Event Parameters definition menu 
(System > Event Parameters, Alarm settings).

• Instructions screen—This window displays the instruction that is linked to the event to be 
acknowledged (i.e. call the police, send a message to a client application, etc.). 
Instructions are defined in the System > Instructions. Then after, they may be associated 
with events.

• Graphic screen—This window will display the location of the alarm being reported (if 
graphics are defined in the system). For more information on assigning graphic, see 
“Defining Graphics” on page 180.

To view system alarm messages:
1 Select the Alarm desktop. Alarm events are displayed according to the criteria selected in the 

Sorted by field.

2 You can double-click the log area (middle of the window) to add a comment. The Add a 
comment window opens and enables you to enter text data. Once you have finished and 
clicked the OK button to close the window, the alarm event will be preceded by a + sign, 
indicating that an annotation has been added to the alarm event.

3 You may change/define the sorting order (Sorted by drop-down list):
• Sequence—alarms are sorted by their order of arrival. This the default sequence. The 

window scrolls to the end each time a new alarm is displayed.
• State—alarms are sorted according to their status (acknowledged, to be acknowledged or 

flagged). When you use this option, you interrupt the normal scrolling of events. Select 
“sequence” to go back to the default display. 
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• Date and time—alarms are sorted according to the date and time of their arrival. 
• Event—The Event messages column is sorted in alphabetical order, grouping identical 

events For example, all Input in alarm events are grouped. 
• Priority—Events are sorted by priority (as defined in Event parameter). 

4 You may right-click anywhere in the window to enable the Properties window from which you 
can enable alarm status icons:
• Red—To be acknowledged or suspended. If suspended, the suspension delay is displayed. 

When the delay expires, the operator is required to acknowledge again. If the delay is not 
expired but the operator wishes to acknowledge a suspended alarm, he/she has to click on 
the delay. The delay will be reset to zero.

• Green—Acknowledged.
• Yellow—Flagged.
• Black—Deleted. To view alarms that have been manually deleted, select the View deleted 

logs from the Properties.
• Blue—Manual log.

5 Select the Manual / Automatic buttons to toggle the acknowledgement method (automatic or 
manual). Only operators who are assigned this feature in the Operator Definition menu can 
use this option. For more information, see “Operator Definition” on page 302.

NOTE: This option (Manual automatic acknowledgement) is only available through the Alarms 
Desktop. When the operator logs out, it will return to “manual” by default.

6 Right click an alarm message to perform additional tasks on alarm events:

• Manual log—When selected, the system displays the Manual log window to allow an 
operator to add log comments, and hence to generate a customized event (with priority, 
event details, color etc.).When a manual log is added, a hand and a blue circle are added 
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beside an alarm message. These are visible when icons are enabled (right-click an alarm 
event > Properties > Show icons)

• Acknowledge—When selected, a green point is inserted beside an alarm message to 
indicate that the event was acknowledged.

• Flag—When selected, the system flags the selected event. A yellow indicator is inserted 
beside flagged events. 

• Add comment—Allows operators to enter comments concerning the selected event. The 
added comments are displayed in the bottom part of the alarm window. A blue + sign 
beside an alarm message indicates that a comment was added to the alarm message 
(visible when icons are enabled: right-click an alarm event > Properties > Show icons)

• Print log—When selected, the system prints the alarm message.
• Delete log—When selected, the selected alarm message is marked for deletion (the 

indicator becomes “black” to indicate that the log has been marked for deletion). To view 
the logs marked for deletion, before you actually purge them, right click anywhere in the 
window and select Properties then select View deleted logs.

• Purge deleted log—Select this option to permanently remove logs that were marked for 
deletion. 

Displaying Alarm Desktops Automatically
EntraPass enables users to display graphics automatically - from any desktop - as soon as an alarm 
occurs.This feature enables operators on duty to automatically view new alarms without having to 
open the alarm desktop and secondary windows associated with it. If Display on new alarm is 
checked the alarm desktop (and its secondary windows) will be displayed as soon as an alarm 
occurs regardless of the active window.
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To display the alarm desktop automatically:
1 Define a desktop and customize it as an alarm desktop: for this, you have to check the items of 

the Alarms desktop section.

2 Check the Display on new alarm option so that operators can automatically view new alarms 
without having to open the alarm desktop and secondary windows associated with it. 

NOTE: If this option is checked and if an operator calls up the alarm desktop, the desktop icon 
background color turns blue, indicating that the alarm and its secondary windows are 
displayed when a new alarm occurs. If however this option is selected when defining a 
Filtered message desktop for instance and if the desktop icon is selected, the filtered 
message desktop will be displayed (the background color of its icon turns blue), but the 
windows below the Display on new alarm section will not be displayed; they are only 
displayed when a new alarm occurs. If those windows are displayed (on new alarm), clicking 
the “X” in the top right hand corner of one of them will close all the open windows. If Display on 
new alarm is not checked, the alarm desktop and all its secondary windows will be displayed 
on call (that is, when the alarm desktop is selected).
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3 Click OK and Go for your configuration to take effect immediately.

NOTE: When you define a desktop as an alarm desktop to be displayed on new alarm, it is 
recommended to reopen the Automatic Alarm Display desktop, to position its windows the way 
you want them to appear, then to click OK and GO again. This way, it will appear exactly as 
you have defined it. 

Acknowledging Alarms/Events
Usually, operators have to acknowledge receipt of an alarm condition (event—such as intrusion, 
input in alarm, etc.) by responding in some way such as depressing an acknowledgment button. In 
EntraPass, operators acknowledge alarm messages from an alarm warning box or from the Alarms 
desktop window. 

NOTE: A sound can be added to alarm events. For more details about setting options for an 
alarm sound, see “Setting up Multimedia Devices” on page 413.

Acknowledgement options are setup in the EntraPass application definition (Devices > EntraPass 
application (selected Workstation) > Message 2 of 2 tab, Acknowledgement parameters). Events 
that require operator acknowledgment are defined in the System > Event Parameters. 

NOTE: If the component that is in alarm is assigned to a video view, the video view or video 
recording is automatically displayed when an alarm occurs. 

Automatic Acknowledgement
Alarms can be automatically acknowledged without operator intervention. This option is enabled 
in the Operator definition menu (System > Operators > Privileges, Auto acknowledge).

NOTE: Only operators granted the appropriate access privilege should be using this option. If 
the Automatic acknowledge feature is used, the alarm message box is not displayed; therefore, 
it will not be possible to suspend alarms. If this option is enabled in the Operator definition 
menu, the Manual button is added to the Alarms desktop. This button toggles between Manual 
and Automatic acknowledgement. 
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To acknowledge an alarm message:
1 When the Acknowledgement required message box appears, take one of the following actions:

• Click the Acknowledge button to acknowledge the displayed alarm event. The red status 
button turns green once an alarm is acknowledged.

• Click the Suspend button to suspend alarms while doing other operations in the system. 
The alarm will be suspended for the delay time specified in the EntraPass application 
definition menu. Once the suspended alarm delay time expires, the system prompts the 
operator to acknowledge the alarm.

• Click the Flag button if you want to acknowledge an alarm message, and if you want to 
identify it for future reference. A flagged alarm is identified by a yellow button. 

• Click the Mute button  if you want to stop the alarm sound.

NOTE: The Acknowledgement required message box will be presented in a format without the 
Instructions window if there are no instructions associated with the alarm message.

NOTE:  If the component that is in alarm is assigned to a video view, the video view or video 
recording is automatically displayed when an alarm occurs. 
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Acknowledging Alarms from the Alarms Desktop 
1 Select the alarm event you want to acknowledge (one that has been flagged, for instance), 

Right-click to enable a shortcut menu.

2 Select Acknowledge from the sub-menu. The status indicator becomes green. 

NOTE: To tag an alarm message for specific purposes, select the alarm event you want to 
identify; right-click and select Flag from the sub-menu. You can also click an alarm message 
until the color of its status indicator changes to the desired color. 
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Instruction Desktop
The Instruction window displays the instructions to follow when an alarm is reported. 
Instructions will only be displayed if this option is enabled during the Event Parameters settings 
(System > Event parameters, Alarm settings).
To view an instruction about an alarm message:
1 You may view instructions about an alarm by selecting the Alarms desktop defined as a 

message and an instruction window, or defined as an instruction window. When a desktop is 
defined as being both a message window and an instruction window, the two windows are 
displayed at the same time:
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2 You may also view an instruction about an alarm by selecting an alarm message and right-
clicking it. 

 

NOTE: This feature is very useful when the Alarms desktop is too small to display the entire 
description of an event. 
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Graphic Desktop
The Graphic desktop displays the graphical location of the alarm being reported (if graphics are 
defined in the system). A graphic corresponds to the secured area of the system where components 
(EntraPass application, controllers, inputs, relays, etc.) are located on a site. 
With graphics, operators can easily view the exact location of a component installed on a site, or 
the status of components and devices such as doors, contacts, motion detectors, controllers, 
assigned to the graphic. Operators can perform manual operations directly from the displayed 
component (for example lock/unlock a door). To define interactive floor plans, see “Defining 
Graphics” on page 180.

To view graphics in the Graphic desktop:
1 Right click the desktop icon you want to assign to graphic, name the desktop (Graphics, for 

example), then define the window type (Floating or Desktop). 
2 Click OK and Go to display the Graphics desktop.
3 Right click anywhere in the Graphic desktop, then, from the shortcut menu, select the graphic 

you want to display. 

NOTE: If the window is smaller than the graphic size, you can click-hold-and-drag the graphic 
to move it around within the Graphic window.

4 You may right click anywhere in the graphic to enable a shortcut menu in order to:
• Adjust the display size of the selected graphic (Fit to screen, Design size or Picture size.
• Select Auto result for the system to display a message indicating the cause of the 

communication loss in case of communication failure. If Auto result is not selected, 
operators will have to manually request the results for the component by using the Show 
result.
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5 Right-click a component in abnormal condition to enable a sub menu:
 

NOTE: Components in alarms are represented by their animated icons. Selecting an animated 
icon and viewing its parent components allows operators to learn more about the “alarm 
condition”.

6 Select Full status from the shortcut menu to display the error list related to one or all the 
components in alarm.

7 Select the Double click menu item to allow operators to modify the status of a component in 
alarm from the Graphic desktop. For example, if the displayed component is a door and if the 
Double click menu item was set to Unlock, an operator can manually open the door from the 
Graphic desktop.

NOTE: When you modify the Double-click feature via the Graphic desktop, the system does not 
save the modifications. Modify the default Double-click feature via the graphic definition 
(Definition > Graphics, Design window, right click a component > Default dblclick menu item). 
For more information on how to create graphics and on how to assign components to 
graphics, see “Defining Graphics” on page 180.
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Network Alarms Desktop
The Network Alarms desktop is used to view all the alarms in the system. Only events that require 
operator acknowledgment and that are programmed in the Event Parameters menu are displayed in 
the Network Alarms Desktop.

NOTE: Network Alarms are available on all workstations of the system. By default the server 
sends network alarms to all workstations at startup. If you do not want the system to 
automatically send network alarms, use the No reload on startup option (Devices > EntraPass 
application > Message 2 of 2 tab). This option is useful when the connection between the 
workstation and the server is slow. 

Operators will only be authorized to view network alarms that were sent to the Applications that 
are selected in their security level definition menu.

To view network alarms:
1 Select the Network Alarms desktop. 

2 Right click anywhere in the window to enable a shortcut menu:
• Refresh: this options allows operators to load new alarm messages in the Network alarms 

desktop. The Refresh menu item is particularly useful when the server does not load 
automatically network alarm at startup; that is, when the No reload network alarms on 
startup option is checked in the Workstation definition menu (Devices> Workstation > 
Messages 1 of 2 tab). 

• Print log—When selected, the system prints the alarm message.
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• Delete log—Purges alarm records from the system. When you select this option, the 
Delete network alarms window appears. You can then specify the Deletion option 
(selected, all or custom messages). 

NOTE: To limit the number of records kept in the alarm database, use the Maximum records in 
system logs: Options > Server parameters > Server tab). This option is used for the server and 
workstation alarm message databases.
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Video Desktop
If the Video feature is enabled in EntraPass, you can configure a desktop as a Video desktop. 

To define a Video desktop:
1 Form the Desktop menu, right-click a desktop to bring up the Desktop properties window.
2 In the Desktop name field, assign a name to the new desktop.
3 Select the window type for this desktop.
4 Check the Video window option.

To use the Video Desktop:
1 In the Desktop window, select the desktop defined as the Video desktop.The Video display 

window appears.
2 Select an icon (in the lower part of the window) to determine for instance the size of the views 

or to display the Panel window (a small window associated with the video display). 

The following table shows the available options:

View Icon Description

Large. This view sets the window to 1024x768 pixels

Medium. This view sets the window to 800x600 pixels

Small. This view sets the window to 640x480 pixels

Tiny. This view sets the window to 400x300 pixels.

Creates a new video view

Shows panel window
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Video playback custom buttons. These buttons appear in the lower part of the 
Video desktop when the operator who is logged on was assigned specific 
permission for viewing and generating video events. This custom buttons offer 
a fast way for viewing or generating video events. 

Edits the current video view

Shows the help related to the Video desktop

Closes the Video window

View Icon Description
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Video Server Status
EntraPass offers the ability to display parameters of the video devices connected to the Video 
server. Operators can for example view information related to network data transfer (images and 
digital sounds).

NOTE: Installing and using the Video feature may take a great amount of your company 
network bandwidth (LAN or WAN). The network administrator may control the use of the 
network bandwidth for Video transfer.

To view the Video Server full status:
1 From the Graphic desktop window, right-click the Video Server icon to display a shortcut 

menu.
2 From the shortcut menu, select Full status to display information about the video server status.

NOTE: The content of the Full Status window depends on the video server associated with 
EntraPass. The following list provides a short description of the displayed fields.

 

Item Description

Unit name The network name of the remote DVMS system (Intellex in this example). The 
Unit name is followed by the DVR IP address
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Unit type The type of the unit. can be Intellex, Iris (network client), etc.

Schedule 
mode

The current schedule mode of the remote DVMS unit. It indicates how images 
are recorded by the DVR installation. The values for this field can be: 
• Regular (regular schedule)
• Single (only a single camera)
• Custom (a custom schedule has been set by the operator).

Recording in 
progress

The active record statue of the remote DVMS unit. Values can be: 
• True: is recording
• False: is stopped.

Time span 
(h:mm)

The time interval (in second) between the oldest and newest images in the 
database.

Unit version The official version of the DVMS unit. 

Number of 
cameras

The number of cameras connected to the Video server. The source of the 
video data is generally a camera, but it may also be a television station or 
other video source.The value varies from 0 to 16. 

Record mode The record mode can be linear or circular
• (Linear: if you select this option, the recording will continue 

uninterrupted until the available space is finished; 
• Circular: if you select this option, the DVR will notify the operators 

before the recording space is completely filled. The operator will then 
choose to continue the recording or to stop it. By default, the recording 
mode is set to Circular.

Recording 
mode

The recording standard of the remote unit. The recording standard depends 
on the area.Values can be: 
• NTSC: the NTSC standard is mainly used in America and in many Asian 

countries such as Japan and South Korea or 
• PAL: the PAL standard is mainly used in Germany, Great Britain, 

China, Australia and Brazil.

Estimated 
remaining 
images

The estimated number of frames that may still be recorded in the video 
database before the DVMS unit space is completely filled. This option is only 
useful if the recording mode is linear.   

Interface 
version (API)

Indicates the version of the application interface between EntraPass and the 
selected Video server.

Item Description
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Number of 
audio

The number of audio streams available of the video server unit. The source of 
the audio data is generally a microphone, but may be another audio source.

Record rate The rate code value. This value indicates the aggregate recording rate for the 
DVR unit in number of frames per second. The value can be: 1, 2.5, 7.5, 15, 30, 
60, 120, other value.

Total number 
of images

The total number of images in the remote unit’s database.

Version 
compatibility

Compatibility between the versions of the DVR unit and the application 
interface used.

Number of 
text

The numbers of text data streams available from the DVMS. The text data 
source may be a cash register or other device.

Item Description
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Chapter 13 • Reports
EntraPass software allows users to define and generate reports. These reports may be generated 
automatically or requested manually. Reports can be sent by e-mail. 
There are three types of reports:
• Quick reports: these are based on selected group of events (i.e.: door, controller, etc.) and 

event types (normal, abnormal, etc.) 
• Historical reports: these are historical and card use reports. The historical report type contains 

archived and filtered events, whereas card use reports contain events related to card use. 
• T & A reports (Time and attendance): these are defined according to selected doors and cards 

defined as time and attendance.
From the Report toolbar, EntraPass users may also:
• View reports— this feature allows an operator to preview and to view report details, or to 

print pre-defined reports.
• View Report states—this features allows an operator to view the status of all reports in 

execution. 
• Perform Manual operations on Time and attendance reports to add, insert, and delete Time and 

attendance entries.
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Defining a Quick Report
The Quick report feature offers a rapid method of creating reports for certain types of events. For 
example, it is possible to create a report regarding all abnormal or normal access events in just a 
few seconds. 
Quick report files may be viewed using the EntraPass Quick Viewer, a utility that allows users to 
display Quick report files and all.QRP files. These include report files that are saved from a report 
preview. The Quick Viewer is launched from Windows Start menu, without the need to launch the 
software. 

To define a Quick Report:
1 From the Report toolbar, select the Quick report request icon.

2 From the Event drop-down list, select the event type for the current report (access, controller, 
door, relay, input, operator, manual operation events, etc.). If you have selected “access 
events”, the Card tab appears in the window.

3 Among the Event type options, select the event type to be included in the report. 
• Normal—Quick report can create reports based on normal events. In an access report, 

normal events would be such events as “access granted” for instance.
• Abnormal—Such events as access denied (bad access level, supervisor level required), 

workstation server abnormal disconnection, gateway communication failure, or all events 
related to a process that is not complete (a controller reload failure, for example), are 
considered abnormal. 

• Normal & abnormal—Select this option to include normal and abnormal events in the 
report.
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• Custom events—Select this option to include your own events. The Custom tab appears 
when the Custom events option is selected. This option allows the operator to selects the 
components that have generated the selected events according to the setting in the “event” 
field. 

NOTE: When you use the Event field, you have to specify which component(s) should be used 
or not used. Once you select an event (i.e. access), the system displays all the doors of the 
gateway. If you select Controllers, the system displays all the controllers for the gateway. 
Once you have selected an event (i.e. controller events), select the controllers (i.e. list of 
controllers) to be included in the report.

4 Select the Card tab to specify filter details about the report. The Card tab appears only if a 
card-related event is selected.

5 In the Card index drop-down list, specify the information that will be used as the filter. For 
example, if you select “card number”, only access events in which the defined card numbers 
appear will be selected. 

NOTE: If you select Card number, the Lower and Upper boundary editable fields display the 
default numerical values to be replaced by card numbers. If you select Card user name, these 
fields are enabled to receive text data. For example, you can enter A in the Lower boundary 
field and F in the Upper boundary fields for the system to include events in which the selected 
door is defined and events in which the defined card numbers appear but only for card users 
whose names begin with A to F. If you select All, the editable fields are disabled. 

6 In the Report name tab, enter a name for the report (this name will be displayed on your 
report).

7 In the Start/end date tab, enter the date and time on which the system will start to collect the 
events. For example, if you enter 7:00 and an event occurred at 6:00, this event will not be 
included. To target events that occurred during a specific time frame, use the Time period tab.

8 In the Time period tab, check the Specific time frame option to include events that match the 
specified time frame. Enter the target time for the report.

9 If you want to overwrite the previous file, select the Miscellaneous tab then check Overwrite 
existing output file. If you do this, the existing default output file will be replaced by this new 
one. 

10 Define the output parameters: 
• Database output type: Select the database output format (Paradox, Dbase IV, or.CSV). 
• Directory—Indicates where the report is saved and stored. The default folder is: 

C:\ProgramFiles\Kantech\Workstation_CE \Report\your file.xx
• Output filename—Indicates the output file name. By default, reports are saved on disk in 

C:\ProgramFiles\Kantech\Workstation_CE \Report\your file.xx. The report filename is 
composed of the date and time on which the report was created. You can modify the 
filename if necessary, but do not modify the extension. 

• Database output process—Select the appropriate output processes. A report template is 
associated with each output. 
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• Database only (the report will be saved in the system database)
• Display historical report (the report will appear on-screen)
• Report printed (sequence, date or events) (the report will be printed according to the 

specified sort order)
• E-mail historical report: the report will be sent by e-mail to a specified valid e-mail 

address.
• Send to workstation—Select the workstation to which the quick report should be sent.The 

list contains all applications defined in the system.
11 Click the Execute button to launch the report. To view the report, select the View report tab.
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Defining Historical Reports
The Historical report definition feature allows users to define customized historical reports and 
card use reports with their own automatic execution parameters. 
Reports that are defined with automatic settings are automatically generated at the specified time. 
However, they may be requested manually when needed. The “Historical Report Request” menu 
enables operators to trigger reports by overriding automatic settings. When requested manually, 
automatic settings are ignored.

Defining a Default “All events” Report
You may generate a default report that will include all events. The default report is an Historical 
report type. EntraPass enables you to send an automatic report by e-mail.

To generate a default “all events” report:
1 Select the Historical report icon from the Report toolbar. The Historical report window 

appears.
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Requesting an “All events” Report
1 Select the Historical Request icon from the Report toolbar. The Historical report request 

window appears.

2 Specify the Start and End time. By default, the end date and time are set to the system time. 
3 You may specify the output parameters or leave these to default. 

NOTE: It is important to know the differences among the output type and processes. For 
details, see “Defining a Report Output Format” on page 389.

4 You may select the Report state icon from the toolbar to view the report status.
5 Select the View report icon from the toolbar to view the report. The default report name is 

YYYY_MM_DD_-HH_MM_SS.db.
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Defining a Custom Historical Report
To define event parameters for an Historical report:
1 From the Report window, select the Historical report icon. The Historical report window 

appears.

2 To create a new report, click the New icon (in the toolbar) and enter the necessary information 
in the language section. The Report type field shows the selected/created report (Historical or 
Card use report). To modify an existing report, select it from the Report drop-down list. 

3 You may check the Select all events option. All the listed events will be checked and included 
in the report. You may choose to check specific events that you want to include in the report. 

4 If you are creating a Historical report type report: from the Report type drop-down list, select 
Historical report. This is the first filter for the report. The selected report will show events such 
as access granted events (with the time, the door that was accessed, as well as the card 
number). 

5 If you selected the Historical report type, you have to select components associated with the 
event. The Components tab appears in the window when the selected report is an Historical 
report type.

NOTE:  When you select Historical report and when a filter mode is selected (Filter mode drop-
down list), the system displays additional tabs, the Components and Cards tabs. The Card tab 
is also displayed when “Access” events are selected. 

6 Check the Overwrite existing output file option if you want the system to replace the existing 
output file each time the report is automatically generated according to the settings defined in 
the “Automatic report schedule”.
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7 Historical Reports Only. Select the Filter mode if you want a report from specific components. 
These filters are used to target specific events that were generated from selected components. 
You can select various filtering methods. When you use this field, you have to specify which 
component(s) to use. 

8 Historical Reports Only. If you selected Historical report, check the Specific time frame option. 
If selected, the time frame specified will be used by the system. Only events (event time) that 
are within this specific time frame will be included in your report. For example, if you define 
8:00 to 8:30, only events which occurred during this time frame will be included in the report. 

9 Select the Automatic report schedule tab to specify details about the report. For details about 
defining an automatic report, see “Defining Automatic Report Schedules” on page 385.

To define components for an Historical Report 
If the selected report is a Historical report type and if you have selected a Filter mode, the 
Components and Cards tabs appear next to the Event parameters tab. You have to specify the 
components and filters that may affect the report. 

To specify components for a report:
1 From the Historical report window, selected the Components tab. The Components window 

lists all the component types that have a direct link with the selected events. 

2 Select an event type to display its items in the right-hand pane. If you select Card type, the 
right-hand pane displays all the card types defined in the system. If you select Doors, all the 
access system doors are displayed in the right-hand pane.

NOTE: If an item in the left-hand pane (Selected components) is selected, its color changes 
(turns red). When it is deselected, it resumes to the default color.
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To define card options for an Historical report: 
1 From the Historical report definition window, select the Card tab. It is displayed only when 

access events are selected. It is used to add more filters to your report in order to target 
specific events.

2 Select the All Cards option to include all cards. When you do this, the other fields are disabled. 
When you select the Use card type as filter option, you can add filters for your report. You can 
view the fields that are included/ excluded as filters and specify a lower and upper boundaries 
for each selection. 

3 Specify the information that will be used as a filter (Filter index drop-down list). For example, 
if you select “Card number”, as the filter index, only access events in which the defined card 
numbers appear will be selected.

4 From the Filter mode drop-down list (None, Include, Exclude), specify if the system should 
exclude or include the value range that you specify in the Upper/Lower boundary fields. When 
a filter mode is selected (Exclude or Include), the “Boundary” fields are enabled.

5 Enter the value range in the Upper/Lower boundary fields according to the selection in the 
Filter mode field. These may be, for example, alphabet letters (if the filter index is by names; 
or numeric, if the filter index is by card number). You could, for instance, use the card user 
name and specify A to F in the Upper/Lower boundary as the lower and upper boundaries. As a 
result the system will include events in which the selected door is defined and events in which 
the defined card numbers appear but only for card holders whose names begin with A to F. 

NOTE: Users may select more than one filter for the same report using the filter index. Events 
will be filtered n times depending on how many filter indexes are defined for the report. 
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Defining a Card Use Report
The card use report feature is used to create reports that will list cardholders who did/did not 
generate events since a specific number of days or a specific date. For example, operators could 
request a report including “access granted” events that were generated since a specific date. 

NOTE: When you select a card use report option, the Use definition tab appears in the 
Historical report window. It allows you to define the card use parameters, such as: used since 
a specific date, not used since 30 days before today, etc.

The system displays five event types:
• Access denied (bad location, bad access level, bad card status, etc.)
• Access granted
• Database (events that have affected the database, such as card definition modified)
• Time and Attendance events (entry, exit).

To define a card use report:
1 From the Historical report window, select a report from the Report drop-down list. If you are 

creating a new report, click the New icon in the toolbar, then enter the necessary information 
in the language section.

2 The Report type drop-down list, displays Card use report if the selected report is a Card use 
report type. If you are creating a new report, select Card Use report. When the selected report 
(in the Report drop-down list) is a Card use report type, only events related to card use are 
displayed in the left-hand pane.

3 You may check the Select all events option (when it is checked the display pane is disabled), 
or you may select only the events you want to include in the report.
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4 You may check the Overwrite existing output file option, to replace the existing card use report 
every time you generate a new one. You may keep the default target folder.

5 You may also check the Process separately option if you want the events to be processed 
individually for each card. For example, if you want a report for “Access denied events” and 
“Access generated events”, if you do not check the Process separately option, the report will 
contain all these events. When the Process separately option is checked the report will display 
Access granted event and Access denied events separately.

NOTE: The Process separately option appears only when the report type is a Card use report.

6 Select the Use definition tab to specify the card use options (Not used since or Used since) and 
target periods. 

NOTE: The Use definition tab appears only when the selected report type is a Card use report.

7 To define the target period, check the From checkbox and enter a date in the From field. You 
may select a date in the calender when you click the Calender button. Alternatively, you may 
use the up/down controls or enter the Number of days back, starting from today’s date.

8 When you have finished defining the report, save it. You may request it using the Report 
request button in the Report toolbar.

Defining Automatic Report Schedules
For both Historical and Card use reports.
Use the Automatic report schedule tab to define automatic settings for your reports so they can be 
automatically generated when needed. These settings indicate:
• The frequency: when the report should be generated (none, weekly, monthly, once) 
• The time period covered
• The output process (display, print, etc.) 
• The output type (dBase, Paradox, CSV) 
• The destination (workstation) 
• The language and the filename
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To define an automatic report schedule:
1 From the Historical report window, select the Automatic report schedule tab. 

2 From the Schedule mode drop-down list, select the frequency at which the report should be 
executed:
• Select None if you want the report to be manually requested (see Historical Report 

Request).
• Select Weekly if you want a report every week. You have to check the day on which the 

report should be executed automatically.
• Select Monthly if the report is needed once a month. You have to specify the day (ex. the 

second Friday of the month or the 15th day of the month) when the report will be 
executed automatically.

• Select Once if you want the report to be executed automatically on a specified date.
3 In the Start at this time field, enter the time at which the system will start executing the report.
4 Specify the Scheduling parameters Only for Historical Reports.

NOTE: These settings are ignored when the report is requested manually by an operator.

• Start this many days back—The report will start collecting events according to the number 
of days specified in this field. It is based on the present date.

• Start at this time—Once you specify the amount of days, specify the starting time (i.e.: 
7:00am). For example, if you enter 7:00, events that occurred at 6:00 will not be included 
in the report. 

• Stop this many days back—The report will include the specified number of days entered 
in this field. It is based on the present date.
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• End at this time—Once you specify the number of days, specify the ending time (i.e.:5:00 
pm), that is, the day on which the system will stop collecting data; you may also specify 
the time at which it will stop. For example, if you enter 7:00 and an event occurred at 
8:00, then this event will not be included. To target events that occurred during a specific 
time frame, you have to use the Specific time frame option.

NOTE: The start and end time are only used for the first day and last day, for example if you 
start collecting events on Monday at 8:00 and end on Friday at 17:00 all events between 8:00 
Monday and 17:00 Friday will be included. The system does not use the start and end time for 
each day but for the whole period.

To specify additional options for an automatic report:
1 Select the More button to add more settings to the automatic scheduled report. When you click 

the More button, the Automatic report output definition window appears.

2 From the Output type drop-down list, select the output format of the report. You may choose 
Paradox, Dbase IV, or CSV formats. 

NOTE: From the Database output process, you can select E-mail historical report if you want this 
report to be automatically sent to specified recipients. If you choose this option, select the E-
mail tab to enter the recipients’ e-mail address in the Send E-mail to field. EntraPass enables 
you to protect the report by a password before e-mailing it. 

3 You may check the Automatic filename (...) option. The default file name is YYY_MM_DD-
HH_MM_SS.X, indicating the year_ month_ day-hours, minutes_second.file extension. 

NOTE: For details on the output type and the output process, refer to the table below. It gives 
a comparison of the different report formats.
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The following table shows the difference between these database formats and their output file 
formats:

4 Refer to the following table for information on the editing tools compatible with the output 
files. Only.db file formats can be edited.

Database Description .db .rdf .csv

Paradox In addition to the traditional.db,.rdf output formats, 
the Paradox database generates 
the.px,.xg0,.xg1,.yg0,.yg1 files. These contain the 
indexes and are useful when using a “Paradox” 
database. They can also be used by the database 
administrator.

 X X X

Dbase IV A popular database management system format for 
storing data that is supported by nearly all database 
management and spreadsheet systems. Even 
systems that do not use the DBase format internally 
are able to import and export data in Dbase format.

X X -

CSV Will save the report in a comma separated values 
format (yourfile.csv). A data format in which each 
piece of data is separated by a comma. This is a 
popular format for transferring data from one 
application to another; because most database 
systems are able to import and export comma-
delimited data.

- X

Output file Paradox Dbase IV CSV

.db, Editing tool dBase IV, dBFast, MultiEdit, 
DbVista, Paradox, SmartWare 
and XtreeGold.

dBase III, IV, FoxPro, 
dBFast, DataBoss 
and Excel.

 -

.csv, Editing tool - - Excel, NotePad, 
WordPad, etc.

.rdf, Viewing tool EntraPass tool (Borland 
Database Engine)

EntraPass tool 
(Borland Database 
Engine)

NotePad
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5 From the Output process drop-down list, select the report template. It will be used with the 
requested report. For details on the output format, see “Defining a Report Output Format” on 
page 389.

Defining a Report Output Format

Historical and Card use reports
1 If you select Database only (CSV, Paradox and Dbase): The report will include the following 

information: event sequence, date and time, event message, description types (displays a 
specific number that identifies a component in the system), description names (displays the 
name of the component as defined in the system—name of description type number) as well as 
the card number (for card-related events). 

NOTE: A database only report is saved in the reports folder in the specified format. It will not 
be printed nor displayed.

2 If you select Display Historical report - Display card last transaction report (Paradox Only): The 
report will automatically be displayed on your desktop when completed. You can customize 
the report before you print it manually. For more information on how to customize the report, 
see “Previewing Historical Reports” on page 403. The report will include the following 
information: event sequence, date and time, event message, card number (for card-related 
events) and descriptions 1 to 4 which contain details on the event. 

3 Report printed by sequence (Paradox Only): This report is sorted by event sequence number 
(order in which they were generated by the system) and printed automatically at the printer of 
the destination workstation.

4 Report printed by date and time (Paradox Only): This report is sorted by date and time and 
printed automatically at the printer of the destination workstation.

NOTE: The printed reports (option three and four) will be saved in the reports folder in the 
specified format. They will also be printed but not displayed.

5 Report printed by event (Paradox Only): This report is sorted by event message 
(alphabetically) and printed automatically at the printer of the destination workstation. The 
report is saved in the reports folder in the specified format, but not displayed.

Time and Attendance Reports
Time and attendance reports will be saved in the reports folder, they are not printed nor displayed. 
User have to manually retrieve the report to view it, they can also use the “View Report” menu.
1 Single file with all data (CSV only): The report is generated in one file containing the data and 

the descriptions (date & time, transaction ID, card number, card user name and door 
description).

2 Database with transactions (CSV, Paradox & DBase IV): The report is generated with all the 
data and transactions in one single file. It includes the date & time, the transaction ID, the card 
number and the card user name. 
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3 Display time and attendance report (Paradox only): The report will automatically be displayed 
on the desktop when completed. You can customize the report before you print it manually. It 
contains: the card number, card user name, entry time, exit time, contents of the card 
information field as selected in report definition and total hours per cardholder. For more 
information on how to customize the report, see “Previewing Time and Attendance Reports” 
on page 404. 

4 Two (2) databases with all data (Paradox & DbaseIV): the report will be generated in two 
separate files: 
• One file containing: date, time, event message (transaction type), pkcard, pkdoor, 

pkdoorgroup.
• One file containing: pk description (explaining pkcard, pkdoor and pkdoorgroup), card 

number, object and contents of card information field selected in the report definition 
menu.

NOTE: Pk refers to a component unique number within the system

5 Single database with all data (Paradox & DbaseIV): The report will be generated in one file 
containing the data and the descriptions (date and time, transaction ID, card number, card user 
name, door description and sequence).

6 CSV compilation time and attendance (CSV Only): The report will be generated in two files. 
One file containing a total, of hours for instance, by department, and the other file containing 
detailed information. Depending on the number of days covered by the report, a “day” column 
will be reserved for each day.
• Automatic filename—Select this feature if you want the system to automatically use the 

date and time as the filename. You cannot use the “overwrite existing output file” when 
you use this option. 

• Filename—If you wish to overwrite the same report (for example—every week), you can 
enter a filename here and when the report will be executed according to specifications, the 
new report will replace the oldest report. 

• Destination: this is where the report should be sent/printed automatically.You can also use 
the Overwrite existing output option to specify a different destination file.

• Report language—This field is used to include additional information in your report. 
Select from the displayed list.
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Requesting Historical Reports 
With this feature operators can request pre-defined Historical reports or Card use reports that were 
created using the Historical Report menu. Operators can also e-mail the report to one or multiple 
recipients.

NOTE: If your report contain automatic settings, these will be ignored. You must indicate new 
settings.

To request Historical reports manually:
1 From the Report toolbar, select the Report Request icon. The Report request window appears.

2 In the Report list display pane, select the report that you want to execute.
3 You may define output parameters, including the database output type, the target folder, the 

output filename, etc. For more information on how to select an output format, see “Defining a 
Report Output Format” on page 389.

NOTE: If a Card use report is selected, the “Date and time” section is disabled. 
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4 Click . A system message informs you that the report is being processed. The 
Report options window appears and is then minimized to the task bar.

5 Select the Preview button to define the report and filter options. This will increase the 
readability of the report by adding, for instance, alternating band colors, framing events, icons 
in the reports, etc., or by sorting events in the report (by event ID number, alphabetical order 
or date and time). (TO check)

6 Enter the description in the Search description field. The report is updated in real-time when 
you enter a filter option. 

7 You may use  to preview the report or the Properties button to view details about the 
report. When you click the Preview button, the system will display the result of the report. 
From that window, you can save the report (in a.QRP format) or print the report.
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Defining Time and Attendance Reports
This feature is used to define customized time and attendance reports with automatic execution 
parameters. 

NOTE: Reports can be defined with automatic settings so they are generated when you need 
them or can be requested manually using the “Time and attendance report request” icon. 
When requested manually, automatic settings are ignored.

To define Time and attendance reports:
1 From the Report toolbar, select the Time and Attendance icon.

2 If you select the Doors option, only the doors defined as “Time and attendance” doors (in the 
Door definition menu) are displayed. Check the View deleted doors to add deleted doors to the 
list. When you select the Door group option, the View deleted doors option is disabled. The 
system displays the door groups of your system; then you may select one.

3 Check the Overwrite existing output file option if you want the system to replace the existing 
file. If you leave this option unchecked, the system will create another output file.
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4 Select the Card tab to add other filters for the report. 

NOTE: The Card type tab appears if the Use card type filter box is checked.

5 Select a filter index, then select a filter mode (None, Include, Exclude). If you have selected a 
filter index, select the filter mode and enter the value range in the Upper/Lower boundary 
fields. To include all the fields, leave the filter mode to None. For example, if you select Card 
number as the Filter index, leave the filter mode to None so that all events triggered by cards 
will appear in the report. 

6 To add information in the sort criteria, select an item from the Additional information drop-
down list. 

NOTE: Repeat these steps for all the card information fields that are listed in the filter index 
field. You could use the card user name and specify A to F in the Upper/Lower boundary fields 
for the system to include events in which the defined card numbers appear but only for card 
users whose names begin with A to F (G and up will not be included even if the card number 
is included in the range).

7 Select the Card type tab if it is displayed, then specify the Card types that will be included in 
the report. This tab appears if you have checked the Use card type filter option. 

8 Select the Automatic report schedule tab to specify information for automatic reports. For 
details, see “Defining Automatic Report Schedules” on page 385.

9 Select the Rules tab in the Time Report window to define the rules of time and attendance in 
employee time reports. Rules can be created to define periods of time as specific values. For 
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example, all employee entries between 7:50 AM and 8:15 AM can be defined as the value of 
8:00 AM on reports.
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Requesting Time and Attendance Reports (T & A)
The Request Time and attendance reports feature is used to request the pre-defined Time and 
attendance reports that were created using the Time and Attendance Report Definition menu. This 
feature is useful when you want to override automatic settings.

NOTE: If the report contains automatic settings, these will be ignored. 

To request a T and A report manually:
1 From the Report toolbar, select the Time report request icon. The Time report request window 

appears.

2 From the Report list display pane, select the Time and Attendance report that you want to 
execute.

3 Specify Date and time as well as the Output parameters.

4 Click to trigger the report.

NOTE: The Time and Attendance report is automatically saved in the output folder of the 
Application selected in the Send to workstation field. For the Paradox output type, the system 
displays a report preview window. For other output formats, you will have to retrieve the report 
manually since it is not printed or displayed. To view all the reports that have been generated, 
use the View report button in the Report toolbar. For details on reports output formats, see 
“Defining a Report Output Format” on page 389.
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Manual Operation On Time and Attendance 
Use the Manual operation on Time and Attendance feature to manually insert, add or delete Time 
and Attendance transactions in the database. This feature is useful for an organization using the 
Time and Attendance feature for the payroll system, for instance. 

To add transaction in the Time and attendance database:
1 From the Report main window, select the Manual operation on Time and Attendance icon.

2 Enter the Card number for which you want to modify the Time and Attendance transactions, 
then click the Load button. If you do not know the number, use the Find button. 

NOTE:  The card number field is mandatory to start loading.

3 Select the View deleted transactions option if you want to view the transactions that were 
previously deleted. Deleted transactions are marked with an “X” in the Delete column. 

4 Check the Find deleted cards option if you want to find the deleted cards. This does not apply 
to entries that were added manually.

5 Specify the Start date, the day on which the system will start to collect the events, by clicking 
the Calender icon and selecting a specific date. Only events that occurred on this date and after 
are displayed. 

NOTE: The Start date is mandatory to start loading.

6 Specify the End date, that is the day and time on which the system will stop collecting events. 
Only events that occurred on the specified date and before are displayed. If you do not specify 
an end date, the system will include all the data up to the present day time.

7 In the Site drop-down list, select the appropriate site to view the Time and Attendance doors. 

NOTE: The Gateway is mandatory to start loading.
39713 • Manual Operation On Time and Attendance Defining a Report Output Format



Reference Manual
8 You may check the All Doors option, then all the doors displayed under this field will be 
selected. You may also select specific doors. All the Time and Attendance events that were 
generated for the selected doors will be displayed.

9 Check the View deleted doors option so that even doors that are no longer defined as time and 
attendance doors (but that have been defined as time and attendance) will be displayed. 

NOTE: Doors are mandatory to start loading.

10 Enter the necessary information in the transaction table. The transaction table displays the 
transactions for the selected cardholder:
• The Delete column indicates transactions that have been deleted (if the View deleted 

transactions option is checked). These are identified by an X.
• The Date column indicates the date on which the transaction occurred. Use this field to 

specify the date when you manually insert a new transaction. 
• The Time column indicates the time at which the cardholder entered or exited an area. Use 

this field to specify the time (entry or exit) when manually inserting a new transaction.
• The Transaction column indicates the transaction type. For every entry transaction, there 

should be an exit transaction. 
• Entry—indicates that this is an entry transaction generated when a cardholder 

presented his/her card at a door defined as entry.
• Exit—Indicates that this is an exit transaction generated when a cardholder presented 

his/her card at a door defined as “Exit”.
• Manual entry—Indicates that this is an entry transaction that was manually inserted or 

added in the system. When you manually insert a transaction, you have to specify if 
this transaction is an “Entry” transaction or an exit transaction. For every entry, there 
should be an exit.

• Manual exit—Indicates that this is an “exit” transaction that was manually inserted or 
added in the system. When you manually insert a transaction, you have to specify if 
this transaction is an entry transaction or an exit transaction. For every entry, there 
should be an exit.

• The Door column indicates which door was accessed by this user. When you manually 
insert a transaction, you have to specify the door according to the transaction type (Entry 
or Exit). 

NOTE: If you are inserting an entry transaction, only doors defined as “Entry doors” will be 
displayed in the list. If your are inserting an exit transaction, only doors defined as “Exit 
doors” will be displayed in the list.

11 Click the Load button to load the transactions from the server for this cardholder. You have to 
enter the card number, select the gateway/site, door(s), then click the Load button. The button 
is disabled once you have loaded the transactions.

12  Click the Add button to add a transaction to the existing transaction list. The new transaction 
will be added at the end of the list.
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13 Use the Insert button to insert a transaction between existing transactions or above any 
transaction. 

14 Click Cancel to cancel any insertion or modification that was made BEFORE saving. 

NOTE: When you delete a transaction that was added manually, it is permanently deleted from 
the list; as opposed to transactions that were generated by controllers. When they are 
deleted, they are identified by an X in the Deleted column.
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E-mailing Reports
EntraPass allows you to e-mail any report to one or more recipients. The e-mail feature is enabled 
when defining an EntraPass workstation and when specifying the report database output format. 
Historical, time and attendance and quick reports can be sent by e-mail to any valid e-mail 
address.

To define a report for e-mail:
1 From the Report toolbar, define a new report or select an existing one, then select the 

appropriate Report Request button.

• To send a historical report, select . 

• To send a time and attendance report, select 

• To send a quick report, select 

2 From the Report request window, select E-mail report as the Database output process option. 
When you select this option the Define E-mail parameters button is enabled. Click the Define E-
mail parameters button. The Automatic report output definition window appears.

3 In the Send E-mail to enter the recipient’s e-mail address. For multiple recipients, addresses 
are separated by a semi-colon.

NOTE: Sending reports does not compromise the security of your data. In fact, EntraPass 
allows you to protect rpf files by a password. Only recipients with the correct password will be 
able to access the file. You cannot set a password to CSV files.

4 Click the Execute button to send the report to the specified recipient. The report will be sent to 
the workstation selected in the Send to workstation drop-down list and to the specified 
recipients. 
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Report State
Use the Report state feature to display a list as well as the status of all requested reports that are 
still pending. To delete/stop a pending report, select it, then click Cancel.
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Viewing Reports
The View Report feature enables users to view the reports that were defined and saved in the 
system. Operators can use it to view reports in any format, or to customize a report before printing 
it. 

NOTE: When you create a report (csv, db or dbf), the system automatically creates an 
associated rdf file. This rdf file is the one that is listed in the View report window. When you 
click “Preview”, the system automatically launches the appropriate program to view the report.

To display a report:
1 From the Report window, select the View report icon. The system displays the default 

destination folder. If the report was saved in a different folder, browse the disk, using the 
scroll-down arrow (bottom of the window) to the report you want to display.

2 Select the report you want to view. If there is a printer installed, the Preview button is enabled. 
It is used to preview the report before printing it.

NOTE: You must have a printer installed on your computer in order to preview or print reports. 
To setup a printer, click on Start > Settings > Printers > Add Printer. For more information, 
consult your system administrator.

3 Click the Details button to display information about the report. If you click the Details button, 
the Report details window appears, displaying information related to the selected report file 
such as the report filename, title, type, date, etc. To close the Report details window, click the 
Details button again.

4 Click the Preview button to view the report in the system displays the Report preview window.
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Previewing Historical Reports
1 From the View report window, select the report you want to view in the right-hand pane. If 

you select an Historical report, the following window appears. It allows you to customize the 
report before printing it

2 Select the display options. If one of the following options is selected:
3 Define the filter options: enter a text string in the Search description field. The report will be 

sorted leaving only events containing the specified text string. You may refine your filter:
• Contains—All events which contain the specified text will be included in the report.
• Starts with—All events which start with the specified text will be included in the report.
• Ends with—All events which end with the specified text will be included in the report.
• Exact words—All events containing the exact specified text will be included in the report.

4 Click . The system displays the result of the report. From that window, you can save 
the report (in a.QRP format) or print the report.

5  Use  to view the settings and details of a pre-defined report. The selected report 
displays the following information:
• Report filename—Displays the whole path where the report was saved as well as its name.
• Report title—Displays the title of the report.
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• Start date—Reports are created for a selected time frame. This option specifies the 
starting date of this time frame.

• End date—Reports are created for a selected time frame. This option specifies the ending 
date of this time frame as well as the time.

• Requested—Displays the date and time at which the report was last requested.
• Delivered—Displays the date and time at which the report was produced and printed.
• Requested by—Displays the operator name that requested the report.
• Count—Displays the number of transactions (lines) in the report.
• Output process—Displays a list of the possible templates used for this report. 

Previewing Time and Attendance Reports
1 From the View report window, select the report you want to view. If the selected report was 

defined as a “Display Time and Attendance Report” and “Paradox Database” as the output 
format, the following window appears. 

2 Select the display options: 
• Group by— Select this option for easier management. The report data may be grouped by 

card user names or by card numbers. 
• Sort by—You may choose a sort order, by user names, or by card numbers. 
• Report type—Select this option for easier management. You may choose to include details 

with or without total. 
3 Click  to display the result of the report. From that window, you can save the report 

(in.QRP format) or print the report.
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Chapter 14 • EntraPass Options
The Options toolbar offers users the ability to change a number of system parameters. These 
include changing the card format, the authentication password, the date and time, or changing 
server parameters. Some of the system utilities are accessed form the Server or the Workstation 
windows.
The following menu options are available from both the Workstation and the Server windows:
• Change card format 
• Change the authentication password 
• Select a language
• Change the system date and time
• Modify the server parameters
• Backup Scheduler
• System registration (this icon disappears from the Workstation menu once the system has been 

registered)
The following utilities are available from the Option menu, only:
• Printer option (select a log printer and a badge printer) 
• Multimedia devices (alarm, video and signature capture settings)
• Verify database integrity
• Custom Messages
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Changing the Card Format
The system can accommodate various reader types. Depending on the reader type, the card display 
format may vary. Use this menu to specify how the system will display the card numbers

To define a display format:
1 From the Options main window, select the Card format icon.

2 Select a display format—When you select a format, the system displays a preview of the 
selected format in the bottom part of the window.
• Decimal—Refers to numbers in base 10.
• Octal—Each octal digit represents exactly three binary digits. An octal format refers to 

the base-8 number system, which uses eight unique symbols (0, 1, 2, 3, 4, 5, 6, and 7). 
Programs often display data in octal format because this format is relatively easy for 
humans to read and can easily be translated into a binary format, the format used in 
computer programming. 

• Hexadecimal—Each hexadecimal digit represents four binary digits. An hexadecimal 
format refers to the base-16 number system, which consists of 16 unique symbols: the 
numbers 0 to 9 and the letters A to F. For example, the decimal number 15 is represented 
as F in the hexadecimal numbering system. The hexadecimal system is useful because it 
can represent every byte (8 bits) as two consecutive hexadecimal digits. It is easier for 
humans to read hexadecimal numbers than binary numbers. 
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3 Indicate How many digits are to be displayed. You may use the up/down controls. When a 64-
bit decimal format is chosen, it is possible to specify the number of digits the system must use.

NOTE: Avoid alternating between different card formats because this may result in lost card 
information.

NOTE: KT100 and KT300 Controllers will do a hard reset on format change.
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Changing the Authentication Password
The authentication password is used to authenticate EntraPass Workstations to the EntraPass 
Server.
The authentication password window is automatically displayed when the system has not yet been 
registered. 

NOTE: If you are not using a specific password for authentication, then the user will have to 
use the master default password for workstation authentication. The default authentication 
password is kantech, in lower case. Passwords are case sensitive.

To change the authentication password:
1 From the Options main window, select the Authentication password icon.
2 Enter the current authentication password (case sensitive) in the Old authentication password 

field. The default authentication password is kantech, in lower case.
3 Enter the new authentication password in New authentication password field (case sensitive). 
4 Enter the new authentication password in the Verify authentication password for confirmation. 

This field will verify that the new authentication password was typed properly (case 
sensitive).

5 Click OK to exist. When you receive an error message, make sure that the data you have just 
entered in the New authentication password and in the Verify authentication password fields are 
identical (case sensitive). 

NOTE: The authentication password is different from the operator password. The 
authentication password is used to authenticate workstations, whereas the operator password 
is used to open a session. 
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Selecting a Language
EntraPass allows you to run the software in the language of your choice. The basic languages are 
English, French, Spanish and German. The Vocabulary Editor utility enable users to add other 
custom languages. 

To change the system language:
1 From the EntraPass main window, select the Options tab, then select the Select language icon.

NOTE: Important note: When you modify the primary language, the database operation will be 
suspended during the operation and the changes will be effective only when you shutdown 
and then restart the system. The database language will be modified according the ascii 
values of the characters in the primary language. Accents and special characters of different 
languages may have an impact on your database. 

2 From the Select primary language drop-down list, select the language you want to use as a 
primary language. From the Select Secondary language drop-down list, select the language 
you want to use as a secondary language. 

3 Restart your computer, and login to EntraPass. 
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Selecting and Configuring Printers
The Printer option menu allows users to select a log printer that will be used when printing events 
and to select a badge printer that will be used to print badges. 

Selecting and Setting up a Log Printer
When you define events (in the Events parameters definition menu), it is possible to determine 
how and when events will be printed. For example, you can decide to dispatch events to an 
EntraPass application, a printer, or to activate a relay. Your decision may be based on, for 
instance, schedules that will send alarms to a remote terminal at a specific moment.

NOTE: You need to assign a “print” schedule to certain events to print them at a specified time. 

To select and set up a log printer:
1 From the Options menu, select the Printer option icon.

2 Select a printing option in the Log printer section:
• No log printer—If you select this option, no event will be printed, even if a print schedule 

is defined for the events.
• Use Network/Local Windows printer (page printer)—If you select this option, all events sent 

to the printer will be buffered and printed when a full page is ready to be printed. Events 
will be printed on the network/local printer - not on a specific log printer.

• Use local dot matrix printer—If you select this option, all events sent to the printer will be 
printed one-by-one and one under the other, or it will print one event per page, depending 
on your printer type. Select the printer port that will be used in the “printer” field. Specify 
if messages and alarms will be printed on this printer.

3 In the Printer selection section, specify whether you wont to print message or alarms.
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• Print messages log—If you select this option, all events that are assigned a “display” 
schedule in the events parameters menu will be printed.

• Print alarms logs—If you select this option, all events that are assigned an “alarm” 
schedule (and need to be acknowledged) in the events parameters menu will be printed.

4 From the Printer drop-down list, select the specific printer that will be used as a log printer. 
• If you have selected a dot matrix printer, select the Port on which the printer is connected 

to communicate with the computer. The Port field appears when a dot matrix printer is 
selected.

• If you are using a network/local printer, select the Font and the Font size. The font and font 
size influence the number of events that will be printed on one page. Using a smaller font 
increases the number of events printed on a page.

Selecting and Setting up a Badge Printer
1 From the Printer option window, select the Badge printer tab.

2 Check the Badge printer option if a badge printer will be used; as a result, the Print badge and 
Preview badge button will be displayed in the Card, Visitor, and Day pass windows.

3 From the Select badge printer drop-down list, select the appropriate badge printer.
4 If you want the picture on the reverse side of the badge to be inverted, click the Invert Reverse 

Side box.
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Changing System Date & Time
The Change system y option should be used with caution and only when necessary; this functions 
may affect logical components of the access system (i.e. schedules, etc.). 
If, for any reason, you want to adjust the system time and date, it is better to do so using the Server 
parameters settings (Options > Server Parameters > Time adjustment).For details on network time 
adjustment, see “EntraPass Options” on page 405. 

To change the system date and time:
1 From the Option main window, select the Change System date and time icon.

2 Enter the date in the Date field, or select a date from the calender. Connected components of 
this application will also receive the date change notification.

3 Enter the time in the Time field. Connected components of this application will also receive 
the time change notification.

4 Click OK to exit.

NOTE: If you want the system to automatically change the time when necessary, use the Time 
adjustment tab of the Server Parameters definition menu. For details, see “EntraPass 
Options” on page 405.

IMPORTANT NOTE: You should not change the time using Windows settings. It is strongly 
recommended to change the system time through the server parameter settings.
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Setting up Multimedia Devices 
The Multimedia devices utility allows you to set up your system multimedia objects:
• Alarm sound
• Video capture devices 
• Signature capture devices
• Video feature devices

To select an alarm sound:
1 From the Options main window, select the Multimedia devices icon.

2 Check the Enable alarm sound option if you want an alarm sound notification.
3 Select a sound from the displayed list. 
4 Select a Priority level for the selected sound so that it is played when an alarm defined with 

this priority is sounded. 

NOTE: The Priority level refers to the order in which alarm messages are displayed in the 
Alarm desktop. In EntraPass, O is associated with the highest priority, and 9 to the lowest.For 
more information, see “Event Parameters” on page 322.

5 Click the Play button to listen to the selected sound. The system will play the selected sound.
6 Click the Add button to add a new sound from your personal files. Clicking on this button 

displays a new window allowing you to add new alarm sounds.

NOTE: The Current selection section displays the sound currently selected (in use). You can 
adjust the delay of the alarm sound in the Delay field. 
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To define video options:
1 From the Multimedia devices window, select the Video capture tab.

2 Check the Enable video capture box to enable the video capture options in your system. 
• MCI device: Standard Windows capture drivers.
• Twain device: Twain capture drivers. (Recommended).
• Use overlay: Option activated for image capture devices.
• Enable controls menu: Activates options (such as zoom, pan and tilt) on image capture 

devices, if applicable.
• MCI device number: Select identification number of MCI device.
• Portrait: Enables portrait orientation of captured images.
• Landscape: Enables landscape orientation of captured images. (Default value).

3 Click the Test button to verify if the video camera is functional.
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To set up the signature capture device:
1 From the Multimedia devices window, select the Signature tab.

2 Check the Enable Signature pad option to enable the use of a signature pad device. 
3 From the displayed list of supported Signature pad devices, select the driver for the signature 

pad you want to use.

NOTE: The Test button allows you to check if the driver selected is functional. When you click 
the Test button, the Signature Pad Test window appears. This window appears whenever you 
choose the Signature pad option (Card, Visitor and Daypass definition windows).

4 Select the Video tab to set video options for use with the Video Integration feature. This option 
option allows you to choose between the Windows or video format for Video playback.
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• Disable DirectX option: DirectX is a Windows technology that enables higher performance 
in graphics and multimedia, including video and sound. By default, DirectX is enabled 
with the Video feature. However, you may want to disable it; if for example Video images 
are not correctly displayed or are not displayed at all, disabling DirectX can be useful. 
However, when DirectX is disabled, the system will use more system resources.
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Configuring Server Parameters
The Server parameters configuration menu allows the system administrator to modify server 
parameters.
This menu may be accessed from a workstation or a server. If the Video Integration feature is 
enabled in your system, the Video Server tab appears in the Server Parameters window. It enables 
EntraPass users to set options for time synchronization.

Modifying Connection Options
To modify log in and log out options:
1 From the Option main window, select the Server parameters icon.

2 In the Server parameters window, select the Logout and idle tab to specify the server 
application behavior on idle (when there is no action on the keyboard from the operator). You 
may select:
• Automatic logout on idle: the operator will have to re-inter his/her user name and password 

to enable the server application again. The maximum allowed delay is (mm:ss): 59 
minutes and 59 seconds.

• Send to tray on idle: the server application will be minimized and sent to the task bar when 
the specified delay expires, if the operator who is currently logged in is inactive. The 
maximum allowed delay is (mm:ss): 59 minutes and 59 seconds.

3 For increased security, select other options for secure log out:
• Must login to close a Server application: if checked, this option obliges operators to 

authenticate themselves by entering user name and password to close the Server 
application.

• Notify last log out: if checked, EntraPass will notify the last operator who is logging out.
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4 For easy identification of the workstation, indicate where you want the workstation name to be 
displayed:
• Display description in title bar: the workstation name will be displayed on top of the 

window.
• Display description in taskbar: the workstation name will be displayed in the lower part of 

the window.

Adjusting System Time
EntraPass server enables users to adjust the system time. This feature is useful for instance for 
managing remote sites.

To adjust the system time:
1 Select the Time adjustment tab in order to specify which Gateway will be used to 

automatically adjust the time of all the computers connected to the EntraPass server. 

NOTE: The gateway polls the first controller on the first site at 5:47 am or 05:47, 1:47 pm or 
13:47 and 7:47 pm or 19:47 to get the controller time. 

• No time adjustment. If you select this option, no adjustments will be made.
• By Gateway. If you select this option, you must select the appropriate gateway from the 

Gateway drop-down list.
• By Server. If you select this option, the server will refresh the time at regular intervals. You 

must also select the number of hours between refreshes in the adjacent selection box.

Setting the Server Options
The Server tab allows you to define the number of system log and to convert the system schedule 
database. 
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Defining the number of system logs
The maximum record in system logs and in system error logs include transactions such as: login to 
server, logout from server, disconnection, connection, stop server or start server, registration 
requested, etc. These records are kept with the date/time, the workstation (where the event or error 
came from), the operator and the description of the transactions. 

To set up number of events stored in the server:
1 Select the Server tab to modify the number of recorded events stored by the server and to 

define the start up option for the Mirror Database and Redundant Server.

• Specify the Maximum record in system logs. 
• Specify the Maximum record in system error logs.
2 In the Auto-restart delay (m:ss) field, specify the delay for an automatic restart of the Mirror 

database and Redundant server. 

Upgrading to Advanced Schedule Capability
EntraPass offers users more flexibility and ease of use by grouping schedules per gateway,
site or system logical components. This option is not automatically enabled
upon installation of this new version. Operators must select the option in the Server
parameters menu. Schedules are grouped as follows:
• System schedules: System schedules are applicable to system logical components such as: 

event parameters, operators login schedules, video triggers, etc. System schedules are not 
loaded in a particular controller; they are applicable to all the system. You can program an 
unlimited number of system schedules.
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• Corporate site schedules: These are defined per site. You can define 100 schedules per 
corporate site for such purposes as: power supervision (controllers), door unlocking, REX 
trigger (doors), activation mode (relay), input monitoring, etc.

To upgrade to advanced schedule capability:
1 From the Server window, check the Upgrade to advanced schedule capability option.

NOTE: When you choose to convert the existing schedule database to the new scheme, 
EntraPass creates a backup of the system database. This copy can be used if you decide to 
restore the old schedule database or for validation purposes (when for instance you want to 
make sure that all your schedules were correctly converted). 

2 Click OK if you want to upgrade the system database.

Displaying Login List
EntraPass saves the list of five most recent operators logged on the server or any applications 
where user names are required. This feature can be enabled for easier system access: operators will 
simply select their user name and enter their password. It can also be used for administrative 
follow up; a system administrator can view the list of operators who have recently logged on a 
specific application. However, despite those advantages, it is recommended to disable it whenever 
system security is at stake.
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To enable the Display login list option: 
1 Form the EntraPass application or Server window, select the Option tab > Server parameters 

button.

2 Check the Display login list option, then click OK to close the window.

Allowing Network Diagnostic
To allow diagnostic on the network:
1 Select the Diagnostic tab, if you want to allow diagnostic on network.

2 Check the Allow diagnostic on network option in order to use the PING (Packet INternet 
Groper) utility program. This stand-alone program is used to diagnose network intermittent 
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related problems and/or to determine whether a specific IP address is accessible. For details 
on the PING program, see “System Utilities” on page 449.

Configuring Network Alarms
1 Select the Network alarm tab to define maximum records to be kept in the network alarm table.

2 Enter the maximum number of records (100,000 maximum allowed) that will be kept in the 
network alarms table. You may use up/down controls to set this number. When you define this 
setting, the server will automatically apply the same setting for all workstations of the system. 
This is to ensure that the file size does not take too much disk space on the workstation and the 
server's hard disk. 

NOTE: When the table reaches the maximum records, events are removed from the table on a 
first in first out basis. For approximately 100,000 (max) events, the file is about 100 MB. For 
more information on network alarms, see “EntraPass Desktops” on page 337. 
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3 Select the Report tab to define the field separator for your reports. By default, the system uses 
a comma (,) as the field separator. You can modify the comma for another character; the TAB 
for instance. 

4 Check the Date and time on separate fields option. It is recommended to check this option. 
When you select CSV (comma separated values) as the output process for your reports, by 
default, the system includes the date and the time in a single field. When you select this 
option, the system will separate the date and the time fields.
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Selecting the KT-100 and KT-300 Firmware
1 Select the KT-100 tab to specify the folder containing the program for KT-100 controllers.
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2 Select the KT-300 Firmware tab to specify the folder containing the firmware for KT-300 
controllers. The system will use this data to update data for the installed controllers.

Selecting the JPEG Quality
If you are using the Badging feature, it is recommended to leave the jpeg quality to default. If you 
are not using the Badging feature, you may reduce the jpeg quality of your images so that they will 
not occupy much space in the database. However, reducing the quality of the saved images may 
affect the quality of the photos imported into badges. If you are not an advanced user, leave these 
values to default.

NOTE: Unchecking Use JPEG format for pictures (or signatures) tells the system to save 
pictures (or signatures) in a tiff format. However, this may affect the image quality.
42514 • Configuring Server Parameters Selecting the JPEG Quality



Reference Manual
To set the JPEG Quality:
1 Select the JPEG quality (1) tab to adjust the image and signature quality for use with the 

Badging feature.

NOTE:  The Jpeg quality value indicates the quality of the image that will be saved. If you 
choose 0, the saved image quality will be poor; 100 indicates an excellent quality. 

2 Select the transparency color for pictures and signature. Four choices are available (top-right, 
top-left, bottom-right and bottom-left). By default, the system chooses the bottom left-hand 
corner for the transparent background color. EntraPass allows operators to choose a more 
suitable color.

3 Select the JPEG Quality (2) tab to specify the JPEG quality for badges and graphics. 
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Specifying the User Name Format
Specifying the user name format will tell the system how cardholder’s names will be sorted by the 
system.

To specify the user name format
1 Select the User name format tab to choose how names will appear and the method of parsing 

data.

2 Check the option Parse user name if you want the system to sort cardholders’ names, then 
select the sort order: by the first name or last name.

Defining Video Server Options
The Video server tab appears in the Server parameters window if the Video integration option is 
enabled in the system. Select this tab to define settings for: 
• Time synchronization: This feature enables EntraPass users running a video management 

application to define settings for manual time synchronization between the EntraPass server 
and video servers.

• Remote Video Process Control: This application acts as an interface between the EntraPass 
Server and the video servers connected to EntraPass. It manages all the tasks (controls) related 
to: recordings, polls, events, and presets and patterns.
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To set up Video server options:
1 Select the Video Server tab.

2 Check the Disable manual time synchronization option if you do not want the EntraPass server 
to update the video server date and time following a manual modification of time. This feature 
is useful when for example you want to keep all recording events that occurred at the video 
server regardless of the actual time at the EntraPass server.

3 Specify the number of Control applications in the Preset and pattern control application field. 
This is the number of applications that will be simultaneously launched for processing presets 
and patterns. The system is preset with a range value of 1 to 8 concurrent applications. 

NOTE: A Preset and Pattern Control application is launched each time a video recording is 
started following a trigger on a preset. If you set this number to 1 and if there are for instance 
more than 1 video servers with presets and patterns defined, the Control application will 
process presets on all video servers. If you decide to increase the number of Preset and 
Pattern Control Applications, keep in mind that running many concurrent applications takes a 
great amount of system resources. 

4 Check Disable DirectX if you want to disable this utility. DirectX is a Windows technology 
that enables higher performance when working or viewing graphics and other multimedia 
contents, including video and sound. By default, DirectX is enabled with the Video feature. 
However, sometimes you may need to disable it if, for example, Video images are not 
correctly displayed or are not displayed at all. However, when DirectX is disabled, the system 
will use more system resources.

5 Check Reset Remote Video Process application if you want the system to terminate the Remote 
Video Process application if for instance video events are not being displayed. If this option is 
checked, the EntraPass server will stop the Remote Video Process application and will 
automatically restart it after a few seconds. 
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6 Check Reset Remote Video Process Control applications if you want the system to terminate 
Control applications instead of stopping the Remote Video Process application. When you 
select this option, all the Control applications (Recordings, Polls, Events and Preset and 
patterns) will be stopped; then the Remote Video Process application will restart them.

7 Check Log Video process error if you want the system to keep a log of all video process errors 
in the EntraPass server files. Video process errors are logged in C:\Program 
files\Kantech\Server_CE\Bin\Log. Each Remote Video Process Control application generates 
a log file:

• CONTROL_LOG_01.txt (errors generated by RVPPoll.exe)
• CONTROL_LOG_02.txt (errors generated by RVPEvent.exe)
• CONTROL_LOG_03.txt (errors generated by RVPRecord.exe)
• CONTROL_LOG_04.txt (errors generated by RVPControl.exe). The system will 

generate as many log files as there are control applications running concurrently 
(CONTROL_LOG_05 to 011). The number of error log files will be equal to the 
number defined in the Preset and pattern control application field.

Setting up PIN Options
EntraPass users have the ability to prevent or allow PIN duplication. They can also configure the 
system to send a notification if a PIN is duplicated. Each time a card is issued, the system checks 
the PIN settings. 
This feature can be used for example while loading cards in a batch. An operator may decide to set 
the PIN option to Allow duplication. Later, if desired, the duplicate PINs can be changed to 
prevent confusion. If the Notify when duplication option enabled, the system will display a 
notification on duplicate PIN numbers. 
Optionally, the operator can display the list of PIN owners. For details, see “Viewing and 
Verifying PINs” on page 207.
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To define PIN options: 
1 From the Options window, select the PIN tab. 

2 Select an appropriate PIN management option:
• No duplication: an alert message appears, the PIN field will be reset to the value you are 

attempting to duplicate and will be enabled, inviting you to enter a valid PIN. Only PIN 00000 
will be duplicated regardless of the PIN setting option.

• Notify when duplication: the Server verifies if this PIN already exists. If the PIN exists, a 
message box appears, indicating that the PIN exists. A Details button will allow operators to 
view a list of cardholders who were issued this PIN. 

• Duplication: no test will be processed, the PIN will be accepted even if it is a duplicate. 

Disk Space Management
The Disk Space feature has been added as a protection against system failures that may be caused 
by the lack of disk space. This feature allows you to monitor the amount of free disk space for 
optimal system operation or for generating reports. In fact, EntraPass offers the ability to have the 
system abort the execution of a report if the free disk space has reached a specified threshold.
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To specify a free disk space quota:
1 From the Server parameters window, select the Server Disk tab.

2 From the Disk free space threshold (MB) scroll-down list, specify a disk space quota that 
indicates when you want the system to warn when the amount of free space falls behind the 
value indicated. This value is in mega bytes. 

3 In the Time between notifications (hh:mm) field, enter the time between notifications when the 
disk free space has reached the quota specified in the Disk space threshold field. For example, 
if you enter 00:30 in the field, a system alert message will be displayed every half an hour.

4 From the Abort report if free space lower than (MB) scroll-down list, specify the minimum 
amount of free disk space required for the execution of reports. This feature is a protection 
when for instance a huge report has been requested. In this case, the system will abort the 
execution of the report and displays an alert message indicating the reason of the abortion.

Archived Reports Management
It is possible to set a limit to the number of events that can be retrieved when generating a report in 
the Archived Message List.
1 From the EntraPass Application window, select the Monitoring  tab.

• To define EntraPass Application general parameters, see “To configure an EntraPass 
applications:” on page 55.
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• To define EntraPass Application Messages parameters, 

2 Enter the Maximum Records in Report Desktop that can be retrieved from archived files and 
displayed on screen. The number can be set to a maximum of 200,000.
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Verifying the Database Integrity 
The database utility program allows to verify and to repair the system databases. When the 
Database Utility is launched, the system scans all the tables for any possible errors and repairs them 
automatically. 
Note that when you launch the Verify Database Integrity utility from the EntraPass application 
menu, this is a surface operation. If your system is experiencing problems, when your system 
experiences problems, you have to run the Database Utility program from Windows Start menu

To perform a quick verification of the database integrity: 
1 From the Option toolbar, click the Database Integrity icon. The system displays a warning. 

2 Select Yes to continue.

NOTE: When you launch the Verify Database Integrity utility from the EntraPass application 
menu, this is a surface operation. If your system is experiencing problems, you must run the 
Database Utility program from Windows Start menu.
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Backup Scheduler
A backup is a copy of the systems database which serves as a substitute or alternative in case the 
computer fails. If your system computer fails, you may restore a backup copy onto another 
computer (on which the EntraPass software has been installed). 
• Back up your files regularly, at least once a week or more if many modifications were made to 

the database.
• We recommend that you make two backups of all your database files. To be especially safe, 

keep them in separate locations. 
• To backup your files, you can use:

• the menus of the Server/Backup Tab, or 
• the Backup Scheduler to apply automatic schedules, or 
• other third party software and hardware.

NOTE: By default, when you backup or restore files, the Server databases will temporarily be 
disabled (not available). The Workstations will not be able to modify the databases.

The Backup Scheduler program is used to schedule automatic backups of your data, archives, and 
Time and attendance databases. Define the default settings and the system will do the rest! 

To schedule automatic backups of the system database:
1 From the Options main window, select the Backup Scheduler icon.
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2 Select the tab corresponding to the information you want to backup: Data, Archive, or Time & 
Attendance.

NOTE: By default, the system will automatically backup your files every Sunday at 4:00 AM for 
all new installations. Setting this feature at 4:00AM has an added benefit of not interfering 
with the system processing time or other tasks scheduled around midnight.

3 Select the Automatic backup option to enable the options displayed in the window. The 
options displayed depend on the tab that is enabled.

4 Select the backup folder: 
• Default folder—will backup your files in a system default backup folder. By default, the 

name of the backup sub-directory is generated automatically according to the following 
convention: X_YYYY_MM_DD_HH_MM_SS (Where 'X' = Data or Archives or Time 
and Attendance (D, A or T), year, month, day, hour, minutes, and seconds. 

NOTE: By default, the system backs up all the information originating from the following 
directories: C:\PROGRAMFILES\ KANTECH\SERVER\DATA or ARCHIVE or TIME. The 
information is sent to:C:\PROGRAM FILES\ 
KANTECH\SERVER\BACKUP\X_YYYY_MM_DD_HH_MM_SS 

• Specific folder—will backup your files in a sub-folder labeled according to the default 
convention in the XXX folder.

5 Select the Backup type. The options that are displayed depend on the type of the data to be 
saved. 
• Separate files: will backup the databases one by one (standard) (Data only). 
• Separate files (full backup): will backup all databases (Archive, Time and Attendance). 
• Separate files (incremental): will backup all databases. Only the information that was 

modified since the last backup will be saved (Archive, Time and Attendance). 
• Self-extracting compressed file: will create an executable file (*.exe) that will compress 

the information so as to reduce the amount of disk space taken by the backup. (Data only)
• Self-extracting compressed file (full backup): will create an executable file (*.exe) that 

will compress the information so as to reduce the amount of disk space taken by the 
backup (Archive, Time & Attendance).

• Self-extracting compressed file (incremental): will create an executable file (*.exe) that 
will compress the information so as to reduce the amount of disk space taken by the 
backup. Only the information that was modified since the last backup will be saved 
(Archive, Time & Attendance).

NOTE: When you have selected “full backup”, each time a backup is done a new sub-folder 
containing the data or the self-extracting file will be created. If you are using the incremental 
backup type, only the information that was modified since the last backup will be saved. If you 
want to restore information, you will have to restore all the sub-folders one-by-one (starting 
from the oldest). 

6 Select the frequency of the backup, 
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• Weekly: the backup will be carried out once a week. Specify which day (example, the 
backup will be executed every Thursday). 

• Monthly: the backup will be carried out monthly, specify the day of the month (example, 
the backup will be carried out every first day of the month).

• Daily: the backup will be carried out every day.
• Now: this option allows you to request a backup when you need it.

7 Enter the time at which the backup will start (24:00 format), then click on OK to save. 
8 Repeat steps 1 to 8 for all the tabs.
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System Registration 
This menu is used to register new system applications such as workstation, gateway, SmartLink, 
etc. in order to register and use the system's database and to establish communication with the 
Server.

NOTE: For more information on how to install and register new applications, see Chapter 2 
‘Software Installation’ on page 7. Before you install new applications, make sure that you 
have the proper serial numbers for the installation.
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Custom Messages
The Custom Messages option allows operators with proper security rights to define custom 
messages that can generate an event based on a schedule. Up to 10 custom messages can be 
programmed to trigger an event at a preset time. And each custom message can be triggered when 
the schedule becomes valid, invalid, or both. In other words, you can trigger up to 20 custom 
events if you take into account the start and/or end of a schedule interval.
Each custom events will be displayed in the Messages List on the Desktops.

To Setup Custom Messages
1 From the Options Main window, click Custom Messages. 

2 In the first tab, enter the first custom message you want to see display in the Messages List. 
Two fields are available for primary and secondary languages. 

3 Select a preset schedule that will determine when the custom event will be triggered.
4 Select if you want the custom event to be triggered when the schedule becomes Valid or 

Invalid, or both.
5 Move to the second tab to enter a second custom message, and so on.
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Chapter 15 • The EntraPass Server 
The EntraPass Server is a dedicated computer on a network that manages the access control system 
database. It is used to receive and dispatch information received from the different gateways and 
workstations receiving information from connected controller sites. 
In some applications, a Redundant Server and a Mirror Database can be used as an alternative if 
the Primary server failed.
The EntraPass server can be used for: 
• Displaying all the workstations connected to the server, the system event log and system error 

log
• Registering new connections and system options (workstation, gateway, client applications, 

etc.) 
• Creating and restoring backups (Data, Archives, Time and Attendance databases)
• Restoring data (Data, Archive, Time and Attendance databases) 
• Verifying database integrity
• Changing the database language
• Cleaning the database by clearing records relating to previously erased data
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Launching the Server
In order to access the EntraPass Server commands, you have to start the Server and login. 
Operators are identified when they login. This allows them to have access to the security system 
menu associated with their access level, and to establish communication and initiate interaction 
with the workstations. However, it is not mandatory to login for the Server to operate.

To launch the Server:
1 From the Windows Start menu, click Start > Programs > EntraPass Corporate > Server > 

Server. You may also click to the Server icon on the desktop, if applicable. 

2 Enter your User name and Password (case sensitive) and click OK to continue. To modify this 
password, see “Operator Definition” on page 302.

To allow an operator to login to the server, select the “Allow login on server” option, during the 
Security Level definition of an operator. For more information, see “Security Level Definition” 
on page 306.
3 To login to the server, click the Login/Logout button, the system displays the login window. 

The status bar indicates the communication status: Green: Communication is OK, Red: 
Communication problems.

The colored flags represent the status of a system logical or physical component: 
• Database state availability state 
• Database locked state: it turns red when the database is locked
• System date and time
• Login name of the operator who is currently logged in the Server
• Number of client connections, that is, the number of workstations connected to the server
• Number of system logs (messages and events)
• Number of error logs
• Computer name (NetbEUI) where the server is installed
• Server’s IP address
• Secondary IP address, if the Mirror database and Redundant server communicate with the 

server through a TCP/IP connection and if they are configured in the system
• Other IP address, if applicable.
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Server Connection list
This menu allows operators to view various lists which show current operational status between 
the EntraPass server and the workstations connected to it

Viewing Applications Connected To The Server
Operators can view the status of all Entrapass applications from the Workstation or Server user 
interface. 

To view applications connected to the server:
1 Start the server (from Windows Start menu or the shortcut on the desktop).

2 Click the + sign next to each workstation to view details about a workstation (such as: 
registration codes, TCP/IP address, connections, messages buffered, etc.).

Viewing the System Log
The System Log window contains all the login and logout events for all workstations defined in 
the system. The logs are displayed with date and time, the workstation name, the operator name 
using the workstation as well as the log type.
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To view system log:

1 To view system log, select the View System Log icon. The System Log window contains 
all the login and logout events for all workstations defined in the system. 

 

2 From the Sorted by drop-down list, select the sorting criterion: the system events will be 
displayed according to your specifications.
• Date and time— This is the normal incoming sequence, if you select another sorting mode, 

you interrupt the normal sequence. Select date and time to restore the normal sequence. 
To do this, you have also to use the “restart scroll” button.

• Operator—When selected, all columns will be sorted according to the Operator column in 
alphabetical order. 

• Workstation—When selected, all columns will be sorted according to the Workstation 
column in alphabetical order. 

• Text filter—When selected, a new window will be displayed. From that window, enter the 
text string (i.e.: kantech), and the system will only display logs containing the specified 
string text. To return to normal display, click on text filter.

3 You may change the background color. To do this, right-click on the window and select a 
color from the displayed short-cut list.

4 You may also clear the window. To do this, right-click in the window, then select Clear from 
the shortcut menu.

Viewing System Errors
The system errors are displayed with the date and time, the workstation name where the error 
originated from, the code number and its description.
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To view system errors:
1 Select the View system errors icon to view all the errors that occurred in the system.

2 You may also use the right-click menu to change the window background or to clear all the 
data displayed. 

NOTE: For information on system registration, see “Installing the System” on page 11.
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Backups
A backup is a copy of your system database which serves as a substitute or alternative in case the 
computer fails. Backing up your files safeguards them against accidental loss when for example 
the hard disk fails or when you accidentally overwrite or delete data. 
If your system computer fails, you may restore a backup copy onto another computer (on which 
the EntraPass software has been installed). 
The EntraPass Backup tab allows operators to perform manually backups of the system data, 
archive and time and attendance databases. It is also used to restore backup data.
Safeguard tips:
• Back up your files regularly, at least once a week or more if many modifications were made to 

the database.
• We recommend that you make two backups of all your database files. To be safe, keep them in 

different locations. 
• To backup your files, you can use:

• The menu of the EntraPass Backup utility, or 
• The EntraPass Backup Scheduler to apply automatic schedules parameter, or 
• Other third party software and hardware.

NOTE: By default when you backup or restore files, the EntraPass databases will temporarily 
be disabled. The second colored square of the database status turns red when the database 
is unavailable. The Workstations will not be able to modify the databases.

All the system data can be found under the following path: C:\Program Files\Kantech\ 
Server\XXXX. If you are using a third party program to perform backups, it is recommended to 
backup the whole Kantech directory and sub-directories. 
Each time a backup is done (even if it is done automatically), a new sub-folder containing the data 
or the self-extracting file is created. If you are using the “incremental” backup type and you want 
to restore information, you will have to restore all the sub-folders one-by-one (starting with the 
oldest).

Creating Backups of Type D, A, and T
By default, the name of the sub-directory in which the data/archive/time and attendance databases 
will be saved is generated automatically according to the following 
convention:X_YYYY_MM_DD-h_mm_ss, where X is the data type (D for Data, A for archive and 
T for Time and Attendance).
The following steps explain how to backup data. The same steps apply also when you backup 
archives or time and attendance data.
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To create a backup (D, A and T):
1 Select the item you want to backup: data, archive, time and attendance databases. The system 

displays the backup sub-directory in which the information will be saved. You may keep the 
default folder, or you may browse your disk to specify a new destination folder for the backup.

NOTE: By default, the system/workstation will backup all the information originating from the 
following directory: C:\Program Files\Kantech\Server_CE \ Data or Archive or Time and 
attendance to C:\Program Files\Kantech\Server\Backup\X_YYYY_MM_DD-h_mm_ss, where 
X is the data type. The data type is followed by the year, month and day information as well as 
the time of the backup.

2 Select the Backup type:
• Separate file: the system will back up the databases one by one (standard). This backup 

type includes the Regdata.ini file containing the following identification data: software 
used to create the backup, backup type (data, archive, time and attendance), operator who 
requested the backup, date and time of the backup as well as the software version.

• Self-extracting compressed file: the system will create an executable file (.exe) that will 
compress the information so as to reduce the amount of disk space taken by the backup. 
The system displays information identifying the backup: software used to create the 
backup, backup type (data, archive, time and attendance), operator who requested the 
backup, date and time of the backup as well as the software version.

3 From the Drives drop-down list, select the drive on which the backup will be performed. A list 
of choices is available according to your computer settings. To save as default, leave as is.

4 You may click the New folder button if you want to specify a new destination folder.
44515 • Backups Creating Backups of Type D, A, and T



Reference Manual
5 Click OK to launch the backup procedure. The backup process can be viewed on the bottom 
part of the window.

NOTE: You can use the “Backup Scheduler” to schedule or plan automatic backups. To 
schedule automatic backups see “EntraPass Options” on page 405.When you backup or 
restore files, the Server databases are temporarily disabled. You cannot modify the databases 
when a backup is in process.

Restoring Data (D, A and T):
If you are restoring data, it is strongly recommended to perform a backup before.
If you are using a third party program to restore the data, it is recommend to restore the whole 
Kantech directory and sub-directories.

To restore archived data (D, A and T):
1 From the Server window, select the desired Restore button (Data, Archive, Time and 

attendance). The system displays the Restore data window. It displays the path of the backup 
folder.

NOTE: By default, the system restores all the information originating from the following 
directory: C:\ProgramFiles\Kantech\Server_CE \Backup\ X_YYYY_MM_DD-h_mm_ss to 
C:\Program Files\Kantech\Server_CE \Data or Archive or Time and Attendance.

2 To change the destination folder, browse the Drives drop-down list. Click OK to launch the 
restore process.

NOTE:  It is recommended to reload the gateway after restoring the data (Operation > Reload 
data). 
15 • Backups Restoring Data (D, A and T):446



Reference Manual
Using the Server Utilities
This menu allows users to verity the system database integrity and to restore the system data bases. 
This menu is also accessible from workstations. For more information on the system utilities, see 
Chapter 16 ‘System Utilities’ on page 449.

To use the system utilities:
1 Select the Utility tab to use the server utilities. 
2 Select an icon in the toolbar. 

3 Click the Rebuild button. The system automatically starts the operation and displays a 
progress bar indicating that the process is on-going.

NOTE: Certain windows may provide only a Yes or No button rather than a Rebuild button to 
start the operation. 

NOTE: The Clean database utility also provides a Yes or No button to clear records from the 
database relating to previously erased data.
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Swapping the System Language
In order to have the system run in the language of your choice, first change the system language 
(Option > Select a language) and then run the Swap description utility.

To change the system language:
1 From the Server main window, select the Options tab.

NOTE: Important! When you modify the primary language of the database, the database 
operation will be suspended during the operation (not available for users) and the changes 
will be effective only when the server is shutdown and restarted.

2 From the Select primary language drop-down list, select the language you want to use as a 
primary language. From the Select Secondary language drop-down list, select the language 
you want to use as a secondary language. 

3 Shutdown the server.
4 Restart the server and login. 
5 Select the Utility tab, then select the Swap descriptions button.
6 Once completed, restart the server.

NOTE: You may also click the Change system font button to modify the font: this option is used 
to select the font for the database. 
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Chapter 16 • System Utilities
This section groups the utility programs of the EntraPass Software. These programs are accessible 
from the Windows Start menu. The following programs are launched from the server or the 
workstation.
• Database Utility —Program intended to re-index archived files, update database fields, verify 

archived files, verify the database integrity, verify the database index, verify the database 
links and to verify the database hierarchy while the server is shutdown.

• EntraPass Video Vault Application —Program used to manage video segments archive. This 
program will process requests from EntraPass users to view archived video segments and to 
monitor video archiving processes.

• Express Setup —Program used to configure all the components related to a gateway including 
the type of readers used, type of connection, number of controller sites, number of controllers 
in a site, etc.

• PING Diagnostic —Program used to diagnose network intermittent related problems.
• Quick Report Viewer —Program used by the operator to view reports without having to start 

EntraPass.
• System Report Viewer—Program used by the operator to view reports without having to start 

EntraPass. This utility is installed from the Setup window.
• Vocabulary Editor—Program used to translate, in the language of your choice, the display text of 

the software.
• Workstation—Configuration Program—Program, similar to a standard workstation, used by the 

system administrator to configure the system logical and physical components.
• Migration Utility—Program used to transfer database information for the upgrade from Special 

to Corporate Edition or Corporate Edition to Global Edition.
• The Gateway Interface—The CardGateway software is a program that creates a mirror copy of 

the EntraPass card database in the MS-SQL or ORACLE Server. This interface allows user to 
modify, add or obtain card-related information, all this in real-time, from the MS-SQL or 
ORACLE Client version. The mirror card database, which contains cardholder information, 
will be updated automatically as soon as new information is available in the EntraPass card 
database.

• The SmartLink Interface—The SmartLink interface allow users to define a message and format 
data that may be sent on the second COM port or to a disk file. Using the SmartLink feature, 
you can interface to just about any intelligent device such as video matrix switchers, paging 
systems, etc. 
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Database Utility
Since the information from the system databases is sent back and forth between , some data might 
end up in the wrong table. 
Some of these verifications such as re-indexing the archive files, updating database fields, 
verifying archive files, or swapping database descriptions require that the Server be shutdown. 
When an operation that requires the server to be shutdown is launched, the operator is warned that 
the databases will be suspended during the operation. 
From EntraPass, the Database utility program verifies the integrity of the tables that are used to 
store events, alarms, network alarms, and graphic. Basically, the system scans all the system tables 
and correct errors (if they are found). 
You may want to start this utility when your systems hangs up frequently.

NOTE: You may also verify the system databases from the Server (Server > Utility). However, 
this will only allow you to perform “surface” verification. If the system hangs frequently, for 
instance, use the Database Utility program. To do so, you have to shutdown the server.

Verifying the Database Integrity 
The database utility program allows to verify and to repair the system databases. When the 
Database Utility is launched, the system scans all the tables for any possible errors and repairs them 
automatically.

To verify the database integrity: 
1 To verify the database integrity, click the Verify database integrity icon in the toolbar (you may 

enable this feature through the Utility menu also). You have the choice to perform a quick or 
complete check.

NOTE: When you launch the Verify database integrity utility from the Options menu, this is only 
a surface operation. When your system hangs frequently, you have to run the Database Utility 
program.

2 Select the type of verification you want to perform. If you select a quick check, the system 
scan through the tables, but does not display a detailed report after.

3 If you select a Complete check of the database, a detailed report is displayed.

Updating Database Fields
This function is automatically executed when the software is updated.
If an operator performs a database restore (Server, Options tab, Restore), the database fields are 
automatically updated when the information is restored. Even when an operator performs a 
database restore outside the Server (copies the databases from a third party backup program), this 
function is automatically carried out when the Server is started up again. 
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To update the database fields:
1 From the EntraPass Database utility window, select the Update database field icon.

NOTE: Use this function when for instance you experience problems when starting the server 
or workstation. When the system does not start, this may imply that there are problems in the 
database; that the source and the structure do not match.

Database Utility, Server
Usually, the system verifies the database integrity automatically at start-up (a system message is 
displayed). If an operator decides not to perform a database check at startup, he/she may trigger 
the operation later, using the Database Utility program. 
It may also be necessary to launch the database utility program when for instance the system 
experiences problems frequently. This operation should be executed when the system is not much 
used since the system databases are not available during operations on the databases.

NOTE: It is recommended to exit the Server before you run the Database utility.
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To run the Database Utility:
1 Exit the server program. During this operation, the system databases are suspended. A red 

square button in the status bar to indicates that the databases are unavailable
2 From Windows start menu, select Start > Program > EntraPass Corporate Edition > Server > 

Database Utility.

NOTE: When you select File > Workstation, the system displays only two icons, the Verify 
database integrity and the Update database fields icons. The Server toolbar offers more choices.
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3 Select the icon or menu item corresponding to the program you want to execute. The system 
displays the result of the analysis.

NOTE: Use this function when for instance you experience problems when starting the server 
or workstation when the system does not start, this may imply that there are problems in the 
database; that the source and the structure do not match, for instance.

Verify Database Index (Server)
This program allows to entirely rebuild the index by using the information that was copied in the 
primary databases and grouping it to rebuild the Registry.DB database. The latter is used to 
increase the system performance. 

NOTE: This program can be used when a database is corrupted because it has not been 
backed up. 

Verify Database Links 
The Verify Database Links utility is used to rebuild all the links of the database. Moreover, this 
program cleans the databases by deleting links that are no longer valid. For example, if a schedule 
was assigned to a functionality and this schedule was deleted, the system will initialize the field 
where it was assigned in the primary database. It will also remove the records that point to deleted 
components. For example, if an access level is assigned to a gateway and this access level was 
deleted, it will delete the record in the database.
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The Verify Database Links utility enables complete management of the links between each 
component and ensures that the correct information is displayed when:
• Viewing the structure of a component's links to all other components of the system,
• Removing all the traces of a component within the database when this component has been 

deleted. For example, if a schedule is deleted, the system will use the link list to initialize all 
the database fields that contains this schedule.

NOTE: It may be necessary to use this function when it is obvious that the database links are 
incorrect. This features is useful when for example the system experiences abnormal 
terminations.

Verify Database Archive Files
This function is used to verify archive files. It assigns a new unique sequential value to all primary 
indexes of archive files.

Verify Time & Attendance Files
This function is used to verify time and attendance database files. It assigns a new unique 
sequential value to all primary indexes of time and attendances database files. 

Verify Database Hierarchy
In EntraPass, the database is set up in a hierarchical way, which means that all components have a 
parent and can have child components. 
The Verify database hierarchy utility is used to rebuild the parent-child links within the database. 
The results of this program are limited if the damages of the database are severe.

NOTE: When a user tries to access a controller by selecting a gateway and a site and when 
the result does not correspond to the reality, this means that the database hierarchy is 
probably corrupted. In this case, the Verify database hierarchy feature can be used to correct 
the problem. If the problem could not be fixed, this could mean that the database is too 
damaged to be fixed. It will be necessary to restore the database.

Swap Description
This function is used to interchange description #1 (primary language) with description #2 
(Secondary language) in all the database of the system. 

NOTE:  When this function is executed, the current primary language becomes the secondary 
language, and the secondary language becomes primary. This function must be executed with 
caution to avoid system language problems.

Follow this procedure to modify the database language, otherwise the database operation will be 
suspended during the operation and the changes will be effective only when the server is shutdown 
and restarted.
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To interchange the system languages:
It is strongly recommended that you to follow this procedure:
1 Modify the system language (Server > Options> Select language icon).
2 Shutdown the server.

NOTE: If the server is not shut down, the Database Utility program will not operate.

3 In the Database Utility main window, click on the Swap descriptions button. 
4 Start the server.

Clean Database
This option is used to physically remove database records which have been identified by the 
system as erased. Most of these records relate to cards and are kept in the Deleted Components 
section of the database. Using this option will considerably reduce the space required by your 
database. It will also improve system performance relating to searches for card information. It will 
not affect the table Registry, nor will it have an impact on historical reports.

To clean the database:
1 Start the Clean database utility (Server>Utility> Clean database icon).
2 Click on the Yes button.

NOTE: It is strongly suggested to back-up the database before performing this operation. Clean 
database will suspend operation of the database while cleaning is in effect.
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EntraPass Video Vault
The EntraPass Video Vault application addresses the need for optimal video data storage and 
archive management. This application offers an easy way for collecting important video data for 
future reference. In fact, video recordings have a limited life span depending on the video server 
setting and capability. Moreover, since video recordings require a great amount of disk space, 
using an archive management tool such as EntraPass Video Vault enables organizations to better 
manage and easily retrieve video contents.
EntraPass Video Vault enables EntraPass users to:
• View the status of video archiving requests
• Monitor the status of video servers associated with the active EntraPass Video Vault 

application
• Monitor video download logs
• Archive video segments
The EntraPass Video Vault application will process the following video segment types:
• Video segments that were triggered by an automated trigger
• Video segments triggered by a manual operation
• Video segments recorded following video server triggers
• Exported video segments tagged for archiving

NOTE: The EntraPass Video Vault application requires an additional license. It is possible to 
install more than one EntraPass Video Vault application with EntraPass. Each EntraPass 
Video Vault must be configured for use with EntraPass (Devices > EntraPass Applications).

Installing EntraPass Video Vault
An Option Certificate is required to install EntraPass Video Vault. For details about installing 
EntraPass advanced options, see “Adding Optional Components/Features” on page 10
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To Install EntraPass Video Vault:
1 From the EntraPass System Registration window, select the EntraPass Video Vault, then 

select the Click here to install component button

2 Enter the Option Serial Number found on the EntraPass Video Vault Management Option 
Certificate.

3 Enter the Registration Confirmation Code provided by the Kantech Technical Support 
personnel.

4 Click OK to close the Component registration window. Once you have completed the 
registration process, the EntraPass Video Vault application is added to the Components list in 
the System Registration window.

5 Use the Installation code and the installation CD to install EntraPass Video Vault on any 
computer meeting the minimum requirements for the EntraPass workstation application. For 
details about system requirements, see “System Requirements” on page 8.
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Launching EntraPass Video Vault
At startup, the EntraPass Video Vault application tries to connect to the EntraPass server. If you 
are launching the application for the first time, you may need the EntraPass Server’s IP address. 
Also, make sure to launch the EntraPass Server before attempting to run EntraPass Video Vault.

To Run EntraPass Video Vault:
1 From the shortcut menu on the desktop, or from the Windows Start menu, launch the 

EntraPass Video Vault application.
• Video Vault root directory: indicates the default folder where video segments are stored. 

The EntraPass Video Vault root directory is determined when configuring EntraPass 
Video Vault from the EntraPass environment (EntraPass workstation application > Devices 
> EntraPass Applications > EntraPass Video Vault). The default EntraPass Video Vault root 
directory is C:\Kantech Video Vault.

• Current process: indicates the number of video segments that are being retrieved for 
archival purposes.

• (KVI, KVA, AVI, IMG) files archived: shows the number of video segment files retrieved by 
EntraPass Video Vault.

• Default video file format: the default format for archiving files. This format is defined 
while configuring video archiving parameters for the EntraPass Video Vault: EntraPass 
workstation application > Video > Video server > Video Vault Parameters tab.

• Registered Video Server(s): indicates the number of video servers associated with he 
active EntraPass Video Vault application. An EntraPass Video Vault application is 
associated with a video server when defining the Video Server (EntraPass workstations 
application > Video > Video server > Video Vault Parameters tab).

• Processing error count: indicates the number of unsuccessful video archiving processes. 
To learn why the archiving process was not completed, log on to Video Vault > Action 
menu item > Video Server List. The Action menu item appears only when you have entered 
a valid operator user name and password. EntraPass enables you to retry retrieving 
unsuccessful archiving processes from the Video Events List window: EntraPass 
workstation application > Video > Video Events List.
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Managing Archived Video Segments
1 From the EntraPass Video Vault main window, select System > Login to launch EntraPass 

Video Vault and logon.

2 Enter the User name and Password for EntraPass Video Vault, then click OK to close the 
Operator login window. You cannot log in two EntraPass applications simultaneously using 
the same user name and password. Since you must run EntraPass Video Vault and the 
EntraPass server at the same time, make sure to use a different user name for EntraPass Video 
Vault.

NOTE: To view detailed information about the numerical values displayed on the main window, 
log on to EntraPass Video Vault.

3 To view the list of Video servers associated with the EntraPass Video Vault application and 
the status of the archiving process, select the View Video server menu item. 
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• Video server on line, archive period valid: During this period, the EntraPass Server 
retrieves video segments from the Video server and queues them for archiving by 
EntraPass Vault. All video segments originating from video triggers (automatic or 
manual) and segments tagged to be archived in the Video Events List are archived in the 
EntraPass Video Vault.

• Video server offline, archive period valid: This status is tagged with a red flag. It indicates 
that the EntraPass server cannot retrieve video segments from the Video server for 
various reasons. Video segments recorded during that period will not be available for 
EntraPass Video Vault.

• Video server online, archive period not valid
• Video server offline, archive period not valid

4 To view the list of drive on which video data have been archived, select the View drive list 
menu item. The Drive list window shows the status of all the files retrieved by EntraPass 
Video Vault from the Video server.

• Disk ready
• Disk space lower than 100 MB
• Network drive not available
16 • EntraPass Video Vault Managing Archived Video Segments460



Reference Manual
• Cannot access this drive
5 Select Transaction log to view the list of transaction errors.

NOTE: The transaction log window shows all the transactions that have occurred in the 
software since the last time it was run. The Filters fields enable users to select the type of 
transactions to be displayed.
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Vocabulary Editor
 The Vocabulary Editor allows users to translate the display text of the software in the language of 
their choice.
EntraPass offers you the possibility of adding up to 99 languages for the purpose of changing the 
text language in the graphic user interface. However, you can only run the software in two 
languages at a time, a primary and a secondary language. 
If you want to use the software in a language other than English, French, German or Spanish, you 
can have the database dictionary translated in the language of your choice. You will then have to 
integrate the translated dictionary in the software. The creation of a new display language is 
carried out in three stages: 
• Translating the source text,
• Integrating the newly created language to the EntraPass dictionary in the Server,
• Distributing the new custom language to all EntraPass application.

NOTE:  In order to be able to run a new language, your operating system (Windows) must 
support the desired language. For example, your keyboard (characters) and window (display) 
must support the specific characters of the desired language. The computers where 
EntraPass applications are running must also support the language. For more information on 
language support, refer to your system administrator.

Installing the Vocabulary Editor
EntraPass Vocabulary Editor is a stand-alone program. You can install it and run it independently.
If you want to translate the system language, you just have to install the Vocabulary editor and 
then to translate the vocabulary database.

NOTE: You do not need an additional license to install the Vocabulary Editor. You just have to 
select it in the Setup window.

Translating the System Language
EntraPass Vocabulary Editor is a stand-alone program. You can run it independently, you do not 
need to launch EntraPass software to run the Vocabulary editor. The Vocabulary Editor program 
will assist you if you want to translate the software in a language, other than English, French, 
Spanish or German. 
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To translate the software language:
1 Start the Vocabulary editor from the Windows Start menu: click Start > Programs > EntraPass 

Corporate Edition> Vocabulary Editor > Vocabulary Editor. 

2 From the available Language list, select the new language, then click . The 
system displays again the Select language window. Select the source language for the 
translation, then click OK. The newly selected language is transferred to the right in the 
Custom Languages display list. The Edit and Delete buttons are enabled.
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3 Select Edit to view the vocabulary database table.
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4 In the Vocabulary Editor window, click the Edit button to start translating the software 
vocabulary. The system displays the dictionary database. 

NOTE:  You must make sure that the Customdictionnary directories are regularly backed up 
(C:\ProgramFiles\Kantech\Vocabulary Editor\CustomDictionary\files.xxx.ath) or 
C:\ProgramFiles\Kantech\”Application type”\CustomDictionary\files.xxx.0

The table below shows the value of the Vocabulary Editor color codes.
 

VOCABULARY EDITOR 
COLOR CODES VALUE

Green Valid  text string.

Blue/Green New text string.

Red Obsolete text string.
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5 The “Source language” column contains text based on the basic language that was selected 
during the creation of the vocabulary. This column will serve as a “source” for the translation. 
Software language columns cannot be modified by the user. 

6 Use the right-click to enable a contextual sub-menu or use the Language editor toolbar. A hint 
appears when you position the mouse over a button.

Integrating your Custom Language in Entrapass
Once the translation is finished, you have to integrate the new dictionary into the system 
dictionary so that system operators can use it.
1 Start the Vocabulary Editor. The Vocabulary Editor window toolbar displays five buttons. 

NOTE: The Graphic User Interface will only appear in one of four languages: English, French, 
German or Spanish.
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2 Select a newly translated vocabulary.

• You may choose to Apply changes to the Operational dictionary: this option is useful when 
you want to test your changes before you update other workstations.

• Restore the operational vocabulary: this option allows the user to easily restore the default 
languages. It creates a self-extracting file which restores the original dictionary.

•  Scan dictionary for new entries: this option is useful when the software was updated for 
example.
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3 If you decide to implement the new vocabulary, select the Actions menu, then choose Create 
self-extracting file for update option. The system creates the Updatedictionary.exe file, and 
prompts you to select a destination folder for the file:

4 Select the destination folder for Updatedictionary.exe. By default, the Self-extracting file is 
stored in C:\Program Files\Kantech (application). 

NOTE: It is recommended to copy the Updatedictionary.exe file on a network folder if you want 
operators to access the file to update their software application.

Distributing the New System Vocabulary
Before you run the file, make sure to exit the EntraPass software; otherwise the operation will not 
work. To update the system vocabulary, you have to update the EntraPass server first. If you have 
a Mirror database application, close it before you shutdown the server (so it does not start the 
Redundant Server when you close the EntraPass server). Once the Mirror database application is 
shutdown, shutdown the Primary server, update it and re-start the server. Update the Mirror 
database and the Redundant server, then start the Mirror database.

To update the server vocabulary:
1 Exit all Entrapass programs.
2 Start Windows Explorer > Kantech > (EntraPass application), then copy the 

Updatedictionary.exe on the server. 
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3 Double-click Updatedictionary.exe. The system displays the Entrapass applications that are 
installed on the computer.

4 Select each application, then click the Update dictionary button.
5 You have to copy Updatedictionary.exe on every computer where EntraPass is installed, and 

then double-click it in order to launch the language update. To do so, you have first to exit all 
EntraPass applications before you run the self-extracting file. 

6 Select the application you want to update (one at a time) and click Update dictionary button. 
The system will automatically copy the vocabulary to the Custom Dictionary directory then 
merge the custom directory with the application dictionary.

NOTE: You MUST update all the applications in the system.

NOTE: To restore the dictionary back to original default values, follow the same procedures as 
for updating the dictionary.
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7 Once you have finished updating the dictionary database for the Primary Server, the Mirror 
Database and the Redundant Server, start the Primary server. 

8  Select the Options tab, then select the Select language icon.
16 • Vocabulary Editor Distr ibuting the New System Vocabulary470



Reference Manual
9 In the Select the language window, select the primary language and the secondary language. 
The newly integrated language is displayed in the list. It is important to select the language at 
this stage, otherwise the operators of the system will not be able to use it.

NOTE: For example, if your primary language is “English” and your secondary language is 
“French”: if you select your new language (i.e. Russian) as primary, all operators who have 
“English” as their display language in the Operator menu will be modified to “Russian”. On the 
other hand, if you change the secondary language to “Russian” and operators are using 
“English”, you will have to manually select “Russian” in the Operator definition menu”. To 
assign the desired language to an operator, use the System definition menu, then select the 
Operator definition menu. 

10 Before you update all the applications, login on the server and verify the display language. If 
everything seems to be normal, then you can proceed with the system update. Remember, the 
computers must support the language (display and keyboard). 

NOTE: For every language you are installing, be sure to select the correct keyboard (Start > 
Settings > Control panel > Keyboard). The selected keyboard is displayed in the system tray. 

Upgrading the System Vocabulary
When you upgrade your system, the new or modified strings are automatically inserted in the 
system vocabulary and also in the custom dictionary.
If you have added a custom language to your system, you have to translate the new/modified 
strings following a system upgrade. Therefore, you have to re-edit the vocabulary and create a new 
self-extracting file.
When you re-open the vocabulary table, new strings are indicated by a green point. Obsolete 
strings (no longer used) are tagged red.

NOTE: For easier management, we recommend that you always edit your vocabulary from the 
same computer and integrate it to the system using a self-extracting file.
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Express Setup Program
The Express Setup program offers a quick and simple way to configure all the components of a 
system gateway: type of readers used, number of sites, site name, number of controllers on a site, 
etc. For example, it enables users to modify a door’s name by   automatically applying default 
settings to all relays and inputs of controllers connected to the selected door. 

To configure a Site under a Corporate Gateway using Express Setup:
1 From Windows Start menu: Start > Programs > EntraPass Corporate> Workstation/Server > 

Express Setup. You may also launch Express Setup by clicking the Express Setup icon from 
the registration window or gateway definition window.

2 Click the Login icon. You have to log into the server before you modify the system 
configuration. Only authorized operators can modify the system parameters.

NOTE:  The Operator login window appears only when starting Express setup in stand alone 
mode.
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3 Enter your Operator user name and password, then click OK. The OK button is enabled when 
the Password field contains data.

4 Select the gateway for which you want to configure a site, then click the New site icon.

5 Enter the Site name in the Site description field, then select the reader type. 
6 Set the number of controllers. 
7 Specify the connection type. This indicates how the site communicates with the gateway 

computer.
• Select Direct, if the site is integrated to the gateway computer and connected to it by an 

RS-232 serial port. If the connection type is direct, then you have to specify the serial port 
(com:) as well as the controller site baud rate (usually set at either 9600 or 19200). The 
default value is 19200.

• Select TCP-IP if the site communicates with the gateway through a terminal server device 
using a port number. Then you have to specify the terminal server’s IP Address and Port 
number. If the connection type is TCP/IP, the port settings section is disabled. To 
47316 • Express Setup Program Upgrading the System Vocabulary



Reference Manual
configure the terminal server, follow the manufacturer’s instructions or refer to the 
terminal server documentation.

• Select Remote site Modem if applicable. The modem option is enabled only when this 
option is installed.

8 Select the controller type for this site.
9 Click OK. You have to specify minimum configuration for the controllers defined in the site. 

This include assigning a name to the controller, specifying the passback option, and entering 
the serial number (the serial number column appears only when it is a KT-100 or KT-300 
controllers). 

NOTE: The passback feature will not allow any card to re-enter unless it has been used to exit. 
This requires that readers be used for both entry and exit. 

10 Check the Same door box if a reader is installed on each side of the door.
11 Select the appropriate passback type (none, soft or hard ). If a door is defined as an access 

door, there is no passback defined for this door. An entry or an exit door can be assigned a 
passback option.

12 Enter the serial number cell, if this column is displayed. Usually the information is found on 
the controller label. 

13 Once you click OK, components associated with the controller and to the site are created in the 
server database. By default, each controller is assigned two doors, if the Same door option is 
not checked. The following table summarizes default values that are assigned to controllers.

NOTE: When the system is updating the database, the second status flag turns red, indicating 
that the system database is locked. When you try to access another system menu while the 
database is locked, an error message appears. Simply wait until the system database 
becomes available.
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The following are default values assigned to controllers by the Express Setup utility.

The following table summarizes how input zones are used by the system. 

Controller Door Relays Input zones Aux. output

KT-100 1 4 4 2

KT-200 2 2 16 4

KT-300 2 2 8 4

Input zones System use Controllers

1 Door 1 contact all

2 Door 1 Rex all

3 Door 2 contact KT-100 & KT-300

4 Door 2 Rex KT-100 & KT-300

9 Door 2 contact KT-200

10 Door 2 Rex KT-200
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The following table summarizes how output zones are used by the system. 

NOTE: The remaining components (relays and input zones) are undefined, that is, they have 
been created but not yet defined. Components that are defined are grayed out. You cannot 
select them or change their description. You can change their description in their respective 
definition menu (Devices > Relays/Input zones).

By default, the system assumes that:
• The reader is Ioprox Kantech 26 bits Wiegand, 
• The power supervision schedule is always valid,
• The failsoft delay is enabled for 45 seconds,
• The resistor type is single (KT-100 and KT-300),
• The wait for second card delay is 30 seconds.

To configure a controller using Express Setup:
When you add a controller to a site, the system prompts you to use the Express Setup tool to define 
the controller. You may also launch this tool by selecting a controller and clicking the Express 
Setup icon in the controller window toolbar.

Aux. output Use Controllers

1 LED (Door 1) All

2 Buzzer (Door 1) All

3 LED (Door 2) KT-200 & KT-300

4 Buzzer (Door 2 KT-200 & KT-300
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1 From a controller definition window, click the Express Setup icon or click Yes in the system 
message box. 

2 Specify if Both readers are on the same door if this is applicable. If two readers are installed 
on the same door, the REX contact option is disabled.
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3 Click the More button to define the other devices, such as doors, inputs, relays and outputs. 

NOTE: Components   are listed in the left-hand pane. The related tabs are displayed in the 
middle of the window. When you select a component, its default name, number and default 
settings are displayed in the language section. Select a component to enable its tab. 
Components that are assigned are gray. You cannot modify their description at this stage. 
You have to go in their definition menu. However, you may later modify any component 
description in its definition menu (Devices > Relay/Input/Output, etc.).

To define relays:
You may configure relays to define their operation mode, activation and deactivation schedules. If 
you want to assign a name to the relay, you have to select it. When you use the Select All button, 
the default names are kept.
1 Select the first relay if you want to modify its description. The relay tab is enabled. You have 

to check the box beside the relay name in order to enable the language section.

2 Check the appropriate options for the Operating mode and for the Activation mode. 
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3 In the Automatic activation schedule drop-down list, choose the appropriate activation 
Schedule.

To define inputs:
By default, the response time for a REX is 250 ms; it is 500 ms for other input zones. The alarm 
restore time is 150ms by default. The Express Setup program allows you to define the Input Normal 
State and Monitoring Schedule.
1 Select the first undefined input (its checkbox is not gray). Check its box to enable the 

language fields, then assign names to it. 

2 Select the Monitoring schedule from the drop-down list. If you want to assign a custom 
schedule to the selected input, you have to define it. (Definition > Schedule).

To define auxiliary outputs:
By default, all outputs are defined, as follows:
• Auxiliary output 1 is used as a LED for door 1 (all types of controllers)
• Auxiliary output 2 is used as a buzzer for door 1 (all types of controllers)
• Auxiliary output 3 is used as a LED for door 2 (KT-200 and KT-300)
• Auxiliary output 4 is used as a buzzer for door 2 (KT-200 and KT-300).
If you want to change their definition, you may do so while defining a controller or in their 
definition menu (Devices > Auxiliary Outputs)
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Quick Viewer 
The Quick Report Viewer program allows operators to view previously saved reports without 
having to start EntraPass. It is used to view / display / load reports that were previously saved (in 
a.QRP format) during a print preview or Quick reports. For details on requesting and generating 
reports, see Chapter 13 ‘Reports’ on page 375. 
This program is useful when EntraPass is off-line and when a report must be displayed for specific 
purposes.

To start the Quick Viewer: 
1 From the Windows task bar, click Start > Programs > EntraPass >Workstation/Server >Quick 

Viewer.
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2 Click the  button to open a report. The system displays the Open window:

3 By default, when a report is saved in a QRP format, the system automatically saves it in “My 
Documents” folder. If you have saved the report in another folder you have to browse to the 
folder to select the report.

4 Click Open to preview the report. Once you have selected the requested report, the system will 
display your report:

5 Use the toolbar buttons to preview the report: 

•  —Use the Zoom out button to zoom out the report view.

•  —Use the Zoom In button to display details (view closer).

• —Use Previous Page and Next Page buttons to change pages.

•  —Use the Open button to open a report located in any folder on your computer.

•  —Use the Print button to print the report. There will be no printer setup dialog box, 
the report will automatically print, to cancel the printing, click Cancel.

•  —Use the Quit button to quit the application.
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PING Diagnostic
This stand-alone program is used to diagnose network intermittent related problems and/or to 
determine whether a specific IP address is accessible. 
It works by sending a packet (block) to the specified address and waiting for a reply. The PING 
diagnostic program is used primarily to troubleshoot Internet connections. 

NOTE: If you want this option to be available, you have to select the “Allow diagnostic on 
network” field when defining the server parameters. For more information, see “The 
EntraPass Server” on page 439.

To use the PING diagnostic program:
1 From the Windows Start menu, click Start > Programs > EntraPass Corporate> Workstation/

Server PING Diagnostic.

2 Select Server, Workstation or Redundant Server depending on which station you want to 
operate. 

3 Select the Block size from the drop-down list. This field is used to select the amount of data 
that will be sent. Selections vary from 1KB to 1024KB (1MB).

4 In the TCP/IP address field, enter IP address of the computer you want to test the 
communication link. 

NOTE: See Network Administrator for the required TCP-IP address. 
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5 When you have entered the TCP/IP address, click the Test button to execute the command. 
The information will be sent 16 times.The system displays the number of bytes sent and the 
number of bytes received and the delay (in milliseconds). 

NOTE: The delay between attempts should be similar, except for the first attempt which could 
be longer than the others. If you do not have a response, the message will be displayed in the 
following format: Sent(block) Bytes, No Answer (1717)
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Workstation—Configuration Program
This utility program is useful when a workstation or gateway needs to be configured. It contains 
all the menus and features necessary to configure a system with event display, desktops, manual 
operations or reports.
The system installer can configure all workstations directly from this program without having to 
go from workstation to workstation.
Start the Workstation config system utility from Windows start menu Start > Programs > 
EntraPass Corporate> Server> Workstation for Configuration. This program can also be launched 
from a shortcut on the desktop.
When using this option, you must first create the operators and security levels (System menu), 
then define the gateway, sites, controllers (Devices menu).

NOTE: For more information see Chapter 2 ‘Software Installation’ on page 7
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Migrating EntraPass Special Edition to Corporate Edition
EntraPass offers you the ability to migrate your database from Special Edition to Corporate 
Edition.

Requirements
• EntraPass Special Edition installed
• EntraPass Corporate Edition.

Steps 
1 Install EntraPass Corporate Edition (do not run it, do not register it). For details about the 

software installation, see Chapter 2 ‘Software Installation’ on page 7.
2 Run the Migration Utility: from the Windows Start menu > EntraPass Corporate Edition > 

Server > Migration from EntraPass Special Edition. The Migration Utility main window 
appears.

3 From the Migration window, navigate to the EntraPass SE database.
4 Launch EntraPass Corporate Edition. Register EntraPass Corporate Edition. To register 

EntraPass Corporate Edition, call Kantech technical support. For details, see Chapter 2 
‘Software Installation’ on page 7. 
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The Gateway Interface
A gateway is a software interface that is used to convert the information received from the sites 
(which receives information from the controller loops) to the server. 
The server and the gateway communicate in the same protocol while the controllers and the site 
communicate in the same protocol. Usually, the gateway software are installed on the same 
computer. Sometimes, the gateway can be installed on an external computer which is linked to 
another computer equipped with the gateway software interface (that communicates the 
information to the server). The access control system is in fact composed of two different systems: 
• Computers are used to enter information and access the database.
• Door controllers (grouped in loops) are managed through the gateway .
The System menu lets you login/logout and reload the gateway.

To start the gateway:
You can start the Workstation and the gateway, the workstation only or just the gateway only 
interface.
1 Click on Start > Programs > EntraPass (software) > Gateway > Gateway. This is when you only 

have the “Gateway Only” software installed. You may also click Start > Programs > EntraPass 
(software) > Workstation & Gateway > Gateway (when you have the Workstation & Gateway 
software installed). 

Reloading the Gateway 
This option is used to reload information to a specific gateway. It is used to refresh all or some 
parameters relative to the network. Information included in the Server is downloaded to each 
gateway, then the gateways reload the controllers. 
When you perform this operation, the controllers will be working on their own (fail-soft mode) 
and. 

The status bar indicates the system's date and time, the name of the operator who is currently 
logged, the status of the gateway (could be any message such as running, etc.) and the IP address 
of the EntraPass server (the green square indicates the server state, if yellow then it is the 
Redundancy Server).
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• Configuration data received from the server: The progress bar indicates that configuration 
data is being received from the EntraPass Server. Configuration data can be information such 
as “Card modifications, etc.”.

• Data requested by workstation: The progress bar indicates that data is being requested from 
the EntraPass Workstations of the system (could be any). Data can be information such as 
“Status Requests, etc.”.

• Messages generated by the gateway: The progress bar indicates that messages are generated 
from the gateway. These messages can be: Access granted, input in alarm, Access denied—
bad access level, etc.

• Configuration data sent to the controllers: The progress bar indicates that configuration data 
(which was received by the EntraPass Server) is being forwarded to the controllers.

NOTE:  The progress bars indicate data transfers being executed and that information is being 
sent back and forth.
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CardGateway Program
The CardGateway software is a program that creates a mirror copy of the EntraPass card database 
in the MS-SQL or ORACLE Server. This interface allows user to modify, add or obtain card-
related information, all this in real-time, from the MS-SQL or ORACLE Client version. The 
mirror card database, which contains cardholder information, will be updated automatically as 
soon as new information is available in the EntraPass card database.
Depending on the client interface that is used (EntraPass or MS-SQL/ORACLE Client) to add or 
modify a card, the CardGateway software ensures that the modifications is conveyed to the 
EntraPass Server’s database through the Mirror Database and vice versa and that the information, 
whatever its origin, is updated in both databases. (For more information, see the “exchange data 
process” diagram).

Installation 
It is recommended to install the CardGateway software on a computer where use is at its 
minimum, since the data exchange process is processed through the computer running the 
software. 
Depending on the size of the database and the number of transactions, the updating process may 
require more memory. Furthermore, the computer on which the software will be installed must 
meet the same requirements as an ordinary EntraPass Workstation (see “System Requirements” on 
page 8).
1 Install the CardGateway program by following the installation procedure, see “Installing the 

System” on page 11 (use the appropriate installation code). 
2 You MUST install MS-SQL/ORACLE client on the same computer as the CardGateway. You 

can also install the CardGateway on a computer where an existing MS-SQL/ORACLE client 
software is already installed,

3 To complete the installation, you must create the database in the MS-SQL/ORACLE Server. 
To do so, you can manually create the database or you can use the automatic integrated 
function to automatically create the database in the Server (see CardGateway Configuration 
below).

CardGateway Configuration
For more information on how to configure the CardGateway application in order to create the 
database automatically or to manually create the database, user name and password in MS-SQL / 
ORACLE Server, see “Manually Creating Server Databases” on page 68.
Starting the program
1 From the Windows tool bar, click on Start > Program > EntraPass (software) > CardGateway > 

CardGateway. The display language depends on the settings of the operator that was 
previously logged in this workstation.
Once you have performed the above steps, the software will try to establish a link with the 
server. During the process, the following screen will be displayed:
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2 When the application connects to the MS-SQL/ORACLE server for the first time, it creates 5 
tables in the KANCARD database named: tbCard, tbCardType, tbCardAccessGroup, 
tbTransactionIn and tbTransactionOut.

NOTE:  Information or data that is being transferred from the EntraPass primary server to the 
CardGateway database will be compressed for faster transfer.

The first three tables (tbCard, tbCardType, tbCardAccessGroup) are filled at the first connection 
with all the Cards, Card Access Groups and Card Types. Writing in these tables is not necessary 
because the CardGateway periodically updates them. They should only be read.
The tbTransactionIn table is used to create, modify or delete cards from the MS-SQL/ORACLE 
server. The CardGateway scans this table periodically. When it finds a card, it creates, modifies or 
delete this card in the EntraPass server depending on the value of the State column of the 
tbTransactionIn record (a state value of 0 will create or modify the card and a state value of 1 will 
delete the card). Once this is done, the CardGateway will delete the card from the tbTransactionIn 
table.
The tbTransactionOut table contains the history of all creations, modifications and deletions of 
cards (since the start of the CardGateway). All successful creations, modifications or deletions of a 
card done by the CardGateway after reading this card in the tbTransactionIn table will also be 
found in the tbTransactionOut table.
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3 Then, the main application screen will be displayed:

System configuration
• Server name—This field indicates the name of the SQL or Oracle Server as defined in the 

workstation definition menu.
• EntraPass State—This field indicates the real-time status of the EntraPass server. In case 

of failure, messages would appear here.
Database

• Database State—This field indicates the real-time status of the card database.
Transaction Report

• Data received from the EntraPass Server—When card-related information are modified 
within the EntraPass server (database), the information is also forwarded to the 
cardgateway database where the SQL or Oracle Server will collect the information. This 
field indicates the number of transactions that were executed and sent to the card 
database.

• Data updated on SQL Server—
• Nb of cards sent to EntraPass Server—This field indicates the number of cards that were 

added or modified in the SQL or Oracle client application and that were sent to the 
EntraPass Server’s database.

Transactions
The registry contains the details of the transactions that are processed by the CardGateway 
interface.
To access this screen, you must login.
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Diagram
The diagram below shows the “DATA EXCHANGE PROCESS” between the CardGateway and 
the MS-SQL / ORACLE database.
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The SmartLink Interface
The SmartLink interface allow a user to define a message and format type that may be sent on the 
second COM port or to a disk file. The following pages explain how to build a character string that 
can be sent through the SmartLink.
Using the SmartLink feature, you can interface to just about any intelligent device such as video 
matrix switchers, paging systems, etc. 
To do this, a RS-232 link is cabled between one of the EntraPass Workstation and the external 
device. The necessary command strings and protocols can be easily edited on site to fit just about 
any job. 
The SmartLink simplifies the interfacing to “alien” intelligent devices because it provides the 
system installer all the tools necessary to build and maintain the actual interface without having to 
purchase “special” drivers from Kantech.
In communications, a link is a line or channel over which data is transmitted. The transmission of 
data from one computer to another, or from one device to another. A communications device, 
therefore, is any machine that assists data transmission. For example, modems, cables, and ports 
are all communications devices. 
Required Material and Installation
• A computer that meets the same requirements as an EntraPass Workstation (see “System 

Requirements” on page 8),
• Installation CD for the SmartLink application including the serial number.
1 Create the new application in the Workstation Registration menu, see “System Requirements” 

on page 8 for more information on how to create new applications,
2 Install the SmartLink application on the computer—see “Installing the System” on page 11.
3 Once the SmartLink application is installed, you need to configure the SmartLink application,
4 If you are using the Message Mode, you will need to create instructions using special macro-

commands. For more information on how to create instructions, see “Instruction Definition” 
on page 330.

Configuring the SmartLink application
The configuration is done on an ordinary EntraPass workstation or any EntraPass Workstation for 
configuration (found on the same computer as the Server software). 
Depending on the modes that will be used for the SmartLink (Messages or Commands), you must 
program the workstation accordingly.

To Start SmartLink application
1 From the computer where the SmartLink application is installed, click on the Windows task 

bar and select Start>Program>Kantech>SmartLink. The SmartLink application will be started. 
Refer to the SmartLink Specifications Manual for more information on the SmartLink 
Application.
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Network Consumption
The consumption of network time can be divided in many categories:
Messages:
• A message originating from a Server can generate:
• Minimum: 128 bytes + (# workstations, SmartLinks * 32 bytes)
• Maximum: 128 bytes + (# workstations * 416 bytes)
• A message originating from a Workstation, Gateway, etc. generates 56 bytes.

Using pictures (cardholders) on a system will increase the network traffic. The increase will 
mainly depend on the number of workstations that are using this option, the number of cards 
in the system as well as the number of transactions per card.

Reloads:
Since reloads are sporadic actions that have few impacts on the network, it is possible to break 
down the reload consumption of the gateway into commonly used features.

Features Bytes Details

System 256 -

Controllers # * 32 Where # = 0 to 128

Doors # * 32 Where # = 0 to 256

Relays # * 16 Where # = 0 to 2048

Inputs # * 16 Where # = 0 to 2048

Auxiliary outputs # * 16 Where # = 0 to 512

Areas # * 32 Where # = 0 to 100

Alarm partitions # * 64 Where # = 0 to 100

Controller groups # * 32 Where # = 0 to 100

Door groups # * 80 Where # = 0 to 100

Relay groups # * 320 Where # = 0 to 100

Input groups # * 320 Where # = 0 to 100

Access level groups # * 80 Where # = 0 to 100

Access levels # * 640 Where # = 0 to 250
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Manual Operations:
There are 2 types of manual operations:
• Operations that are used to execute functions such as unlocking a door. These operations, 

which are occasionally requested, usually involve an insignificant amount of information. 
Operations which are used to recuperate a component or request a card list. Even though these 
operations can be frequently requested, they usually involve an insignificant amount of 
information. For example, requesting a door status only requires 16 bytes OUT and 64 bytes IN.

Schedules # * 64 Where # = 0 to 100

Cards # * 16 Where # = 0 to 32,000

Holidays # * 64 -

Event parameters # * 16 Where # = 0 to 50,000

Features Bytes Details
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Chapter 17 • Animated Icons
Animated icons indicate the status of physical or logical components in the windows of EntraPass 
software. They represent the component status in real time and simulate a movement by displaying 
a series of pictures associated with the component.
If a particular component status is difficult to identify, use this section to identify it.
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Controllers 
Controller animated icons indicate the status of a door controller in the graphic window (Desktop 
> Graphic desktop) or in the “Operation” window. 

Status unknown

This animated icon appears when the EntraPass application has not received the component' status 
after four (4) attempts. It is displayed in: 
• the Operation window (alarms, door, elevator door, relay, input, reload data) or the “Graphic” 

window (Desktop—graphic).

Controller AC failure

This animated icon appears when the controller is in AC failure. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the “Operation” — “Controller Reset” Controller AC failure and Tamper Switch in “alarm”

This animated icon appears when the controller is in AC failure and the tamper switch is in alarm. 
It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Controller Reset

Controller is not communicating

This animated icon appears when the controller is not communicating. It is displayed in: 
• the “Operation” — “Controller Reset” windows.
• the “Graphic” window (Desktop—Graphic desktop).

Controller communication is regular (no problem)

This animated icon appears when the controller is communicating and the communication is 
regular. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Controller Reset.
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Controller status is not yet known

This animated icon appears when the status of the controller is not yet known. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)

Controller is in “Reset” and AC failure

This animated icon appears when the controller is in “reset mode” and in “AC failure”. It is 
displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Controller Reset.

Controller is in “Reset”, “AC failure” and “Tamper in alarm”

This animated icon appears when the controller is in “reset mode”, in “AC failure” and the tamper 
is in alarm. It is displayed in:
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Controller Reset

Controller is in reset and tamper in alarm

This animated icon appears when the controller is in “reset mode” and the tamper is in alarm. It is 
displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation” > Controller Reset.

Controller tamper in alarm

This animated icon appears when the controller tamper is in alarm. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the “Operation” “Controller Reset” when the controller tamper is in alarm.
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Controller reloading firmware

This animated icon appears when the controller is reloading firmware. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the “Operation” “Controller Reset”.
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Doors
Icons representing a door state indicate the status of door within the graphic window (from the 
desktop) or within the “Operation” window. 

Door forced open

This animated icon appears when the door is opened and that no access granted nor request to exit 
was permitted. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the “Operation” “Door, Elevator Door” 

Door forced open (reader disabled)

This animated icon appears when the door is opened and that no access granted nor request to exit 
was permitted and the reader is disabled. it is displayed in: 
• the “Graphic” window (desktop—graphic) 
• the Operation > Door, Elevator Door

Door closed and locked

This animated icon appears when the door is closed and locked. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation> Door 

Door closed and locked (reader disabled)

This animated icon appears when the door closed and locked and that the reader is disabled. It is 
displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the “Operation > Door.

Door status unknown

This animated icon appears in: 
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• the “Graphic” window (desktop—graphic) when the status of the door is not yet known.

Door open too long

This animated icon appears when the door is opened more than the permitted delay set in “open 
time”. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the “Operation >Door, Elevator door.

Door open too long (reader disabled)

This animated icon appears when the door is opened more than the permitted delay set in “open 
time” and that the reader is disabled. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the “Operation” “Door, Elevator door”.

Door open and unlocked manually

This animated icon appears when the door is opened and it was unlocked by an operator. it is 
displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation >Door > Elevator door”.

Door open and unlocked manually (reader disabled)

This animated icon appears when the door is opened and it was unlocked by an operator and the 
reader is disabled. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation >Door > Elevator door”.

Door is opened and unlocked by schedule

This animated icon appears when the door is opened and it was unlocked by a schedule. It is 
displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
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• the Operation >Door > Elevator door”.

Door is opened and unlocked by schedule (reader disabled)

This animated icon appears when the door is opened, and it was unlocked by a schedule and the 
reader is disable. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation >Door > Elevator door”.

Door pre-alarm on open too long

This animated icon appears when the door is opened more than half the time permitted delay set in 
“open time”. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation >Door > Elevator door”.

Door pre-alarm on open too long (reader disabled)

This animated icon appears when the door is opened more than half the time permitted delay set in 
“open time” and the reader is disabled. it is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Door > Elevator door”.

Door still opened schedule invalid

This animated icon appears when the door is opened and the unlock schedule is invalid. It is 
displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Door/Elevator door”.

Door still opened schedule invalid (reader disabled)

This animated icon appears when the door is opened and the unlock schedule is invalid and the 
reader is disabled. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
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• the Operation > Door/ Elevator door”.

Door unlocked by an operator

This animated icon appears when the door is unlocked by an operator (manually). It is displayed 
in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Door > Elevator door”.

Door unlocked by an operator (reader disabled)

This animated icon appears when the door is unlocked by an operator (manually) and the reader is 
disabled. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Door/Elevator door”.

Door unlocked by a schedule

This animated icon appears when the door is unlocked by a schedule. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Door/Elevator door”.

Door unlocked by a schedule (reader disabled)

This animated icon appears when the door is unlocked by a schedule and the reader is disabled.
 It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Door/Elevator door”.

Elevator door unlocked and closed

This animated icon appears when the elevator door is closed and unlocked. It is displayed in: 
• the Graphic desktop (Desktop > Graphic desktop window)
• the Operation > Door/Elevator door”.
17 • Doors502



Reference Manual
Relays
Relays icons indicate the status of a relay within the graphic window (from the desktop) or within 
the “Operation” window. 

Relay activated by an event

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the relay is triggered by an event.
• the “Operation” “Relay” when the relay is triggered by an event.

Relay temporarily activated by an event

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the relay is temporarily activated by an 

event.
• the “Operation” “Relay” when the relay is temporarily activated by an event.

Relay activated by an input

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the relay is triggered by an input.
• the “Operation” “Relay” when the relay is triggered by an input.

Relay temporarily activated by an input

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the relay is temporarily activated by an input.
• the “Operation” “Relay” when the relay is temporarily activated by an input.

Relay activated by an operator

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the relay is activated by an operator.
• the “Operation” “Relay” when the relay is activated by an operator.
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Relay temporarily activated by an operator

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the relay is temporarily activated by an 

operator.
• the “Operation” “Relay” when the relay is temporarily activated by an operator.

Relay activated by a schedule

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the relay is activated by a schedule.
• the “Operation” “Relay” when the relay is activated by a schedule.

Relay deactivated

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the relay is not activated.
• the “Operation” “Relay” when the relay is not activated.

Relay status unknown

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the status of the relay is not yet known.
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Inputs
This section is used to indicate the status of an input within the graphic window (from the desktop) 
or within the “Operation” window. 

Input in alarm—Not supervised

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the input is in alarm and the monitoring 

schedule is invalid.
• the “Operation” “Input” when the input is in alarm and the monitoring schedule is invalid.

Input in alarm—Shunted by operator

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the input is in alarm and it is shunted by an 

operator.
• the “Operation” “Input” when the input is in alarm and it is shunted by an operator.

Input in alarm—Supervised

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the input is in alarm and the monitoring 

schedule is valid.
• the “Operation” “Input” when the input is in alarm and the monitoring schedule is valid.

Input in alarm—Supervised by operator

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the input is in alarm and it is supervised by 

an operator (continuous supervision).
• the “Operation” “Input” when the input is in alarm and it is supervised by an operator 

(continuous supervision).
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Input OK—Not supervised

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the input is in normal condition and the 

monitoring schedule is invalid.
• the “Operation” “Input” when the input is in normal condition and the monitoring schedule is 

invalid.

Input OK—Shunted by operator

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the input is in normal condition and it is 

shunted by an operator.
• the “Operation” “Input” when the input is in normal condition and it is shunted by an operator.

Input OK—Supervised

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the input is in normal condition and the 

monitoring schedule is valid.
• the “Operation” “Input” when the input is in normal condition and the monitoring schedule is 

valid.

Input OK—Supervised by operator

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the input is in normal condition and it is 

supervised by an operator (continuous supervision).
• the “Operation” “Input” when the input is in normal condition and it is supervised by an 

operator (continuous supervision).

Input status unknown

This animated icon appears in the “Graphic” desktop when the status of the input is not yet known.
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Sites and Gateways
These icons indicate the status of a site, or gateway within the graphic window (from the desktop) 
or within the “Operation” window. 
Controller Site:
Site status is not yet known

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the status of the controller site is not yet 

known.

Controller site connected

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the site is connected and communication is 

OK.
• the “Operation” “reload data” when the site is connected and communication is OK.

Controller site connected and in “Reload Data”

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the site is connected and is in “reload data” 

state.
• the “Operation” “reload data” when the site is connected and is in “reload data” state.

Controller site—Communication Failure

This animated icon appears in: 
• the “Graphic” window (Desktop—graphic) when the site is disconnected and there is a 

communication failure.
• the “Operation” “reload data” when the site is disconnected and there is a communication 

failure.
Gateway:
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Gateway—Communication Failure

This animated icon appears in: 
• the “Operation” (door, elevator door, relay, input, reload gateway) window when the gateway 

is in communication failure.
• the “Graphic” window (desktop—graphic) when the gateway is in communication failure.

Gateway in “Reload Data”

This animated icon appears in: 
• the “Graphic” window (Desktop—graphic) when the gateway is being reloaded.
• the “Operation” (door, elevator door, relay, input, reload gateway) when the gateway is being 

reloaded.

Gateway—Communication Failure during Reload Data

This animated icon appears in: 
• the “Operation” (reload data gateway) window when the gateway loses communication during 

a reload data operation.
• the “Graphic” window (desktop—graphic) when the gateway loses communication during a 

reload data operation.

Gateway communication is regular (no problem)

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the gateway is communicating and the 

communication is regular.
• the “Operation, reload data gateway, communication is regular. 

Gateway Trouble

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the gateway is not communicating.
• the “Operation” “reload data gateway”, the gateway is not communicating.
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Gateway Trouble when Reloading

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the gateway is not communicating. 
• the “Operation” “reload data gateway” is not communicating with the gateway during a reload 

data operation.
Gateway (Gateway Software Interface):
Gateway OK—communicating

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the gateway is communicating.
• the “Operation” “reload data” when the gateway is communicating.

Gateway in “Reload Data”

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the gateway is being reloaded.
• the “Operation” “reload data” when the gateway is being reloaded.

Gateway—Communication Failure

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when gateway is not communicating.
• the “Operation” “reload data” when the when gateway is not communicating.
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EntraPass Application
Application status is not yet known

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the status of the application is not yet known.

Application attempts communication

This animated icon appears in: 
• the startup window when the workstation attempts to communicate with the server.

Application—Communication Failure

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the workstation is in communication failure.
• the “Operation” window (alarm, door, elevator door, relay, input, reload gateway) when the 

workstation is in communication failure.
Others
Database Initialization

This animated icon appears in: 
• the startup window when the workstation initializes the database.

Data not available

This animated icon is used to indicate a transient stage. This could indicate that the requested 
information is not currently available.

No state available

This animated icon is used to indicate a transient stage. This could indicate that the requested 
component status is not currently available.
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Output status is not yet known

This animated icon appears in: 
• the “Graphic” window (desktop—graphic) when the status of the output is not yet known.

Status unknown

This animated icon appears in: 
• the “Operation” (alarms, door, elevator door, relay, input, reload) window when the 

workstation has not received the component' status after four (4) attempts.
• the “Graphic” window (desktop—graphic) when the workstation has not received the 

component' status after four (4) attempts.

Error in process

This animated icon appears in: 
• the “Operation” (alarms, door, elevator door, relay, input, reload data) window when a 

specific error is detected.
• the “Graphic” window (desktop—graphic) when a specific error is detected.

Undefined Component

This animated icon appears in: 
• the “Operation” window (alarm, area door, elevator door, relay, input, reload data gateway) 

when the component does not exist.
• the “Graphic” window (desktop—graphic) when the component does not exist.
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Event buffer 91
Events

Acknowledge schedule 324
Color 323
Deleting and Restoring Associations 326
Display (schedule) 323
Instructions (assign to events) 324
Parameter Definition 322
Print Parameters 328
Print schedule 323
Set priority 324
Viewing Associations 324

Expired 213
Exported Video 172

F
Fail-soft 335, 345
Filtered Messages Desktop 351
floor confirmation 100
Floor Definition 179



Floor Group 287

G
Gateway

Animated Icons (status) 507
message filter 59

Graphic Status (controller view) 295
Graphics

See also Animated Icons 495
Groups

Access levels 286
Controllers 282
Doors 283
Floors 287
Inputs 285
Relays 284

H
Hardware

definition 87
Help 4
Historical Report Desktop 352
Historical Report State 353
Historical Reports

Automatic Filename 390
Automatic Report Schedule Screen 385
Destination 390
Filter mode 382
Output process 389
Output type 387
Preview 403
Report language 390
Schedule Mode 386
Selected components 382

Holiday Definition 185



I
Icons, see Animated Icons 495
Import/Export 269
Information #1 to #10 205
Input Group 285
Inputs

Animated Icons 505
Create groups 285
Monitoring schedule 124
Normal condition 124

Installing the System 11
Instruction Definition 330
Instructions

Assign to events 324
interlock 112

K
Keypad escape key 95
KT Controllers 92
KT-100 94
KT-100 Controller 94
KT-200

expansion devices 96
KT-2252 elevator controllers 96

to program 97
KT-300 94

L
Language (operator) 303
Login name 303
Login schedule 304
Logout on idle 55



M
mantrap 112
master password 405, 408
Message mode 74
Messages definition (filters) 332
Messages Desktop 343
Mirror Database 419
Multimedia Devices 413

alarm sound 413
signature capture 415
video options 414

Multimedia devices 405

N
Network Alarms Desktop 368
New master password 408
Normal condition 124

O
Operator Definition 302
operator name 302
Operators

Allow login on server 308
Bypass workstation message filter 303
Definition 302
Language selection 303
Login name 303
Login Restrictions 308
Operator login schedule 304
Password 303

Output Definition 128
Output filename 377
Outputs

Activation period 129



Associating door events to auxiliary outputs 129
Flash 129
Flash timed 129
Operating mode 128
Steady 129
Steady timed 129

P
passback

option 213
Password

Change master password 408
Operator 303

Pending 213
Picture 215
PIN number 95, 212
PING Diagnostic Program 482
Port number 87, 473
Power supervision schedule 94
Print a log 359, 368
Print Cards 254
Print Event Parameters 328
Printer, see Log printer 410

R
REB-8 Elevator Controllers

to program 99
REB-8 relay expansion board modules 96
recorded events 419
Redundancy Server Address 71
Redundant Server 419
Register the system 19
Registration, see Workstation Registration 437
Relay Group 284
Relays



Activation schedule 121
Animated Icons 503
Create groups 284
Operation mode 121
Temporary activation timer 121

relays 53
Reset, see Controllers 191
Retrieving site events 90
REX 95
REX (Request to Exit) 111
REX contact 112
Rex options 111
rpf files 80
RS-232 serial port 87, 473

S
Schedule Definition 176
Schedules

Acknowledge schedule 324
Days 177
End time 177
Login schedule (operators) 304
Monitoring schedule (inputs) 124
Printing events 323
REX schedule 112
Start time 177
Unlock schedule # 1 (elevator doors) 114

Scheduling 90
Security Level

Assign to operator 304
Read only - (View components) 308

Security Level Definition 306
Administrator 302
Installer 302
Restricted 302

Security parameters 56



Server
Database Utility Program, see Database 450
Getting Started 440
Login 440
Modify the font 448

Server Parameters 417
server parameters 405
server’s IP Address 87, 473
Shunt Delay 125
signature capture 415
Site

retrieving site events 90
Site/Loop Definition 86
SmartLink 75

Create instructions 330
Sound Notification 413
Start a Session 30
startup (see SmarLink) 75
State (cards), see Cards 212
Status icon

refresh delay 61
Support 4
Suspend messages 57
Swap descriptions 454
System Components 22
system data 444
System Date & Time 412
System Log

View 442

T
TCP-IP 87, 473
Terminal server 87
terminal server 87
Time & Attendance Reports

Add transactions 398



Automatic Report Output Definition 396
Preview 404
Select doors 393
Use specific card range 394

Time and Attendance 108
Trace

option 213

U
Unidirectional mode 74
Unlock schedules (elevator floors) 114
Upgrading the System 24
usage restriction 214
Users 203

V
Validate Card Access 252
Verify master password 408
Video Integration 131
video options 414
Video server tab 427
Video Vault

Configuring EntraPass Video Vault 75
file format 78

View Last Transactions 258
Visitor Definition 263
visual feedback

see reader 92

W
What is Access control? 1
window

description 57
Workstation



Automatic logout on idle 55
Suspend messages 57

workstation
filters 57

Workstation Registration 437
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